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INTRODUCTION

Rapid globalization coupled with the growth of the Internet and information
technology has led to a complete transformation in the way businesses or
organizations function today. It has not only affected the management culture, but
has also led to an increase in competition in terms of market and resources.
Businesses have become more customer-driven and e-commerce is gaining
popularity. Traditional means of correspondence have given way to online dealings,
e-mails and chats.

With such a radical shift in the approach to doing business, came the need
for a specialized system to handle the various departments and functions in an
organization.

Management Information System or MIS can be called an organized and
well-structured system put in place in an organization for the collection, storage,
processing and dissemination of data in the form of information that helps the
management in the smooth functioning of the organization.

This book, Management Information Systems, explains the concepts of
MIS, its meaning, scope and role in modern management. It also deals with system
analysis, input—output designs, the Internet and emerging technologies and how
these have affected MIS; several data processing techniques, classification and
implementation procedure of MIS and the organizational changes that have been
brought about by the changing technologies associated with information system.

The book has been written in a self-learning manner. Every unit starts with
the ‘Objectives’ that lays bare what the students would learn in that unit. This is
followed by the ‘Introduction’ that gives a brief outline of the concept to be dealt
with. ‘Summary’ and ‘Key Terms’ are given after every unit to help students
recapitulate the concepts. The ‘Check Your Progress’ and ‘Self-Assessment
Questions and Exercises’ sections in each unit help in better understanding the
subject. The ‘Further Reading’ section creates a research interest in students for
further exploration of the topics covered.
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Overview of Management,

UNIT 1 OVERVIEW OF Organisation and MIS
MANAGEMENT,
ORGANISATION AND MIS SIS

Structure

1.0 Introduction
1.1 Objectives
1.2 Need for Information Systems
1.3 Basics of Information System
1.4 Introduction to MIS
1.5 Role and Scope of MIS in Modern Management
1.5.1 Organizations and Information Systems
1.52 How Information Systems Affect Organizations
1.5.3 Managers, Decision-Making and Information Systems
1.54 Information Systems and Business Strategy
1.6 Fundamental Concepts of MIS
1.6.1 Management
1.62 Information
163 System
1.7 Computer-Based MIS
1.7.1 Contemporary Approaches to Information Systems
1.7.2 Towards the Digital Firm: The New Role of Information Systems in an
Organization
1.7.3 Learning to Use Information Systems: New Opportunities with ®
Technology
1.8 Answers to ‘Check Your Progress’
1.9 Summary
1.10 Key Terms
1.11 Self-Assessment Questions and Exercises
1.12 Further Reading

1.0 INTRODUCTION

Information systems play an important role in management. Even though the study of
information systems does not encompass the study of Information Technology (IT),
information systems use IT extensively. Thus, some knowledge of IT is essential for
the student. But first you will learn about the information needs of an organization
and how this information is classified. You will learn how to acquire information, the
nature of information and the various types of information. Then you will learn about
information models and information management; two critical components of business
operations. The present business trends point to the need for information management
in business organizations. Systems are built to manage such information. These systems
are housed on a computerized platform so that they deliver information in a timely
and accurate manner. Information systems, as these are called, are designed to help
organizations become more efficient by utilizing their resources to the maximum.
Therefore, knowledge of systems concepts is important in itself. It is especially

necessary while learning about information systems. Sp- Heamine ,
ateria
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Overview of Management, Management Information Systems (MIS) deals with organizational functlons
Organisation and MIS ol ers are people who drive an organization by planning its future, organizing
and controlling its present and directing others in the organization to _work towards
a common objective. However, strictly speaking, in functional terms, management
NOTES is all about taking decisions. In fact, the only quality which distinguishes a manager
from the rest of the people in the organization is the manager’s ability to take
decisions. However, no decision can be taken in isolation. Even simple decisions
require information as an input. These decision requirements fuel an insatiable
need for information within the organization. This need for information is met bya
set of information systems working in a synchronized manner, collectively called
Management Information System (MIS). The competitive environment of today’s
business necessitates that MIS of any modern organization work on an information
technology platform and suitable information be delivered to the right person at
the right time.
In this unit, you will learn about need for information systems, basics of
information system and introduction to Management Information System (MIS).

1.1 OBJECTIVES

After going through this unit, you will be able to:
¢ Understand information systems
e Appreciate the role of information systems in an organization
e Discuss about the meaning of Management Information Systems (MIS) ~ «
* Know about the role and scope of MIS in modern management
e Analyse the fundamental concepts of MIS
e Elucidate on computer-based MIS

1.2 NEED FOR INFORMATION SYSTEMS

Assessing the information needs of an organization for business execution is a
complex task. The complexity can be handled if the information is classified on the
basis of its use and application.

Information Needs/Classification of Needs of an Organization

The classification of information is as follows:

1. Organizational Information

Organizational information is the information that is required by departments and
divisions of an organization. It may contain acount of the employees, products,
services, and locations, the type of business, turnover and a variety of details of
each one of these entities.

2. Functional Information

Functional information is the information required by functional heads to conduct

PR il management functions. This information is purely specific to that function and by




definition does not have a use elsewhere. Examples are purchases, sales,
production, stocks, receivables, payables, outstanding, budget and statutory
information.

Functional information is normally generated at equal time intervals, such as
weekly, monthly or quarterly, for understanding the trends and making comparisons
against the time scale. Such information is used for planning, budgeting and
controlling operations. Functional information is used for assessing particular aspects
of business, such as stocks of finished goods, receivables, and so on.

Functional information can be assessed on the basis of such parameters as
work design, responsibility and functional objectives.

3. Knowledge Information

Knowledge information creates an awareness of those aspects of business which
require the manager to think, decide and act. Such information shows the trends
of an activity or a result against a time scale. For example, the trends in scale
production technology, the deviations for budgets, targets norms, etc., competitor’s
information, industry and business information, plan performance and target and
its analysis. This information is used by the middle and top management.

4. Decision Support Information

Decision support information is required by the middle and top management for
decision-making. This information does not act as a direct input to the decision-
making procedure or as a formula but supports the manager in decision-making,

Information is used in a decision support system for model building and
problem solving. The support may act in two ways: one for justifying the needs of
a decision and the other as an aid to decision-making. For example, information
on a particular aspect such as utilization, profitability standards, requirement versus
availability; information for problem solving and modeling; information on the
business status; non-moving inventory, overdue payments and receivables.

5. Operational Information

Operational information is required by operational and lower level management.
The purpose of this information is fact-finding and taking such decisions and actions
that will affect the operations at a micro level. The source of operational information
is largely internal. It is obtained by processing transactions. Itis mostly current
and relates to a small time span.

6. Strategic Information

Strategic information is required for long-term planning and for directing the course
the business should take.

7. Tactical Information

Tactical information is required to take short-term decisions to run the business
efficiently. It requires specifically designed processing of data. Most of it can be
obtained from day-to-day collection of routine data.

Overview of Management,
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Determining Information Requirement

The main purpose of a business information system is to produce such information
that will reduce uncertainty in a given situation. The difficulties in determining a
correct and complete set of information are as follows:

e The capability constraint of the human being as an information processor, a
problem solver and a decision-maker.

e The nature and variety of information.

e Reluctance of decision-makers to spell out the information for political and
behavioural reasons.

e The ability of the decision-makers to specify the information.

Methods of assessing Information Needs

The four methods of assessing information needs are:
1. Asking or interviewing
2. Determining from the existing system
3. Analysing critical success factors
4. Experimenting and modelling

1. Asking or interviewing

In this method, an MIS designer converses with the user of the information to
determine information requirements.

2. Determining from the existing system

Existing systems have evolved after a number of years of usage. They are faitly
useful in determining the information requirements of an organization. Sometimes,
information systems of other organizations can also come in handy in determining
information requirements.

3. Analysing critical success factors

For each organization, there are critical factors which determine its performance.
Analysing these factors can give a valuable insight.

4. Experimenting and modelling

Where there is total uncertainty, the designer and the user of the information resort
to experimentation to determine information requirements. This would decide the
methodology for handling situations. Information needs are determined after a
method has been finalized as these methods have evolved through experimentation.
Test marketing of a product is an example of this approach.

Nature of Information

Information is nothing but refined data. That is, data that has been put into a
meaningful and useful context and communicated to a receiver who then uses it to
take decisions. As a corporate resource, its nature can be defined by the following
characteristics:

1. Information is meant to be shared by all those who are associated with the
attainment of the company’s common goals and they, in turn, contribute to
the corporate stock of information.




2. Most of the information is organization specific and its value depends upon
its use by the decision-maker.

3. Ithas a high rate of obsolescence and thus must reach the user as early as
possible. Redundant part of this resource must be weeded out of the total
stock of information.

4. Information is exposed to a variety of security risks. Therefore, appropriate
security policies and procedures should be implemented to protect
information such that these do not hinder the informations’s seamless flow.

5. Information is a value added resource. Just as value is added to a product
as itmoves from the raw material stage to the final stage, the same is true
for converting data into information.

6. Information has a specific cost associated with it just as if it were acquired

from a market. Therefore it is essential to acquire and utilize information
efficiently.

1.3 BASICS OF INFORMATION SYSTEM

Information Systems (IS) are a special class of systems that are used for data
storage, retrieval, processing, communication and security. Information systems
that help management at different levels to take suitable decisions are called
Management Information Systems (MIS). Information systems are housed in a
computerized environment / platform to enable users to get accurate information
immediately.

Information Systems: Definition and Characteristics

According to Orlikowski (1992), ‘Nothing is more central to an organization’s
effectiveness than its ability to transmit accurate, relevant, understandable
information amongst its employees. All the advantages of an organization’s economy
of scale, financial and technical resources, diverse talents, and contacts are of no
practical value if the organization’s employees are unaware of what other employees
require of them.”

Information systems over the years

Information systems have transformed remarkably in the last forty years of their
existence. Initially, information systems were designed to perform a specific task
quickly with very few errors. The concept of using information systems to take
decisionshad notbeen thought of earlier. Organizations used information systems
onlyfordataprocessing, beitsalaries orbills. Those who worked on these systems
were familiar with the commands and the interface, which was characterbased. The
outputwasin the formofsalaryslips, billsand invoices. These were dataprocessing
systems. These systems used file-based data storage systems on whicha programme
would work, i.e., the programme would be able to access the data and organize it,
butitwould storethe dataina file. The problem with this type of system is that it leads
toreplication of dataand loss of consistency.

Over the years, information systems have changed. Now the focus is on
helping management by providing information useful for decision-making. Data
processing systems have become obsolete. Delivering the right information to the
right people at the right time is the priority. Information systems have become

Overview of Management,
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Overview of Management,  faster, more accurate and user friendly. Those who work on information systems

Sl nowadays know little about systems. They are normal users. New concepts, such

as client server architecture, networking, distributed computing, centralized

database, graphical user interface and the Internet, have emerged in the information

NOTES systems space to help organizations get better value for their money. Bulky and
expensive mainframe systems have been replaced by expensive software.

Information Systems: Components, Applications and Types

Information systems are data processing systems, which collect data from different
sources, process that data and generate information from the data which can further
be used for different applications within the organization. For example, in a business
context, an information system collects data from various systems such as finance
and sales systems from the supplier side. The information system processes the
data and generates information for the customer. Customers provide feedback to
the supplier depending on the information processed by the information system.
Figure 1.1 shows the information system in a business context.

ORGANIZATION
Suppliers Customers
Input data > Process Information
7 7'y
Feedback
INFORMATION SYSTEM B

Fig. 1.1 The Information System in a Business Context

Information systems are basically systems that help to maintain and manage
information. An information system helps to manage and store information to
perform various functions such as decision-making, documentation of business
activities and generation of reports for analysis of organizational operations. One
needs to understand the concept of information and system to acquire a basic
knowledge of information systems. Various terms used in information systems are
as follows:

e Dataisthe raw material that can be a number, a fact, a sound, a picture
or a statement gathered from different sources. In the real world, data
can represent anything related to business processes and employee
details.

o [nformation is meaningful data or processed data. It defines the relation
between the different data.

o Systemisrefers to a collection of components that helps in achieving a
common objective. For example, in a human—machine system, the
machine element consists of hardware and software to perform
computation, and people make decisions based on this computation.

Self - Learning
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Components of information systems

A system consists of two types of components: abstract system components and
physical system components. Abstract system components perform such operations
as collecting input data, processing the data and generating information from that
data. Physical system components consist of various elements such as hardware,
software and human resources. There are a few more components of an information
system, such as:

e Data: Input that the system takes to produce information.

¢ Hardware: A computer and its peripheral equipment such as input, output
and storage devices.

o Software: Application programs or a set of instructions that process the
input data using computers, generate information and store information for
future use.

¢ Network: A collection of computer systems connected to each other to
share the information.

e Manpower: Information system professionals and users who perform various
organizational operations such as analysis of information, designing and
construction of the information system, and maintenance of the information
system. The workforce could comprise IT experts, managers and workers.

e Graphical User Interface (GUI): This is an interface for the users of an
information system to work with information on the computer system. A
user can operate, process and retrieve information from the computer storage
using GUL

The components of an information system describe the functioning of the
system. An information system takes the input data from the users of the information
system to perform business operations. The users interact with the computer to
process data using GUI. After processing data, information is retrieved at the
users’ end. Figure 1.2 shows the basic information system to perform business
operations.

= B Input Data
|:| EI o Users of IS
R cutaris|e B | | e
Network ® Managers

® Workers
Information ® Other

= |:| 5 employees
Processing of Data INFORMATION SYSTEM

Fig. 1.2 The Basic Information System
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Applications of information systems

There are many application areas that implement information systems in a business
environment to solve business problems and to pursue business opportunities.
Figure 1.3 shows the various application areas of information systems in an

organization.

Marketing

Interactive marketing sales
force automation

Advertising and promotion
market research
Production Operations Personnel
Manufacturing resource Compensation analysis
planning Employee skills inventory
Manufacturing execution Personnel requirement
systems forecasting
Accounting Finance
Order processing Claghi
management
AInventm'y coptl:gll Audit management
SEAMINTEREINE e Investment management
Acco;nts p&lalyable Capital budgeting
ay 1o ot 731 :
Genersl Todiger Financial forecasting

Fig. 1.3 The Application Areas of Information Systems

Types of information systems

Information systems manage data and process it to provide operational and managerial
support in an organization. Operations-support systems control business operations,
generate sales orders and determine payment to the employees. Management-support
systems help to take managerial decisions for the development of the organization.
Figure 1.4 shows the classification of information system.

INFORMATION SYSTEMS

A 4 v
|Knuwledge Level Systems”Strategic Level Systems] IMEngement Level Systemsl l Operational Level Systems I

R

Office Systems

KWSs EISs MISs DSSs Expert Systems TPSs

Fig. 1.4 The Classification of Information Systems

Organizations use different types of information systems as per the
requirements of organizational functions. Various types of information systems on



the basis of organizational functions that help in integrating business processesand =~ Overview of Management,
information are as follows: Organisation and MIS

e Management Information System (MIS) which manages the information
to plan and control the organizational tasks and to make decisions.

e Decision-Support System (DSS) which supports the low-level and the
middle-level workers to take decisions for a better performance of the
organizational functions.

o Executive Information System (EIS) which helps top business executives
in decision-making using key business information.

o Expert Systems which analyse business information and provides solutions
to those business problems already defined in its implementations.

o Knowledge Work System (KWS) which takes inputs as designing
specifications, models them and generates pictures and graphics. The
output of the system helps technical staff and professionals to understand
the business operations visually. KWSs generate, share and distribute
knowledge and help in decision-making.

e Transaction Processing System (TPS) which is an essential business
system that assists the functional plane. An inbuilt system, it plays a vital
role inthe execution and documentation of routine dealings for the smooth
running of the business.

e Office Systems (OS) which helps to keep records and manage various
office operations such as accounting and sales. These systems process
word documents and generate electronic information.

Different types of information systems are used for different types of functions.
For example, an EIS is used for strategic planning, Strategic planning helps to take
decisions for future plans. Figure 1.5 shows various types of information systems,
their functions and the level of the system in which they are used.

| TYPES OF SYSTEMS
Executive Support

! Systems (ESS)

i

Management
Information
Systems (MIS)
Decision-Support
Systems (DSS)

NOTES

Knowledge Work
Systems (KWS)

Office
Systems

Transaction
Processing
Systems
1 (TPS) : - :
E Sales and Manufacturing ~ Finance Accounting Human
Marketing Resources

Self - Learning

Fig, 1.5 Various Types of Information Systems, their Levels and Functions Py f1
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An information model is a formal representation of any particular entity, be it a

project, an object or a system. It includes the entity’s various. features and
NOTES characteristics, functions and interrelations. An information model represents all
the concepts, rules, operations, limits and specifications to represent data in a
stable, sharable and organized structure. A mapping of an information model is
called a data model.

Overview of Management,  Ipformation Models
Organisation and MIS

Facility Information model

A facility information model is a model of a facility, with integrated data and
documents. A facility is something that can be designed, fabricated, constructed
and installed, operated, maintained and modified. Examples of a facility include an
infrastructural network, a building, a process plant, a highway, a plane or a ship. It
is different from a product model, which is typically expressed as a data structure.
A facility information model on the other hand, can integrate more than 1000
components and a large number of documents. It is useful to those who want
information about the components of a facility and their operations.

A facility information model can be a fixed data model or can be expressed
in a flexible modelling language such as Gellish English.

A facility information model may consist of the following:

A facility model with processes and activities
o A documents and data sets section
e An electronic common dictionary

¢ Requirements models
Facility Model

A facility model describes a facility in a hierarchical structure. It is divided into
sections, which in turn are broken into units and utilities. These are further divided
into equipment systems, subsystems and control loops, which are broken into
components of equipments. It comprises data in the form of relations between the
components and their properties and relations to other objects.

Documents and data sets
Each document and data set is related to a particular element in the facility model.

Electronic common dictionary

All the components, data and documents are classified and defined in an electronic
common dictionary, which is an integral part of a facility information model.

Requirements models

The requirements of a facility information model are defined in computer-
interpretable ways to measure its quality.

Self - Learning
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Integrating the information model with the data processing system Overview of Management,
Organisation and MIS

The primary function of an information system is to manage large quantities of
data, which can be both structured or unstructured. Data models depict structured
data so they can be stored in data management systems. Unstructured data like e- NOTES
mails, word processing files, digital audio, video and images are generally not
depicted.

Business Process Integration

l Business Model l

I Process Model I l Data Model |

| Process ‘ ‘ Process ‘ ‘ Process I | Data [ { Data —| ] Data |

N\ / —
| Pseudocode —I l\zgzi?l E%
v :
| AppEiC}tion Prototypes | Rg‘;‘éﬁﬁi‘i“ %‘/ Phlz)séz:lal
o f— NG -
F—0 =0

User Application Database 1/0 Data
View Panels Programs Generation Structures

Fig. 1.6 Business Process Integration

The integration of data processing system and information model illustrates ®
the functions associated with a process and the organizations that perform these
functions.

Role of data models

Data models provide a data’s definition and format and support data and computer
systems. Data can be compatible if this is done consistently across all systems.
Different applications can share the same data if the same data structures are
used. Some of the drawbacks of data models are:
¢ Small changes in business operations require major changes in computer
systems.
» Sometimes, entity types are wrongly identified, or not identified at all,
leading to duplication at all levels, with attendant costs.

e Different systems can have different data model. Complex and costly
interfaces are required in such cases to share data.

e Not all data can be shared electronically due to their inherent structures.
The main cause for these drawbacks is lack of standards for data models.

Information modelling and business orientation

Information models are a major component of enterprise content management,
and dynamic content management. Business Information Modeling (BIM) provides
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a structure describe the business under consideration from an information
perspective. BIM breaks down a business into its basic components and identifies
information-processing requirements.

An understanding of the flow of information throughout an organization
provides a foundation for identifying opportunities for automation that can add
significant value to companies, especially in reducing costs, improving quality,
increasing revenues and enhancing customer service.

A BIM is often divided into primary functions, the functions that are required
to develop and deliver a company’s products or services; and support functions,
which the company requires to perform to support the primary functions.

Business Information Model

Primary Design Manufacture Marsl;(:flﬂnd Distribute
Functions: Product Product Product Product
Support Plan the gﬁg Manage ;’:c aﬁ?ﬁg:s Manage i
Functions: Business Resources Finances | | 1 Material Informatwni

Fig. 1.7 A Business Information Model

BIM serves as a framework to document business processes. It also the
depicts the data that a company requires for its business processes, and, in turn,
the data that is produced by these processes. These processes have to be
documented in process models. The data used by each process should be
standardized and documented in data models.

Information Management (IM)

Information Management (IM) comprises the compilation and management of
information from various sources and the sharing of that information with audiences.
Till about the 1970s, this was limited to maintaining paper-based files, folders and
records. With the revolution of information technology or IT from the 1980s
onwards, information management started taking the shape of data maintenance.
Skilled professionals and experts at hardware and software, were now required
for the tasks of information management. By the late 1990s, network managers
became information managers.

Information Concepts
We will now look at some concepts related to information, that is, data, information
and knowledge.

Data

Data refers to the basic facts and entities such as names and numbers. Examples
of data are dates, weights, prices, costs, numbers of items sold, employee names,
product names, addresses, tax codes, registration marks, etc.

Data is collected, stored and processed in a way so that it can be used to
arrive at specific conclusions.

|
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In a business, data input is a collection of facts about elements, such as Ovegfew of ﬂ{anag«zn;;g
consumers, suppliers, competitors and government. Data refers to the raw materials e
consumed in production processes, that used in factories or industries.

Information ' NOTES

Information is data that has been converted into a more useful form. Information is
used for direct utilization of mankind, as it helps human beings in their decision-
making process, for example, time tables, merit lists, report cards, headed tables,
printed documents, pay slips, receipts, reports, etc.

Information is obtained by assembling items of data into a meaningful form.
Other forms of information are pay-slips, schedules, reports, work sheets, bar
charts, invoices and account-returns. Information may further be processed and/
or manipulated to form knowledge.

Knowledge

Knowledge is a hierarchy of reliable data and information that is used to service
work and decisions. Its consolidation creates an intangible wealth for all purposes.
A small difference exists between data, information and knowledge. Data is raw
facts and numbers. Information is the result of processing data to give it meaning,
An accumulation of relevant information is called knowledge.

There are two types of knowledge:

1. Explicit: Explicit knowledge which can be attained from reading a
document.

2. Tacit: Tacit knowledge is shared from an individual’s experience .
through dialog, judgement, lessons, etc. It is not easily transferable.

In a competitive market where every organization is primarily using innovation
as a tool for competitive advantage, knowledge combined with a good strategy
helps promot innovation.

Data in itself, especially raw data in large quantities, is of very little use or
rather no use to decision-makers within an organization. It is too difficult for a
single or a group of persons to look at a set of data and extract some meaning
from it. Figure 1.8 shows the process of using data, information and knowledge in

order to make organizational decisions.
m

@
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Fig. 1.8 The Process of Data, Information and Knowledge Self - Learning
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Overview of Management,  (Classification of data

Organisation and MIS
For data management purposes, data is classified into two categories: (i) structured
and (ii) unstructured data. ‘
NOTES (i) Structured Data

Structured data or structured information is the data stored in fixed fields within a
file or a record. This form of data representation is also known as tabular data,
where data sets are organized in the form of a table. Structured data is managed
by techniques that work on query and reporting against programmed and stored
data types and relationships. Databases and spreadsheets are examples of
structured data.

(ii) Unstructured Data

People use and create unstructured data everyday, although they may not be aware
of the same. A word processed letter or e-mail, in fact documents, and images
such as those captured by a digital camera are all examples of unstructured data.
Unstructured data primarily consists of textual data and image data. Textual data
being any string of text, this could be a whole book or simply a short note. Images
are digital pictures such as photographs and maps.

In business, unstructured data can take the form of letters, memorandums,
reports and legal documents. In order to manage this data effectively it needs to
be organized for storage and retrieval, because the information in these documents
may be critical to business processes. One technique for organizing or structuring
unstructured data is to utilize metadata.

LY

Metadata
In its simplest definition, metadata is ‘data about data.’ Metadata about a
document could include:

¢ Author or source

e Date written

¢ Document category

e Document content

e Number of pages, words, data entries, etc.

The use of metadata does not require one to follow any rules or protocol.
Any conceivable characteristic can be attributed to a document or a set of data,
though an effective use of metadata requires some planning and foresight. It allows
an organization to structure and index its digital document resources based on
categories or characteristics defined by the organization itself.

Managing data

Data is a valuable resource for any organization, large or small. Regardless of the
operations and objectives of an organization, it keeps records of its finances,
employees, stocks, production, and so on. Whether these records are stored and
updated electronically using a computer system or on paper using a filing cabinet,
an organization will benefit by managing this data effectively.

Self - Learning
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Recording and storing data within an organization is only useful if this datais ~ Overview of Management,
used to benefit the firm. Unused data, apart from the legal requirements of record il
keeping, is generally considered a wasted resource. Data on stock control and
production output in a manufacturing firm can be analysed to identify strengths and '
weaknesses in the production process, employee records can help identify trends NOTES
and information regarding salary and demographics can help focus development
on the workforce. These and many more such benefits can be achieved by
managing an organization’s data.

At its most basic level, managing data is about organizing an environment or
system where data can be stored, updated and retrieved. An organization’s data
management requirements will be greater than the aforementioned and its specific
requirements will be more complex. Standard requirements of data management
within an organization are as follows:

1. Outline the organization’s objectives: What does the organization want
to achieve through data management? What systems and processes are
already in place? What are the remaining requirements to fulfill these
objectives?

These are questions an organization needs to ask before implementing
a data management strategy or changing the way it manages data. Every
organization is different and, therefore, the requirements of data management
are also different. One objective may be to use a decision support system
that utilizes data from three different departments in order to help focus the
organizational goals and improve business processes. This objective can be
broken down into technical requirements and specifications. By doing the &
same with all identified objectives, the organization can quickly view its
total requirements to achieve all its objectives related to data management.

2. Provide a data storage solution: This involves designing and implementing
an appropriate system for the organization to store its data. It usually, but
not always, involves a database system. The storage solution should fulfil
the following basic requirements:

e Security: The storage system should not be accessible to outsiders.
Sensitive data should only be made available to appropriate persons,
departments or systems within the organization.

¢ Easily updatable: The system should allow updation of records and
addition of new data quickly and easily.

¢ Easy retrieval of data: The system should allow data to be retrieved
quickly and easily.
¢ Appropriate capacity: The system should be designed such that its

capacity is large enough for both current and future data requirements.
It should also be upgradable and expandable for future needs.

e Backup: There should be an appropriate backup system in place in
order to recover data should there be a critical failure or event. The
more often a system updates and alters data, the more often backups
should take place.
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To summarize, a poor data management strategy can at best provide the
basic functions for storing and updating organizational data and at worst become
a security risk for sensitive data. A good data management strategy allows an
organization to utilize data to increase its effectiveness. Developing and implementing
an effective data management system can be costly. However, for most
organizations the benefits far outweigh the costs.

Data management in IT

From the very moment a computer was used to make calculations involving data,
the need to store and access this data was identified and the following solutions
were developed: File System was developed in the 1950’s followed by hierarchical
Data Base Management Systems (DBMS) in the 1960’s. Network DBMS,
followed by Relational DBMS were developed in the 1970’s and later on
developed into Object-oriented DBMS in the 1990’s.These concepts will be
examined in the following sections.

Dimensions of information

Information can have different dimensions, broadly categorized under business
and technical dimensions.

Business dimensions

This dimension relates to the business angle of information and its value to the
organization. The sustainability of getting information from a managerial standpoint,
the accuracy and reliability of information and its scope and appropriateness, are
the parameters for understanding the business dimension of information. This
dimension has got more to do with the ‘what’ of the information rather than the
‘how.” The business dimension of information can have the following parameters:

¢ Time: Information has to be timely to be of any value.
¢ Accuracy: Information has to be accurate to satisfy the user.
¢ Reliability: Information has to be reliable, so that users have confidence.

e Appropriateness: Information must be relevant to the receiver. It must be
appropriate to his needs.

e Scope: Information should be within the user’s scope.

¢ Completeness of Content: Information should be complete and not in
bits and pieces.

Technical dimensions

The technical dimension relates to the gathering, summarizing, storing and retrieval,
analysis and cost aspects of information. It can have the following parameters:
e Information gathering
e Analysis methodology
e Technological issues
¢ Networking and communication
— Data management and maintenance
— Visualization and reporting




e Costs of information
¢ Cost of data acquisition
e (Cost of data maintenance

e Cost of data access

Role of Information in Decision-Making
Decision-making is a process that includes the following stages:

¢ Identification and structuring of problems: One needs mformatlon to
identify a problem and describe it in a structured manner.

¢ Putting the problem in a context: Without information about the context
in which the problem has occurred, one cannot take any decision onit. Ina
way the context defines the problem.

¢ Generation of alternatives: Information is a key ingredient in the
generation of alternatives for decision-making.

e Choice of the best alternative: Based on the information about the
suitability of the alternatives, a choice is made to select the best alternative.

Information is required to take decisions. Imagine a simple decision like the
one a driver makes, when he presses the brakes to stop his speeding vehicle, a
child crossing the road. The driver decides on braking based on the information
processing that occurs in his brain. At every stage, he uses information, which he
captures visually. All decisions are like this.

First we get information about a problem, which we format into a structure.
Then we get information about the context in which the problem has occurred. In
the example described above, if, instead of the child crossing the road, the driver
had seen the child about to cross over with a few steps only, he would not have
braked to stop but would have slowed down, as he would have calculated that by
the time the vehicle reached the crossing stage, the child would have passed. If the
problem was described as ‘how not to hit the child crossing the road’, and if the
child was in the middle of the road, the driver would have braked but had the child
been about to complete crossing the road, the driver would have only slowed
down and not braked to stop. Therefore, we see that context has a major role in
decision-making and information is required both about the problem and about
the context in which the problem occurred.

The next stage for the decision-maker would be to generate alternatives. In
the driver’s case, such alternatives would be to:
(a) Stop by braking.
(b) Slow down.
(c) Take a sharp turn towards the left or right to avoid the child.
(d) Press the horn so that the child crosses the road quickly.
(e) Drive the vehicle on to the footpath and out of the road to avoid
collision.
So the decision-maker generates these possible solutions to the problem at

hand, based on the knowledge and information he has. For instance, in the example
discussed above, the driver would need to know that braking stops the vehicle. If
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he is unaware of this crucial information he would not be able to generate this
alternative.

To decide which alternative to choose, the decision-maker needs to know
what would be suitable. In our example, the driver calculates the payoff for each
alternative, based on his calculation of the outcome, which again is based on
information. He selects the best option to solve the problem. Thus, we can see
that information is the key to the decision-making process. Without information
and the right kind of information, decision-making is not possible.

Therefore, to enable managers to take good quality decisions, it is very
important to provide them with the right kind of information. An MIS provides this
service to the managers, enabling them to take informed decisions.

Subsystems of an Information System

An information system allows the storage, retrieval and processing of dataina
secure environment. Logically, the subsystems of an information system are:

o Data repository: This is a subsystem that is at the core of any information
system. This is a relational database management system (RDBMS) that
includes preformatted and structured tables for storage of data. These
structures are arranged in a way that helps in the faster storage and retrieval
of such data with adequate security.

o User interface: This subsystem handles the interaction of the system with
the user and hence it has to take care of issues related to the display of data
on an output medium. This can be either graphical or character-based

depending on the level of ease offered to the user. s

e Network: This subsystem ensures communication between the different
entities of an information system. It is crucial for the functioning of an
information system.

e Computer hardware: IT infrastructure is necessary to use information
systems in an effective manner. Almost all the components of an information
system are housed in some kind of computer hardware to enable it to perform
tasks faster. For example, an algorithm to find the lowest of three numbers
can be calculated manually but under a computerized system it will be much
faster and efficient.

o System software: Some basic software is required for an information
system to function efficiently. System software enables information systems.
Examples would include operating systems.

¢ Input/output: Sometimes, this is clubbed with the user interface to suggest
that I/O functions are handled by Ul alone. However, in some systems /O
may be user-independent, such as when an alert is activated, the input for
the alert comes from some other system input, rather than a user.

o Business rule (process): This is a set of rules that govern how a system
should function to mimic real-world business processes.

¢ Algorithm/application software: This is the component that integrates all
the components. The logic (business rule) is defined in the program




(embedded in it), which enables the functioning of the information system ~ Overview of Management,
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for some specific purpose.
All the above components work in concert to make a functional information ,
ysiem. NOTES
Check Your Progress

1. What is organizational information?

2. What are the methods of assessing information needs?
3. Define MIS.

4. What is a data model?

1.4 INTRODUCTION TO MIS

Meaning of MIS

Management Information System (MIS) is a term used to refer to a class of
information systems, that provides the management with the information required
for decision-making. The three words which constitute the term, Management
Information System, have a role to play in its design and functioning,

. Management is the unseen force that drives an organization. It is the lifeblood
ﬁ' of an organization. People performing various management roles in an organization
iﬁ are called managers. These managers are the key people within an organization
who are responsible for the smooth functioning of the organization. The managers
are divided into different levels depending on their level of authority and power.
Normally, the higher the level of a manager, the higher the authority he has in an
organization. However, authority does not come without checks and balances.
With authority comes responsibility. In fact, in management there can be no authority
without responsibility. Managers at different levels perform important tasks.
However, the most important task they perform is the task of taking decisions.

Information is the key ingredient for taking decisions; that is why
management values information. Information improves the quality of decision-
making, which is the most important task of management and hence information is
the most important asset for managers. Information is created after processing
data, mostly transaction-level data. This transaction-level data has to be captured,
stored and then processed to create any meaningful information for managers.

A system can be defined as a set of interacting entities having interrelation,
interconnections with each other, forming an integrated whole. System in the context
of MIS in today’s times means a process (technology-enabled) for capturing data,
storing it and then processing/analysing it to provide information.

Information systems that help a management in taking decisions are called
management information systems. MIS consists of a set of information systems

' working towards the common goal of achieving greater efficiency in decision-
making at each level of management. Typically, MIS deals with internally-generated

Self - Learning
Material 21




Overview of Management,
Organisation and MIS

NOTES

Self - Learning
22 Material

information. The in-house data is processed (summarized/aggregated) to create
reports, which helps a management at different levels in taking decisions. Today’s
management information systems have a data repository at the core, which is
mostly in the form of a relational database management system. All in-house data
(mostly transaction-related) are saved in this database, which is itself designed on
the basis of set rules. Over this data repository are several tiers of logic and/or
business rules, which help in creating an interface and various reports to be used
by managers at different levels. An MIS is normally designed in order to achieve
information flow, which is based on the ‘need to know”’ principle. This means that
any manager would be given only that type of information to which he is entitled
and has any use. This means that a shop floor supervisor may get the details of all
personnel working under him, but will not get the salary details of the CEO as he/
she is not entitled to know such information or will not get the details of all
employees working in the human resource department as he has no use for such
an information. This hierarchical rule-based information delivery to the different
levels of management is put in place to avoid both information overload and enable
security of information.

Many modern systems have come up in recent times to help managers in
their tasks like Enterprise Resource Planning system, which is a transaction
processing/support system but comes in-built with the best practices of the industry
and helps in generating integrated scenarios for managers at different levels.
Customer Relationship Management system helps in the management of customers
by creating profiles and making available complex analytical tools to managers for
processing customer data. Similarly, there are systems to help managers deal with
supply chain data called Supply Chain Management system. All these modern
systems basically help in achieving greater efficiency by making the job of
management decision-making better and therefore, falls under the category of
Management Information System.

MIS is a set of systems, which helps the management of an organization at
different levels to take better decisions by providing the necessary information.

The role of information technology in developing good MIS is meant to
enhance the timeliness and quality characteristics of the information. The subject
of MIS does not necessarily mean a study of information technology; however,
MIS now has an overwhelming component of IT in it.

MIS is not a monolithic entity but a collection of systems, which provides a
user with a monolithic feel. The different subsystems working in the background
have different objectives, but work in concert with each other to satisfy the overall
requirement of managers for good quality information. MIS can be installed by
either procuring ‘off-the-shelf” systems or commissioning a completely customized
solution. Sometimes, management information systems can be a mix of both', i.e.,
an ‘off-the-shelf” system but customized according to the need of the organization.

However, before we proceed any further, we must have a clear understanding
of what managers do in an organization and why they need MIS.

Managers are the key people in an organization who ultimately determine
the destiny of an organization. They set the agenda and goal of an organization,
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plan for achieving the goal, implement that plan and monitor the situation regularly
to ensure that deviations from the plan are controlled. This set of activity ensures
the smooth functioning of the organization and helps it attain its objectives and
hence these managers are vital for a successful organization. The managers, in
turn, conduct these activities, collectively called management functions, by doing
something that others in the organization do not i.e., decide. They decide on all
such issues that have relevance to the goals and objectives of an organization. The
decisions range from routine decisions taken regularly, to strategic decisions which
are sometimes taken once in the lifetime of an organization. The decisions themselves
differ in terms of:

o Complexity

¢ Information requirement for taking the decision

o Relevance

e Effect on the organization

¢ Degree of structured behaviour of the decision-making process

Different types of decisions require different types of information. Information

systems, which supply relevant information to managers to enable them to take
decisions are collectively termed as Management Information Systems. They have
common characteristics and even though their actual implementation in an
organization may differ according to the needs of an organization, their basic
characteristics remain the same. The information technology platform on which
MIS is based may also vary in terms of complexity and scale, but the technology
component does not change the broad characteristics of the MIS. Technology is
the only medium through which a solution is delivered.

Conceptually, MIS and information technology are two very different things.
MIS is an information management concept and has no technological component.
Indeed, technologies will change and have changed in the past but management
information system and its requirement and characteristics will broadly remain the
same. Only MIS with changing time and technology regimes will have different
technology platforms. In the early 1970s, MIS was mostly run on the mainframe
computers with COBOL programs. In the 1980s and 1990s, it changed to a
personal computer-based solution using networking, databases and 4GL tools.
Today, MIS runs on advanced computer networks with wireless connectivity with
hugely advanced software tools, but the broad characteristics of MIS have remained
the same. In the 1960s and 1970s also, it was instrumental in providing information,
which helped in management decision-making, just like today. Only the degree
and quality of information has improved. However, the character of MIS has not
changed with the changing technology. Technology has always been and will be a
platform for MIS. However, the technology intervention to provide a platform for
MIS has increasingly grown over time and some confuse MIS with the technology
on which it runs. Technology has become an integral part of MIS but one must
appreciate that MIS is a much larger concept critical to management decision-

making,
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Information Technology

The term ‘information technology’ or IT as it is commonly called, refers to the
technology that uses computer software and hardware for the purposé of processing
data and producing useful information.

The Information Technology Association of America (ITAA) defines
information technology as the ‘Study, design, development, implementation, support
or management of computer-based information systems, particularly software
applications and computer hardware for the purpose of converting, storing,
protecting, processing, transmitting and securely retrieving information’.

Today, information technology impacts all aspects of our lives and is now
an integral part of our everyday activities. It covers a wide range of activities like
a simple information storage or retrieval, hardware installation, data management,
communication over networks and software development.

Uses of Information Technology

IT can mean different things to different people. IT and its applications are used
widely across every section of society, business, education, government, etc.
Household devices such as televisions, telephone, radios, microwave oven, dish
washers, washing machines and mobile phones, all involve information technology
in one form or another. E-mail, word processors, spreadsheet software, the Internet,
and communication software have redefined the way people work and are now
an integral part of our daily lives.
Some of the common uses of IT are:
* Telecommunications through the use of e-mail, telephonic exchange, remote
data transfer, etc.
* Publishing, whether online or through printed material.
* Weather forecasting uses computer systems to process data in order to
predict upcoming weather patterns.
» Commerce, whether through the selling of goods over the Internet
(e-commerce) or using computers to manage accounts, stock control, etc.

e Industries use IT in many processes, such as Computer-Aided Design
(CAD,), control of manufacturing systems, Database Management Systems
(DBMS), Enterprise Resource Planning (ERP), Management Information
System (MIS), and Remote Sensing.

* Banking, in its current form, relies heavily on IT to perform transactions,
store huge amounts of financial information, and interact with customers
and partners.

® IT-enabled Services like Business Process Outsourcing (BPO) and
Knowledge Process Outsourcing (KPO).

* Administration, whether of a business, an educational institution or public
entity is enhanced by the use of IT.




1.5 ROLE AND SCOPE OF MIS IN MODERN
MANAGEMENT

Let us first understand the two terms, information and system individually. Information
is that data which has been simplified into a form that is meaningful to human beings
(see Figure 1.9). Data represents some raw facts and figures that are derived from
some observations, experiment, or events. Data, until organized into a meaningful
form, cannot help in the decision-making process.

SM001 North P001 475 Salesman Code Zone Item Code
SM002 East P001 500 Sales
G > SM001 North P001 475
SM002 East P002 500
Data Processing Information

Fig. 1.9 Data and Information

The second term, that is, system, may be defined as a set of interrelated components
that are put together to achieve a common task or goal. Often, a system is composed
of several subsystems, which may further be composed of other subsystems.
Subsystems focus on achieving the sub-goals and contribute to the main goal. They
can take input from other subsystems (or systems), process it, and produce output.

Information system is thus concerned with processing the raw facts into
information and transferring this information to the users. It also takes feedback
from the users so that input can be given.

An information system can be manual (that uses pen, pencil, or paper
technology) or computer-based. Here, however, the focus is on computer-based
information system (CBIS) that uses information technology (IT) to perform its
various activities. The term information technology refers to all the components
that a system needs to operate, including the following:

o Software: Operating system software, database management software,
‘Web browsers, etc.

¢ Hardware: Servers, computers, input/output (I/O) and storage devices.

¢ Telecommunication: Telecommunication channels, telecommunication

processors (modems, switches, routers, etc.), software to support the

Internet and other private networks (either wireless or wire-based), etc.
Note: The term information technology and information system are often used
interchangeably.
The primary aim of corporate information management is information integration
which serves as a basic foundation. The scope and role of MIS changes from
stand-alone systems such as DSS (decision support system), and EIS (executive
information system), to the integrated component of information management.
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To classify MIS, one should first understand its business perspective. There
are many different areas of MIS having possibilities and important roles. The
second approach for classifying MIS is by system architecture. For this too, different
sub-types of MIS and middleware should be identified. Tasks and potentials of
middleware and MIS are put forward and real-life examples from companies are
discussed.

The main scope of MIS corresponds to different phases such as analysis,
design, planning and construction. These also include many other activities such as
implementation, utilization, evaluation and handling of information systems for
coordinating various activities in the organization. Such activities are:

* Aimedatmosteffective utilization of organizational resources using information
technology

* Handling information technologies in an interactive way in relation to the
organizational structure

* Regular evaluation of information systems

* Analysis of the existing model including changes required in design and
implementation of computer-based information systems

* Incorporating data, knowledge and information in the organization

* Application of information systems such as transaction processing, routine
data processing, decision support and using relevant data/information to
support other systems such as expert support system and executive support
system

* Activities related to research in the field of cognitive science, knowledge

engineering, and systems theory and its application in operations management

The nature of MIS is passive. It only supplies information to managers; it
does not actively lead managers to a decision. Managers take decisions without
the support of MIS. The systems only supply background information, on which
such decisions are based. The systems do not provide active support to the
manager’s decision. It does not have models to imitate the real-life scenarios as a
proactive system as in the case of the decision support system. It only supplies the
basic information. Even though this role of providing information is very important,
itis only an enabler for better decisions. The scope of MIS is thus limited in a way.
Characteristics of MIS
Management information being a specialized information system category, conforms
to certain characteristics. These characteristics are generic in nature. These

characteristics remain more or less the same even when the technolo gy around
such systems changes:

* Management-oriented: One important feature of MIS is that it is designed
top down. This means that the system is designed around the need for
information of the management at different levels. The focus of the systemis
to satisfy the information needs of the management.

* Management-directed: Since MIS is ‘for the management’, it is
imperative that it also should have a very strong ‘by the management’




initiative. The management is involved in the design process of MIS and
also in its continuous review and upgradation to develop a good quality
system. The system is structured according to the directions factored in by
the management. This helps in minimizing the gap between the expectation
of the management from the system and the actual system.

Integrated: MIS is an integrated system. It is integrated with all the
operational and functional activities of the management. This is an important
characteristic and requirement for a system to qualify as an MIS. The reason
for having an integrated system is that information in the managerial context
for decision-making may be required from different areas within the
organization. IFMIS remains a collection of isolated systems, each satisfying
a small objective, then the integrated information needs of managers will
not be fulfilled. In order to provide a complete picture of a scenario, complete
information is needed, which only an integrated system can provide.

Common data flows: Since MIS is required for an integrated system, the
data being stored into the system, retrieved from the system, disseminated
within the system or processed by the system can be handled in an integrated
manner. The integrated approach towards data management will result in
avoiding duplication of data, data redundancy and help simplify operations.

Strategic planning: An MIS is never designed overnight. A high degree of
planning goes into creating an MIS. The reason for this kind of planning is
to ensure that the MIS being established not only satisfies the information
need of the managers currently, but also serves the organization in the next
five to ten years with modifications. Sometimes, when the planning is over,
systems tend to perform well in the present but tend to become obsolete
with time. Planning helps to avoid this problem.

Bias towards centralization: Since an MIS is required to give ‘one version
of the truth’ (i.e., it must supply the correct version of the latest information),
there is a requirement for the data repository to be centralized. Centralized
data management helps an MIS to exercise version control as well as provide
an integrated view of data to the managers. In a non-centralized system,
data is entered, updated and deleted from different locations. In such a
case, it becomes difficult to provide the correct information to managers.
For example, in a decentralized system if a person superannuates from an
organization and his superannuation is only recorded in the human resource
system but not communicated to the finance department system, then it is
quite likely that his salary may be generated by the finance system for the
next month. A centralized system where data is entered, updated and deleted
from only one location does not suffer from such problems. In a centralized
system, the superannuating employee’s details are deleted from the master
file, thereby eliminating the risk of generating his salary for the next month.

Information and communication technology-enabled: The extreme
pressure of competition requires information to be timely and accurate for
effective decision-making, both of which can be ensured if information is
managed using IT. Hence, any modern MIS has a very high dose of
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NOTES Functions of MIS

The broad functions of MIS are as follows:

1. To improve decision-making: MIS provides background information on
a variety of issues and helps improve the decision-making quality of the
management. The fast and accurate information supplied by the MIS is
leveraged by managers to take quick and better decisions, thereby improving
the decision-making quality and adding to the value of company.

2. To improve efficiency: MIS helps managers to conduct their tasks with
greater ease and better efficiency. This reflects in better productivity.

3. To provide connectivity: MIS provides managers with better connectivity
with the rest of the organization.

MIS generally has an applicability in system decision-making. For example, MIS
can be used to identify problems needing urgent attention for solutions with a timely
feedback, to make the upper managers aware of the current progress and its
shortcomings. Thus, there are many functions of MIS depending upon the tasks that
an organization performs. The main functions of MIS are:

1. Data processing: This comprises collection, transmission, storage and
processing of data to provide an output.

2. Prediction: It carries out analysis on data to predict a future situation, by
applying methods of modern mathematics, statistics or by way of simulation.

3. Planning: The analysis of data of a regular nature may give many indications
on likely future events or situations and this can be utilized in planning or
reviewing the plan already made earlier.

4. Control: From arecord of day-to-day activities, monthly activities, quarterly
or annual activities, certain factors may be noted that need control. These
factors may be controlled without much difficulty, if noted on time. There
may be certain factors that need the attention of the higher management to
remain under control. But there are many small factors that if ignored in the
beginning, may disturb other factors as well.

S. Assistance: Providing assistance to the higher management by analysing
and inferring from regular records about various factors related to the
performance of the business operation, is one of the main functions that
MIS has to provide. This data may pertain to human resources, financial
resources, material resources, etc.

1.5.1 Organizations and Information Systems

Different organizations may have different needs. Information systems are developed
to serve the needs of a particular organization. The role and use of information
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What is an organization?
An organization can be defined in more than one way. From a technical viewpoint,
an organization is a formal social structure that takes inputs from its surrounding
environment and transforms these inputs into outputs through production process.
Here, inputs consist of capital and labour provided by the environment, and outputs
are products and services. The environment consumes the outputs (products and
services) and provides more inputs (capital and labour) in the feedback loop (see

Figure 1.10).
/ Organization \
Inputs from the : : : » Outputs to the
environment [ o

environment

Production process

- "

Fig. 1.10 Technical View of Organization

Another more descriptive definition of an organization is from the behavioural point
of view. From this view, an organization is a collection of rights, privileges and
responsibilities that are balanced over a period of time. Figure 1.11 illustrates the
behavioural view of an organization.

! Division of labour
| Business processes

Rules, procedures
Resources from Culture

environment > Outputs to the
Prociis environment
Rights/obligations
Privileges/responsibilities
Values

Ni
\(_Peagle J

Fig. 1.11 Behavioural View of Organization

Common and unique features of organizations

Almost all organizations have some features that are common to them. Other features
of organizations distinguish one organization from another.
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Common features of organizations
Some of the features common to all organizations are as follows:

e Hierarchy: Organizations are hierarchical structures with different levels

and specialists. All specialists are arranged in a hierarchy of authority and
responsibility. The hierarchy arranges people in a pyramid of rising authority
and responsibility. Managers, professionals and technical employees are at
the upper levels, while the operational personnel are at the lower levels.

Rules and procedures: Authorities and responsibilities are defined by rules.
Organizations develop different rules to accomplish tasks. These rules guide
the employees in various procedures such as writing bills, replying to customer
complaints, and so on.

Unbiased judgements: Rules created by organizations are impartial; that
is, everyone must follow those rules and everyone is treated equally.

Technical qualifications for positions: Organizations need different people
with different skills, such as managers, architects, engineers and so on. They
recruit and train the employees on the basis of their technical qualifications.
Maxcimum efficiency: Organizations believe in maximizing efficiency, that
is, maximizing the output by using limited inputs.

Organizational culture: All organizations have some basic, secure, and
undisputed assumptions that define their goals and products. Organizational
culture is this set of assumptions that describes the products to be produced
by the organization, how to produce them, and where and for whom to
produce. It is a powerful force that limits political differences and encourages™
common understanding, agreement on procedures and common practices.
It adds significantly to the organization’s goodwill and reputation, thus leading
to on-time projects and high productivity.

Routines and business processes: Individuals in all organizations develop
some routines over time for producing goods and services so that the
organizations become more efficient. These routines (also called standard
operating procedures) are specific rules, methods and practices developed
to deal with all the expected situations. These routines help employees to
become more creative and efficient. In a school, for example, a receptionist
has some specific set of routines for gathering information, teachers have a
different set of routines for teaching students, and the principal has a well-
developed set of routines for running the school.

Business processes are the collection of such routines. Analysing business processes
and routines helps in understanding the actual working of a business. It also helps in
making business more effective and efficient. All business processes together make
a business firm (see Figure 1.12).
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Fig. 1.12 Routines, Business Processes and Business Firm

Unique features of organizations

All organizations have some features that are unique to them. These features
distinguish one organization from another. These include leadership styles, goals,
tasks, structures, and surrounding environments.

The leadership styles differ greatly from one organization to another. Some
organizations are more influential or self-governing than others. Another difference
between organizations is the tasks performed and the technology used by them.
Some organizations perform the tasks that require little judgement (such as
manufacturing firms), while others perform those tasks that require judgement in .
some way or the other (such as educational and consultancy firms). Organizations
also differ in their ultimate goals and the power used to achieve these goals. Some
organizations have coercive goals (such as prisons), some have utilitarian goals
(such as businesses) and some have normative goals (such as universities and

religious groups).
The most important factors that make one organization different from another
are the organizational structure and its surrounding environment.

e Organizational structure

There are several ways of classifying organizations based on their structures. The
most common classification is the classification made by Henry Mintzberg, which
identifies five basic types of organizations as shown in Table 1.1.

Table 1.1 Types of Organizational Structures

Type Description Example
Entrepreneurial = Small firm managed by an Small new
entrepreneur. business
= Simple structure.
= Solves simple tasks.
= Lacks standardization of tasks.
Machine bureaucracy = Large bureaucracy. Medium-sized
= Produces standard products. manufacturing
= Dominated by centralized firm
management team. Self - Learning
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Divisionalized = Combination of multiple Firms like
bureaucracy machine bureaucracies. General
= Each bureaucracy produces Motors

different product or service.
= All divisions are handled by the

central headquarters.
Professional bureaucracy | = Knowledge-based organization | Hospitals, law
where goods and services are firms, schools

dependent on the knowledge of
the professionals.

= Ruled by department heads.

= Weak centralized authority.

Adhocracy = Task force organization that
must adapt to quickly changing
environments. Consulting
= Consists of large groups of firms

specialists that are organized
into short-lived
multidisciplinary teams and
have weak central
managements.

e Organizations and environment

All organizations are situated in an environment which could be business, governmental,
or educational. In this environment, there are other organizations and people, such
as suppliers, clients or customers and competitors with whom transactions have to
take place. Organizations, on one hand depend on social and physical environment,

financial and human resources. The legislative and other requirements imposed by,

the government as well as the actions of customers and competitors must be taken
into account by the organization. On the other hand, organizations can control their
environments. Business firms, for example, bond with other businesses to influence
the political process; they advertise to influence customer acceptance of their
products.

Information systems play an important role in environmental scanning and
also help managers to identify the external changes that require organizational
response.

Changing role of information systems in organizations

Information system has become vital for organizations as it helps them to deal with
fast-paced changes in global economies and businesses. It provides communication
and logical tools and is involved in minute-to-minute operations, thus creating an economic
value for the firm. Information systems have changed the economic condition of
organizations and enhanced their working conditions. As the technology changes, an
organization’s infrastructure and the services it provides to its employees, customers,
and suppliers also change.

Usually, there is an information systems department in organizations that
provide IT services. Typically, the members of information system departments
maintain hardware, software, networks, and other components of IT infrastructure.




Earlier, the department mainly consisted of skilled programmers, whereas =~ Overview of Management,
nowadays, the department consists of programmers, system analysts and managers. CREemistion nd IS
Programmers are the technical persons and are experts in one or more programming
languages. They are responsible for developing computer programs. System
analysts are persons with good analytical and technical skills. They are responsible NOTES
for analysing business problems and requirements, and proposing solutions to these
problems. They interact with the end-users to understand the problems thoroughly
and also discuss with the managers. End-users are people for whom the applications
are developed. Though they are not part of the information systems department,
they play a major role in designing and developing applications. System managers
manage such teams and also the teams of staff responsible for data entry. Many
companies now appoint a Chief Information Officer (CIO) as a senior manager
who supervises the information system department.

1.5.2 How Information Systems Affect Organizations

Over the last few years, the information systems have greatly changed the
organizational economics and increased the possibility of organizing work.

1. Economic impact

Both the cost of information and capital are affected by the change in IT. With the
decrease in cost of IT, the dependence of many firms on IT has increased. Further,
since the cost of labour and capital has been rising constantly, today’s managers
have increased their investments in IT. Slowly, IT has started substituting labour and
various forms of capital like property and machinery.

Information systems help organizations in running their business effectively
with reduced costs. This can be explained with the help of an example. Suppose a
company develops a policy regarding the revision of salary. It first instructs the HR
assistant to write the plan of policy on paper and forward it to the HR director for
review. After the HR director has reviewed (or made certain changes to) the policy
plan, the assistant reprints the document. However, if there is an information system,
the assistant can directly forward the plan to the director electronically. Further,
the director can modify the electronic version of the file and return it to the assistant.
Once the plan is finalized, it can be sent to each employee via e-mail, thereby
reducing the need to print various copies. Hence, both time and resources are
reduced with the use of information system.

An information system also affects the cost and quality of information. It
makes the firm smaller in size as it can reduce transaction costs. Transaction costs
are the costs incurred when a firm buys the goods which it cannot make itself. The
Transaction Cost Theory is based on the notion that firms try to economize their
transaction costs in the same way as they economize their production costs.
Traditionally, firms have tried to reduce their transaction costs incurred by
communicating with remote suppliers, purchasing insurance, acquiring information
on products, etc.
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Fig. 1.13 Transaction Cost Theory

Figure 1.13 shows that as transaction cost decreases, the number of employees ina
firm (firm size) also decreases. This makes shrinking of the firms easier and cheaper,
and they can buy the goods and services from the marketplace rather than make the
goods or offer the service themselves. Hence, an information system reduces the
cost for a given firm size, thereby shifting the transaction cost curve inward and
increasing the revenues of the company.

With the help of an information system, the internal management costs are
also reduced. According to the Agency Theory, an owner hires agents (employees)
who work on his or her behalf. These agents are delegated some decision-making
authority. They are required to be constantly supervised or else they would practise
their own interests. The cost incurred in supervising the agents is called agency
cost or coordination cost. An information system reduces these agency costs by
reducing the cost of acquiring information.

jA2

- ——

Agency
cost

Fig. 1.14 Agency Theory

In Figure 1.14, the agency costs increase as the number of employees (firm size)
increases. The information system shifts the agency cost curve down and to the
right, thus allowing the firms to increase size by lowering agency costs.

2. Organizational and behavioural impact

The growth of information system and the implementation of new applications have
been affecting the structure of the organizations. In this section, we will discuss
how and why information system affects organizations.

Information system flattens organizations

Before computerization, the work process in organizations used to remain unchanged

" f‘;’f - .Li“mfﬂg for a long time. There were various levels of management that managed the lower
ateria




level staff (see Figure 1.15). Managers were responsible for making decisions and
the lower level staff used to operate under the supervision of the senior managers.
Since there is a limit on the number of people a person can supervise, the managers
failed to efficiently handle large number of employees at the lower level. Therefore,
traditional organizations were usually less competitive than the modern organizations
that involve advanced IT applications in their work process.

Fig. 1.15 A Traditional Organizational Hierarchy of Management

The use of information system has increased the efficiency of today’s organizations
and it helps flattening the hierarchies. IT applications provide the lower level employees
with the information they require and they are empowered to make decisions without
supervision. Moreover, the efficiency of managers in making decisions has enhanced
because they receive accurate information on time. Therefore, fewer managers are
required to supervise more employees than before (see Figure 1.16).

Fig. 1.16 A Flattened Organizational Hierarchy

Virtual organizations

IT enables some organizations to act as virtual organizations where work is no
longer limited by geographic locations. Virtual organizations connect people, assets,
and ideas with the help of networks. They can support customers, suppliers and
even competitors in creating and distributing new products and services without any
limitation of physical locations. In other words, a virtual organization is one whose
members are geographically apart, while appearing to others to be a single, unified
organization with a real physical location. Many people are forming virtual companies
as the optimal way to implement key business strategies and alliances that ensure
success in today’s competitive business environment.
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Virtual companies develop flexible and adaptable virtual workgroups and
alliances to make best use of fast-changing business opportunities. A business, for
example, wants to make use of new market opportunities but it lacks time and
resources, and information technologies needed to develop the infrastructure. This
problem can be solved by simply creating a virtual company through a strategic
alliance so that it can integrate the components needed, such as the Internet, intranets
and other Internet technologies, to sort out the customers’ problems as well as
exploit the market opportunity.

There are many reasons as to why many organizations are implementing virtual
organizations:
e To increase flexibility: Since a large number of workers is available, the
organization can hire the best regardless of where they live, thus increasing
the flexibility of the organization.

o Globalization: Many organizations now realize that a vast pool of untapped
skills, knowledge and abilities are available throughout the world. Thus,
when these different skills and abilities are integrated in a virtual organization,
greater level of collaboration, cooperation and efficiency is achieved.

e Changes in employee values and attitude towards work: Employers
have realized that balance of professional as well as personal life, family
requirements, and personal fulfilment are important considerations in life.

e Cost reduction: The cost of physical assets used to support work
environments, cost of infrastructure or the cost involved in maintaining the
offices at several physical locations is reduced. .

Although there are many situations that drive organizations to implement virtual
organizations, not all companies can make virtual work effective because it is difficult
to evaluate and organize the workers.

Organizational resistance to change

The use of information systems result in many changes in organizations. They
potentially change an organization’s structure, culture, politics and work. Hence,
there is a considerable resistance to them when they are introduced.

Since organizational resistance to change is very powerful, many IT
investments stagger and do not increase productivity. After thorough research on
project implementation failures, it is observed that the most common reason why
large projects fail to reach their goals is not due to failure of technology, but
organizational and political resistance to change. Figure 1.17 depicts that to
implement change, all the four components, that is, task, technology, people, and
structure must be changed simultaneously.
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Fig. 1.17 Components of an Organization

Organizational changes may be essential in order to survive competition. Hence,
organizations must adapt to fit changing economic factors and other circumstances.
Top managers of the organization must try to diagnose the cause of resistance and
then work to solve it before it ruins the progress of the organization.

In order to overcome the resistance to change, the following three steps are required.

1. Generate a climate for change: A suitable climate should be created by
exposing employees to seminars and conferences so that they can focus on
the shortcomings of the present system as well as find methods to overcome
those shortcomings.

2. Create effective agents of change: Organizations should recognize their
efficient leaders who could be sent to seminars so that new ideas stimulate
in their minds, which will help them in gaining the support of other employees.

3. Rearrange the organization: To achieve better working relationships,
organizations should be modified to fit evolving organizational behaviour.

The Internet and organizations

The Internet has made phenomenal changes in the working of organizations. It
provides precise, timely, and accurate information and also helps in effective decision-
making. It increases the accessibility, storage, and distribution of information and
knowledge for organizations, thereby lowering the transaction and agency costs.
Various banks, for example, in foreign countries can now deliver their procedure
manuals for the internal operations’ to their employees at remote locations by simply
posting them on the corporate website. As a result, the huge amount of money they
would have otherwise spent in distribution is saved.

Other than affecting the cost of running an organization, the Internet has also
affected the task, technology, structure, culture, and people of the organizations.
The tasks, for example, have become automated with the help of technology.
Similarly, workers have been transformed to knowledge workers.
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1.5.3 Managers, Decision-Making and Information
Systems

The major roles of managers include decision-making for which they rely on
information. The decision they make depends on the quality of information. Better
the quality of information, more effective will be the decisions. Information systems
contribute to effective decision-making by improving the quality of information.

The role of managers in organizations

Managers perform a variety of tasks, such as making decisions, participating in
meetings, writing reports, and so on. The role of managers can be better explained
by examining the classical and behavioural models of management.

The Classical Model

The Classical Model of Management basically describes what managers do.
According to Henri Fayol, the following are the classical functions of managers
[see Figure 1.18(a)].

o Planning: This is a process of predicting the future. It answers questions,
such as what to do, when, where, how, and why it should be done. To
achieve the plan, managers set goals and lay down policies, procedures,
schedules and budgets.

e Organizing: The process of organizing involves recognizing the job, dividing
the job into suitable tasks, assigning the divided jobs to appropriate persons,
and delegating authority to get things done by subordinates.

e Staffing: 1t is the process of allocating the right job to the right pefson. It
includes selecting appropriate persons for the required positions and training
them to carry out their tasks in an efficient manner.

¢ Directing: This includes activities such as communication, motivation and
leadership. A manager has to guide, motivate and lead his subordinates.

e Controlling: The process of controlling includes the following tasks:

» Fixing standards to measure work performance

» Measuring actual performance

« Comparing the actual results with standard results and finding out
variations, if any

= Taking appropriate actions
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(a) Classical Model (b) Behavioural Model

Fig. 1.18 Role of a Manager in an Organization

The Behavioural Model

The Classical Model presents formal managerial functions but fails to describe what
managers actually do. It does not discuss the tasks that managers perform while
planning, decision-making, and controlling the work of others. According to the
Behavioural Model, the actual behaviour of managers is less systematic and more
informal.

On the basis of manager’s day-to-day behaviour, Henry Mintzberg
categorized the roles of managers into three categories, namely inferpersonal,
informational and decisional [See Figure 1.18(b)].

1. Interpersonal role: Managers’ interpersonal roles can be classified into
following three categories. They act as:
(i) Figurehead: Managers represent their companies to the outside world
and perform duties such as presenting awards to employees.
(ii) Leader: As a leader, managers motivate, guide and support their
subordinates.
(iii) Liaison: A manager acts as a link between the members of the
management team.

2. Informational role: In the informational role, managers need specific and
up-to-date information to redistribute it to those who should be aware of it.
Thus, managers act as information propagators and spokespersons for their

3. Decisional role: In the decisional role, managers have to make routine
decisions related to daily operations of the business, such as payment of
wages, payment of raw materials, sanctioning leave to subordinates, and so
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Decision-making is considered as a core managerial function. Every task performed
by a manager in an organization involves decision-making, Decision-making is not
an easy task for a manager. It has become complex due to several reasons. First,
because of enhanced technology and communication systems, the number of available
alternatives has considerably increased than ever before. Second, the decision to be
taken should be most accurate; any wrong decision may prove fatal for the
organization. Third, due to increasing competition, managers are forced to act fast
and take decisions quickly.

Decision-making is the process of choosing the best alternative from among
various alternatives. It visualizes two or more alternatives from which a final decision
is to be made. It is not just making a commitment after evaluating alternatives;
rather it is a complex issue. It includes the whole process of setting up of goals,
defining activities, finding alternatives, and developing plans. It involves all the
activities of coordinating, information processing, problem solving, and evaluating,
before finally making a decision.

Decision-making process

Decision-making is a process that consists of various different activities. According «
to Herbert A. Simon, a decision-making process can be described in four different
stages, namely intelligence, design, choice and implementation.

(i) Intelligence: This stage includes finding, analysing and understanding the
problem, the nature of the problem, the reason for its occurrence, and its
effects on the organization. In this stage, information system provides detailed
information in the form of routine reports, interpreted transaction data, and
exception reports that help in identifying the problem.

(1i) Design. This stage includes finding the possible solutions for the problem.
Here, the Decision Support System (DSS) proves to be of greathelp as it
provides the user with logical tools for modelling data, thereby enabling
users to find possible solutions for the problem.

(ifi) Choice: This stage includes choosing the optimal solution among the
alternatives. The Group Decision Support System (GDSS) provides an
electronic environment to conduct group discussions among all managers,
who discuss the various alternatives and select the suitable solution for the
problem.

(iv) Implementation: This stage includes putting the solution to work and
monitoring the working of the solution. It also includes analysing the chosen
solution and finding whether the applied solution is the optimal solution by
comparing it with other possible solutions. Here, MIS provides routine
reports and informative data that help in analysing the solution.
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Fig. 1.19 Stages in Decision-Making

According to Simon, the four stages in the decision-making process are linear in
nature and occur in an orderly manner one after the other (see Figure 1.19). Butin
reality, the stages in decision-making do not necessarily follow a linear path. A
manager, for example, may be in the process of implementing a decision only to
discover that the solution may not be the optimal one. In such cases, the manager is
required to repeat the previous stages.

Types of decisions

There are several decisions taken by managers in an organization. These decisions
differ in a number of ways. One classification can be on the basis of level of
programmability—Simon proposed two types of decisions, namely programmed
and non-programmed decisions. G, A, Gorry and M.S. Scott Morton referred to
these programmed and non-programmed decisions as structured and unstructured
decisions respectively.

(i) Structured decisions: These decisions are well defined, certain, and need
little effort from decision-makers. These decisions need to be made ata
small interval of time. They can be easily made using some definite procedure;
thus, operational (lower) level managers are permitted to take such decisions.
Inventory reorder decisions, routine credit decisions, etc., are structured
decisions.
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(ii) Unstructured decisions: These decisions are not well defined and no
certain rules are specified to take such decisions. Such decisions are critical
and are of non-routine nature. Therefore, decision-makers must spend
sufficient time to have an insight into the problems and then usé their judgement
and intuitions to finalize a decision. Such decisions are taken by strategic
(higher) level managers of the organization. Introduction of a new product,
deciding long-term corporate goals, planning for R&D, etc., are unstructured
decisions.

Decisions that are neither structured nor unstructured are called semi-structured
decisions. Such decisions have elements of both the structured and unstructured
decisions, and thus, there are some well-defined or certain rules for some part of
the problem; the rest needs to be solved using judgement and intuition. Generally,
middle level managers handle such decisions. Developing a marketing plan,
designing a new corporate website, etc., are semi-structured decisions.

Management decision problems

A situation where the management of a company has to take a decision that requires
research is called a management decision problem. It is just a statement of the
issue that management is dealing with.

A management, for example, has to decide the price of a new product. To
solve this problem, the management has to work on the following issues.

e What are the costs of production and marketing?

e What will be the product’s status in the market? n
e Atwhat price do similar types of products sell for?

* What is the perceived value of this product in the market?

Implications for the design and understanding the information system

The developer of information systems must have complete knowledge about the
organization for which they are developing an information system. The design
process of an information system is complete and efficient when it fulfils the
requirements it was meant to achieve. While planning a new information system,
the following factors must be considered.

e Organizational structure

e Organization’s type and leadership style

e Surrounding environment of the organization

e Organization’s culture

e Nature and attitude of end-users of the system

1.5.4 Information Systems and Business Strategy

Business strategy is long-term planning of organizations that determines what
products (or services) they provide, the market they compete in, their customers
and suppliers, their future plans, etc.




Strategies are often discussed and finalized in a process called strategic =~ Overview of Management,
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planning process. Almost all organizations are involved in this process yearly or
sometimes more frequently. The output of the process is the strategic plan that
depicts all the strategies of the organization. The plan is then handed over to the
managers of the organization to achieve the planned goals. Note that changes in

the surrounding environment affect the organization’s goals, and the plan must
adapt to these changes.

NOTES

Generally, strategy takes place at the following three different levels.

(i) Business: Business is a set of related products and services. Information
systems assist firms in becoming low-cost developers, distinguishing products
and services and serving new markets. The strategy at this level is mainly
concerned with how to compete efficiently in a particular market.

(i) Firm: A firm is a business organization. Information systems enhance services
by combining together the operations of different business units so that they
can operate as a whole or can share knowledge across various business
units.

(iii) Industry: Several firms that constitute an industrial environment is called
an industry; for example, automotive industry, television broadcasting, etc.

What is strategic information system?

Information systems are designed with the goal of solving some problems or seeking
new opportunities. The information system that helps an organization to accomplish
a long-term competitive advantage is known as Strategic Information System (SIS). “
It can be developed from scratch or by modifying an existing system.

These systems change the goals, operations, products, services, and
processes of the organization to help it gain an edge over the competitors.
Sometimes, even the organization’s business needs to be changed, which in turn
forces it to adopt the new behaviour patterns. All these result in changing internal
operations, recruiting new managers and workforce, and establishing close
relationships with customers and suppliers.

Business-level strategy: The Value Chain Model

The most commonly used model to support business-level strategies is the Value
Chain Model. According to this model, every firm is a sequence of basic activities,
with each activity adding some value to its products or services. The model aims to
identify those activities where information technology can be applied effectively to
help a firm in gaining advantage over its competitors.

The basic activities that constitute a firm are classified into primary and
support activities. Primary activities are directly associated with production and
distribution of products or services of a firm that create value for the customer,
whereas support activities provide support to primary activities. Various primary
and support activities along with the type of strategic information system that can
be used to make them cost-effective are listed in Table 1.2.
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Overview of Management, Table 1.2 Primary and Support Activities and the

Organisation and MIS Type of Information System Used
Activities Description Type of SIS Used
Inbound logistics Includes receiving and | Automated warehousing
NOTES storing materials for systems
distribution
Operations Converts inputs into Computer-controlled
Primary finished products machining systems
Involves storing and Automated shipments
Outbound logistics | distributing finished scheduling systems
products
Includes promoting and | Computerized ordering
Sales and marketing | selling products systems
Includes maintaining Equipment maintenance _
Service and repairing goods or | systems £
services ',
Organization Administration, Electronic scheduling systems ‘
infrastructure management E
Support Human resource Hiring and training of | Workforce planning systems
employees
Technology Improving products and | Computer-aided design
production process systems
Procurement Purchasing inputs Computerized ordering
systems G

Internet technologies enable firms to expand their value chain to include customers,
suppliers, and other business partners, thereby creating a value web. A value web is
a group of independent firms that coordinate their value chain with the use of
information technology to generate a product or service for a market collectively. E
Using the value web, the firms can maintain long-term relationships with their
customers, as well as adjust to the changing demand and supply needs.

Firm-level strategy and information systems

The overall performance of a firm depends on the performance of each business
unit. The performance can be improved if all the business units work together instead
of on their own and share knowledge. The information systems promote synergy by
integrating separate business units so that they can act as a whole. The business
units are combined in such a way that the outputs of one unit become inputs to other
units, thereby lowering the cost and increasing the profits.

el L

Information systems encourage sharing of knowledge, and thus, help in
creating a core of competency. A core competency is an activity for which a firm
is the foremost leader. It may include the world’s best toymaker or the best package 5
delivery service. It depends on the knowledge that is obtained over several years ,
of experience and a good research organization. Such a system also improves
existing competencies and enables the employees to become aware of the new .
external knowledge.
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L Information remains ‘valuable’ only when supplied ‘timely’ and ‘accurately’ to a
management. This insatiable need for information in a business organization has NOTES
given rise to the discipline of management information system, which deals with
the methodical study of a seemingly disparate set of subjects that includes
management systems, information systems, information theory and information
technology. It deals with the purpose, planning, construction, implementation and
operation of a set of systems (information gathering, assimilating and disseminating
systems). Theoretically, it can be manual, but the compulsions of a modern
competitive environment dictate that MIS be in a computerized environment.

Several types of MIS exist, ranging from the very basic in which the everyday
tasks in an office are automated to the very complicated in which the system uses
artificial intelligence and other advanced techniques to help the managers in decision-
making. However, in all such systems the purpose of MIS is to assist the management
of an organization in performing their tasks and aid in decision-making. MIS in
most cases supplies information on a ‘need to know’ basis to the management; the
type of information it supplies to the different levels of management differs in type
and content.

The focus of an MIS is to supply the right information to the right person at
the right time. This triad of the right person, the right information and the right time
makes MIS a powerful tool essential for business organizations. If any of the three
entities—person, information and time—is not right, then the MIS fails in its .
objective. Hence, the purpose of the MIS is to maintain the flow of information
within an organization by focusing on the triad of right person, right information
(i.e., the accuracy of the content of information) and right time. The entire study of
MIS focusses on these three things and aims to improve upon them.

Trends in modern business show that the business environment has
progressively become complex. Competition is now at a cut-throat level and there
is hardly any scope for error. Managers have to be on their toes all the time,
analysing the business environment and taking decisions to solve problems in order
to take advantage of an opportunity. Thus, the focus is very much on decision-
making. However, decision-making itself is of several styles. It can be intuition-
based or data-based. The modern environment favours the data-driven informed
approach of decision-making. Thus, in order to take a decision, the manager has
to have some background information about the issue. This competitive
environment and the associated role of the manager has given rise to a discipline
called information management, which deals with gathering, storing, analysing,
retrieving and disseminating information within an organization. In today’s
environment, information management is essential for a modern manager to take
any worthwhile decisions.

1.6.1 Management

Managers take decisions based on several triggers. Some managers are optimists

and take an optimistic view of any situation, be it a problem or an opportunity,  Seif - Learning
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while others take a completely pessimistic view. They look at only the negative
aspects of decisions. Some managers take decisions based on intuition, i.e., the
reaction they feel coming from within themselves, their instinct. Some take decisions
based on the analysis of data. These data-driven managers rely wholly on
information systems to provide them with the necessary data and information in
the form of reports. Nowadays, the prevailing view is that data and analysis-
driven decisions deliver greater value to the organization than intuition-based
decisions. In the instinct-based decision-making approach, the judgement and
experience of the manager plays the most important role in choosing an altemative.
However, even an experienced manager can be wrong when deciding on the
basis of instinct. Hence, conventional wisdom suggests that managerial decisions
must be taken on the basis of solid rationale and information. If the manager has
complete information about a problem or opportunity, then he can take an
appropriate decision; else, his decision will be based on intuition or judgement,
which is prone to personal bias and hence is likely to be inaccurate. Therefore,
managers in today’s world are increasingly data-driven rather than feeling-driven.

Before understanding the role played by the management in an organization,
we must appreciate that the management is the invisible force that runs an
organization. Managers get things done efficiently and effectively (mostly by others),
thereby adding value to the organization. They plan, organize, direct and control
the employees in order to ensure that everyone in the organization works towards
a common goal. An organization without managers would have no cohesion, no
purpose and no direction. It will simply collapse. Managers perform multiple roles
within an organization. The role of the management can be divided into three
categories—interpersonal, informational and decisional. The role of the management
under different categories is as follows:

* As a titular figurehead whose role is only symbolic: The person who
performs this role is widely respected within the organization and known
for some special quality or contribution to the organization and society.
Even though the person is a figurehead and does not enjoy a lot of actual
authority and power, he/she helps to galvanize the employees to work
towards a greater goal. This kind of role is often very important for the
success of an organization.

® As a leader who takes responsibility of getting things done by
inspiring and motivating his people: In this role, a manager works like
an inspirational guru to the people in his domain of influence. This role is
sometimes performed by the management at junior level also, when managers
lead by example, rather than on the basis of power and authority vested
upon them. Several managers who have worked in shop floors have been
known to inspire workmen and get things done by inspiring and motivating
people.

e As a liaison agent who interacts with social networks for business
development and other related activities: In this role, the manager works
like a salesperson and a representative of the company, interacting and
networking with people to get more business and achieve other related
goals.

B i, T Ty T e p s s



¢ As a control monitor who controls the organizational activities: In
this role, the manager is a control master, who keeps a close tab on the
activities within the organization and corrects any deviations from the planned
result. A manager plays this role when he is in a middle-level position. He
exercises his power to control the organizational system and regularly acts
on feedbacks.

¢ Asan information disseminator who relays information from top down
and bottom up: A manager needs to be a good communicator to be able
to achieve this. In this case, the role of the manager is not onlyto act as a
post office, but also to ensure that the disseminated information is understood
by all concerned.

e As a communicator/spokesperson who communicates with the
environment: In this role, the manager works like a public relations specialist
for the organization and communicates the key issues facing the organization
to the market, buyers, sellers, regulators, etc.

¢ As an entrepreneur who hunts for opportunities and initiates changes:
In this role, the manager brings a particular opportunity to the fore and
initiates steps to benefit from it.

¢ As a troubleshooter who solves organizational problems and does
mid-course corrections: In this role, the manager works as a control agent
who ensures that corrective actions are taken at the appropriate time to
thwart any problem.

¢ As an allocator of resource: In this role, the manager decides on the
quantum of resources required for completing activities under his domain.

* As anegotiator who manages deals for the organization: In this role,
the manager works as the sole representative of the organization keeping in
mind the best interests of the organization.

All managers perform all these roles in their regular course of work but
some managers are more adept in performing certain roles, which they do with
great élan.

Why is MIS required by a manager?

A modem manager is responsible for the most important task within an organization,
i.e., taking decisions. However, if we are to categorize his tasks on the basis of
staffing, planning, controlling, organizing and leading, we would have to say that
different managers at different levels spend different amounts of time and effort in
each of these categories of activities, even though most managers would be required
to perform all the activities in their own domain of influence. For performing his
tasks in each of the above-mentioned activities, the manager needs information.
Without information he cannot perform his role in any of the activities of planning,
organizing, directing or controlling. For example, a manager when performing the
task of planning would need to know many things. Some of the issues that he
needs to be aware of are as follows:

e What is the objective of the plan?
e What are the parameters that need special attention while planning?

Overview of Management,
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e What are the independent variables and what are the dependencies?

e What are the things one must take into consideration to ensure that the plan
isrealistic?

e What is the context under which the planning is done?

e What are the key issues related to the plan?

e Who are the key people involved and affected by the plan?

Answers to all these questions will be required if the manager has to establish
a suitable plan. However, each question has several questions/issues embedded in
it. As we can see, a vast amount of information is required to set the process of
planning into motion. A manager in today’s modern competitive business
environment may not be fully aware of all the issues and the information against
each issue. This is precisely the reason why he needs to rely on a system that
provides him with this necessary information. MIS bridges this gap by providing
the manager all the necessary information from different angles, thereby making
the task of the manager easier. The same is the case when the manager is organizing,
directing or controlling. In each sphere of activity, the manager needs information
justas he needs it in the case of planning. Normally, the means to get the information
is through reports. Reports are formatted documents, which arrange information
in such a manner that the manager understands the meaning of the information
being provided in the document easily, without any further analysis. Visualization
of data and information is a common tool used to make the report easily
comprehensible and also to provide managers with an insight on a particular issue.
Visualization can be done in several ways. The easiest way to attain visualizatien is
to use graphs in reports. A pictorial representation of data in the form of a graph
conveys greater meaning to the manager than data being presented in a plain text.
Hence, reports have a bias towards graphical representations. Moreover, the
preformatted nature of the report, called report structure, helps the manager to
quickly access the information he requires. He knows what information is available
in which part of the report and can save time by accessing the particular portion of
the report he needs. This is another feature of reports.

Management reports

The means by which a data-driven manager achieves his tasks is through the use
of reports. Reports convey to the manager the following:

e They give him an idea whether the activities under his sphere of influence
are proceeding according to his expectations. For example, when a
production manager checks the production schedule and compares it with
actual production in the factory. In this case, the manager is trying to assess
whether the production process is within control and in accordance with
expectations. Any deviation from the actual procedure will indicate that the
process is not within control and hence corrective action is required to be
taken.

e They give a clue or an insight into some larger problems, which might be
happening within the organization. For example, if a manager notices that
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the attrition rate is going up sharply, it might give him an insight that either the =~ Overview of Management,

market for the skills of his employees has become more competitive (that is Organisation and MIS
to say that more players may have entered the market, which requires
employees with the same skill set), or that the salary levels of the present ' NOTES

organization are way below the prevailing market rates for such skills. This
might lead the manager to delve deeper into the problem of attrition, which
is only a symptom of a much larger phenomenon of behavioural changes in
his own workforce that prefers monetary compensation to loyalty.

Hence, we can see that a modern manager relies heavily on data to take
decisions and the means by which he gets the information is through reports. Reports
are of the following types:

Scheduled reports: These reports are generated regularly. They are in the
nature of daily reports, weekly reports, monthly reports, etc. They contain the
latest information and help the manager to understand and analyse the information
in the context of the recent past. These reports are the first line of reports and
normally the first signs of problems or opportunities can be understood by surfing
through these reports.

On-demand reports: These types of reports are unscheduled in nature
and are created when the managers need such reports. They help in analysing a
particular issue in a greater degree of granularity. These reports are generally the
result of a reaction to any event.

Exception reports: In management, exceptions warrant greater attention
than any normal event. Exception reports are special reports, which indicate to the =
manager that some control needs to be exercised to bring an issue under control.
For example, if in a company the average absenteeism is 2 per cent and in the last
week the average absenteeism is 20 per cent, then an exception report is generated
to make the concerned manager aware that something is amiss and needs attention.

Predictive reports: These are special reports, which give the manager a
sneak preview of the future. These reports give a scenario of the future and are
very useful for the purpose of planning.

Summary reports: These are general reports, which aggregate data and
provide a summarized information to the manager so that he may get a macro view
of an issue.

Regulatory and statutory reports: These reports are created under the
obligations to follow rules and statues. They are primarily meant for external
consumption or information needs of regulatory bodies.

Thus, we see that reports reveal to the manager the issues behind a problem
and give him with adequate information required for taking decisions. However,
information can be of various degrees of value to a manager. A set of information,
which he already knows, or incorrect information is of little value to him. So we
must understand the meaning of valuable information.
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1.6.2 Information

According to Orlikowski (1992), ‘Nothing is more central to an organization’s
effectiveness than its ability to transmit accurate, relevant, understandable
information amongst its employees. All of the advantages of an organization’s
economy of scale, financial and technical resources, diverse talents, and contacts
are of no practical value if the organization’s employees are unaware of what
other employees require of them.’

What is an information system?

Information systems form a special class of systems whose main objective is to
store, retrieve, process, communicate and secure data. Information systems, which
help management at different levels to take suitable decisions, are called management
information systems. Typically, information systems are housed in a computerized
environment/platform, to enable users to get faster and accurate information.

Information systems can be of several types. At the very basic level, it can
be used to automate tasks in the office using an office automation system; it can be
used to provide the right kind of information to management; or top management
can make decisions by using decision support systems. Decision Support Systems
are complex systems used at the strategic management level for dealing with
unstructured decision problems. Models are used in such decision support systems
to help in decision support. MIS is used by the management to acquire information
for taking decisions. Typically, MIS does not have a direct decision support role,
apart from helping in decision-making by supplying the right information.

L

Information systems over the years

Information systems have undergone a remarkable transformation in the last forty
years of their existence. Initially, information systems were designed to perform a
specific task. The objective was to perform a task as quickly as possible with
minimum number of errors. The concept of using information systems for taking
decisions had not been realized before. Organizations used information systems
for data processing only. Be it salary processing or bill processing, information
systems previously were focused only on the efficiency of the operation. The people
who worked on these systems had a certain knowledge about the system and the
user interface of the systems were very basic (character user interface). The output
was in the form of salary slips, etc. Processing the data in the most efficient way
was the prime focus of such systems. Most of these systems used file-based data
storage systems on which a program would work, i.e. the program would be able
to access the data and organize it but the data would be stored in a file. The
problem with this type of a system was that it led to the replication of data and loss
of consistency.

Over the years, information systems have changed. Now the focus is more
on helping the management by providing information useful for decision-making.
Data processing systems have become obsolete. The focus is on delivering the
right information to the right people at the right time. Information systems have
become faster, more accurate and user-friendly for easy applicability. People who




work on information systems nowadays, do not possess much knowledge about ~ Overview of Management,
the systems per se. They are general users. The systems have become so friendly Cript o
that they do not require any specialization in information systems. Newer concepts
have emerged in information systems to help organizations get better value for
their money. Concepts like client—server architecture, networking, distributed
computing, centralized database, graphical-user interface and the Internet, have
completely transformed information systems. Gone are the bulky mainframe systems
requiring loads of money to run. Now more money is required to procure the
software than the hardware.

NOTES

Somogyi (1987) placed the development of information systems in a three-
eramodel. According to him, the initial era of information systems dealt primarily
with the Electronic Data Processing (EDP). These systems worked as isolated
islands of data processing without any linkage with any other process. Their main
focus was on automating routine, repetitive work like payroll preparation, etc., by
batch processing of data files. The format of data processing was inflexible and
technology was at the forefront. The data processing tasks were tailored to suit
technological requirements. This required specialized personnel who understood
the complexities of technology; the general management personnel were unable to
use it. Ease of use was definitely not a key feature of such systems. With the
advent of personal computers and networking, it became easier to provide
information to the management for better decision-making. This was the era of
MIS in which large databases, which housed all transaction-level data, began to
be processed for obtaining significant information for managers. In this era, the
business context of information came to the forefront and technology began to be
used more as an enabler rather than as an end in itself. The systems began to
become user-friendly, so that general management personnel could use it without
much difficulty or training. In the moder era, the focus has shifted further to provide
strategic value to organizations, so that competitive advantage could be gained
through the intervention of information systems. Information systems are now closely
integrated with business strategy to get better value. Technology in such systems is
used as an enabler and the business strategy takes the centre stage.

Information systems and ICT

Trends in modern business require that Information Systems (IS) should be able
to run on Information and Communication Technology (ICT) platforms. Even
though an information system in its pristine form does not require any technological
intervention, practicality of use in modern business environment forces information
systems to run on information and communication technology platforms. The basic
reasons for IS to run on ICT are as follows:

¢ Timeliness: ICT-enabled IS can deliver information faster to the decision-
maker. In today’s competitive environment, speed is the key to success.
Information that is relevant now, for decision-making will lose its value if
delayed. It will be like listening to ‘news’ of the previous day. The value of
information decreases drastically if it is delayed. The manual systems of IS
cannot cope up with the speed required for delivering information and hence,

it is essential to take recourse to an ICT-enabled platform. Self - Learning
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ganpaton any use to the decision-maker. Any information is useless and of no value if
found inaccurate.
NOTES Basics of computers

To appreciate MIS and develop a solution-based information technology platform
for MIS, one must understand the basics of computers. A brief description of a
computer and its allied devices is as follows.

The computer is a device consisting of hardware and software. Hardware
is the term used to refer to the physical components of a computer. All electrical,
electronic and mechanical components of the computer fall in this category. It
includes:

1. Input/output devices: These are the devices through which data is entered
into the computer and come out as output from the system. The following is

a set of /O devices:

Input devices

e Keyboard
e Mouse
o LightPen
o Joystick
Output devices
o Display Unit-Cathode Ray Tube based or Light Crystal Display basea
e Printer
o Plotter
2. Central processing unit: This is the component in which all the data
handling—data storage, data processing and data retrieval—is done. This
is the main component of a computer. A CPU in a strict sense also indicates
a portion of the microprocessor, which plays a central role in the data
processing activity; but here, the CPU is used in a more broad sense to

refer to the main component of the computer. In this context, the CPU
consists of the following:

Microprocessor
e RAM
e ROM
e Hard Disk
e Motherboard
e Bus
Ports: These are physical (and also virtual) junctions of the computer. They

are the junctions through which the computer can be connected to other devices
or other computers. Ports are of two types: serial and parallel.
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3. Software: It is the non-physical component of a computer. It is classified =~ Overview of Management,
into the following two categories: g
(i) System sofiware: It is the software which is responsible for the basic
functioning of the computer system.
(ii) Application software: It is the software which is responsible for the
applications that run on a computer. MIS solutions are examples of
application software.

NOTES

Role of information in decision-making
The decision-making process includes the following stages:

o Identification and structuring of problem: One needs information to
identify a problem and put it in a structured manner.

o Putting the problem in a context: Without information about the context
in which the problem has occurred, one cannot take any decision onit. Ina
way, the context defines the problem.

o Generation of alternatives: Information is a key ingredient in the
generation of alternatives for decision-making.

o Choice of the best alternative: Based on the information about the
suitability of the alternatives, a choice is made to select the best alternative.
Information is, thus, very important for decision-making. Imagine a simple

decision like the one a driver makes when he, on seeing a child crossing the road,
applies the brakes to stop a speeding vehicle. The driver’s decision to apply the
brakes is based on a lot of information processing that happens in his brain. At .
every stage of the decision-making, he uses the information that he captures visually.
All decisions are like this.

First, you get information about a problem, which you then format into a
structure; then the information about the context in which the problem has occurred
is factored in. As in the above case, if the driver, instead of finding the child in the
middle of the road, had found that the child was about to cross the road, would
probably not have applied the brakes to stop but would have slowed down, as he
would have calculated that by the time the vehicle reaches the crossing, the child
would already have cleared the path. So if the problem was structured as ‘“how to
not hit the child crossing the road?,’ the decision would be: if the child was at the
middle of the road, the driver would have applied brakes; however, had the child
been at (say) 90 per cent completion level of crossing the road, the driver would
have only slowed down and not applied brakes to stop. Therefore, you can see
that the context has a major role in decision-making and information is required
both about the problem and the context in which the problem occurred. The next
stage for the decision-maker would be to generate alternatives. In the driver’s
case such possible alternatives would be (a) to stop by braking, (b) to slow down,
(c) to take a sharp turn towards left or right to avoid the child, (d) to press the horn
so that the child crosses the road fast, () to drive the vehicle on to the footpath
and off the road to avoid collision, etc. So the decision-maker generates these
possible solutions to the problem at hand. Obviously, he needs knowledge and
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2 generating alternative (a) i.e., to stop by braking, the driver would need to know

the braking distance. If he was unaware of this crucial information, he would not

have been able to generate this alternative. So information is vital for generation of

NOTES alternatives. The decision-maker also needs information about the suitability of

each alternative to decide which is the ‘best’. In the example, the driver calculates

the ‘pay-off” for each alternative based on his calculation of the outcome, which

again is based on information. He selects the ‘best’ option, which solves the

problem. Thus, you can see that information is the key to the decision-making

process. Without information, and the right kind of information, decision-making
is not possible.

Therefore, to enable managers to take good decisions, it is important to
provide them with the right kind of information. MIS provides this service to the
managers, enabling them to take informed decisions.

Subsystems of an information system

Information system is a special type of system, which allows storage, retrieval and
processing of data in a secure environment. Logically, the major subsystems of
information system are as follows:

e Data repository: This is a subsystem which is at the core of any information
system. Mostly this is a relational database management system, which has :
preformatted and structured tables for storage of data. These structures ]
are arranged in a way that helps in faster storage and retrieval of data with :
adequate security.

e User interface: This subsystem handles the interaction of the system with
the user and hence, it has to manage issues related to the display of data on
an output medium. This can be either graphical or based on character \
depending on the level of ease offered to the user.

e Network: This subsystem ensures communication between the different
entities of an information system. It is crucial for the functioning of an
information system. 1

o Computer hardware: One needs an IT infrastructure to use information 4
systems in an effective manner. Almost all the components of an information :
system are housed in some kind of computer hardware to enable it to
perform the tasks better. For example, an algorithm to find the lowest of
three numbers can also be calculated manually; but under a computerized
system, it will be much faster and efficient.

e System software: Some basic software is required for the efficient
functioning of information systems. These system software do not directly
aid in the functionality of information systems but work as enablers. For
example, operating systems, etc.

¢ Input/output: Sometimes, this is clubbed with the user interface (UI) to
suggest that I/O functions are handled by Ul alone. However, in some
systems, I/O may be user-independent; for instance, when an alert is
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¢ Business rule (process): This is a set of rules which governs how a system _
should function to imitate the real business process. NOTES

o Algorithm/program/application software: This is the actual invisible
component, which integrates all the components. The logic (business rule)
is defined in the program (embedded in it), which enables the functioning of
the information system for some specific purpose.

All the above components work in concert to establish a functional information
system.
Value of information

The normal mathematical and economical explanation of value of information
suggests that if an event occurs whose expectation was low and information of its
occurrence is known, then such information is valuable. For example, let us say
that the reader of this text gets the information that an earthquake of 10.5 magnitude
on the Richter scale is going to hit India and the epicentre of the earthquake will be
the very spot in which he is located, then that information is of more value to him
than the information (say) that he has to pass his BCA exam to get the BCA
degree. In the former case, the information is more valuable to him as he is not
expecting it, whereas in the latter case, he already knows the information with
certainty and expects it completely and hence the value of such information is less.
All market mechanisms work on this model of information.

In a managerial context, the value of information is judged on the basis of
the following parameters:

e Timeliness: Information is valuable to the management only when it can
result in some timely intervention/decision. The aspect of time in making
decisions is very vital for any value to be attributed to them in management.
Information of an event will only be valuable to managers if they have time
to react to it. If the reaction time is not available, then the information loses
its managerial value.

o Presentation: Managerial information is valuable when presented in a way
that facilitates decision-making. Information should not only be given but
also be presented in such a way that the decision-making aspect becomes
obvious.

e Accuracy: Any information to the management is worthless unless accurate.

e Context: Information for the management is highly contextual. Information
is valuable to a manager only if it has a decision-making connotation to it.
For example, for a finance manager, any information about the competitor’s
product is worthless.

e Expectation: Information is generally more valuable to the management
when it generates an expected view or an expected result or an expected
reaction. Any information, which is unexpected, carries a higher value. For
example, if a manager has made a marketing strategy expecting his
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g:;;‘;;?;g :4; oy it 2 competitor to launch product A and before the launch he gets the information \ J:
that the product to be launched by his competitor is not product A but ‘
product B, then this information has a greater value for him as it is contrary
to his expectation. '

1.6.3 System

MIS is not the same as information system. They have two different meanings.
Information systems refer to systems that exist in principle but are not put to practice
for decision-making. MIS is known as information technology management. This subject
of study is not the same as the study of computer science, but it uses computer as an
enabling system. Management of IT service is a discipline that is practice-based. MIS
is also different from Enterprise Resource Planning (ERP), as ERP is not for decision
support. MIS is mainly related to data processing, to find meaningful information for
further distribution to other departments in the organization for the purpose of decision-
making. The working process of the MIS can be charted as follows:

Data—Information—Communication—Decisions t

NOTES

Data collection includes the use of IT, consisting of computers and
telecommunication networks, such as e-mail, voice mail, Internet, and telephone.
Computer plays an important role as it provides more quantitative than qualitative :
data collection, storage and retrieval. Its special features include speed, accuracy
and storage of large amount of data. Telecommunication provides the method for i
one-way or two-way communication by sending and receiving messages using
different components of IT such as telephone, computer, processor and printer.
Its advantages include saving of money, less time consumption and protection of
data and messages. "

1.7 COMPUTER-BASED MIS

Investment in information system and technology provides real economic value to
the business. The information systems are built and maintained on the assumption
that investment in information systems and technology will provide better returns
as compared to investments in buildings, machines or other assets. These returns
may be in the form of increased productivity, increased revenue, or a strong long-
term strategic position in the global market.

From a business point of view, an efficient information system is the most
important tool that helps the firms to increase its revenue or decrease costs by
providing valuable information to the firm. This valuable information helps managers
to make better decisions and improve the execution of business processes. The
information system for a supermarket, for example, can provide managers the
information like total number of units sold or total sales revenue from a specific
product. Based on this information, managers can make better decisions about
which products to stock and which products to promote, and thus help to increase
the business value.

Every business has its business information value chain (see Figure 1.20)
from which valuable information is obtained. In business information value chain,
the raw data is collected, validated, transformed and analysed through various
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stages and then converted into useful information. This useful information is then
disseminated to various business processes, including supply chain management,
enterprise management, customer management, and knowledge management; and
management activities including planning, coordinating, controlling, modelling and
decision-making. This information helps the managers to improve decision-making,
enhance organizational performance, and thus increase the firm’s profitability. The
extent to which an information system can help the business firms in making better
decisions, efficient operation of business processes, and firm profitability determines
its value to the business.

Business processes

=

Information processing activities \
Y 5, U ST

Planning Coordinating Controlling Modelling and
decision-
making

Firm's

profitability and

Management activities

Business value

Fig. 1.20 Business Information Value Chain

1.7.1 Contemporary Approaches to Information Systems

As a result of various perspectives on the information systems, its study is a
multidisciplinary field. A number of disciplines, including management science,
computer science, operations research, sociology, etc., help in providing solutions to
the problems and resolving the issues that arise while studying the information systems.
In general, this field of study comprises two approaches, namely technical and
behavioural (see Figure 1.21).

Information systems are neither purely social nor purely technical. They not
only consist of hardware and software technologies, but also need significant social
and intellectual investments to perform in a better way. Therefore, they are also
termed as socio-technical systems.

“ec'“n.\cal APPro 3

Computer
science

anagemen
science

=

g <
Wioural ApP™°
Fig. 1.21 Contemporary Approaches to Information Systems
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Overview of Management,  The Technical Approach
Organisation and MIS

The technical approach stresses on the use of mathematical models to analyse
information systems. It also helps to study the formal capabilities and physical
technology of the information systems. Disciplines like computer science, management
science, and operations research lead to technical approach.

The three disciplines contribute to the study of information systems in various
ways. The operations research methods and techniques, for example, help to solve
the decision-making problems by providing the best alternative among various
available alternatives. They also use the mathematical techniques to optimize the
selected parameters of the organizations, such as transaction costs, transportation
and inventory control. Computer science helps in establishing theories and methods
of computations. It also provides methods for efficient storage and access of data
in the information system. The field of management science is related to operations
research as it provides models and common analytical methods for decision-making
and management practices.

NOTES

The Behavioural Approach

The behavioural approach concentrates on behavioural issues such as changes in
organizational policies, management and behaviour, that occur while developing and
maintaining the information systems. The models used in the technical approach are
not sufficient to study these issues. Therefore, behavioural disciplines, including
economics, sociology and psychology, help to explore these issues by applying their
concepts and methods.

Psychologists study information systems from the perspective of how
decision-makers comprehend and make use of the available information. They
emphasize more on studying and understanding people and their behaviour. Various
techniques are applied to study the thinking pattern and behaviour of individuals in
a group, and how people’s attitudes are affected by society and organization.

Sociologists study information systems from the viewpoint of how groups
and organizations are developed and how systems develop from groups and
organizations, and how the systems affect people, groups and organizations.

Economists study information systems from the viewpoint of how they impact
the cost and control structures within an organization and within global markets.

Socio-technical Systems

Neither the technical nor the behavioural approach can, by itself, comprehend the
information systems efficiently. This is because the success or failure of an
information system is neither purely technical nor purely behavioural. Thus, to optimize
the performance of the organization, both the approaches are equally considerable.
This results in the need of adopting a different view of information systems that
combines different approaches. One such view is the socio-technical view of
information systems.

From the socio-technical view, the information system is a combination of
both the technical and the social systems used in the production. The optimal
performance of an organization is obtained by optimizing the technical and social

61~ earsitng systems together. That is, to optimize the performance of an organization, both the
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technical and social systems need to mutually adjust with each other until an
acceptable level is achieved (see Figure 1.22). For this, as the technology advances,
organizations and individuals must also change, thereby allowing the technology to
work and thrive. Similarly, the technology must also be changed and then
redesigned in order to fit as per the needs of the organizations and individuals.
However, sometimes, we need to de-optimize the technology to obtain the desired
fit.

Organization design Technology design
alternatives alternatives
Design 1 [« P Design 1
Design 2 » Design 2
Design 3 |4— »| Design 3

Design 4 | Design 4

Fig. 1.22 A Socio-technical View of Information Systems

1.7.2 Towards the Digital Firm: The New Role of
Information Systems in an Organization

With the advent of digital firms, the role of information systems in modem organizations
has become vital. The way managers decide, plan, and manage is directly influenced
by the information systems. Moreover, the information systems help to determine
what products to be produced, and when, where and how the products are to be
produced. Thus, the responsibility of building and managing the information systems
cannot be left only up to the technical decision-makers; rather it also requires a
major involvement of the organization.

In today’s systems, the interdependence between the firm’s information
systems and its business capabilities has been growing continuously. Any change
in business strategy, processes, or rules requires a change in the information system’s
components, including hardware, software, databases, and telecommunications.
Similarly, a change in hardware, software, or telecommunication also affects the
business rules, processes, etc.

The widening scope of information systems

With time, the role of computer-based information systems in the organizations has
broadened. Figure 1.23 describes the roles of information systems in business and
management over the years.

1990-2000
Electronic Business
198090 and Commerce
Strategic and End

1970-80 user Support
Decision

1960-70 Support

Management
1950-60 Reporting
Data
Processing

Fig. 1.23 Roles of Information Systems in Business and Management
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During the 1950s and the 1960s, the role of information systems in organizations
was quite simple. They were used only for data processing operations, including
recordkeeping, transaction processing, traditional accounting applications, and other
electronic data processing applications. Then, during the 1960s and the 1970s, the
need for studying management information systems (MIS) developed the focus on
the use of information systems for developing business applications. These
applications produced management reports to provide managers the information
required for making decisions.

During the 1970s and the 1980s, the concept of decision support systems
(DSS) was introduced because the predefined management reports of MIS were
not able to meet some of the decision-making needs of the management in an
adequate manner. The new role of information systems was to provide specific
and interactive support to the managers in their decision-making process.

During the 1980s and 1990s, a wide variety of information systems, including
end-user computing systems, Executive Support Systems (ESS), and Expert
Systems (ES), were developed, and as a result several new roles for information
systems appeared. The end-user computing systems provided direct computing
support for end-user productivity and workgroup collaboration. The users were
no longer required to wait for support from the corporate information services
departments. The executive support systems (ESS) were developed for the top
management because most of the top management executives were not directly
using the reports of MIS or the analytical models of DSS. ESS was created to
provide critical information required by the top management at the time of their
need and also in their preferred formats. In the expert systems (ES), the techniques
of artificial intelligence were applied to make the systems act intelligently on behalf
of their owners, thereby eliminating the need of human intervention. Today, expert
systems can provide the end-users with knowledge-based expert advice in some
specific fields.

In the late 1980s, the concept of strategic role for information systems was
introduced and it continued through the 1990s. The strategic information systems
(SIS) use IT in products, services, or business processes of an organization, and
thus help them to gain a competitive advantage. From the mid to the late 1990s,
the Enterprise Resource Planning (ERP) systems emerged. An ERP system is an
organization-specific form of strategic information system that integrates almost all
business functions, such as planning, sales and marketing, inventory control,
manufacturing and human resources.

During the 1990s and 2000s, the rapid development of the Internet, intranets,
and extranets altered the capabilities of information systems in business in a dramatic
manner. Today, Internet-based e-business and e-commerce systems have become
very popular and are being used in most business organizations.

The network revolution and the Internet

For most businesses to be successful, there is a need for continuous and prompt
flow of information. In an organization, for example, the orders from the sales
department are passed on to the shipping department; the accounts department
collects statistics and passes them to the management, and so on. Any industry that
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delivered both constantly and on time. Computer networks help in communicating rgmiscnion and W8S
this information swiftly and effectively.
The term ‘network’ means an interconnected system of computers. The '
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linking of two or more autonomous computers and other devices with the software
for sharing information and hardware resources is called networking. Whenever
more than one computer is used at the same location, networking them together
facilitates exchange of data and information (data communication) between the
connected computers in a fast and efficient manner. This ability to share information
is what gives computer networks the power.

The foundation of computer networks was laid in 1969 by the Department
of Defense (DOD) of the United States of America. The US government formed
an agency named Advanced Research Projects Agency (ARPA) which developed
the first network— Advanced Research Projects Agency NETwork
(ARPANET)—to connect computers at various universities and defense agencies.
This network was used for exchanging data and messages, playing games, sharing
views and ideas on any topic among engineers, students, scientists, etc. The main
objective of ARPANET was to develop a network that could continue to function
efficiently even in the event of a nuclear attack.

Later in 1980, another agency, the National Science Foundation (NSF),
created a new network of computers based on ARPANET, called NSFNET,
which turned out to be more efficient and capable. Initially, NSFNET was designed
to link five supercomputers situated at the major universities of NSF and allowed
only academic research. Over time, this network expanded to include sites for <
business, universities, government, and so on, and finally became a network
consisting of millions of computers, now known as the Internet.

The word ‘Internet’ is derived from two words: Interconnection and
Network. It is basically a network of networks that facilitates data transmission
and exchange across millions of domestic, academic, business and government
networks. It is a global, publicly accessible network that enables sharing of files
and other resources using protocols through the transmission media.

Nowadays, the Internet has become one of the necessities for growth and
development due to its diverse applications. Companies, individuals (different users)
and institutions use the Internet in different ways. Companies carry out business
online, including advertising, selling, buying, distributing products and providing
sales services. In addition, the Internet has helped business organizations in
communications, marketing research, providing access to complex database, and
soon.

New options for the organizational design

Organizational designing is the process of structuring an organization, department or
division to optimize its performance and improve the growth prospects. It covers the
processes and human resource programmes that ensure effective operations within
the organization. Organizational design helps to transform the organization’s structure,
culture, politics and processes to increase its productivity, efficiency and effectiveness.
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organizational designs play a very important role. Changes in leadership, shift in
strategy and changing factors within an organization are some of the reasons to
choose new organizational design. Information systems provide new options for
NOTES the organizational design, which are explained as follows:

e Flattening organizations: In digital firms, flattened organizations are more
popular. The flattening of organizations provide ‘optimal hierarchies’ that
help in balancing the load of decision-making. The flattened structure
provides more decision-making authority to the lower level employees, and
the number of levels as well as the employees in the organizational hierarchies
is reduced.

e Separating work from location: The new organizational design has
changed the way of doing different types of work in different situations. The
factor of distance has been completely eliminated with the help of
communication technology. Nowadays, employees can work even from
their homes and still collaborate with the team dispersed across the world.
Teams can work together towards a single goal, even if they are located in
different countries. The new organizational design has also improved
productivity. The sales representatives have more time to spend with
customers, thereby availing the most recent information. Thus, the companies
get more chances to improve their product. Businesses are also much freer
to choose the locations from where they want to operate, and can move to
more efficient locations. Nowadays, the entire business set-up need not to
be at one place. A business, for example, may move its manufacturing part
to some low-wage country and maintain its warehouse at some other
location.

e Increasing flexibility: Today’s business enterprises are more flexible than
the older ones. By flexibility, we mean that the organization is adaptable to
diverse situations. An organization faces threats and new changes constantly.
Flexibility makes survival and success of the organization in a turbulent
environment easy. The more flexible the organization, the better it will
respond to changes.

e Reorganizing workflows: Reorganized workflows help organizations to
improve their efficiency by automating the manual tasks. Earlier, a single
application used to take a long time to process as it had to move through
various channels. However, with the advancement in the business industry,
work procedures have been automated and a number of applications can
be processed electronically in less time.

e Redefining organizational boundaries: The emerging digital firm has
made it possible to operate the businesses beyond the organizational
boundaries. The business can be conducted outside the organization in the
same efficient manner like it was conducted inside. It has given birth to the
interorganizational systems that enable the information to flow across the
boundaries of an organization. They also help organizations to identify new
customers and suppliers, and thus redefine the organizational boundaries.
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Opportunities with Technology

Organizations need different types of information systems to serve various
organizational functions and business processes. To fulfil these requirements, systems NOTES
need enterprise-wide integration. Due to these growin g needs, new opportunities
and challenges have come into the picture.

New opportunities

The use of information systems in businesses is growing at a faster pace. Due to
this, businesses are now getting extraordinary opportunities to apply information
systems in every part of the firm to achieve higher levels of productivity and earnings.
Today, information systems support nearly all levels and functions in the firm. They
actas tools to create value for the firm. In addition, they help managers and employees
in the decision-making process by providing valuable information at the right place
and at the right time.

The challenge of information systems: Key management issues

Building and using an information system for the organization is not an easy task.
The following are the challenges of information systems that managers have to
face.

* The information systems investment challenge: As discussed earlier,
investment in information systems creates value for the firm. However, it
has been seen that not all companies get good returns from investments in
information systems. Thus, one of the major challenges faced by managers n
is to ensure that investments in information systems contribute to corporate
value. Managers are confronted with a number of questions posed by the
senior management which are not easily answerable. Examples of such
questions include: Are we obtaining meaningful returns from our investments?;
Are our competitors getting better returns?; How can we evaluate our
investments in information systems like other investments?

¢ The strategic business challenge: Information systems can make
organization and managers more effective only if they are accompanied by
complementary assets, such as new business processes, organizational
culture, or management behaviour. These complementary assets are required
to support the working of technology assets, such as hardware, software,
and so on. Unfortunately, most organizations lack complementary assets
because of which they do not get significant returns on investments on
information systems. Thus, to take full advantage from IT and make
organizations more effective and competitive, it is essential to redesign the
organizations. The organizations need to develop new business models,
change the outdated working rules and business processes.

o The globalization challenge: Globalization demands information systems
that are capable of endorsing production and sales of goods in a number of
countries. Multinational companies maintain their regional offices in many
countries. However, because of differences in language, culture and politics
in various countries, centralized management control became unmanageable.
For the development of integrated, multinational information systems, global
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hardware and software must be developed; global communication standards,
cross-cultural accounting and reporting structures should be maintained.

e IT infrastructure challenge: One of the major challenges that managers
face is to develop an IT infrastructure that is capable of supporting the
organization’s goals with the changing business conditions and technology.
Most companies lack IT platforms that can adapt to changes in business
strategies and technologies. Thus, to meet new business and technology
challenges, the organizations need to be redesigned and new IT infrastructure
need to be developed.

e The ethics and security challenge: To develop systems that can be
understood, used and controlled by the people and that too in a socially
and ethically responsible manner is a major management challenge. Today,
more people are employed in collecting, handling and distributing information
than in any other occupation. Due to power of information these days,
information systems are used in the organizations to automate their core
production processes. As a result, our dependency on systems has increased.
Apart from IT benefits, information system has raised many ethical and
social problems and challenges. The ethical and social issues include threats
to intellectual property rights, individual’s privacy, elimination of jobs, etc.
In addition, the rise of information systems, Internet and Web-enabled
technology has introduced threats of unauthorized access to user’s data,
data theft, data alterations, etc. As information systems are valuable assets
for the business organizations, government and daily life, their security,
accuracy and reliability must be ensured.

Planning a new Internet business .

With the availability of the Internet twenty-four hours a day, Internet businesses are
growing at a faster pace. They are becoming popular because they are easy to start
with less investments. One need not hire people, or rent a room for the business;
also, there is no need to quit the job. In an Internet business, by investing time and
small amount of money, one can earn a lot of money.

Apart from its benefits, many Internet businesses that start everyday over
the world fail to succeed because of their poor business plan. The success of any
business largely depends on the business plan. A business plan is a proposal for a
new venture which gives details about the expected needs and results. In an Internet
business plan, both the website and the business model are integrated. It also
encompasses activities like planning, developing, marketing, and managing a
website. It ensures that the right type of customer is targeted, and that the Internet
is being fully used as a marketing tool.

The purpose of creating a business plan is not to have an end product;
rather it allows thinking effectively about the business. An Internet business plan is
composed of ten sections (see Figure 1.24), which are as follows:

1. Executive summary: This section explains the basics of the entire business
plan; for example, the product, the customers and owners, the future of the
proposed business, etc. While preparing the executive summary, one should
also consider the factor that the user may not be familiar with the Internet.




2. Business description: In this section, the products and services to be
offered by the firm along with the industry-specific information are discussed.
All information should be provided in detail. It should also describe how the

1. Executive summary

3. Marketing plan

3.1 Customers

3.2 Competition

3.3 Advertising

3.4 Pricing
' 3.5 Delivery and payment
Research and development
Operations and manufacturing

|
!
i 2. Business description
|
|
|
|

Management
Risks

. Financial data
Timeline

10. Bibliography

° 2 N2 ;R

Fig. 1.24Sections of a Business Plan

product and the Internet complement each other.

3. Marketing plan: This section covers the following:

o Customers: Depending on the target market, the customers along with
their characteristics and geographic locations are defined. The number
of Internet users is also identified. To identify this, help from various

Internet societies and groups can be taken.

Competitors: To be successful in the market, the competitors or similar
types of products are identified and several situations like whether the
competitors would compete across the board, or only for some specific
products, customers, or locations are examined. To make comparisons
with important competitors, a competitive analysis is done. Table 1.3
shows a sample competitive analysis format to compare a firm with two

competitors.
Table 1.3 A Sample of Competitive Analysis Format

Factor

Me Strength Weakness Competitor A | Competitor B

Importance to
customers

Products

Price

Quality

Selection

Service

Reliability

Stability
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In this table, the first column describes the key competitive factors. The next column
labelled as ‘Me’ mentions how a firm will be favourable to the customers
corresponding to each competitive factor. Then, whether the corresponding key
factor will be the firm’s strength or weakness is determined and this is mentioned in
the subsequent columns. After identifying the strengths and weakness of the firm,
the major competitors are analysed for the same competitive factors. The last column
of the table represents the importance of each competitive factor to the customer.
Note that numeric values can be used in this column to represent the relative
importance; for example, 1 represents critical and 5 represents not very important.
Finally, after performing the competitive analysis, a short summary is written that
outlines the firm’s advantages and disadvantages over its competitors.

o Advertising: In this section the procedure to advertise the product or
service on the Internet is described. For advertising the product on the
Internet, beautiful webpages are designed. This is considered to be the
first step. To promote the website, there are more alternatives available;
for instance, one can add the Web address of his site to the databases
of search engines like Google, Yahoo and MSN. Web address can also
be submitted to ‘What’s new with NCSA Mosaic’ as this gives
information about new websites. The address can also be added at the
end of each e-mail message.

e Pricing: In this section, how the prices for the products or services
have to be set are described. For setting the prices, research can be
done on what the competitors are charging for similar products or
services. If required, a pricing model to justify the firm’s prices can be
provided on the Internet. b

e Delivery and payment: In this section, the mode of delivering products
and receiving payments is described. For this, a variety of delivery models
and online payment methods through credit cards, DigiCash, etc., can
be used. In addition, to provide secure transactions online, a number of
encryption techniques, such as pretty good privacy (PGP), can be used.

4. Research and development: This section provides the description about
the technical aspects of the project; for example, the current state of the
project, type of R & D efforts required to complete the project, and the
cost estimation of project completion.

5. Operations and manufacturing: This section describes the major aspects
of business, such as daily operations of the business, the equipment required
for the business, etc. In addition, certain other aspects, for example, if the
firm needs to use its own Web server or give contract to some other
company, whether the staff is knowledgeable about the Internet or they
need to be trained in-house are also dealt with.

6. Management: This section discusses about the management that will run
the business. As the business is through the Internet, the business management
team should be very capable. To describe the role of the owner is also a
part of this section.




10.

. Risks: This section describes the major risks involved in the business. Along

with regular business risks like downward industry trends, cost overruns
and unexpected entry of competitors, Internet risks, such as computer
viruses, hacking and unauthorized access are also included.

. Financial data: This section describes the financial matters related to the

business. It forecasts the profitability of the business. All financial statements
related to the business are included. Expenses in the Internet business are
low in comparison to other businesses. This point should be considered in
the financial statement.

. Timeline: This section describes the sequence of steps necessary to convert

a proposal into reality. To develop this schedule, ideas about how much
time other online businesses have taken to establish can be taken.

Bibliography: This section includes business references as well as Internet
references in order to make the plan more effective. It provides knowledge
to the readers about the Internet being a part of the firm’s business. These
Internet references are additional to business references.

10.

11.
12.

. Define information.
6. Data until organized into a meaningful form cannot help in the

. The term informa-tion technology refers to which of the following

. What is an organization?
9. Organization is a hierarchical structure with different and

Check Your Progress

components?

(a) Software

(b) Hardware

(c) Telecommuni-cation
(d)All of these

Which of the following is a unique feature of an organization?
(a) Hierarchy

(b) Organizational structure

(c) Rules and procedures

(d) None of these

How do information systems flatten organizations?

Since the cost of and has been rising constantly,
today’s managers have increased their investments in IT.
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13

14.
135.

16.

17
18.
19:
20.

21.

22.
23.

24.

23,

26.
27,

. Agency costis also known as

(a) Transaction cost

(b) Capital

(c) Coordination cost

(d)All of these

Name the two models that help in explaining the role of managers.

According to Herbert A. Simon, decision-making process can be described
in four different stages, namely , , ,and

According to Henri Fayol, which of the following is a classical role of
managers?

(a) Staffing

(b) Interpersonal

(c) Informational

(d) Decisional

Define business strategy.

What is a strategic information system?

A is an activity for which a firm is the leader.

Which of the following is not a primary activity of a firm?

(a) Operations .
(b) Procurement

(c) Service

(d) Sales and marketing

The basic activities that constitute a firm are classified into primary activities
and

List the major factors that have altered the business environment.

E-commerce refers to the electronic means to conduct commerce
between and over the Internet.

intends to execute all the activities in a business enterprise
using the Internet and digital technologies.

is the process of integrating the economies of countries
around the world.

Define digital firm.

In the business information value chain, raw data is transformed into valuable
information through the following process.

(a) Collection

(b) Validation

(¢) Transfor - mation
(d)All of these




. Which of the following disciplines does the technical approach comprise?

29.

30.
31

82.
a3.
34.

(a) Computer science

(b) Mathematical science
(c) Social science

d) None of these

The is used to explore issues like changes in attitudes,
management, and organizational policy with the help of economics,
sociology, and psychology.

Define socio-technical system.

Outline the roles of information systems in business and management over
the years.

Flexibility helps organizations to be adaptable to
List the key management challenges of information systems.
is used to compare a firm with various competitors.

1.8

ANSWERS TO ‘CHECK YOUR PROGRESS’

. Organizational information is the information that is required by departments

and divisions in an organization. It may contain the number of employees,
products, services, and locations, the type of business, turnover and variety
of the details of each one of these entities.

. The four methods of assessing information needs are:

(a) Asking orinterviewing

(b) Determining from the existing system
(c) Analysing critical success factors

(d) Experimentation and modeling

. Information systems that help management at different levels to take suitable

decisions are called Management Information Systems (MIS).

4. A mapping of an information model is called a data model.

. Information is that data which has been shaped into a form that is meaningful

to human beings.

6. Decision-making process
7. (d)All of these

. An organization can be defined in more than one way. From a technical

viewpoint, an organization is a formal social structure that takes inputs from
its surrounding environment and transforms these inputs into outputs through
the production process. From a behavioural point of view, an organization
is a collection of rights, privileges, and responsibilities that is balanced over
aperiod of time.

Levels; specialists
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10.
11.

12,
13.
14.

15.
16.
I'7.

18.

19.
20.
21.
22.

23.
24.
25.
26.

27.
28.
29.

(b) Organizational structure

In today’s organizations, the use of information system increases the efficiency
of organizations and help flatten the hierarchies. The IT applications provide
the lower level employees with the information they require and they are
empowered with the rights to make decisions without supervision. Moreover,
the efficiency of managers in making decisions has enhanced because they
receive accurate information on time. Therefore, fewer managers are required
to supervise more employees than before.

Labour; capital

(c) Coordination cost

The Classical and the Behavioural model help in explaining the role of
managers.

Intelligence, design, choice, implementation

(a) Staffing

Business strategy is long-term planning of organizations that determine what
products (or services) they provide, the market they compete in, their
customers and suppliers, their future plans, etc.

Information systems are designed with the goal of solving some problems
or seeking new opportunities. The information systems that help organizations
to accomplish long-term competitive advantage are known as Strategic
Information Systems (SIS).

Core competency
(b) Procurement
Support activities
The major factors that have altered the business environment are as follows:
(a) Internet growth and technology convergence
(b) Transformation of business enterprise
(c) Globalization
(d) Transformation of industrial economy
(e) The emergence of digital firm
Business communications; transactions
E-business
Globalization

A firm in which almost all the relationships between the firm and its
employees, suppliers, and customers are managed via digital means is known
as adigital firm.

(d)All of these

(a) Computer science

Behavioural approach




30.

51;

32.
33

34.

A socio-technical system is the combination of social and technical systems.
It not only consists of hardware and software technologies, but also has
social and intellectual investments to perform in a better way.

Theroles of information systems in business and management over the years
are as follows.

e 1950s and the 1960s: Data processing
e 1960s and the 1970s: Management reporting
e 1970s and the 1980s: Decision support
e 1980s and the 1990s: Strategic and end-user support
e 1990s and the 2000s: Electronic business and commerce
Diverse situations
The key management challenges of information systems are as follows:
¢ Information systems’ investment challenge
e The strategic business challenge
o The globalization challenge
¢ The information technology infrastructure challenge
o The ethics and security challenge
Competitive analysis

3,

SUMMARY

Organizational information is the information that is required by departments
and divisions of an organization. It may contain acount of the employees,
products, services, and locations, the type of business, turnover and a variety

of details of each one of these entities.

Functional information is the information required by functional heads to
conduct management functions. This information is purely specific to that
function and by definition does not have a use elsewhere.

Strategic information is required for long-term planning and for directing the
course the business should take.

Tactical information is required to take short-term decisions to run the
business efficiently. It requires specifically designed processing of data. Most
of it can be obtained from day-to-day collection of routine data.

Information Systems (IS) are a special class of systems that are used for
data storage, retrieval, processing, communication and security.

An information model is a formal representation of any particular entity, be
it a project, an object or a system. It includes the entity’s various features
and characteristics, functions and interrelations. An information model
represents all the concepts, rules, operations, limits and specifications to
represent data in a stable, sharable and organized structure. A mapping of
an information model is called a datamodel.
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o In this unit, you have learned about information systems, their need in the
organizations, management and making strategies. The timely, reliable, and
correct information leads to better management decisions, more efficient
business processes and higher profitability. Almost all modern firms invest
heavily in information system, a set of interrelated components used to
collect, process, store, and provide information to the decision-maker.
Information is that data which has been shaped into a form that is meaningful
to human beings.

NOTES

e System may be defined as a set of interrelated components that are put
together to achieve a common task or goal. Often, a system is composed
of several subsystems, which may further be composed of other subsystems.

¢ Computer-Based Information System (CBIS) uses Information Technology
(IT) to perform its various activities. The term IT refers to all the components
that a system needs to operate, including software, hardware, and
telecommunication. The role and usage of information system is influenced :
by the needs of organizations, surrounding environment, etc. Introduction
of a new information system affects the organization’s structure, day-to-
day working, performance, productivity, work design, etc.

e From atechnical viewpoint, an organization is a formal social structure that
takes inputs from its surrounding environment and transforms them into
outputs through the production process. From the behavioural point of view,
an organization is a collection of rights, privileges, and responsibilities that is
balanced over a period of time.

o The Internet has made phenomenal changes in the working of organizations.
It provides precise, timely, and accurate information and also helps in
effective decision-making. Managers perform a variety of tasks such as
making decisions, participating in meetings, writing reports, etc.

PR p———

e Decision-making is considered as a core managerial function. It is a process
of choosing the best alternative from among various alternatives. According
to Herbert A. Simon, the decision-making process can be described in four
different stages, namely intelligence, design, choice, and implementation.
Simon proposed two types of decisions, namely programmed and non-
programmed decisions. Gorry and Scott Morton referred to these
programmed and non-programmed decisions as structured and unstructured
decisions respectively. Decisions that are neither structured nor unstructured
are called semi-structured decisions.

PP —

e The most commonly used model to support business-level strategies is the
Value Chain Model. According to this model, every firm is a sequence of
basic activities, with each activity adding some value to its products or
services. The basic activities that constitute a firm are classified into primary
and support activities. A value web is a group of independent firms that
coordinate their value chain, with the use of IT, to generate a product or
service for a market collectively.
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| e Information systems promote synergy by integrating separate business units ~ Overview of Management,

. : i
so that they can act as a whole. Information systems encourage sharing of CrRaRRaHN e M
knowledge, and thus help in creating a core of competency. A core

competency is an activity for which a firm is the leader.

e Information systems provide different ways of conducting business that help SRR

the organizations to gain a strategic advantage over their competitors and
differentiate them from their competitors. Five changes that have altered the
business environment are the growth of the Internet and technology
convergence, transformation of business enterprises, globalization,
transformation of industrial economy, and the emergence of the digital firm.

¢ Globalization refers to the process of integrating the economies of the
countries around the world.

e In today’s systems, the interdependence between the firm’s information
systems and its business capabilities has been growing continuously. The
linking of two or more autonomous computers and other devices with the
software for sharing information and hardware resources is called
networking. The Internet is basically a network of networks that facilitates
data transmission and exchange across millions of domestic, academic,
business, and government networks.

1.10 KEY TERMS

o System: A collection of components that work together to achieve a goal.

o Digital firm: Firms that use IT to change their core business processes,
manage their customers and suppliers and manage the organization and its
employees.

e Strategic information: The information needed for long range planning
and directing the course a business should take.

¢ Tactical information: The information needed to take short-term decisions
to run a business efficiently.

¢ Operational Information: The information needed for day-to-day
operations of a business.

o Information model: A formal representation of the properties and
relationships of an entity integrated with its relevant data and documents,

¢ Information management: Compiling and managing information from
various sources and sharing that information with audiences.

¢ Transaction costs: Costs incurred when a firm buys goods which it cannot
make itself

e Agency cost: Cost incurred in supervising the agents.

» Decision-making: The process of choosing the best alternative from among
various alternatives.

o Structured decisions: Decisions that are well defined, certain, and need

little effort from decision-makers. Self - Learning
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Organisation and MIS , L
S rules are specified to take such decisions.
e Semi-structured decisions: Decisions that are neither structured nor
NOTES unstructured.

¢ Management decision problem: A situation where the management ofa
company has to take a decision that requires research.

e Digital firm: A firm in which almost all the relationships between the firm
and its employees, suppliers, and customers are managed via digital means.

¢ Business processes: A set of logically related activities that are coordinated
and focused to accomplish specific business outcomes.

e Enterprise Resource Planning System: An organization-specific form
of strategic information system that integrates almost all business functions,
such as planning, sales and marketing, inventory control, manufacturing,
and human resources.

¢ Network: An interconnected system of computers.

¢ Networking: The linking of two or more autonomous computers and other
devices with the software for sharing information and hardware resources.

e Internet: A network of networks that facilitates data transmission and
exchange across millions of domestic, academic, business and government
networks.

1.11 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Y

Short-Answer Questions
1. What is an information system?
What are the components of an IS?
What is an information model?
What is information management?
‘What is an information system?
. What is a computer-based information system?

N R W

. Write short notes on the following:
(a) Transaction cost theory

(b) Agency theory
(c) Virtual organizations
(d) Management decision problems
8. How does Simon classify decisions?
9. According to Henri Fayol, what are the classical functions of managers?

10. What are the roles of managers in organizations?
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11. How have business enterprises changed with rapid changes in the market =~ Overview of Management,

s comp it Organisation and MIS
12. What do you understand by business information value chain? _
13. Write a short note on the evolution of the Internet. NOTES

Long-Answer Questions

1. Explain the need for information systems with respect to organizations.
. Discuss in detail the various information models.
. What is the role of information systems in decision-making?

B W N

. What is an organization? Discuss the common and unique features of
organizations.

. Discuss the role of the information system department in an organization.

. Describe the decision-making process.

. Discuss Mintzberg’s classification of the roles of managers.

. Explain the major factors that have altered the business environment.

O 00 N Y W

. What do you understand by organizational design? Discuss the new options
for organizational design.

10. Describe some major challenges of information systems.

11. How should one plan before starting a business on the Internet? Discuss the
major risks involved in an Internet business.

1.12 FURTHER READING

Curry, A., P. Flett and F. Hollingsworth. 2006. Managing Information and
Systems: The Business Perspective. Oxford: Routledge.

Orna, E. 2004. Information Strategy in Practice. Burlington: Gower Publishing
Ltd.

Haag, S., M. Cummings and D.J. McCubbrey. 2004. Management Information
Systems for the Information Age. New Delhi: Tata McGraw-Hill.
Bhagchi, Nirmalya. 2010. Management Information Systems. New Delhi: Vikas
Goyal, D.P. 2000. Management Information System: Managerial Perspectives.

New Delhi: Macmillan Publishers India.

Laudon, Jane P. and Kenneth C. Laudon. 2007. Management Information
System: Managing the Digital Firm. New Jersey: Prentice Hall.

Saxena, Sanjay and P. Chopra. 2006. Computer Applications in Management.
New Delhi: Vikas Publishing.

Saxena, Sanjay. 2009. Introduction to Information Technology. New Delhi:
Vikas Publishing.

Self - Learning
Material 75




gr”“w",-iﬁ,?f ﬁi’?ﬁ;’gﬂnﬁ Bhatt, Pramod Chandra P. 2003. An Introduction to Operating Systems— |
B Concepts and Practice. New Delhi: PHI :

Bhattacharjee, Satyapriya. 2001. A Textbook of Client/Server Computing. New
Delhi: Dominant Publishers and Distributers.

Hamacher, V.C., Vranesic, Z.G. and Zaky. 2002. S.G. Computer Organization,
5th edition. New York: McGraw-Hill International Edition.

Nutt, Gary. 2006. Operating Systems. New Delhi: Pearson Education.

Date, C.J. 2000. An Introduction to Database Systems, Seventh edition. Boston:
Addison Wesley.

Shepherd, Robert D. Introduction to Computers and Technology, First edition.
New Delhi: Crest Publications.

Tanenbaum, Andrew S. Structured Computer Organization, 4th edition. New
Delhi: Prentice-Hall of India.

NOTES

Self - Learning
76 Material




Office Automation and

UNIT 2 OFFICE AUTOMATION AND B st
FUNDAMENTALS OF ,
COMPUTERS NOTES

Structure
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2.1 Objectives
2.2 MS WORD 2010
2.2.1 Formatting Paragraph and Text in MS Word
222 Shortcut Keys for Various Tasks
223 New Features in Word 2016/ Difference between Word 2010 and 2016
2.3 MSEXCEL 2010
23.1 Working with Cells
232 Working with Basic Formulae and Charts
233 Modifying and Merging Rows and Columns
234 Adding Spellcheck in Spreadsheet
2.4 MS PowerPoint 2010
24.1 Creating Presentation and Slides
242 Working with Objects
243 Printing Slides
244 Putting Text on Slides
2.5 Introduction to Computers
2.5.1 Number System for Computers (Binary, Octal, Hexadecimal)
252 Data Representation and Coding Systems (BCD, EBCDIC, ASCII)
253 1/0 Devices
2.54 Types of Computers (Mini, Micro, Mainframe and Personal Computers)
255 Auxiliary Storage Devices
2.6 Answers to ‘Check Your Progress’
2.7 Summary
2.8 Key Terms
2.9 Self-Assessment Questions and Exercises
2.10 Further Reading

2.0 INTRODUCTION

Microsoft Word (MS Word or Word) is a program which is used for creating
documents. It is used by the organization or standalone user to create documents,
reports and notes. Word provides the facilities of creating reports and pictures
and thus, manifests your idea on the paper. If you have worked in MS Word
earlier, you will notice that a lot of new features are added in MS Word 2010. If
you are a beginner, there is no need to worry about learning MS Word. This unit
focuses on every aspect of this software from beginning to the expert level. In this,
you will learn about the essential features of MS Word, which are needed to
enhance the documents. This is one of the common usages of MS Word. This tool
of Microsoft Office 2010 also makes creating short reports or lengthy documents,
an easy and time saving task.

Self - Learning
Material 77




Office Automation and
Fundamentals of
Computers

NOTES

Self - Learning
78 Material

Microsoft Excel (MS Excel or Excel) is the program that is used for creating

the Excel sheets or worksheets. It is used by businessmen and individuals for
storing data and its interpretation. It is a part of MS Office, which provides the
facilities of storing data in the form of table that contains rows and columns. This
program helps in doing the tasks at a faster speed as all the calculations are
performed using formulas and functions. If you have used MS Excel 2010 earlier,
you will notice that more complicated features have been added. It includes features
such as calculation, pivot table, slicers, sparklines and many more. The programming
language used by the Excel for applications is Visual Basic. In this unit, we will
discuss briefly about the essential features of the MS Excel 2010. We will also
learn different features such as file management, information management and
shortcuts and tips.

Microsoft PowerPoint (MS PowerPoint or PowerPoint) is a program which
is used for creating presentations. It is used by the working professionals, students
and politicians for creating attractive presentations. It consists of information in the
form of text and various visual aids such as graphics, pictures and video, which
keeps the audience interested. This way of presenting information and sharing of
ideas increases visual literacy among users. This unit emphasizes on each and
every aspect of creating and designing presentations. In this unit, you will learn
about the essential features of PowerPoint, different methods of formatting and
ways to enhance your presentation. Moreover, it will make you an expert in
delivering the presentation and convincing the audience. PowerPoint provides the
facilities of creating the presentation and manifests the idea in front of audience in
an organized and easily understandable way.

=

Digital computers are commonly used for data processing and solving
problems using programs. These operate by counting digits in the binary form and
processing data in discrete form. Hybrid computers are generally used for weather
forecasting and industrial process control. A number system that uses only two
digits, 0 and 1 is called the binary number system. A transistor can be made to
operate either in cut-off or saturation; a magnetic tape can be either magnetized or
non-magnetized; a signal can be either HIGH or LOW; a punched tape can have
ahole orno hole. You will also understand data representation and coding system.
Memory in the computer system is required for storage and subsequent retrieval
of instructions and data. We will also learn about the Central Processing Unit or
CPU that contains several registers for storing data and instructions. Programs
and data must be entered into the computer memory for processing, and results
obtained from computations must be displayed or recorded for the user’s benefit.
An Optical Barcode Reader or OBR uses laser beam technology. The laser beam
is moved across the pattern of bars in a barcode. Mainframe computers support
a number of users to access a variety of software applications. They are also
called organizational computers because they are used in large organizations.

In this unit, you will learn about the MS Word 2010, MS Excel 2010, MS
PowerPoint 2010 and introduction to computers.
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After going through this unit, you will be able to:
¢ Discuss the significant features of MS Word 2010 NOTES
¢ Format word documents using bullets, numbering and styles with the help

of illustrations
¢ Enhance the documents using table, border, page setup, header and footer
¢ Manage file and create secured document
e Discuss the important features of MS Excel 2010
¢ Understand the working with cells and basic formulae and charts
e Insert data and calculate the values using formula and functions
o Apply quick style to charts, and tables
e Discuss important features of Microsoft PowerPoint 2010

¢ Understand the introduction of computers

2.2 MS WORD 2010

Opening, Creating, Saving and Working with Documents

Microsoft Word is used for the creation of documents. It is the most commonly
used format for storing information and sending it through e-mails. There are several n
interactive features in MS Word 2010 that help in making the documents productive
and innovative. Here, we will explore some features such as the management of
various files in the word documents, management of the information in a secured
way and various shortcuts and tips to access different commands.

File Management

File management provides the facility to organize the files by saving them in the
computer and drives such as disk drive, USB drive, etc. The saved file can then
be searched and opened later on. Also, the files can be moved from one location
to another as the need be. To better understand the features and functions included
in file management, it is essential for you to know about the File menu of MS
Word 2010.

To make you comfortable with the various aspects of file management, a
detailed description of the File menu is given below:

File Menu

In the previous version of Microsoft Office there was no File Menu. Instead,
there was an Office Button. This is shown in the following screenshot.
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The Office Button has been replaced by the File Menu in Microsoft Office
2010. Whenever File Menu is clicked, a backstage view of Microsoft Office is
visible. In MS Office 2010 File Menu, allows users to easily access frequently
used commands.

A screenshot displaying File Menu is shown below:
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When you click on the File mu, arious options relted to the file are
displayed.
A screenshot displaying the options is shown below:
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Save & Send

Help
|3 Options
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Creating a new document
To create a new document in MS Word. Follow the following steps.
1. Goto the file menu in the ribbon interface.
2. Click on New option, you will see the new blank document template.
Inside File tab you will find six main sections and six buttons.
The six sections present inside File are as follows:

e Info: Info section gives important information related to file, by specifying
its properties. It enables youto protect documents, check for issues and

manage versions.

* Recent: The Recent section is by default selected is. This section
shows' all the Recent Documents and Recent Places. Recent
Documents are the word documents which can be opened just by
clicking. Recent Places are the places where these recent documents
are being saved. If a user wants to quickly access recent documents, he
should check the option Quickly access this number of Recent
Documents by selecting the number from a drop down box. All
documents will appear on the left hand side. You can recover documents
which have not been saved by clicking Recover Unsaved Documents
button.

e New: New section helps you to create new documents. By default, the
Blank Document is the template selected, however the user can choose
any template,.

e Print: Print section enables you to print the files with the available settings
and a preview of the Print section is shown on the right hand side of the
window.

e Save & Send: There are different options present inside Save & Send
option. Send Using E-mail allows user to send the file with the help of
email. In Save to Web option you need to login with the help of
Windows Live ID. After that, you click on Save As option to save the
file at the location which you want. The Save to SharePoint option is
similar to Save to Web option. In Publish as Blog Post option, user
can create blog post by incorporating the present document. This helps
to publish blogging contents online. In Change File Type option, the
user can change the extension of the file type. In Create PDF/XPS
Document option user can convert word document to PDF or XPS
format.

e Help: In case of any need, the user can click on Help button. The Help
button also lets you know about updates related to the Office.
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The six buttons which are present inside File are as follows:

¢ Save: Save button helps in saving the document which you are, currently
working upon. Suppose, you are saving the document for the first time
then it will ask you the location where you want to save it..

o Save As: Save As button is used when you want to rename the document
and save it in another location.

¢ Open: Open button is used when you want to open a document which
has already been saved.

e Close: Close button is used when you want to close the documents
which you are currently working upon.

e Options: Options button is used when the user wants to apply various
Word options related to the file.

o Exit: Exit button is used to exit documents. Before you exit, you are
asked whether you want to save the document or not.

Saving a document

In MS Word 2010, files are saved in the default format, which is .docx. This is
because .docx format is more secured and damages can be easily recovered.
Some other formats of saving the files in Microsoft Word are .docm, .dotx and
.dotm, which are explained as follows:

.docm file format is used when the document is to be saved in macro-
enabled documents.

.dotx file format is used when the document is to be saved in documerit
template.

.dotm file format is used when the document is to be saved in macro-
enabled template.

There are many ways of saving the files but these are optimized for the
specific uses.

Steps to save the documents are as follows:

1. Click the File tab which is present on the left hand side of the ribbon.
2. Click the Save As option.

3. Select the drive and folder where you want to save the file.
4. Go to the File name textbox to write the name of the file.
5

. Select the format in which you want to save the File. By default, the file
format in which the file is saved is .docx.

6. Click on Save button to save the file.
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Saving a document in PDF or XPS format

There are two methods for saving a document in PDF or XPS format, both are

given below:

1. One method of saving the file in Pdf or Xps format is with the help of Save

As button.

2. Another method of saving the file in Pdf or Xps format is with the help of

Save & Send section.

Here are the steps for saving a document in PDF or XPS format using Save As

option:
1. Go to the File tab which is present in the ribbon.

2. Inside File tab, click on the button Save As. The Save As dialog box

appears.

3. Choose PDF extension from Save as type which will save the word file in
PDF format. In order to save the file as an XPS Document, choose XPS

Document extension.

To save a document in PDF or XPS format using Save & Send option, follow

the following steps:
1. Go to the File tab which is present in the ribbon.
2. Inside File tab click on the section Send & Save.
3. Click on the button Create PDF/XPS Document.

This can also be done by clicking the Save icon present on the Quick
Access Toolbar. The keyboard shortcut for saving a word document is Ctrl+S.
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4. Click on Create PDF/XPS button, present on the right hand side of the
dialog box. After clicking on Create PDF/XPS button, the Publish as
PDF or XPS dialog box appears.

5. After that Click on Publish button to publish the document in PDF format.
If the user wants to publish the document in XPS format then user should
choose XPS Document from the Save as type drop box.

Moving file into a specific folder
Steps to move the file into a specific folder are as follows:

1. Clickthe file which you want to move.
2. Hold the left click of the mouse on the file and drag that file to the specific
folder.
Opening the document
Steps to open documents are as follows:
1. Click the File tab which is present on the left hand side of the ribbon.
2. Click the option Open.

3. Select the location of the file, that is, the appropriate drive and folder from
where you want to open the file.

4. Select the file which you want to open.
5. Click on Open button to open the file.

Deleting Text

You can delete or remove the text from the document that is no longer required.
To do so follow the given steps.

e For deleting text to the Left of the insertion point, press the Backspace Key
on the keyboard.
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e For deleting text to the Right of the insertion point, press the Delete Key on Office Automation and
the keyboal‘d Fundamentals of

Computers
¢ For deleting a Range of Text, first select the text that you want to delete or
remove and then press the Delete Key on the keyboard.

NOTES
Copying and Moving Text

You can copy and paste the same text that exists in your opened document to
other regions or locations of the same document. Moreover, you can copy and
paste the text to another document also. This saves your time. MS Word also
allows you to move the selected text from one region of the document to another
region as per your requirement. To do this just cut and paste or drag and drop the
selected text to the desired location or region.

Copying and Pasting Text

By copying a text you can create duplicate or replica of the selected text. To do
this follow the steps given below.

1. Select the text that is to be copied.

2. Onthe Home Tab, click on the Copy command or simultaneously press the
CTRL + Ckeys on the keyboard. Alternatively, you can right-click on the
selected text and then select Copy.

3. Position the insertion point in the text where the text has to be copied.

4. On the Home Tab, click on the Paste command or simultaneously press the
CTRL + V keys on the keyboard.

5. The copied and pasted text will appear at the position specified by you.
Cut and Paste Text

1. Select the range of text that you have to cut and move to the new specified
position. On the Home Tab, click on the Cut command or simultaneously
press the CTRL + X keys on the keyboard. Alternatively, you can right-
click on the selected text and then select Cut command.

2. Position the insertion point in the document where the text has to be moved.
On the Home Tab, click on the Paste command or simultaneously press the
CTRL + V keys on the keyboard. The text will be moved to the specified
location in the document.

Find and Replace

In the document let us use the Find and Replace command for changing the word
‘Word’ to “MS Word’. To do so, follow the steps given below.

1. Onthe Home Tab, click on the Replace command.

2. When you click on the Replace command, then the Find and Replace dialog
box will appear.

3. In the Find what: field, type the text (in our case ‘Word’) that you want to
find in the document.
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4. Inthe Replace with: field, type the text (in our case ‘MS Word’) with which
you want to replace. Now click on Find Next. Now press ‘Replace’ to
change the word.

5. MS Word will quickly find the first instance of the text “Word’ and highlight
itin gray color.

6. Now check your document to Review the text and confirm that the word
you wanted to replace is done successfully. If there are more than one
word to be replaced in the document then select the command ‘Replace
All’. All the words in the document will be replaced and an update will be
displayed on the screen that how many words are changed and replaced.

Printing a new document

After creating the document in MS Word 2010, you can save, share and print
your document to view it offline. MS Word provides various options for printing
the document. You can preview your document before printing using the Print
pane so that you can make necessary modifications.

The MS Word provides the very significant feature ‘Custom Printing’ which
helps you in printing only the part text or selected text of the document when you
do not want to print the whole or entire document, because by printing unnecessary
pages you will be wasting the printing paper. Using the Custom Printing option
you can print either several or numerous individual or separate pages or a specified
range of pages. Word permits you to specify or identify and select the exact pages
from the document for printing.

Printing Document using Custom Print

To print a specific range of pages and individual pages you have to enter the
individual page numbers and the range of page numbers. Remember that each
entry has to be separated with a comma, for example 2, 5, 8, 15, 20-25, 41-54,
and so on.

1. Click on the File Tab to open the Backstage view. Click on the option
Print.

2. The Print pane dialog box will appear. Click on the arrow that appears
next to the field ‘Print All Pages’ in the ‘Settings’ option. A menu will be
displayed, select the option ‘Custom Print’.

3. To do Custom Printing, in the field ‘Pages:’ enter the page numbers
(individual page numbers or range of page numbers) that has to be printed.

4. Click on ‘Print’ to print the preferred pages.
Print Preview

The ‘Print Preview’ feature of MS Word helps you to view on the screen how the
printed version of the document would look like before printing a hard copy. In
latest versions of the MS Word (MS Word 2010 Onwards), there is ‘NO’ Print
Preview Tab or Option. As an alternative, click on the File Tab then on the option
Print from the menu that appears on the left side. The Print pane will be
displayed. In the Print pane, click on the ‘Page Setup’ option to open Page
setup dialog box. In the Page setup dialog box define the Margins, Paper
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Size and Layout options for setting the document text so that the text remains Office Automation and
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within the printable area. —
The Ribbon Interface
Ribbon View is a substitute that provides the facilities of accessing the commands NOTES

for applications. It is organized using a horizontal bar. It provides an easy way to
access the commands, as all the commands are organized using tabs and groups.
With the help of Ribbon, performing various actions to the Office application is
easy. Ribbon is dynamic in nature, which implies that behavior changes as the size
of Microsoft Office changes.

‘Ribbon’ is a set of toolbars which displays the commands and tools for
performing various tasks. In Microsoft Office 2003, user worked with the classic
drop down menu and toolbar and users were able to work with them easily and
quickly. With the release of Microsoft Office 2007, the new term ‘Ribbon’ was
proposed that refers its own implementation of tabbed toolbars bearing
heterogeneous controls, known as ‘The Fluent User Interface’, which swapped
the menus and toolbars with a single ‘Office Menu’. MS Word, PowerPoint,
Access and Excel implemented ‘Ribbon’ in MS office 2007.

With the release of MS Office 2010, however, ‘ribbon’ was implemented in
the rest of the MS Office applications and added end user customization support
for its end user. MS Office 2010 ribbon is great, flexible and easy to use.

Screenshot for Ribbon is as shown:
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Ribbon Groups

If you click on any tab or groups, each button and each dropdown menu
will perform different actions

For example: When one clicks on the Home tab or any other tab, various
options are displayed. With the help of these options, one can change the
Formatting, Orientation, Layout, Caption, and Proofing of the MS Office
Application.

As an example in MS Word 2010, the labeling of the commands and menus
is as shown in the screenshot:
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e Tab: It shows different types of commands for creating MS Offices
applications. You can see the commands by clicking on the particular tab.

® Quick Access Toolbar: It is a way to provide quick access view to the
most frequently used commands. By default, Save, Undo and Redo buttons
are visible on the Quick Access Toolbar.

e Contextual Tabs: It displays the Commands for a particular selected
object. When the user draws any shape, a Contextual tab called Drawing
Tools appears.

¢ Minimize Ribbon: You can minimize the ribbon in the following ways:
o Byclicking on minimize ribbon button.
o Bydouble clicking the tab on the ribbon.

o By right clicking the tab from the contextual menu and selecting
minimize ribbon button.

o Bypressing Ctrl+F1 button.

¢ Help: For getting any help, you can click on Help button or by clicking on
the File tab and selecting Help from the menu.

¢ Dialog Box launcher: You can see the Dialog box launcher or the Task
pane by clicking on the Clipboard Task Pane.

e Group: Set ofall correlated commands which appear in each tab.

o Gallery: Gallery contains the option list and additional choices are displayed
as thumbnail preview.

2.2.1 Formatting Paragraph and Text in MS Word

Formatting word document is necessary in order to create an effective document.
In case of formatting, you format a text, letters, words, pictures, paragraphs, and
so on. It can be applied to any portions of word documents. There are four types
in which formatting are classified, which are character, document, section and
paragraph. There are various tools which let you format the word documents. You
can apply font and paragraph formatting; create bullet and numbering to show the
information in point. You can also apply various styles to enhance the text. In this
section, you will learn to format a word document by applying different formatting
effects.

L8

Paragraph and Font Formatting

Font and paragraph formatting is one of the most important styles of formatting. If
you do not apply any style, then font and paragraph formatting are applied by
default. It is applied to keep the documents simple and appealing.

Paragraph Formatting

Paragraph formatting is used to change the appearance of paragraph. It is present
in the Home tab of ribbon view. You can apply the Paragraph Formatting by
selecting the paragraph. It contains various controls for providing a quick access
to many frequently used functions. All options of paragraph formatting are found in

the paragraph group.
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The screenshot of Paragraph Formatting is as shown: Office Automation and
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Paragraph
The available buttons and icons of the Paragraph Fonnattmg toolbar are
shown:

o [i= Sir Bullets button of the formatting toolbar helps in creating and
removing the bullets of the selected paragraph.

e |{= - Numbering button of the formatting toolbar helps in creating and
removing the numbers of the selected paragraph.

e ‘i=- Multilevel list button of the formatting toolbar provides you the
facility of adding numbered lists of items, using multiple levels.

= Decrease Indent button decreases the indentation level of the
paragraph.

e ;= Increase Indent button increases the indentation level of the
paragraph.

e 4| Sortbutton helps in sorting the text, number and date to either

[ ]
FILIN

ascending or descending order.

e 9 Show/Hide shows or hides the formatting symbols of various
sections of adocument. Arrow symbol denotes tab and dot denotes
space. Itis set from left to right direction.

. J%]Ahgn Text Left button of the formatting toolbar helps in alignment
of text, number, paragraph and object to left.

° | = Align Center button of the formatting toolbar helps in alignment of
text number, paragraph and object to center.

v = ‘Align Text Right button of the formatting toolbar helps in alignment
of text, number, paragraph and object to right.

© i%lAhgﬂ Justify button of the formatting toolbar helps in alignment of
text, number, paragraph and object to both left and right margins.

e !=- Line and Paragraph spacing of the dropdown menu helps in

changmg the amount of space between the paragraphs when selected.
You can choose any space by clicking on the dropdown menu.

e » - Shading dropdown box helps you to add colored background to o
the area of text which is selected. A;aj;é.:ria;ammg 89
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e i - Bottom Border dropdown box helps in selecting the borders

from optionsin the dropdown menu. By default, “Bottom Border™ is
selected. You can change border to Top Border, Left Border, Right
Border etc. You can add and remove the border around any texts,
pictures or paragraphs.

Spelling and Grammar Checking

MS Word provides significant feature ‘Proofing’ for checking the text in the
document by using the option ‘Spelling & Grammar’. If you have made mistakes
in the document while typing the text then you can use the numerous proofing
features provides by MS Word to produce error-free and professional documents.
You can check the spellings in the document and after making necessary correction
you can change the corrected spelling in the whole document.

Running a Spelling and Grammar Check

1. To start the proofing of the document text, on the Review Tab go to the
Proofing group option and then select the command Spelling & Grammar.

HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS VIEW

ABE € ) %y £ Previoss i'5 G A Markup  +| J}J B -
i 7 Next _;‘Z E Show Markup - a
language  New Delete _ . Track o Accept
- Comment Show Comments | Changes» 5] Reviewing Pane .
. Comments Tracking e Changes
Spelling & Grammar (F1) 2 i 1 3 ¢
Typos? Not on our watch. Let us
check your spelling and grammar,

2. The Spelling pane will be displayed on the right side of the screen. MS
Word will provide one or more suggestions for every error in the
document text. Select the correct suggestion to modify the error if you
want and then click on ‘Change’ to change this specific error or click on
‘Change All’ to modify the similar error in the whole document. If you
do not want to modify or change the error then click on ‘Ignore’ for
ignoring this error or click on ‘Ignore All’ for ignoring the similar
errors in the whole document. Generally, the error is highlighted by a
red line in the document text.

3. MS Word will go through each error in the document till you review all the
errors in the current document. When you review the last error in the
document then the dialog box will be displayed on the screen to confirm
that the checking of spelling and grammar is now completed. Click on OK.

4. You can also manually modify or correct the spelling errors in the document
when no suggestions are provided by MS Word.

Ignoring Errors

Do not entirely depend upon the Spelling and Grammar check as it may not be
correct always. Essentially while checking errors in grammar, it is possible that MS
Word may not notice various grammatical errors. It is also possible that at times the
Spelling and Grammar check option may mark any spelling as incorrect while actually

it mar iy
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it is correct, for example name of people or place which is not included in the MS Office ;“‘:maﬁo”’aﬂd
Word pre_deﬁned dictionary. Use the following options for checking a spelling or “ agj:;fu”: ef{
grammatical error.

Checking ‘Spelling Errors’ NOTES
e Ignore: When you click on ‘Ignore’ option then the MS Word will skip
checking the marked word, i.e., it will not be changed.

e Ignore All: When you click on ‘Ignore All’ option then the MS Word will
not only skip checking the marked word, i.e., it will not be changed, but it
will also skip checking all other occurrences or instances of the similar
word in the current MS Word document.

o Add: When you click on ‘Add’ option then MS Word will add the marked
word to the existing predefined dictionary so that it will not be marked
as error again. Before clicking on the Add option check the spelling of
the word to ensure that the marked word is spelled accurately.

Checking ‘Grammar Errors’

MS Word provides detailed explanation for each marked ‘Grammar Error’ that why
it is incorrect. It also displays some related example sentences or phrases to explain
the concept, as shown in the given Illustration. These examples will help you in
determining whether to change the marked sentence or phrase by clicking on the
Change option or to ignore it by clicking on the Ignore option.

Change: When you click on the Change option then MS Word will modify or change
the marked sentence or phrase in the document with the suggestion that you have
selected. .

Ignore: When you click on the Ignore option then MS Word will skip checking the
word or phrase in the document without making any change or modification to it.

Automatic Spelling and Grammar Checking

By default, MS Word will automatically check the Spelling and Grammar errors in
the document. Hence, there is no need to perform a separate checking in the document
for spelling and grammar. MS Word indicates these errors by distinct colored and
wavy lines.
e Ifthe word is marked with the red wavy line then it indicates thatitis a
misspelled word, i.e., the spelling of the marked word is incorrect.

e Ifthe word or sentence is marked with the blue wavy line then it indicates
that it is a grammatical error, i.e., either the usage of word is grammatically
incorrect or the sentence includes misused words.

The misused word is also termed as a ‘contextual spelling error’. This term is
used when the spelling of the marked word is correct but it is used incorrectly. For
example, while writing a letter if you start with the phrase ‘Deer Mr./Ms. XYZ’
then the word ‘Deer’ will be a misused word or a contextual spelling error. The
spelling of the word Deer is correct but in the letter it is used at incorrect place. The
correct word to be used is ‘Dear’.
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Correcting the Spelling Errors
To correct the Spelling Errors, follow the steps given below.
1. Place the insertion point at the word marked as error by MS Word. Now

right-click the marked underlined word. The menu with spelling suggestions
will appear.
2. Select the spelling that is correct for your document from the list of suggested
spellings as shown below in the [llustration.
3. MS Word will change the marked word with the corrected spelling in the
document.
Word Count

Total number of words in a Word document is displayed on the status bar at the
bottom of the Word window. If it is not displaying then right-click the status bar
and then click Word Count.

1. Go to the File tab 1
2. Go to the Save As
The screenshot of |

Table of Contents (TOC)
Table of Contents gives a quick reference point or an abstract overview to the
reader where the reader can find data or content. N

Inserting Table of Contents:

TOC is inserted in the document at the position, where the cursor is placed and it
is not inserted from the starting place of the document.

Steps to insert table of content are as follows:
1. Create a blank document.
2. Click on References tab from the Ribbon view.

3. Click on the Table of Content option under Table of Content group.
A dialog box opens which shows different type of Table of Content
options.

Table of Content Fields: This is another method of adding fields in Table

of Content.

Steps to add entries in Table of Content are as follows:

1. Click on the Insert tab.

2. Click on the Quick Parts which comes under Text group and select
the option Field.

3. Then, a Field dialog box opens.

4. Select the option TC.Then type some text in Text Entry text box and
click OK button.




5. For displaying the entries, click on the Table of Content option in the Office Automation and

. . Fund
Reference tab. Then, click on the option Insert Table of Contents. . “zj,’,',f,f‘;’;{

6. Then, a Table of Content dialog box opens.

7. Click on the Options in this dialog box, then, a Table of Content NOTES
Options dialog box opens.

8. Uncheck the Styles and check the Table entry fields options and then
click OKbutton.

Updating the Table of Contents: If you want to change the some content
in the document then you can update it by using following steps:

1. Click on the Reference tab. Select Table of Contents under it and
choose any one style for creating TOC. An example of Table of
Contents is as shown:

Contents

9. Updating The Table Of Contents
7

12. Adding Entries To A Table Of Contents
)

14. Removing Entries From A Table Of Contents
8

2. Then click on Update Table, a dialog box Update Table of Contents
will be opened click on the OK button of that dialog box.

3. Update the content of table according to your need. .

Removing entries from the Table of Content: You can also remove the
i entries from the Table of Contents.

Steps to remove entries from the Table of Content are as follows:
! 1. Click on the Reference tab.
i 2. Click on Add Text option under the Table of Contents group.

Working with Tables, Columns and Sections

Table

Table consists of the rows and columns. Rows are horizontal and columns are
vertical. At the intersection of the rows and column there is a cell which contains
the text. We can format the tables according to our requirements.

Creating a table
e Go to the Insert tab and click on the Table option.
e Move your cursor over the grid, the table will appear in the document. We

can add the desired number of rows and columns in the table. Left click on
the grid when the size of the table is appropriate.
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The screenshot of the table created using the grid is as shown:
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¢ Sometimes, the required table might be greater in size than that is available
in the grid. In that case, click on the Insert Table button and enter the

size manually.
The screenshot of the table created manually is as shown:

o Below the grid, there are other optlons that can be used to design the
table according to the requirement.

The screenshot showing the other options available for creating a table is as
shown:
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Deleting the table Office Automation and
Fundamentals of

e Click on the table. Table layout will be displayed on the top. Computers
e Click on the Delete button. :
e Select the Layout tab if this is not already selected. NOTES

o Click on the Delete Table button. This will delete the table. Other actions
can also be performed on the table according to the requirement.

The screenshot of Delete Tableis as shown:
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o Click on the table. Go to the Layout tab.
e In the Layout tab, go to the Rows and Columns section.

o Click on Insert Right or Insert Left for inserting a column on the left and
right side of the particular column.

The screenshot of inserting a column on left or right of a selected column in
atableis as shown:
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Insert Row

¢ Click on the table. Go to the Layout tab.
e In the layout tab, go to the Rows and Columns section.

e Click on Insert Above or Insert Below button for inserting a row above
or below the row where the cursor is present.

The screenshot of inserting a row above or below a selected row in a table
1s as shown:
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Sections
Section means splitting the cells or table into different parts or sections.
1. Splitting the cells
e Go to the particular cell in the table. Then, go to the layout menut‘

o Click on Split Cells button. Split cells dialog box appears that prompts
to enter the number of rows and columns.

e Specify the rows and columns. The cell will be divided into sections.
The screenshot of Split Cells is as shown:
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2 Sp].ltt]Ilg the table Office Automation and
Fundamentals of

* Go to a particular row in the table from where you want to divide the Computers
table. Go to the Layout bar. _

¢ Click on Split Table Button. The table will be divided into sections. NOTES
The row that was selected will be the first row of the second table of the
split tables.

The screenshot of Split Table is as shown:
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Borders and Shading

With Microsoft, the user can apply border to a table. You can also provide different
shades to the table of your choice.

Applying Border to a table
e Select the table to which you want to apply the border.
e Click the Border button to select the border from different types of border.
e You can delete the border by selecting No Border option.
The screenshot of Border option is as shown:
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Computers e Select the table. Click the Border button, a list will appear. Click on border
and shade option. .
NOTES e A dialog box will appear, select border from that dialog box.

¢ Choose the border of your choice and color and apply it to the table.
The screenshot of Borders options is as shown:

Adding shades to the table
¢ Select the row or column you want to shade. Go to Border button. .

e Select Borders and Shading option from the list. A dialog box will appear.
Select Shading tab and select the color of your choice.

o Apply the shade to the row or column. The row or column will get shaded.
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Break: In word, a new page begins after the previous page is completely filled Computers
but with the help of break, the user can force the text to start from the new page.

Insert page break NOTES

¢ Open the document. Go to the location from where you want to start a new
page.

¢ Go to the Insert tab and click Page Break. New page will start from the
insertion point.
The screenshot of Insert page break is as shown:
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Page Setup: This option is present in Page Layout tab. It helps in setting the
orientation of the page in the document. It also includes options for setting margins
on a page and page break. By default, the orientation of a page is selected as
Portrait. You can also choose landscape mode. Let’s learn about margin.

The screenshot of Page Setup dialog box is as shown:
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Margin

¢ Open the document; go to Page Layout option and click on Marginstab.
Alistwill appear. Click on Custom Margin option available.

e A dialog box will appear that specify the margins you want to keep for the
document.

The screenshot of selecting the Margins option is as shown:
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Line spacing
To format line spacing, follow the steps given below.
1. Select the text in the document.

2. Click the Line and Paragraph Spacing command in the Paragraph group on
the Home tab.

3. Select the desired spacing option from the drop-down menu.

4. From the drop-down menu, you can also select Line Spacing Options to
open the Paragraph dialog box.
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Page length

You can set the page length using the size command of page setup group of page
layout menu in the ribbon interface as shown below.

t i I W= Breaks -
¥ Line Numbers

¥ Orie ze 'l Column:
e = Tl Hyphenation

Letter
21.52 em x 27.94 cm I

Tabtoid
2794 cm x 43.18 ecm |

L
21.59 cm x 35.56 cm

A3
297 em x 42 em

Aa
| 21 cmx29.7 cm

AsS

14.8 em x 21 cm

B84 (1S)
25.7 cm x 36.4 cm

as ug1s)
18.2 em x 25.7 em

tapanese Postcard |
10 cm % 14,8 cm

More Paper Sizes,.,
Header or Footer

Header and footer are the important parts of any document. They are used for
representing information about the document such as the page number, heading of
the document etc. Header is present on the top of the document and footer is
present at the bottom of the document.

Adding Header or Footer

e Click on the Insert tab. After this, click on either Header or Footer
whichever you want to apply to the document. A list appears from which
you can select the header you want to apply to the document.

» When you select the header, it will appear in the editable form in which you
can write whatever you want to add.

The screenshot of inserting the header in the document is as shown:
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Editing the Header or Footer

e Click on the Insert tab. Select header or footer whichever you want to
edit. A list will appear with the option Edit Header.

e Click the Edit Header button. The header is now availablé in editing form
so that you can edit it.

The screenshot of Edit Header is as shown:
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Alphabet
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[Type the document title]

Annual

[Type the dacument title] | [Vear]

E t Updates from Office.com..,
5 Edit Header
e "

Inserting special symbols and pictures

You can insert the symbols in a Word document using the symbol command in the
insert tab in the ribbon interface. When you click on the symbol command, it
shows the various types of symbols which can be selected as per the requirements.

You can also insert the pictures in the document form the available pictures
using the pictures command in the insert tab. Click on the Insert tab on the Ribbon
interface and select pictures. On the window that appears, go to the location
where the picture is located and click Insert.

To wrap text around an image follow the given steps.

1. Select the image. The Format tab will appear.

2. Click the Format tab.

3. Click the Wrap Text command in the Arrange group.
4

. Select the desired menu option. The text will adjust based on the option
you have selected. ...

5. Move the image around to see how the text wraps for each setting.
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Hyphenation Off Office Automation and

Fundamentals of

To turn off auto hyphenation in Word 2010, follow the steps given below Computers

1. Go to the Page Layout tab > Page Setup group.
2. Click Hyphenation. NOTES
3. Select None.

Types of justifications

There are several types of justification:

o Left-justification: All lines in the paragraph butt up against the left text
margin. No extra spaces are added to the line.

e Center-justification: All lines in a paragraph are centred between the left
and right text margins. No extra spaces are added to the line.

o Right-justification: All lines in a paragraph butt up against the right text
margin. No extra spaces are added to the line.

o Fill-justification. All lines in a paragraph are expanded so they butt up

against both the left and right text margins. Space is added, between words
and characters, as necessary to fill out the line.

Cursor movement and control

You can move the cursor to another location by moving the pointer and then
clicking, or by using the keyboard. To type anywhere else in the document, you
need to move the cursor to that place. Here are a couple of ways to do that:

¢ With your mouse, move the cursor just to the left of “During,” and then click
to insert the cursor. Then start typing.

e Press the UPARROW ( [t ] ) on your keyboard to move the cursor up one
line at a time. Then press the LEFT ARROW ( [] ) to move the cursor left,
one character at a time.

Bullets and Numbering

Bullets and numbering allow you to present information in the simple ways. With
the help of bullets and numbering, information is separated easily in the form of list.
This helps in saving the space in the document. Bullet and numbering option are
available in the paragraph group on the Home tab. Microsoft Word lets you to
create bulleted and numbered lists, to specify different lines or topics. Once you
create bulleted and numbered list, each time you press enter, same bullets are
added to your list. If you want to add another bullet, then you can choose different
bullets and numbering from the Home tab.If you hit enter twice, then you will
return to the earlier level. If you hit enter twice at the end of the list, then the list will
be terminated.

The screenshot of bullet and numbering list is as shown:
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Bulleted list
The screenshot of different types of bullets that can be used to create a bulleted
list are as shown:
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Custom bullet

You can define your own bullet using Define New Bullet option. When you click
on this option, following dialog box appears. This holds option for setting picture,
symbol and font of the bullet character. It also contains the options for alignment
and for seeing the preview of the page.

The screenshot of Define New Bullet dialog box is as shown:

Define NewBulet | CosMESN
Bullet character
[ symbol.. | [ pcwre.. | [ Eont.
AMignment:
R[4
Preview
L
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Numbered list

Numbered list dialog box contains different types of numbered lists like Recently
Used Numbered Format, Numbering Library and Document Number Formats.




The screenshot of different types of numbered list is as shown:

[EHz € A, M »
i

{ Recenily Used Number Formats

Numbering Library

ff |4, — | 1)—

J; None

il 22— | 2)————|
| fr—]>—|
| - ]

{| h=—————| | A—————| | g)—— |
|| h——| B——| | ——
i M, ———| | C.—— | | 0)-
—
[ | b | | i, e |

| € =————e | | ], ———
i

Document Number Formats

[ %=

.2_ —

| Define New Number Format..,

Custom Numbering

You can define your own numbering using Define New Number Formats option.
When you click on this option, a dialog box appears containing options for setting
number format. It also contains the options for alignment and for seeing the preview
of the page.

Font Formatting

Font formatting is used to change the appearance of words or a single character.
Itis present in the Home tab of ribbon view. You can apply the Font formatting by
highlighting the text.

Font Formatting contains the various controls for providing a quick access
to many frequently used functions.

The screenshot of Font Formatting is as shown:
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The available buttons and icons of the Font Formatting toolbar are as
follows:

o Caiibri Body) ~ Fontdropdown box of the Font Formatting helps in
changing the font of text or number when selected. You can choose any
font by clicking on the dropdown menu. The default font in Word is
Calibri (Body).

e 11 - Font Size dropdown box of the Font Formatting helps in

changing the size of the text when selected. You can choose any size by
clicking on the dropdown menu. The default font size in Word is 11.

e A" Grow Font button of the Font Formatting helps in increasing the
size of the text when selected.

e ,” Shrink Font button of the Font Formatting helps in decreasing the
size of the text when selected.

e Change Case dropdown menu of the Font Formatting helps in changing
the case of the selected text.

For example:

Suppose you have written “Hello”. You want to change the uppercase letter to
lowercase, then you can choose Change Case dropdown menu to do that.

The screenshot of Change Case is as shown:

3 || -

Aa]
‘ Sentence case,
lowercase
UPPERCASE
Capitalize Each Word

tOGGLE cASE

e | @, Clear Formatting menu of the Font formatting helps in clearing
the formatting by selecting that particular area. It is useful in situation
where you want to remove entire formatting at once.

e [m Bold button of the Font Formatting toolbar helps in making selected
text or numbers bold and in removing bold formatting when the text or
numbers are already bold.

e 7 Italics button of the Font Formatting toolbar helps in making selected
text or numbers italics and in removing italics formatting when the text or
numbers are already italics.

e p - Underline dropdown box of the Font Formatting toolbar helps in
making selected text or numbers underline and in removing underline




formatting in already underlined text or numbers. You can choose any Office Automation and
type of line from Underline dropdown menu. # ""“""’gf"fafs of
omputers
* a4 Strikethrough button draws one straight line throughout the
selected word. NOTES
For example:

Consider the following sentence “See the effect”. If you apply Strikethrough effect
by selecting the words then the same sentence will look as shown: “Seethe effeet”.

* x, Subscriptbutton helps in making selected text or character look smaller
without changing its Font size. It places them below the other characters.
For example:
Consider the following set of character “a5b.” If you apply Subscript effect by
selecting number 5, then the following set of character will look as shown: “ab.”
® x' Superscript button helps in making selected text or character look

smaller without changing its Font size. It places them above the other
characters.

For example:

Consider the following set of character “a5b.” If you apply Superscript effect by
selecting number 5, then the following set of characters will look as shown: “a’b.”

e U - Text Effects dropdown menu of the Font Formatting toolbar helps

in drawing colored line around the text. You can choose any color from
dropdown menu.

For example:

Consider the following sentence “See the effect”. If you apply Text Effect by
selecting the text then the same sentence will look as shown: “See the effect”

e 37 - Highlightbutton of the Font Formatting toolbar highlights the text or

number with the specified color. By default, “Yellow” color is selected. You
can choose any color from the drop down menu. You can add and remove
the color by clicking the specific color.

e A - Font Color button of the formatting toolbar helps in changing the
color of the text. By default, “Red” color is selected. You can choose any
color from the drop down menu.

Page Numbering

For adding Page Numbers to the Header section or Footer section simply click
on the Page Number command to select the option Top of Page or Bottom of
Page as shown below in the Illustration.
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Inserting date and time
You can insert date and time in a document by simply click on date and time
command in the insert tab. Follow the steps Insert — Date and Time. After using
this you will see date and time in the document.
Format Painter
To use the format painter, use the following steps.

1. Select the text or graphic that has the formatting that you want to copy.

2. On the Home tab, click Format Painter.

Format Painter
Home tab Bold and Underlined Text
b - (djv- o} - Documentl - MicroseftWord (=L@ e |
Ful [ How‘:t‘ ‘ Intert Plge Layout Rtfnm'us Maifings Review Wiew Add-lns _ﬁ_ 0
= Calibn {Boay) il - EeELNE R
B} v ' o
:m ¢ (8 7 (@ 1 f (-_T' W Quick Change Editing
9
F A2 A Ay {“j" Dy e Bl T shpese Soters =
cuphnm s | Font Hugupn 0 Stytas

FaRCRCE S RO SRR SN NG SO N SR A T SR TN T et STy KN R T
=T =y ¢ e ST ST = m ¥ e L e e L s

3. Use the brush to pamt over a select:lon of text or graphlcs to apply the
formatting, This only works once. To change the format of multiple selections
in your document, you must first double-click Format Painter.

4. To stop formatting, press ESC.

2.2.2 Shortcut Keys for Various Tasks

Some of'the shortcut keys for various tasks in MS Word are shown in the table

below:
Table 5.1 MS Word Shortcuts

Using Keyboard Shortcut
Action Keystrokes
Creation of new document CTRLAN
Saving a document CTIRLAS
Opening a document CTRL+O
Printing a document CTRL+P




Closing a document CTRL+W

Selecting an entire document CTRL+A
Copying a text CTRLAC
Cut specific text CTRL+X
Paste specific text CTRL+V
Undo CTRL+Z
Redo CTRL+Y
Bold CTRL+B
Italics CTRLAHI
Underline CTRL+U
Alignment of text to the left CTRLAL
Alignment of text to the right CTRL+R
Alignment of text to the justify CTRLH]
Alignment of text to the center CTRLHE
Finding the text CTRLAF
Replacing the text with particular text CTRL+H
Adding and removing 6 point of spacing before a paragraphCTRL+0
Opening font preferences windows CTRLAD
Inserting link CTRLAK
Indentation of a paragraph CTRL+M
Creating an hanging indent CTRLAT
Creating a bullet point CTRL+SHIFT+L
Changing the font CTRLASHIFT+F
Increasing selected font to 1 pointto 12 point CTRL+SHIFT-+>
Increasing selected font to 1 point CTRLAH]
Decreasing selected font to -1 to -12 point CTRLASHIFT+<
Decreasing selected font to -1 point CTRLH
Viewing or hiding non printing characters CTRLA+SHIFT+*
Moving contents to the beginning CTRLA+!
Moving contents to the end CTRLA+*
Deleting Word to the right of the cursor CTRL+Del
Deleting Word to the left of the cursor CTRL+Backspace
Moving cursor to the end CTRLAEND
Moving cursor to the beginning CTRL+HOME
Resetting default font to the highlighted text CTRL+SPACEBAR
Changing text to heading one CTRL+ALT+1
Inserting time SHIFT+ALT+T
Inserting date SHIFT+ALT+D
To Save As file F12
Spell Checker F7
Opening Help F1
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2.2.3 New Features in Word 2016/ Difference between
Word 2010 and 2016

The Tell Me box in Word, Excel and PowerPoint 2016 helps in performing
important tasks. Rather than using Help or just poking around as in 2010 version,
you can now type what you want to do in this box. Office shows you a list of
commands for completing your task. If you have selected something in your
document, you will see commands specific to that object.

!
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Insights lets you search for information from within Word, Outlook, Excel, and
PowerPoint. Right-click a word or phrase and choose Smart Lookup.

TR

Smart Lookup = ¥ %

Explore Define

~
Standard deviation s
In statistics, the standard n’
deviation (SD, also ‘,"’- =

represented by the Greek
letter sigma c ors)is a
measure that is used to

enwikipedis.org

Explore Wikipedia

If several people are working on a Word document that is stored in OneDrive
for Business, real-time co-authoring, the feature which was not available Word
2010, allows multiple users to collaborate, edit and update simultaneously. They
can see changes as they are made and even where cursors are currently placed.




Word 2016 has the new editing feature of adding and viewing threaded Office Automation and

. C : ) Fundamental
comments, which was missing in Word 2010. There are five view modes in Word undamentals of

Computers
2016 as compared to four in Word 2010. Smart Look Up feature of Word 2016
was missing in Word 2010 and 2013. You can send a link to a document saved on
OneDrive, if you are using Word 2016, which was not possible in 2010 version. NOTES

Check Your Progress

1. How can the ribbon be minimised?

2. When is the .dotx file format used?

3. When s the ignore option used in MS Word?

4. State the steps used to correct the spelling errors.
5. State the uses of header and footer.

2.3 MS EXCEL 2010

MS Excel: An Overview
Letus analyse the different features of MS Excel.
The Ribbon Interface

Ribbon interface in Microsoft Word 2010 is same as that of Microsoft Excel
2010, the only difference lying with the changes in commands. With the help of
ribbon performing various tasks with the spreadsheet becomes easy.

Screenshot for Ribbon is shown as:

(]| Baald = Mic BT Yo B
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‘j B3 BI U~ Ay EEFTE $-% [l Format as Tabje - 3% Delete ~  [GA- S’I‘j?‘ E‘ﬂ&
MY E- &-A R | Ws (85 Cell Styes » Biromat - | @} jond fnd
Cupboard 3 [™—Fomt = Algnment 2| Wamber o] S el Y Eawng ]
M e 7 _ {
s s R B T i S F G H I i K L
i |
2 Ribbon Groups Ribbon tabs
If you click on any tab or groups, each button and dropdown menu will
perform different actions
Customizing the Ribbon

Follow these steps to customize the ribbon:

1. Right click on any tab or group and click on the Customize the Ribbon
option. Excel Options dialog box will appear.
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Screenshot dlsplaymg Excel Options is as shown:
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2. Choose the command which you want to add. Here, Copy command has
been selected. Next, click on New Group button (in order to add commands
the user needs to create a custom group first). Click on Add button in order
to add selected commands to the New Group.

3. Click on OK button. Copy command will be added to New Group which
is seen under Home Tab after the Editing option.

Screenshot displaying New Group is as shown:
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Excel 2010 Backstage View

Backstage view has been previously introduced in MS Word 2010. Most of the
features of backstage view remain the same. Some modifications are discussed as
follows:

Protect Workbook under Permission tab of Info option includes two more
choices. They are:

e Protect Current Sheet: This option protects current sheet from
unauthorized access. Here you set a password for protecting current
worksheet. You can also specify which type of changes people can make
in this worksheet by checking them on allow all users of this workbook
to list.




Snapshot of Protect Worksheet is as shown: Office Automation and
Fundamentals of

Pratect Warkshest o Computers
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¢ Protect Workbook Structure: By using this option you can protect
entire workbook to be changed by unauthorized users. It provides two
levels of protection. These are as follows:

1. Protect Workbook for Structure: It protects the structure of the
worksheet from unwanted modifications. For example unauthorized
users can not add new worksheet or delete an old and cannot change
the order of the sheets.

2. Protect Workbook for Windows: It is not checked by default. If
you check Windows then the book is protected also from resizing any
windows you have inserted in your workbook like charts, pictures,
shapes etc.

Screenshot of Protect Structure and Windows is as shown:
Prodest werkbook for
Vi Structune
! iiones
Basgorord {optionall:
EE 253

— .

As shown, in both the above cases Password is optional.

In order to unprotect, click on Unprotect Worksheet or Unprotect
Workbook. You are asked for password, if set.

Creating, Opening and Working with Excel Documents

Microsoft Excel is used for storing the data in the form of table. It is used by
several organizations to perform complex calculations, statistical analysis and
tracking income and expenses. It uses pie charts, slicers, sparklines to easily analyze
the data. Excel 2010 provides very interactive features which help in analyzing
and visualizing the data in productive and innovative ways. In this chapter, you will
learn about the essential features of MS Excel, various ways of building Worksheets,
methods of formatting and filtering data, management of Excel worksheets and
various shortcut commands to perform the task easily.
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File Management

File management is the task of maintaining the newly created folders or the existing
folders in the computer. It involves various tasks such as saving the folder,
maintaining the data and many more.

Saving a document

In Microsoft Excel 2010, files are saved in .xIsx format. There are different ways
of saving the files in the computer depending upon the requirements. When the
files are saved in .xlsx format, you can use new features provided by Excel such as
Sparkline and Slicers which are not supported by other file formats.

Steps to save the documents in Excel are as follows:
1. Go to the File tab which is present on the left hand side of the ribbon.
2. Go to the Save As options on the left most side of the screen.
The screenshot of Save As option is as shown:
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3. Choose the drive and folder where you want to save the file.
The screenshot displaying specific Drive and Folder is as shown:
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4. Goto the File name téxtbox to write the namé of the file.

5. Choose the format in which you want to save the File. By default, the
file format is .xlsx.

6. Click the Save button to save the file.




Saving a Document as PDF Office Automation and
Fundamentals of

Excel 2010 provides enables the user to store documents as PDF files, while Computers
sharing them with others. PDF stands for Portable Document Format.
To save an Excel file in PDF format follow these steps: NOTES

e First click on the File tab present on the top left corner of MS Excel or
press Alt+F as a shortcut to File tab.

o After this click on Save As option.

* Now, enter the filename. When you are asked to select the type of file,
choose PDF. You can select Standard for high quality printing or select
Minimum size if you desire a file of small size.

Screenshot displaying the Save as type option is as follows:
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¢ Finally, click on Save button to save file in PDF format.
Opening a document
Steps to open the document are as below:

1. Go to the File tab which is present on the left hand side of the ribbon.
2. Go to the Open option on the left most side of the screen.
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The screenshot showing Save As option is as shown:

3. Choose the appropriate drive and folder from where you want to open the
file.

4. Choose the file which you want to open.
5. Go to the Open option to open the file.

You can save the important files in the Libraries so that you can access the
specific folder and files easily. The Libraries option appears on the left hand side
of'the screen.

Deleting a spreadsheet
Follow the steps given below to delete a spreadsheet.
1. Open the Excel workbook containing the sheet that you want to delete.

2. Click the tab at the bottom of the window for the worksheet that you want
to delete.
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3. Click the Home tab at the top of the window.
4. Click the arrow under the Delete button in the Cells section of the ribbon
at the top of the window, then click the Delete Sheet button.
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5. Click the Delete button to confirm that you want to delete the sheet.

Reordering spreadsheets

You can change the order of sheets as per your need in a file by simply click, hold
and drag on the sheet tab at the bottom of the window.

Renaming a spreadsheet
You can follow the steps given below to rename a spreadsheet:
¢ Double-click on one of the existing worksheet names.

¢ Right-click on an existing worksheet name, then choose Rename from the
resulting Context menu.

e Select the worksheet you want to rename (click on the worksheet tab) and
then select the Sheet option from the Format menu. This displays a submenu
from which you should select the Rename option.

Duplicating/Copying sheets in a workbook

Using Move or Copy command, you can make one copy of a worksheet, multiple
specific worksheet or all worksheets into active workbook or another workbook.

1. Select the workbook you need to copy.

2. Right click on sheet tab and select Move or Copy option. An illustration is
shown below.
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3. Inthe Move or Copy dialog box, specify the following settings.
e From To book, you can specify the workbook where the worksheets
will be copied into.
o Specify the position of the copied sheets, you can choose it after all of
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e Check Create a copy option, if you don’t check this option, the selected
worksheets will be moved into another workbook.
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4. And then click OK, it will copy the selected worksheets one time into the
specified workbook. The screenshot is given below.
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2.3.1 Working with Cells

Excel file is a workbook that contains one or more worksheets. Formatting Excel
sheet improves the presentation of the worksheet and makes it easy to use. By
default, each Excel file has three worksheets.

Entering data and Text formatting &

To insert data in the spreadsheet, you can select the row or column where you
want to insert the data or insert new rows and column in between.

Formatting Cells

Microsoft Excel has 16,384 columns and 1,048,576 rows. Cell is intersection of
rows and columns where you can enter data in the cell. There are many options to
format cell and text. We are going to learn how to change colour, style of cell,
alignment of text, etc. There are four ribbon groups such as Font, Alignment,
Number and Styles. Font command is used to change font, font size, and style
of text such as Bold, Italic and Underline, change border, change the cell color
and text color. Alignment command is used to set alignment of text and merging
the cells. Number command is used to select cells and set number format such as
percentage, date, etc. Cell styles option in Styles group is used to set specific
color to cell.

Steps to change the Font are as follows:

1. Selecta cell in which you want to set a specific font.

2. Click on Font option from the Font on Home tab.

3. Select the desired font from drop down list to apply the font.

i e 4 el i




The screenshot of selecting the Font is as shown:
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To change a font size

Steps to change a font size are as follows:

1. Select a cell in which you want to set specific font size.

2. Click on Font Size from the Font on Home tab. There are two options for
increasing and decreasing fonts.

3. Select font size from drop down list. Otherwise, click on increasing font or
decreasing font.

If you click on increasing font option, text size increases according to the
selection. If you click on decreasing font option, text size decreases according to
the selection.

The screenshot of selecting the Font Size is as shown:
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Computers Steps to set Bold, Italic and Underline are as follows:
1. Select a cell in which you want to set style such as- Bold, Italic and
NOTES Underline.

2. Click on Style option in Font group on Home tab. There are three options
such as Bold, Italic and Underline.

An example of Bold, Italic and Underline is as shown:

Bold B Welcome
Italic I Welcome
Underline U | Welcome

3. Text appears according to selection.
The screenshot of selecting the font style is as shown:
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To change text alignment
Steps to change text alignment are as follows:
1. Select the cell.
2. Click on the Home tab.
3. Click on vertical Alignment and horizontal Alignment commands in
Alignment group.
In vertical Alignment, there are three options:
1. Top Align: Text set to the top of the cell.
2. Middle Align: Text set to the middle of the cell.
3. Bottom Align: Text set to the bottom of the cell.
In horizontal Alignment, there are three options:
o Align Text Left: Text set to the left of the cell.
o Center: Text set to the center of the cell.
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* Align Text Right: Text set to the right of the cell.
Text aligns according to the selection.

The screenshot of selecting the Alignments is as shown:
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The given screenshot shows vertically Middle Align and horizontally Cen
alignment.
Applying cell styles

Cell styles contain the formatting of font and cell. You can directlyuse cell styles to
set the range of cells. Excel 2010 has in-built cell styles that you canuse. You can
also create your own cell style.

Steps to apply cell style are as follows:
1. Select the cell.
2. Click on cell styles in Styles group on Home tab.

3. Select cell style that you want to apply on the cell. Cell is now displayed
according to the style selected.

The screenshot of the cell style is as shown:
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Selecting Cells or Range

When you edit sheets in MS Excel 2010, you often need to select cells, copy
cells, set a range for deleting cells, and also search for data within the cells of a
worksheet. To select a particular cell, select that cell or use arrow keys to reach
that cell.

For the selection of range, click on first cell and then drag to the last cell or
instead of dragging, just hold SHIFT key and use arrow keys to reach the last cell.
For selecting all cells in worksheet, press CTRL+A.

Inserting and Deleting Rows and Columns
To insert rows and column in a worksheet, follow the steps given below.
1. Select the cell or row or column where you want to insert row/column.

2. Click the drop-down arrow attached to the Insert button in the Cells group
of the Home tab. The screenshot is given below.

- —3
T 7 n n:x —— AutoSum -
0y B | E‘%:' = 2
s & B EC B gy,
Formatas Cell | |Insest Delete Format
Table= Styles~ isdl -~ v & Clear~
tyles E‘“ Insert Cells... ‘ Ed

€= Insert Sheet Rows %

U™ Insert Sheet Columns

] Insert Sheet

L

3. Select the one of the option in the drop down menu as per requirement.

Sorting and Filtering Information

In MS Excel, you can store enormous data. If you want to arrange the data, you
can use Sort command. Filter command is used to find any specific information
from specific column. In Excel 2010, Sort and filter command are available
together in Editing group on Home tab. Both the commands are described in
further subsections.

Sort: Sort is most commonly used command to arrange the list of data in
alphabetical order. In Excel, there are two basic sorting methods suchas Ato Z
and Z to A. For example, if you want to arrange employee name in ascending
order, click on A to Z in Sort & Filter option. Sort command is used to visualize
the data such that it increases understanding and makes data easily searchable.

Sort Data in single column
Steps to Sort Data in single column are as follows:
1. Select a column in which data needs to be sorted.

2. Click on Sort & Filter option in Editing group on Home tab. It displays
drop down list.
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The screenshot of selecting Sort & filter is as shown:
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3. Click on Sort Largest to Smallest option. It displays Sort Warning dialog
box.

The screenshot of Sort Warning dialog box is as shown:
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Microsoft Excel found data next to your selection, Since you have not
selected this data, it will not be sorted,

What do you want to do?

There are two options which are as follows:
* Expand the selection: Sort selected column with other columns data.
* Continue with the current selection: Sort only selected single column.
4. Click on Expand the selection.
5. Click on Sort button.
The screenshot of selecting Sort button is as shown:

IE FEECE T - @R Bookd ' MicrosoftEcel | 1 )
Home insen Page Layout Formulas Data Review View Developer a@ao@n
% & cumd BETR - ,;\ &  cenest - [Blcondionsi Formatting = Seincen - E - ér lﬂ
- EEHE 5% v 5 romatesTable - 4% Delete + .

Peate 7 Bru- @3- &-A EiE 9 T8 % U} Coli Styles - Birormat - 2 :,?{:,‘: ::r[':n&.

Clipboard i | Font - »ltwnmmt a | MNumber 5 Styles Ceills Editing
&7 - A 104 v

T T i il i R G H 1 S e T TR T
I 55 i
24 |
ﬁ} | ‘
&

i | &l
6 Sr. No. E
[he i 4|
=4 3 Chennai ‘
N 2 Mumbai
o ] i

|

12
13
14
15 : 2 B - . b |
Both M| Sheet1  Sheetd ~“Sheetd T = T ool Al L =¥}

l L e ; L Awesge 1925 Countid_Sum 410 “Eum 200% (=) o Self - Learning

Material 123




Office Automation and
Fundamentals of
Computers

NOTES

Self - Learning
124  Material

To Sort multiple data
Steps to Sort multiple data are as follows:
1. Select whole table in Excel sheet.

2. Click on Sort & Filter option in Editing group on Home tab. It displays
drop down list.

The screenshot of selecting Sort & Filter is as shown:
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3. Click on Custom Sort. It shows Sort dialog box as shown in the screenshot:
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4. Select the column that you want to sort in Sert by drop-down box.
5. Select type of sort in Sort On list.
6. Select Values option if you want to sort text, number or date and time.
7. Select Cell color, Font color, Cell icon option if you want to sort data by

format.
8. Select order in Order list.

9. Add Level is used to add another column to sort by. Copy Level is used
to copy a column to sort by. Delete Level is used to delete selected entry.
Up or down arrows are used to change the order of the Column.




The screenshot displaying the options in Sort dialog box is as shown:
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Filter

You can find any value, information quickly in worksheet using Filter command.
You can filter more than one column of data. Filter command creates a list of
data. Therefore, you can see any information from a list. Let’s learn how to use
filter command.
To filter data
Steps to filter data are as follows:

1. Selecta table.

2. Click on Sort & Filter option in Editing group on Home tab. It displays
the drop-down list.
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The screenshot of selecting Sort & Filter is as shown:
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3. Select Filter option. It dlsp]ays atable with drop-down arrows in the header

of'each column.

The screenshot of table after applying filter option is as shown:
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4. Ifyou click on drop-down arrows, it displays the list of data with gheck

box.

The screenshot of table displaying drop-down arrows is as shown:
3
‘._.. e |Sr. No.| ~ [Name | = |Paymel =
18] Sort Smailest to Largest Shalini 10,000
‘ %1 sort Largest to Smallest Abhinav 15,000
: Sorf by Color » |Sidhu 25,000
!' & tear Filter Fy MV 40,000
!1 Fitter by
i MNumber Fiiters ’
] [ 5|
: ] (select AR) L
# ¥ 102
{ 103
1 B 135
i ¥ 201
1
1
2
2
ﬁ (o) Camn ]|

When you uncheck any check box of data, that data will not be displayed in

the table.




AutoSum in spreadsheet Office Automation and
Fundamentals of

Follow the given steps to apply AutoSum Computers
1. Click the cell where you want to display the calculation.
* To sum with a range of numbers, select the range of cells you want. NOTES

¢ To sum with only some of the numbers in a range, select the cells or
range you want using the Ctrl key. Excel inserts the sum in the first
empty cell below the selected range.

* To sum both across and down a table of number, select the range of
cells with an additional column to the right and a row at the bottom.

2. Click the Formulas tab.
3. Click the AutoSum button.

2.3.2 Working with Basic Formulae and Charts

There are various formulas and functions available in Microsoft Excel 2010, which
make Excel simpler and easier to use. Let us explore these functions in the next
sections.

Working with Arithmetic Operators and Text Functions

Arithmetic Operators involve four major operations. These are: addition,
subtraction, division and multiplication. These are known as the basic operators.
These basic operators can be combined so as to perform more complex
mathematical operations.

For example, if it is required to add cells A1 and A2 and then multiply their
sum by a third cell (A3), then in Excel, this operation can be performed using the

formula: = (Al +A2 )x A3

Similarly, if you want to add cells from A1 to A5 and then multiply their sum
by a third cell (A6), then, write the formula as: =SUM (A1:A5) x A6

This formula adds numbers in the cell from A1 to A5 and the answer obtained
is multiplied by number in cell A6. The answer is displayed in the cell where formula
is written. While performing more complex operations on an arithmetic operator,
operator precedence plays a very important role. Excel follows the BODMAS
(Bracket Order Division Multiplication Addition Subtraction) rule of order of
execution in arithmetic operations. The order precedence will be clear with the
help of following example:

1. Open anew Excel sheet. In cell A1, enter 25. In cell A2, enter 50 and
in cell A3, enter 2.

2. Click in cell A5 and enter the formula= (A1 + A2) x A3 and hit enter.
The answer displayed in A5 is 150.

3. Now, enter the formula= A1 + A2 x A3 and hit enter. The answer
displayed in A5 is 125. Clicking on cell means that the result will be
shown in this cell.
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gﬁ&‘c; Aut(;n;:ti;n and In this example, the bracket is solved first where addition takes place.
. Thereafter, the result is multiplied by third number outside bracket.

Computers
The screenshot representing the discussed example is as shown:
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Text Functions 3

Text functions, which are the part of Function Library group, are available at
the Formulas tab. Some of the functions available under Text functions are CHAR,
CONCATENATE, REPLACE, LOWER, UPPER, DOLLAR, TEXT, etc.

The screenshot of Text functions is as shown:
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Some of the commonly used text functions are explained as follows:

¢ CONCATENATE Function

This function is used to combine or merge two values. Suppose, you have two
columns and you want to combine both of them, then this function is used.

The syntax of CONCATENATE function is— CONCATENATE (Textl,
Text2, ...)

Where, Text1 represents first text string and Text2 represents text string
for concatenation with the previous text string. The text strings mustbe separated
by commas.

For example, if the excel has “first name” of a person in it as the first column
and the other column contains the “last name” then, to combine both the firstand
last name in a single column, CONCATENATE function can be used.

Use the CONCATENATE function as—CONCATENATE (“John”,

« Smith”). Thus, on applying this function the output will be the full name of the

Self - Learning person like—John Smith
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REPLACE function is used to remove the sequence of unwanted characters from

the Excel sheet with another set of characters. These unwanted characters appear -

in the cell whenever the data is copied from one Excel sheet to another.

The syntax of REPLACE function is: REPLACE (Old_text, Start_num,
Num_chars, New_text).

Old_text represents the original string of characters required to be replaced.

Start_num identifies the position from where the substitution of the
characters starts. Num_chars denotes the number of characters to be replaced
intheold text.

New_text is the set of characters that will be used for replacement.

To access the REPLACE Function, go to the Text function drop-down
menu, navigate to the REPLACE function and click on it. Also, enter the data in
therespective fields of Function Arguments dialog box of the REPLACE function.

For example: Enter the original string as “ab123”(as string must always
be enclosed in double inverted commas) in the Old_text and enter numeric value
2 inthe Start_num field. In N um_chars field, enter the value as 4 . At last, in the
New_text field, enter cde as the the string which will be used for substitution.

After filling the data, when you click on the OK button, the final result or
output of the REPLACE function will be obtained as:

acde

e UPPER, PROPER and LOWER Function

In Microsoft Excel, some functions are available for converting the entered data
into uppercase, proper case and lowercase, If you want to make all the characters
of a string uppercase, then enter the command = UPPER (Place of string). In
the similar way, the functions LOWER and PROPER are used.

Thus, if you enter the name as William and apply Upper function on it as—
UPPER (William), then the result obtained or displayed will be WILLIAM.

Similarly, if the name entered in the Excel sheet column is RICKY
PONTING and LOWER function is applied on it as— LOWER (RICKY
PONTING), then the result obtained or displayed is ricky ponting.

And, in case you apply PROPER function with syntax as— PROPER
(RIcKy PoNting), then you will get the output — Ricky Ponting.
* TEXT Function

The TEXT function helps in converting a numeral value or number to text in a
required number format. This finction is helpful when you want to display numbers
in a more readable format. It also helps in combining numbers with text or symbol
and in displaying the number as a text containing several places of decimal digits.

The syntax of TEXT function is

—TEXT (Value, Format_ text) where, Value represents a numeric value
or is a reference to a cell containin g anumeral or numeric value. Format _text

e, ¢ REPLACE Function Office Automation and
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represents a field for entering the text string to be converted into a numeric value.

To access the TEXT Function, go to the Text function drop-down menu,
navigate to the TEXT function and click on it. Now, enter the data in the two
fields under the Function Arguments dialog box of the specific function.

For example, enter the number 143 as the Value and * 0.0000” as the
Format_text field to convert the number in the decimal format. After filling the
data apply the Text function as— TEXT (143, “0.0000”0). When you click on
OK, then the final result of the TEXT function i.e. after converting a numeric value
to a text containing 4 decimal digits, will be displayed in the Excel sheet as:

143.0000

e Summing up Text Functions:

Function

Description

BAHTTEXT

CHAR

CLEAN

CODE

DOLLAR

EXACT
FIND

FIXED

LEN
MID

RIGHT

It is used for transforming or converting a number to a text
using the currency format BAHT.

It is used for providing the character of the specified code
number or value.

Itis used for clearing out all those characters from the text
that are non-pritable and will not be printed with the
operating system.

Itis used for extracting the first character from the text string
and returning the numeric code for that. .

It is used for converting a numeric value to text using the $
currency format.

It is used for finding or comparing two text values.

It is used for locating the position of one text or substring
within another text or string.

It is used for rounding off the number and fixing the number
of decimal places.

It is applied to the text value for returning the leftmost
characters from it.

It is used for calculating the value of the length of the string.

It is used for returning the number of required characters
using the provided position, from the text string.

It is used for repeating the text as per the number of times
mentioned or given

It is applied on a text value for returning the rightmost
characters from it.




SEARCH It is used for searching or locating the required value or text Office Automation and
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within another value or text Congiters
SUBSTITUTE It is used for replacing the old text with new or current text.
T It is used for checking whether the passed value is text or NOTES

not. Ifthe value is text then it returns that and ifit is not then

double quotes are returned.
TRIM It is used for replacing and trimming out the extra spaces

present in the text, leaving behind only single spaces

between words
VALUE It is used for converting the argument or value passed as

number to text.
Date and Time Functions
Date & Time functions are used for making the modifications in date and time
and also, to know the current date and time. There are various Date & Time
functions which are collectively present or available in the MS Excel under Date
& Time icon of the Formula tab.

The screenshot of Date & Time functions is as shown:
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The Date & Time functions are explained as follows:

¢ DATE Function

The DATE function is used to represent the spec1ﬁc date. The syntax of DATE
functionis

“=DATE (Year, Month, Day)”. This function can be accessed from the
Date & Time drop-down menu of Function Library group under Formulas
tab.

Self - Learning
Material 131




Office Automation and
Fundamentals of

Computers
NOTES
Self - Learning
132 Material

For Example: In the Function Arguments dialog box of DATE function
if you enter valid entries for Year, Month and Day for the respective fields, then
the DATE function will be applied as: =DATE(2013,10,2) and you will get the
output as 10/2/2013. )

e TIME Function

The TIME function returns the time in TIME format (Hour, Minute and Second).
The syntax of TIME function is TIME (Hour, Minute, Second).

This function is also accessed from the Date & Time drop-down menu of
Function Library group of Formulas tab.

For Example: In the Function Arguments dialog box of the TIME
function, if you fill the valid entries of Hour, Minute and Second in the
corresponding fields and use the TIME function on the entered data as— TIME
(12,34,78), then the output in the cell will be shown as 12:35PM.

e Summing up Date & Time Functions

Function Description

DATEVALUE It is used for representing the data in the Excel
date-time format, by converting the text to numeric
value or numbers

DAY It is used for returning or calculating the day of
the month by converting the provided date or serial
number N

DAYS360 It is used for finding or returning the days present

between two provided dates. It calculates the
number of days on the basis of either a year of
360 days or twelve-30 days-months.

EDATE It is used for returning the same date in the serial
format, by using the supplied start date. The
specified months are added or subtracted from
the start date to calculate the past or future dates.

EOMONTH It is used for calculating or finding out the last day
of the month using the given start date and
specified month before or after the start date.

MONTH It is used for extracting or returning the particular
month from the supplied or provided date.
NETWORKDAYS It is used for finding or returning the total number

of working or business days present between two
dates. Weekends and holidays are excluded while
calculating the number.




NOW

TIME

TIMEVALUE

TODAY

WEEKDAY

WEEKNUM

WORKDAY

WORKDAY.INTL

YEAR

YEARFRAC

NETWORKDAYS.INTL

This is a New Function in Excel 2010. It is
used for calculating the total number of working
or business days that are present between the two
dates. It also gives out the number of weekends
and holidays separately while calculating the
number of workdays.

It is used for calculating or returning the present
date and time

It is used for returning the time in the time zone
format by using the supplied values of Hour,
Minute and Second.

It is used for returning the current date in a
predefined format without taking any arguments
or values.

It is used for returning the current date in the
predefined format without taking any arguments
or values.

It is used for representing or finding the day of
the week by using the supplied date value.

It calculates or finds out the week number from
the given date.

It is used for calculating or knowing the date
before or after given number of working days and
using a specific date as start date.

This is a New Function which has been added
to Microsoft Excel 2010. It is used for
providing the valid date before or after the supplied
date, by calculating the given number of workdays
on the basis of weekends.

It is used for representing or extracting the year
from a given date.

It is used for calculating the year in fractional form,
on the basis of two supplied dates.

Math Functions

Math functions are those functions that are used to perform mathematical operations
in Microsoft Excel. In Microsoft Excel 2010, you can access the math functions
from the Math & Trig drop-down menu of the Function Library group.
PRODUCT, QUOTIENT, POWER, AGGREGATE, MOD, SUM, FACT, EXP,
SIN, COS etc. are some of the useful functions available in the Math & Trig

functions.
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The four basic math operations are PRODUCT, MOD, QUOTIENT and
SUM are discussed as follows:

e Product: This function calculates the product or multiplication of the
numbers in the given cells. For example: The resultant product, of two
numbers 10 and 20, using the PRODUCT function — PRODUCT
(10,20) will be 200.

* Quotient: This function calculates the quotient when one number is
divided by another in the specified cells. For example: The Quotient
obtained by dividing the number 34 by the numeric value 2 using the
QUOTIENT function— QUOTIENT (34, 2) will be 2.

e Mod: This function calculates the remainder when one number is divided
by another in the given cells. For example: The value of the remainder
or Mod obtained by dividing the number 56 by the numeric value 23
using the MOD function — MOD (56, 23) will be 10.

° Summing up Math and Trig Functions:

Function Description

ABS It is used for converting the given or supplied number into
its absolute value.

ACOS It is used for providing the value of a number in arccosine.

ACOSH Itis used for representing the inverse hyperbolic cosine of
anumber.

AGGREGATE New function that has been added to Microsoft Excel
2010.1t is used for calculating the aggregate value of a list
of numbers or multiple arguments.
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ASIN It is used for providing the value of a number in arcsine. Office I;‘”Z’maﬁt;"lﬂm}
undamentais o
ASINH It is used for or representing the inverse hyperbolic sine of Computers
anumber. :
ATAN It is used for providing the value of a number in arctangent. NOTES
ATAN2 It is used for representing the arctangent of the supplied x
coordinate and y-coordinate.
CEILING It is used for returning the number after rounding it up to

the nearest possible integer number or value. The number

is rounded up or down on the basis of the sign the number
has.

CEILING PRECISE 1t is used for returning the number by rounding it up to the
nearest possible integer number or value. The number is
always rounded up irrespective of the number’s sign.

COMBIN It is used for providing all the possible combinations of
objects or group of objects for the specified or given
number of values or items.

EVEN It is used for returning the positive or negative number by
rounding it up or down to the even number that is nearest
to the supplied number.

EXP Itis used for returning the number in exponential form by
raising the power to the number supplied within the
function. “

FACT It is used for calculating or finding out the factorial of a
number.

FLOOR It is used for returning the number by rounding it down to
the nearest possible integer number or value. The number
is rounded up or down on the basis of sign of the number.

FLOORPRECISE Itis used for returning the number by rounding it down to
the nearest possible integer number or value. The number
is always rounded up irrespective of the number’s sign.

GCD It is used for calculating or providing the greatest common
divisor of a given or supplied number.

INT It is applied or used on a real or fractional number to
convert it into the nearest possible integer.

LCM It is used for calculating the least common multiple or
smallest common factor of a given or supplied number.

MMULT It is used for returning the product of two arrays as a matrix
product. '

MINVERSE Itis applied on a supplied array matrix to calculate or find
out the inverse matrix.
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ODD It is used for returning the positive or negative number by
rounding it up or down to the odd number that is nearest
to the supplied number.

RAND It is used for returning a number ranging between O to 1,
randomly.

SQRT It is applied to a given number to calculate or return the
positive square root of that number.

SUMSQ Itis applied on the list of numbers to return to determine
the sum of the squares of the numbers passed or referred.

TRUNC It is used for truncating or trimming the number by removing

or extracting the decimal points or fractional part from the
number. Thus, it converts the given number to an integer
number or value.

Statistical Functions

Statistical Function is present inside More Functions dropdown box. The user
needs to browse More Functions in order to access Statistical Function.
Statistical function plays an important role in Microsoft Excel. There are various
functions available in Statistical function like AVERAGE, MAX, MIN, COUNT,
MEDIAN, SLOPE, SKEW, FREQUENCY, etc.

The basic statistical functions are described as follows:

e AVERAGE: It gives the average of the given numbers. .
The screenshot representing AVERAGE function is as shown:

Al - f | =AVERAGE(34,55)
(o e S A e b
1 2451

e MAX: Itisa function used to return the maximum value from the values
passed in arguments. The screenshot representing MAX function is as shown:

Al v @ f+ | =MAX(10,16,24,20,7)
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x: 24

e MIN: It is a function used to return the minimum value from the values
passed in arguments. The screenshot representing MIN function is as shown:

Al v (= £ | =MIN(10,16,24,20,7)
A B b e i e e e e




e COUNT: It returns the count of the number of arguments. Office Automation and
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The screenshot representing COUNT function is as shown: Computers
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° MEDMN: This function returns the middle number of the set of numbers.

Syntax of MEDIAN function is—MEDIAN (numberl, number2, ...),
where, number 1 represents the first number and number 2 represents the
second number. Each number is separated from the other with the help of a
comma operator.

The middle number can be easily found in case of odd numbers but when
the number is even, it is found by calculating the average of the middle two
numbers.

e AVEDEYV: This function calculates the average deviation of the given set
from mean. Syntax of AVEDEYV function is—AVEDEV (numberl,
number2, ...)

The equation for the average deviation is as:

1 _
~2 [x-%|
n
Where,
n is the total number of values,
x takes each and every value which is present in the set,

¥ bar is the average of groups of values.

Suppose, you have 5 numbers which are 1, 2, 3,4 and 5. First the mean of
five numbers is calculated, which is 3. Then the average deviation is calculated
using above formula.

S - fls-2-3)efo-41+45-)
:é(2+1+0+1+2)

=1.2

e CORREL: It calculates the Pearson Product- Moment Correlation
Coefficient for the two sets of given values. Syntax of CORREL function
is—CORREL(arrayl,array2,...), where, array1 is cell range of the first
cell and array2 is cell range of the second cell.

The equation is as follows:
o 2.-¥)(-7)
V(% X (r-5)
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Where,
¥ and ¥ bar are mean of the group of values.

e RANK: This function gives statistical rank of the given value. In case there
are duplicate values, it gives the same rank. The syntax for the calculation
of RANK of'the number is as:

RANK (number, ref, [order])

e STDEV: This is the function which calculates the standard deviation for a
given set of values.

The equation is like:

Sample S tan dard Deviation = | (x-7)

Where,

2
X

(n=1)

x is the group of values and » is the total number of values.

e Summing up Statistical Functions:

Functions Description

AVERAGEIF It is used to calculate the average according to certain
criteria.

AVERAGEIFS It is used to calculate the average according to a set of
criteria. .

BETA:DIST Itis used for returning beta cumulative distribution function.

BETA:INV It is used for returning the inverse of the beta cumulative
distribution function.

BINOM:DIST It is used for returning binomial distribution probability.

BINOM:INV Itis used for returning the inverse of the binomial distribution
probability.

CHISQ:DIST It is used for returning chi-squared distribution.

CHISQ:DIST.RT  Itisused for returning chi-squared distribution of right tailed
probability.

CHISQ.INV It is used for returning the inverse of chi-squared
distribution.

CHISQ.INV.RT It is used for returning the inverse chi-squared distribution
of right tailed probability.

CHISQ.TEST It is used for returning the values of chi-squared distribution.

COUNTA It is used for returning total number of non-blanks in the
cells.

COUNTBLANK  Itisused for returning total number of blanks in the cells.

COUNTIF It is used for returning the total number of cells on the

basis of certain criteria.
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s

COUNTIFS

COVARIANCE.P

DEVSQ

EXPON.DIST
FINV

EDIST.RT
FORECAST
FREQUENCY
GEOMEAN
HARMEAN
KURT
LARGE

LINEST

LOGEST

LOGNORM.DIST

MAXA

MINA

MODE.MULT
NORM.DIST

NORM.INV

PERCENTRANK

PERCENTILE

POISSON.DIST

QUARTILE
STDEV.P
STDEV.S

Itis used for returning total number of cells on the basis of
set of criteria.

It is used for returning population covariance.

It is used to perform the summation of the square of the
deviations.

Itis used for returning exponential distribution.

It is used for returning the inverse of F probability
distribution.

Itis used for returning the right tail F probability distribution.
Itis used for predicting future values from a given value.
It isused for finding the repetition of values within a range.
Itis used to perform the geometric mean.

It is used to perform the harmonic mean.

Itis used to perform kurtosis of the given data set.

Itis used for finding the largest element present in the data
set.

It is used for returning statistical information determining
the graph line on the basis of values of x and y coordinates.

Itis used for returning the exponential trend parameter.
It is used for returning log normal distribution.

It is used for returning greatest value from the argument
list.

It is used for returning smallest value from the argument
list.

It is used for returning frequently used values.

It is used for returning normal cumulative distribution of
mean and deviation.

It is used for returning inverse of the normal cumulative
distribution.

Itis used to find the percentage rank of any element, present
in the data set.

It is used to find data set percentile.

It is used for returning position distribution.

Itis used to find data set quartile.

It is used to find data set population standard deviation.

Itis used for computing standard deviation on the basis of
population sample
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The screenshot displaying the Change Chart Type option is as shown:
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2. A Change Chart Type dialog box gets displayed on the screen.
3. Choose any chart from the list of chart type, and then press OK.

The screenshot to choose a chart from the Change Chart Type dialog
box is as shown:
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Steps to move chart to different worksheets are as follows:
1. Go to Design tab, select Move Chart command. A dialog box appears.
The screenshot to display Move Chart option is as shown:

: h

| Lnnﬂonl

b Move this chart to another sheet or
tab in the workboak.

2. Select the location where you want to move the chart by filling in the text
box Object in.

The screenshot to place the chart to the location as per the user choice is as
shown:
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Legend refers to information about the elements of chart. Legends enable us to Computers
understand what information is given by different colors and trend lines.

For example: If a record set has three fields, then each field in chart is NOTES
represented by a different color.

Snapshot of a chart which has a legend is as shown:
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There are three fields shown in this chart: Income, Expense and Profit.
Each is represented by a different color.

Legend Options
Steps for formatting or setting legend as per requirement, are as follows:
1. Selectchart.
2. Click on Layout to switch on Layout tab.
3. Inthis tab, you will find Legend option under Labels group.
Snapshot of Legend in Labels group is as shown:
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In this option, you will find various choices to set the legend at the left, right,
top and bottom of the chart or as Overlay Legend. You can change the style as
well, by clicking on More Legend Options under the same popup menu.

You find the Format Legend window also on the right click popup menu
of Legend.
Formatting Axes and Gridlines Within Charts And Graphs

A chart s a pictorial view of the numeric data contained by a sheet. In Excel 2010,
you will find various types of charts in the Charts group of Insert tab. These can
be easily inserted in the worksheet.

Excel provides 2D charts as well as 3D charts. You can insert them according
to your need.

Snapshot of a Column type 3D chart is as shown:
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Formatting Axes
Steps needed to format the axes of the chart are as follows:
1. First select the chart by clicking on it.
2. Click on Layout under the menu bar in order to show the Layout tab.
Screenshot of Layout tab is as shown:
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3 Chck on Axes option under Axes group

Screenshot of sub-options included under Axes option are as shown:
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d i ' E| Do nat display Axis ‘ )
| i8] primary Vertical Axis ¢ | L L
oS Rl e, R i | | Show Left to Right Axis
Display Axis Left to Right with Labels
Show Axis without labeling
Display Axis without labels or tick
marks
Show Right to Left Axis |
Display Axis Right to Left with Labels |
More Primary Horizontal Axis Options..,
- L - - — =




4. Within Axes option, you will find various choices under both Primary Office Automation and
Fundamentals of

Horizontal Axes and Primary Vertical Axes. Computers
Primary Horizontal Axes :
Within this head, you will find the following options: NOTES

1. None: It is used when there is no need for the axes to be displayed. If you
click on this option, the horizontal axes will be removed.

2. Show Left to Right Axes: The chart presented above shows this option,
as the Vertical Axes is on the left moving to the right side.

3. Show Axes without Labeling: By applying this option, you can remove
only the labels of the axes. It has almost the same effect as the None option.

4. Show Right to Left Axes: Vertical axis is moved to the right of the chart
and the labeling of horizontal axes starts from right, moving to left.

5. More Horizontal Axes Options: By clicking on this you will find a Format
Axes dialog box, enabling you to change the appearance of the axes. In left
pane of this dialog box you will find various formatting options for applying
on the axes.

Primary Vertical Axes

Screenshot of sub-options of Primary Vertical Axes is as shown:

[&] Primary Horizontal axis » dund | Analysis

] Primany Vertical Axis v | | Naone
G H | [iif| Do not display Axis .

Show Default Axis
M Display Axis with default order and
| labels
, Show Axis in Thousands
il Dispiay Axis with numbers
represented in Thousands

‘‘‘‘‘ 5 Show Axis in Millions
ilm] Display Axis with numbers
represented in Millions

tion Details 1 Show Axis in Billions
1] Display Axis with numbeis
represented in Billions

_ _ 51 Show Axis with Log Scale
fin] Display Axis using a lag 10 based
Within this head, you will find following options:
1. None: It is used when there is no need for the axes to be displayed. If you
click on this option, the vertical axes will be removed.
. Show Default Axis: It will show the default labels and orders.
. Show Axis in Thousands: It will show number format in thousands.
. Show Axis in Millions: It will show number format in millions.
. Show Axis in Billions: It will show number format in billions.

. Show Axis with Log Scale: It will show the log 10 based scale format of
the numeric values.
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7. More Vertical Axis Options: On clicking on this you will find a Format
Axis dialog box, to set the values and apply formatting options.

Formatting Gridlines

A chart can have Horizontal as well as Vertical Gridlines. You can customize both

ofthem.

Steps needed to customize the gridlines are as follows:

1. Select the chart by clicking on it.

2. Click on Gridlines from Axes group of the Layout tab. You will find two
options: Primary Horizontal Gridlines and Primary Vertical Gridlines.
Snapshot of sub-options of Gridlines is as shown:

i Micrnsoft Excel

Formulas View | Design.

]MW@Duggf

Chart Axis Legend Data Data |
Titler Titles* +  Labels~ Table~ | v

1'!l3’ @ Chart Wall ~

‘ [® Chart Floor =
Plot
| Area- Lj 3D Rotation

None
Da not display Horizontal Gridlines

& Primary Llorlzontat srmnnes ’
[®] Primary Vertical Gridlines |

Major Gridlines
Display Horizontal Gridlines for Major units

Minor Gridlines
Display Horizantal Gridlines for Minor units
Major & Minor Gridlines

Display Horizontal Gridlines for Major and
Minar units

Maore Primary Horizontal Gridlines Options...

—a_20.

IS EY T T T T T W

3 In both of the gridlines you will find same options. The options contained

under these heads are:

¢ None: Click on it if you don’t want to display gridlines.

¢ Major Gridlines: This option helps display gridlines with major units.
The gap between gridlines is more than that between minor gridlines.

e Minor Gridlines: Click on it to display gridlines with minor units. The

gap between gridlines is less.

e Major and Minor Gridlines: This option helps display Major as well
as Minor Gridlines. Major Gridlines will be shown with a slightly dark

colour.




Snapshots of Major, Minor and Major and Minor Gridlines for
Horizontal Gridlines are as shown:

Production Details Production Details

"
in

"

% | 1
25 1 1
1“1 | =
i
i

Production Details
—
|

Nut Bolt Scraw Pin

e Major Primary Gridlines Options: Click on it to show a Major
Format Gridlines Dialog, enabling you to format and color the gridlines.

Setting Up Live Charts

Live charts are charts which display, changing situations graphically. They help to
easily understand the current situation. Live Charts are used to compare situations
in different scenarios, to enable analysis.

For example: The rise and falls of securities listed in stock market could
easily be displayed on the charts, to understand the actual condition.

These charts are prepared for displaying values of different fields, for any
small or large record-set. If new values are added to that record set, the charts
automatically show these newer changes. Hence, the end users need not concern
themselves with the record-set.

For understanding this better, let’s take an example. Suppose, there is a
Cricket record-set containing the runs of Team 2, after the completion of each
over. The first team has already completed its turn and information about the runs
they have scored has already been inserted in that record-set.

Screenshot of that database is as shown:

(i aieTaved Dieiny
Overs Team1l Team2
5
8
1
14
1
10
8
9
10
11

BB e oixiovis e

"

O W o N B W e
PR - ]

Self - Learning
Material 147

Office Automation and
Fundamentals of
Computers
NOTES
LY
|



Office Automation and
Fundamentals of
Computers

NOTES

Self - Learning
148  Material

Only ten overs play has been recorded in this example, but as you know the
actual game will produce a huge database. Therefore, a pictorial representation of
this information would make it easier for viewers to compare and understand the
positions of both teams. ‘

Excel provides various types of charts for showing any record-set graphically.
Different types of charts are found under Charts group of Insert tab.

Screenshot of Charts group under Insert tab is as shown:

Bl 9o Bookl - Microsoft Excel ' = B
n Home  Developer | msen | Fagelayout  Famulas  Deta (Review  View 40””913

1?; j [ | E‘_‘J TP shapes - B Line = iy Area - BEne —_.;j, a i'j"i “Uﬂ' o wordas T Equation
p“ e E P smanan @i [ Seatter & column "s‘ : - ‘:‘“— n‘ & Siomature Line = | 7 Symbol
wotTable T lumn v b

(Wukle e | e T,f & Screenshat - o Bpoer- D 0ther Charts - | R Winiloss il B Box n::::,'ﬂamm

i . Sparkdines | Tiler | Linki | Ted Symbaly

Tables Jilustrationy Charts

Forcomlsarmg two related terms, the Colum; andBar Chai'ts are consid;red
the best.

Steps to insert these charts are as follows:

1. Select the fields to be displayed in the chart.

Screenshot of the selected fields is as shown:

e o s

2. Click on either Column or Bar chart under the Insert tab. (You can aiso
insert Line chart)

3. Click on any of the charts displayed in this category.
Screenshot of a 3-D Column chart is as shown:

A live chart presents the recent changes in the record-set as well. In above
example, when second team would complete its 6% over, the runs will be added to
the record-set. As soon as the runs are added, the chart will automatically display

it.




Screenshot for showing automatic modification in chart, as per the changes
in record-set is as shown:

1 Overs Team1 Team2 | e ]
2 1 5 7

3 2 8 6 ‘

4 3 11 5 | ‘
s a4 m_ aly

6 5 12 10.‘ |

7 5 2t BTeam1 ‘

2 & 8 W Team 2

9 8 9

10/ 3 10 i
11| 10 1

12 |
13 : = |
14 | s '
15 | | — -~ o o _

When you will select a chart, three new tab options will appear: Design, Layout
and Format. You can use any of these options for modifying and formatting the
inserted chart. Some of the important options for making the live charts more
understandable are discussed below:

1. Chart Layout: For adding a chart title, you can go to Design tab and
click on any of the pictures displayed under Chart Layout group.

2. Move Chart: For displaying a chart in different locations, you can click on
Move Chart button of Layout group under Design tab.

3. Select Data: For selecting any other data range or modifying legends and
axes labels for a particular chart, you can click on Select Data of Data
group under Design tab.

Find, Replace and Go to

Excel 2010 provides some options to find specific data, replace previous data
with new data, and go to specific cell. These are done by Find, Replace and Go
to command. Find command is used to find quickly specific text, number in
worksheet. Replace command is used to find and replace any data with new
data. Go to command is used to jump on a specific cell or range of cells. These
commands are available on Editing group on Home tab. Let us learn these
commands one by one in detail. First, we will learn to find text or number in
worksheet.

Find:
Steps to Find text or number are as follows:
1. Click on Editing group on Home tab

2. Click Find& Select on Editing group.
3. Click on the Find command.
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Office Automation and The screenshot of Find & Select is as shown:
Fundamentals of
Computers (& @e-o-Ts T ool - Micrasoft Excel = | @ .
.Hame I Insert Page Layout Farmulas Data Review View Developer & 0 = ﬁ ="
o alibri 1 = =|=|F cenen A A=l
NOTES da- B I U- ANy EESFHEE $~% ¢ 3% Delete ~ |
g m &-A EE P (W& Eroma .z E.?,“.f‘ l?i’.‘?a"
Cipboard A __Font _fi | Alignment 5| Number 5 | cens | Editing 34 - Eind...
k2 @R a-——_
dl A 8 e GRS TR G H ] | = ga:.r.mcmﬂ
3 Go To Special...
24 Sr. No. |Name Payment | Fomuylas
& 101/Shalini 10,000 —
4 102|Abhinav 15,000| s :
3 | 103|sidhu 25,000 Conditional Formatting
E’ | m‘);a jiv ‘_’Iw_ 000 Copstants
7 105|shubhangi| 33,000 | | DutaYaidation
& 106|Nisha 23,000| i Select Objects
g 107(Kalyani 10,000' | Bty Selection Pane...
10 108|Pradnya 26,000| - —
ELY 109|Ganesh 20,000|
31 110|Vardha 18,000
L e LU MR 1 &
W <"» %] Sheeti | Sheet2 . ‘Sheets | ”J R T30
B “mbﬁf*‘uﬁ‘”@"
4. On chck:mg, Fmd and Replace dialog box appears. Type a text or number
that you want to find.
The screenshot displaying 107 number in Find what box is as shown:
rFmd and Replace ‘ ,?, ‘,, X3 ,1
Fid |Replace.|
Fodwhet: (07 [d

[ fndal | [ Bndbext | [ cos |

5. Click on Find Next button. It selects the cell where 107 numbers placed.

6. If you click on Find All button, the location of all the occurrences of that
number or text is displayed.

Replace:
Steps to Replace text or number are as follows:

1. Click on Editing group on Home tab
2. Click Find & Select on Editing group.
3. Click on the Replace command.
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5. Click on Find Next button. It will select cell where 107number is placed.

6. Click on Replace button. The number107is replaced with 127.

The screenshot of table after replacing 107 with 127 using Replace button

is as shown:

Sr. No., |Name Payment
_101)E %0 52,040
102{Jonny 52,000
103|Jackson $3,000
104|Emmy $3,050
10s|ericson | $2,000
106)watson | 3,050

[ 127jRambc | s2040
108|Anne 53,080
105|Roboin | s4,000
llalHarmavni 53,050

7. If you click on Replace all, it will replace all the occurrences of the 107

and replace it with 127,

The screenshot of Replace is as shown: Office Automation and
Fundamentals of
r@]‘r H9 = Bookl - Microsoft Excel (Trial) = 1 > Camwters
n' Home |risst Pagelayout  Formuiss | Data . Review View i e 0 = @ EE
B & catibr i1 v -|_=_— &F  General A g=insen > I -
P:‘I G- BIUOU- AV EE ! BHr $ % sr-:- ¥ Delete - ﬂ- :Z? Lﬂ NOT‘ES
TS @ SA EE R WY T Bromat 2+ Fiter s sereets
Clipboard Font d _:h_\_;n_me it Number & | Cells | E-Juir‘s:rh- i-mrl
B9 T Nt I" 127 f!;‘ Replace..
g oh | Nk D E F G TR aY Tl gt
1 Go To Special..,
2 Sr, No. lName Payment Formylas
3 410&']0“" $2,040 Comments
£ IDJ.. Jm?ny 52,09(] Conditional Farmatting
3 mllad(snﬂ 33.0("3 | Capstants
§ 104]Emmy $3,050 | ;n'” .
-7 | 105|Ericsan sz'm Dats Validation
8 10s|watson | 43,050 4 Select Qbjects
9] I 127 |Rambo $2,040 B selection Ear.e.... )
|10 108[Anne $3,080 ] Ui
1 108fRoboin | 4,000 ‘
12 110jHarmayni| $3,050 |
13
£t >
| 4TF W Sheet1 Bhaetz Shesta %3 T T4 77’7"__—"””77"__ »
Bt Lonediicpuuonsnginn d e T 00w D) .
4. Onclicking Replace Fmd and Replace dialog box appears. Type a text
or number in Find what and Replace with box.
The screenshot of displaying 107number in Find what and127 number in
Replace with textbox is as shown:
Find and Replace R
L%
Fid | Regce | iy ‘
Hnd what: |107 - E |
Replace with: 127! _ E
|
Ewﬂﬂ Hﬂwl[ﬂﬂwﬂldﬁe?
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Go To:
Steps to use Go To command are as follows:
1. Click on Editing group on Home tab.
2. Click Find & Select.
3. Click on the Go To command.
The screenshot of Find & Select is as shown:

a@:ﬁ!ix

I AutoSum * %—r ;ﬁ? |
|

@ Fin - |
. Sort & |Find &
QG dear~  Fijter - [Select +|

Editing 'ﬂ Eind. —
| %3 Beplace..,
Q (HERC ™ GoTe

Go To Special..,
Formgylas
Comments
Conditional Formatting
Copstants
Data Validation

i Select Objects

B, seiedtion Pane...

4. On clicking Go To, Go To dialog box appears that prompts to enter
reference. Enter the cell reference where you want to jump, say D3:D7.

The screenshot of Go To dialog box is as shown:

GoTo l ? W e S .
Go to:

Reference §

paed ]

5. Click OK button. The cellsD3 to D7are selected.
Screenshot of table after clicking OK button is as shown:

T o3 & | 2010
EREER R

106| watson $3,050

10 108|Anne $3,080

1| Robbin | 54,000 |
12 110|Harmayni|  $3,050




2.3.3 Modifying and Merging Rows and Columns

In the MS Excel worksheet, by default the height and width of the cells in every
row and column is similar. The default Column Width is ‘8.43’ and Row Height is
‘15’. MS Excel provides different methods for modifying column width and row
height including wrapping of text and merging of cells.

Modifying Column Width

It becomes essential to modify the width of a column in the worksheet when the
complete cell content is not visible or displayed. To make it visible you have to
increase the width of the column. Additionally, if the width of the cell is more or
extra and the cell content is less then you can decrease the width of the cell to give
an appropriate width to the worksheet column.

1. To change or modify the column width, position the mouse pointer or cursor
over the column line in the column heading. The mouse pointer or cursor
will now change from the White Cross to Double-Arrow.

2. Click, hold and drag the mouse pointer for increasing or decreasing the
column width.

3. Now release the mouse pointer. See the column width of the selected column
is increased and changed and the complete cell content is visible. Similarly
increase the column width also so that the complete cell content will be
visible. You can also change the column width of range of columns together
by selecting them and applying the command.

4. While entering numeric data or date if the cell displays the pound signs
(H#HHHHA) then it specifies that the column width is not sufficient or
appropriate for displaying the cell content. To view the complete cell content,
increase the width of the column.

6. Alternatively, you can also increase or decrease the width of the column by
selecting Format command in the Cells group on the Home Tab. If you
select the option ‘Column Width. .. then the Column Width dialog box will
appear. Enter the new value for changing the column width and press ‘OK”.
You can also select the option ‘ AutoFit Column Width’ or ‘Default Width. ...
When you select the option ‘AutoFit Column Width’ then MS Excel will
automatically increase or decrease the Column Width as per the cell content.

7. When you press ‘OK’ then the column width will be increased.

AutoFit Column Width

As discussed, the AutoFit Column Width feature automatically set’s the column
width to fit its content. One method we have already discussed that is using the
Format option. Alternatively, select the cell for formatting and position the mouse
cursor or pointer above the column line in the column heading. The White Cross
Cursor will now become a Double-Arrow Cursor. Now when you double-click
the mouse then the Column Width will automatically change to fit the cell content.
Similarly, you can change the Row Height.
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Modifying Row Height

You have learnt how to modify the Column Width of a cell. Similarly, the Row
Height of a cell can also be modified.

1. To change or modify the row height, position the mouse pointer or cursor
over the row line in the row heading. The mouse pointer or cursor will
change from the White Cross to Double Arrow.

2. Click, hold and drag the mouse pointer for increasing or decreasing the row
height.
3. Now release the mouse pointer. See the row height of the selected Row 2

is increased and changed. Similarly you can increase the row height of the
other rows in the worksheet.

4. Alternatively, you can also increase or decrease the height of the row by
selecting Format command in the Cells group on the Home Tab. If you
select the option ‘Row Height...” then the Row Height dialog box will
appear. Enter the new value for changing the row height and press ‘OK’,
You can also select the option ‘AutoFit Row Height’.

When you select the option ‘AutoFit Row Height’ then MS Excel will
automatically increase or decrease the Row Height as per the cell content.
Merging Rows and Columns
For merging rows and columns, follow the following steps.

1. Select the cells that you wish to merge.

2. Click on merge and center command to open drop down menu in the
alignment group of Home tab.

3. Click on the option as per your requirement. An illustration is given below.

BE S & B
| HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER

. N o

B &% Cut [Calibri Ju s E=F ¥ EwnepTe Ge

m e cal R A A T = -

o SrormatPainter ° T U R-A- === ‘ g 3
Clipboard r. Font n Allqnm Merge & Center

¥ Merge Across

| B2 v i / f | Dennis

| : nmerge Cells
I

5 PO Topeka
122 5 Road North Newton | 67117!

3 |

2.3.4 Addmg Spellcheck in Spreadsheet

To add spellcheck in spreadsheet, follow the following steps.
1. Click the Review tab on the ribbon.
2. Click Spelling.




51

misspelled word.

Alternatively, you can press F7 key to apply spellchecker.

Adding Borders and Colors to Cells

To set border
Steps to set border are as follows:
1. Select the cell.
2. Go to Home tab.
3. Click on Borders option in Font group.
4. Select Border style that you want to use.
The screenshot to select Borders is as shown:

o> SR
s _Tanet
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} 1y i MW, - Dot
CEL T comment
| e
|| Sreting g 5|
| " the sprling of tea. o
S Tmotey
3 ha
[ -

3. Ifthe program finds spelling mistakes, a dialog box appears with the first
misspelled word found by the spelling checker.

4. After you decide how to resolve the misspelling (ignoring it, adding it to the

program’s dictionary, or changing it), the program moves to the next

<
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To set Fill cell colour
Steps to Fill cell colour are as follows:
1. Select the cell.
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Office Automation and 2. Go to the Home tab.
Fundamentals of
Computers 3. Click on Fill colour option in Font group.
4. Select color that you want to fill in selected cell.
NOTES The screenshot to select Colours is as shown:
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To set the Font colour
Steps to set the Font colour are as follows:
1. Select the cell.
2. Click on Home tab.
3. Click on Font colour option in Font group.

4. Select color that you want to set in selected cell. Text in cell gets displayed
with selected color.

The screenshot to select Font colour is as shown:
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Printing a Worksheet/Workbook

You can print all pages of a worksheet or only selected page(s) by using Print
option of File menu.

Snapshot of Print options is as shown:
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Before printing, you can set print styles as per your requirement, While printing a
document, there are various settings available. These are as follows:

1. Copies: You can set number of copies to be printed as well as select the
pages to be printed.

2. Printer: Select printer, if there are more than one printer attached. Otherwise,
Excel will automatically recognize the attached printer.

3. Settings: In settings, you will find the following options:

A. Print option, which gives you three choices— print active sheet,
entire workbook or print selection. You can select whichever you
need and see the preview of the printing layout on the right side.

B. Pages: Here, you can set the range of pages to be printed..

C. Collated refers to printing the pages one by one and Uncollated
means printing the required copies of first page, then those of second
page and so on.

D. Portrait and Landscape Orientation options leave you to decide
whether you want to print the pages lengthwise or widthwise,
respectively.

E. You can set the Page Type for the print to be taken. In this snapshot,
Letter size is selected.
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F. You can set Margin as well. By default, it is set as Left: 0.7" Right:
0.7".

G You will find some scaling options as well, which are helpful if you
want to compress or enlarge the size of the content.

At last, you click on Print button on top, to take the final print out(s).

Validating and Analyzing Worksheet Data

Validation is important aspect of MS Excel; it provides the facilities to enter only
those values as input in the cell which are appropriate. For example: If in a
worksheet, numbers between 1 to 10 are required to be entered, then, you must
not enter number greater than 10 or less than 1. Also, only integer values should
be present in the cell. Validating provides constraints that eliminate the chances of
entering wrong data and hence increases the reliability of the worksheet.

The screenshot displaying an example of validation is as shown:

(I O " VST TRREEETEETET N S Book! < Mecrosoft Bicd
Home Ingert Page Layout Formulas Data Review View
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= U3 Copy - )
P‘-“' # Format Painter B S U- D GD'A' EE R EtFE BBMege&cCenter| § - % » | %%
Clipboard ] Font . Alignment I Humper
R —— —
= B W T T T R T ) T I i sl B
1
L2 Answer
3] How many students are present in the class?

As shown in the screenshot, in the questions like “How many student§'are
present in the class?”” The number must be less than or equal to total number of
students in class and greater than or equal to zero. In validating and analyzing,
there are certain terms that require understanding. These are explained in the
succeeding sections.

Conditional Formatting

Conditional formatting is a tool of formatting a cell of the worksheet that contains
some condition. In the conditional formatting there are different types of rules,
bars of option, color scale, etc. All these tools can be used to make the worksheet
formatted according to the condition provided by the user. It helps the user to
analyze the data in worksheet. You can use the conditional formatting to highlight
or change the color of the cell. There are many mathematical relations present in
the MS Excel 2010 such as greater than less than, between, equal to, etc.

Steps to apply conditional formatting are as follows:
1. Click on Home tab.
2. Click on Conditional Formatting.




The screenshot of selecting the Conditional formatting is as shown:
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3. Select Highlight Cells Rules and then, select Greater Than.
4. Fill the value in Greater Than Text area.
5. Click OK button.

The screenshot of output displaying the cell, outlined with red color, which
contains the value greater than 400 is as shown:
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Other options like Data bars are used to see the difference between the
values in the cell of the worksheet.

Steps to format the worksheet with a bar are as follows:
1. Click on Home tab.

2. Click on Conditional Formatting,

3. Select Data Bars.

4. Click on the different Color bar.
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Views in Slides
PowerPoint views can be accessed from two locations.

¢ Views can be access quickly from the bottom bar just to the left of the
zoom settings

lumnnm
-I ildl astes I3 mater
[ mendout Master | I3 Godhnes
B | [ Goides
Maités Viewn | Shaw
——

hun nln'n

Title Slide

 Click to add subtitle

Quick Access to Presentation Views

e Views can also be access from the Presentation Views section in the View
ribbon

Presentation Views View Ribbon

I'r:nmm Mnmm Sidt m hmw

L 7: vm-—? i 78
il suge Soner 2 $36e Miter 3 punr. q E“}] =1 = E
') Motes Poge | |5 Mandout Mester . FT Grgiines i PBI i Ermuh :Eir & | o m 1 i
O G resdngview | [ nsto Mt | E1Guion | 0 Window | BWck and Whee | wingew B0 o| Mo |
Praveniation Views | MaftarViess | Show % rm ColouSayicale . | indaw Maeriss

A short description of the different views and their features.
Normal View:
This is the default view in PowerPoint and this is primarily used to create and edit

slides. User can create/ delete/ edit/ rearrange slides, add/ remove/ modify content
and manipulate sections from this view.
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* Click to add text
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Normal View icon

Slide Sorter View:

This view is primarily used to sort slides and rearrange them. This view is also
ideal to add or remove sections as it presents the slides in a more compact manner
making it easier to rearrange them.

T

Design  Transitions  Animations
e » =42 I IY-

B L U 8 - P HE FH

Slide Sorter View icon
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Reading View:

This view is new to PowerPoint 2010 and it was created mainly to review the
slide show without losing access to rest of the Windows applications. Typically
when User run the slide show, the presentation takes up the entire screen so other
applications cannot be accessed from the taskbar. In the reading view the taskbar
is still available while viewing the slide show which is convenient. User cannot
make any modifications from this view.

[ [B] Powerpoint Siide Show - [Presemtatian1] - Micrasot PowerPoint e e T e |
|
Slide#2
|
* Sample Text 2 i

* Only text box content

Word Art Sample Text

in a shape .

int
Windows Taskbar visible botroonv:‘f);iz;;ible

Slide Show:

This is the traditional slide show view available in all the earlier versions of
PowerPoint. This view is used to run the slide show during presentation.
Slide#i2

* Sample Text 2
* Only text box content

W@M /9\[7‘& Sample Text

in a shape

Step (1): In the Design ribbon, under the Background group click on
theBackground Styles command.

A I €

E e e R e TR | S
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&) Format Background..,
%) Reset Slide Background

i

Step (2): Select one of the background styles that suits your requirements

Home Insert | Design | Transitions  Animations  Siide Show  Review View & 0
?‘El ECnlurs 3 P Background Styles ~ i -
S = @Furﬁs r |

(4] Hide Background Graphics

| Page Slide Themes
Setup Onentation~ |+ | EMfects ©
Page Setup | Themes

Background ir]
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}eﬁm":m;‘g’" and Step (3): To edit the background for a specific slide, right click on the desired
C':,',:,pu,e,'; b background slide and select “Apply to Selected Slides”

NOTES e o s
I e |
Page Shige | Themes

{| Somm’ Oriontaisii=| v M'i
Fage Setiap l Themes |

)| Format Batkground..,
ﬂ Peiet $uge Batkgraung

Apply to Selected Slides option

Step (4): Selected slide(s) now have the new background.
2.4.1 Creating Presentation and Slides

Opening a presentation in PowerPoint
Steps for opening a presentation are as follows:
1. Go to the File tab which is present on the left hand side of the ribbon.
2. Go to the Open option of the File tab.
The screenshot of an Open option is as shown:

3. Asyou click on the Open option, an Opeil dialog box appears. Choose
the appropriate drive and folder from where you want to open the file.
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The screenshot of an Open dialog box is as shown: Office Automation and
Fundamentals of
Computers
. = “:3} » Libraries » Documents » v‘&,” Search Documents 5
Qrganize » New folder e - (] NOTES
(] Microsoft PowerPc—  Documents library Anagebss Foldes
§  Includes: 2 locations
3 Favorites | Name : Date modified Type
Bl Desktop
4 Downloads E 4. My Web Sites 8/24/2013 3:47 PM File folder
% Recent Places 4. OneNote Notebooks 8/19/2013 3:17 PM File folder
4 Libraries i
|'¥| Documents 3
|
Jﬁ Music '
[ Pictures
B videos
ﬁ Homegroup el ; el | . .|
Flename  + [AllPowerPoint Presentations ~
Tools = 1' Gpen fv] [_ Cancel

4. Choose the file which you want to open by writing its name in the File
name text box.

5. Click on the Open option to open the file.

Saving a document

In PowerPoint 2010, by default, files are saved in .pptx format. In the previous
version, files are saved in .ppt format. There are different ways of saving the files
in your computer depending upon the requirements.

Steps for saving the presentation in PowerPoint are as follows:
1. Go to the File tab which is present on the left hand side of the ribbon.
2. Goto the Save As option of the File tab on the left most side of the screen.
The screenshot of Save As option in File tab is as shown:

3. Asyouclick on the Save As option, a Save As dialog box appears. From
the dialog box, you can choose the required drive or folder where you want
to save the file.
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3. Click on Effect Options icon to apply an animation effect to the selected
object.

The screenshot of Effect Options icon of an Animations tab is as shown:

Animations SlideShow  Review  View | Deslgn Format |
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4. Click on the Add Animation icon present next to Eﬂect Options. As you
click on Add Animation, a pictorial view of all of the animation effects to
animate text or graphics appears.

5. Choose the animation effect for adding it to the required object. The selected
animation effect will be highlighted in golden color.

The screenshot of Add Animation and selecting a specific animation effect
is as shown:
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6. Timing group of Animations tab allows user to adjust the sequence and
timing of selected animations. User can also adjust settings if an animation
should be performed when the mouse is clicked or automatically.

The screenshot of Timing group is as shown:

b Start: On cuck T b Stat:|OnClick
® Duration: 0200 * | ©® Durat| OnClick
| ® Delay: 00.00 ay @ Delay: With Previous
‘ After Previous
Timing er—— L
7. Click on the Animation Pane, it displays all the animations applied to
each slide.

The screenshot of Animation Pane is as shown:
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8. After selecting all the animations as per the requirement, you can see the
preview by clicking on the Preview icon available below the File menu.

The screenshot of Preview option is as shown:

ezt
*

Preview |

Preview ‘

Transition Effects

Slide Transition is also an animation effect which is to define effects while proceeding
from one slide to next slide during the slide show. It also includes adding sound
effects. You can apply the different kinds of transition effects in slides of a

presentation.
Steps to apply the transition effect are as follows:
1. Click on the Transitions tab which is available on the Ribbon view.
The screenshot of Transitions tab is as shown:
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2. Click onthe'Up’ and ‘Down’ arrow of Transition to This Slide group to
choose a special effect that gets applied during the transition between the
previous slide and next slide.

The screenshot displaying all the Transition Effects is as shown:
h H?[nl_ _l_niut Dulnn_ i’r:\nww_liu;' A"imw, 75!\1“533\&7 j\mewwwo.w . T 4 ; 7_ ) .
oo (T a @ = m & & @
Ge O
1 | m‘:" ) - 5 ) ) - _
| E O E @ B W @ ¥ @ H &
o W O m M
=
| 2 m o =
Pan Ferris Wheel Conveyor Rotate ‘Window Orbit Fly Through !

3. Asyouclick on any of the transition effects, a prewgvogthetheme plajg m

front of you. To set the transition to slide, left click on the choice which you
want.

. Click on the Apply To All option of the Transition tab to apply the same

transition effect on all slides.

. Click on the list box of the Sound option of Transition tab.
. Select and click on the sound which you want to play during the transition

between the current and the previous slide.
The screenshot displaying different types of Sound options is as shown:.

d sound: [NoSound] [*] Advance Slide

| @ Durstio{NoSoung) - ap
| {53 apply ¢ [Step Previous Sound] ;
Applause

i

i Cash Register
| Chime

Other Sound.., b
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7. After applying all the transitions you can also see the preview of a slide by

clicking on the Preview option.

Adding Sound and Video in Slides

Microsoft Office PowerPoint 2010 allows its users to easily use audio-visual content
in the presentation. It supports a large variety of video files such as, Windows
Media File, MP4 Video, MPEG-2 TS Video and Window Media Video File,




along with audio files such as ADTS Audio, AIFF audio file (aiff), AU audio file, Office Automation and
Fundamentals of

W3 aﬂd MP4 audlo ﬁ].es Computers

Audio and video content can be added to Microsoft Office PowerPoint
2010, using the Media Clips Option under the Insert Tab. Thus, it is possible to
insert sound, picture or media files in PowerPoint presentations or slides to make
them more attractive and presentable.

NOTES

Steps for adding audio or video clips in PowerPoint 2010 are as follows:
1. First go to the Insert menu of the menu bar and click on it.

2. When you click on it, you will discover the Media group containing Video
and Audio options.

3. Now, click on the Audio or Video icon, as per your requirement.

Screenshot displaying the Audio and Video icon, available under the Media
group of the Insert tab is as shown:

Insert Design Transitions Animations Slide Show Review View Atrobat
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Ip Sceenshot Phato | Shapés SmartArt Chart | Hyperfink Aclion | Text Header WordAm Date  Siide Object Equutlun Symbol Haeo Au ua
t Album * * Box &Footer -  &Time Number

Images Dlustrations Links Text Symbais Media

¢ Adding audio or sound Files in Microsoft Office PowerPoint 2010:
Steps for adding Audio clip to the PowerPoint file is as shown:

1. Click on the drop down arrow of the Audio icon under the Media group.

2. Asyou click on the drop down arrow, a list of options available under this
icon appears.

Screenshot displaying the Audio icon, visible after clicking the drop down
arrow, is as shown:
wdeu Audio | Embed
¥ Flash

M6 B Audio from Fll:
i | Clip Art Audia,..
|

3. You can choose any of the three options to add audio from various sources,
like from a previously saved file on your computer or from Clip Organizer.

4. Suppose you choose Audio from File option, then on clicking Audio from
File, Insert Audio dialog box appears, showcasing a set of folders having
the music or song files present on your system.

5. Now, navigate to the appropriate folder to use or place the desired audio
file into the PowerPoint File

6. Click on Libraries and then double click on the Music library file or option.
When you click on Music, the Sample Music folder appears. Next, double
click oniit.

7. After clicking on Sample Music, a window containing all the music files

available in your system appears. Here, you can choose any media or sound
file, you want to insert in your presentation.
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Screenshot of the Insert Audio dialog box and files showcased under the
Music Folder, after clicking on Audio from File, is as shown:
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8. After choosing the desired file, click on the Insert button which will add the
audio file to the slide.

Screenshot of the slide after the Audio File has been added is as shown:
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¢ Adding Video Files in Microsoft Office PowerPoint 2010:
1. Click on the drop down arrow of the Video icon of the Media group.

2. When you click on the drop down arrow, a list of available options appears.

Screenshot displaying the Audio icon after clicking the drop down arrow is

as shown:
&8 e »

Video | Audio  Embed |
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Video from

&b Site.,

Clip Art Video..,

4. Now, you can choose one of the three options to add Video from various
sources. Click on Video from File or to add from a website, click on
Video from Web Site. To add from Clip Organizer, click on Video from
Clip Organizer. Here, for example, let’s click on Video from File. On
clicking Video from File, Insert Video dialog box appears displaying the
set of folders having all the music or song files present on your system.




Screenshot displaying the Insert Video dialog box containing the Pictures
and Videos library is as shown:

, <
S HegET -
; poooolhy ) Slactidbintet L LR
g~ 0.8
> [#] Microsoft Powr Libraries
Open a library to see your files and arrange them by folder, date, and other properties.
457 Favorites I e
B Desitop § J,;i? Documents ‘
8 Downloads QHW"' l
& Google Diive |7 i
‘#] Recent Places < by
| i Libraries ’ ’:: Pictures
L4 ‘—L} Library
5“ Homegroup
Videos
(8 Computer Library
v iy Local Disk (C}) =
File name: - Ve Files Paskassrep <
Toots = [imen [ [ Concel ]

5. Now, navigate to the appropriate folder to place the desired video file in the
PowerPoint file.

6. Click on Libraries and then, double click on the Video or Picture library
file.

7. When you click on the Video library, the Sample Video folder appears.
Double click on it.

8. After clicking the Sample Video, a pop-up window containing all the video
files available in your system appears, from where you can choose any
media or video file to insert in your presentation.

Screenshot of the video file present in the Sample Video folder, visible
after clicking on Video library, is as shown:
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9. After choosing the desired file, click on Insert button. This will add the
video file to the slide.
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Working with Tables and Pictures

ATable is a representation in the form of rows and columns for managing and
presenting the data. For using tables in the slides, there are various processes like
create table, insert table, format table, etc

e Create and Format a table
Steps to Create and Format a table are as follows:
1. Select the slide where you want to add a table.
2. Select Table option from the Insert tab in the Tables group.

3. Click on the Insert Table command from the drop-down menu. An Insert
Table dialog box appears where you can add the required number of rows
and columns.

The screenshot of an Insert Table dialog box is as shown:

|
4. You can also insert the table by selecting the required number of rows and
columns on the Table grid of the drop-down menu.

The screenshot of inserting a table using table grid is as shown:
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5. For addmg text to the table cells click on a cell and enter the text.

6. For adding arow at the end of a table, click on the last cell of last row and
then press TAB.

e For Adding a Column or a Row:

Steps to add a column or a row are as follows:

1. Click on the cell (insertion point) adjacent to which you wish to add row or
column.

The screenshot displaying the insertion point is as shown:




2. Use commands available in Rows & Columns group under Layout tab of
Table Tools to insert rows or columns (above, below, left and right) of the
selected cell.

The screenshot of Layout tab having Rows & Columns group is as shown:
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e Deleting a Row or Column
Steps to Delete a Row or Column are as follows:
1. Click on any cell of a desired row or column you want to delete.
2. Click on the Layout tab of the Table Tools and then, click on the Delete
icon available in the Rows & Columns group.

3. Asyouclick on the Delete icon, a drop-down menu containing three options
such as Delete Columns, Delete Rows and Delete Table appears. You
can select any one of them according to the requirement.

The screenshot of Delete icon available in Rows & Columns group is as
shown:
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Creating Photo Album

While creating the Photo Album in PowerPoint, you can use templates which are
built in or create on your own. This feature allows you to add the pictures or
photos of your choice in a presentation. Also, by exploring this feature of the MS
PowerPoint, you can choose, rearrange and add text to the pictures. You can also
add pictures from your drives to the Photo Album. Several effects like layouts,
slide transitions and themes can be applied to the Photo Album. You can also add
captions to the photos and frames around them.

For Creating Photo Album

Steps to create a Photo Album are as follows:
1. Select and click on the Insert tab available in the ribbon.
2. Click on the Photo Album option in the Images group and then select

New Photo Album from the drop-down menu.
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The screenshot of the Photo Album is as shown:

Hnme lnsm | Design Transitions Anlmwom

hl@fji

Tab!.e Picture Cllp Scrumhut_ joto- | Shap:s Smartart Chart |
At lbuln' I

Tables | Images.

B @ Edit Photo Album,

3. Asyouclickon the New Photoum, a Photo Album dialog box appears.
The screenshot of Photo Album dialog box is as shown:

] & |

Pictures in album: Preview:

No preview Is available for this
¥ sejection

Album Layout
Fleture Jayout) iﬂtm slide.

Frame shape: [ﬂzdﬂ'ljt

IHems: [

4. Click on the File/Disk... button of the Photo Album dialog box.

5. Asyou click on the File/Disk... button, an Insert New Pictures d1alog
box appears on the screen.

The screenshot of Insert New Pictures dialog box is as shown:

(] Microsoft Powerpc—  Pictures library Amngeby: Folder ¥
Includes: 2 lo¢ations

5 Libraries Sample Pictures

6. Now, you can choose the desired images or photos from the corrmpoﬁdjng
drive by writing the name of the file in the File name textbox and then click
on the Insert button.




7. Apreview of the selected image appears inside the Photo Album dialog Oﬁ"'ceFA”’;’”’“ﬁMIﬂ"d
box. There are several options available for changing the layout, rotating - "Z’,‘;’,’,’,’,f‘,,f;{
the image, adjusting it as needed

8. Now, click on the Create button to insert images into the Photo Album.

The screenshot of the Picture layout and Theme in the Photo Album
dialog box is as shown:
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9. Apresentation witﬁic;me image in each slide will be created. A title page is
also automatically added in the presentation.

Working with SmartArt

A SmartArt can be easily inserted in MS PowerPoint 2010. SmartArt icon can be
found in Mlustrations group. The various graphics available in this option are All
(basic block list, alternating hexagon, etc.), matrix, relationship, hierarchy, etc.

Steps to use the SmartArt icon are as follows:
1. Go to the Insert tab and then go to the Illustrations group.
2. Click on the SmartArt option of the Illustrations group.
The screenshot of SmartArt option in Illustrations group is as shown:
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Office Automation and 3. Asyou click on the SmartArt, a dialog box Choose a SmartArt Graphic
Fundamentals of . . G ) . .
Computers appears having different categories such as List, Relationship and so on.
You can choose any one of them according to the requirement.
NOTES The screenshot of Choose a SmartArt Graphic dialog box is as shown:
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4. Click OK button of the dialog box.

5. Asyouadd SmartArt graphic by clicking the OK button, the SmartArt
Tools appear on the PowerPoint slide. To change particular individual
shapes, click on the Format tab of the SmartArt Tools and do the changes
as required. Also, a text can be added from Ribbon.

6. You can also change the layout by selecting any layout from the Layouts
group of Design tab in SmartArt Tools. n

The screenshot of Layouts group is as shown:
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7. Youcan also change style, color and effects of the SmartArt Graphic by
using the SmartArt Styles group.

The screenshot of SmartArt Styles group is as shown:
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8. You can change the size of the SmartArt shapes by clicking the Smaller
and Larger icons from the Shapes group of the Format tab.
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The screenshot of Shapes group is as shown:
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SmartArt Types and Their Uses

SmartArt is amethod, which helps to improve the artistic view of a presentation.
SmartArt is nothing other than the visual representation of textual data presented
in adocument. You can create SmartArt graphics in PowerPoint, Excel, Outlook,
and Word.

You can try out different layouts, and then choose one which suits your
needs. You can choose among nine SmartArt graphics.

SmartArt Graphics are available under the SmartArt icon or button of
Hlustration group under the Insert tab.

Steps for using SmartArt graphics in your presentation are as follows:
1. Go to the Insert tab of the menu bar and click on it.

2. When you click on it, the Illustration group will open displaying three
icons or buttons, namely Shapes, SmartArt and Chart,

Screenshot displaying the SmartArt icon in the Iustrations group is as
shown:

Home Insert Design Transitions Animations
kB s PR

Table Picture Clip Screenshot Photo  Shapes SmartAm, Chart
- Ant » Album ~ ”

Tables Images = ustrations

3. Now, as you click on the SmartArt icon, a new window or dialog box with
the caption Choose a SmartArt Graphic will appear. This window contains
several different categories or layouts of graphics such as List,
Relationship, etc. You can choose any one of them, as you see fit.
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Screenshot displaying the Choose a SmartArt Graphic dialog box is as

shown:
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4. Choose the desired type and layout and click on the OK button.

5. When you click on the OK button, the selected SmartArt Graphic layout
will be added to your presentation file.

6. Also, the Design tab of the menu bar will automatically appear, displaying
the Layouts group and SmartArt Styles group. The layout of the graphic
can be changed anytime by selecting a different layout from the Layouts
group under Design tab in SmartArt Tools.

7. You can also change individual shapes by clicking on Format tab of the
SmartArt Tools and making the required changes. Text can also be added

from Ribbon.
The screenshot displaying the Layouts group and SmartArt Styles group
of the Design tab is as shown:

SHHCE BTty Tty

Layouts SmartArt Styles

8. You can change the size of the SmartArt shapes by clicking on the Smaller
and Larger icons, available under the Shapes group of the Format tab.

The screenshot of Shapes group is as shown:

Home Insert
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Edit
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e Uses of different SmartArt Graphics or Layouts:

SmartArt Graphics represent information and ideas in visual form. It is chiefly
designed for expressing concepts or ideas in a much more attractive and presentable
way, as opposed to presenting the content solely in text format. In Microsoft




PowerPoint 2010, the eight categories of SmartArt Graphics enable the user Office Pf‘ "‘;’"aﬁo"lﬂ"d
to access or insert all the layout types. These graphics play a key role in providing - “g",f,’,’,ﬁ;;{
anew shape and style to your content. Further, they enhance the versatility of your

document.

OTES
Some of the frequently used SmartArt Graphics, their purpose and the N

advantages they have are as follows:

1. List

This type of layout can be used for data written in the form of a list. It transforms
the bulleted list or text into a SmartArt Shape or Graphic. The shapes can be
colored, resized and animated in order to highlight and emphasize the importance
of your main points.

The layouts that belong to this group, do not present sequential information
and thus, they do not have arrows for indicating the flow.

For example: Basic Block List, Alternating Hexagons, Picture Caption
List, Table Hierarchy, Stacked List, Pie Process, etc. are examples of Layouts
under the List category.

Screenshot displaying the pattern under Alternating Hexagons type of
List is as shown:

This type of layout is used for representing content and ideas, as an
interconnected series. Using this shape, Text appears in two levels. This implies
that text is expressed inside the hexagons as well as outside the hexagons. Also, a
couple of List layouts allow you to express your data using pictures. So, you can
add pictures along with the text to highlight important information. For Example:
Horizontal Picture List of the List group shows data in a non-sequential form
and includes top shapes for inserting in pictures.

Screenshot displaying the Horizontal Picture List with two shapes is as
shown:

¢ [Text]
Process layout is used for expressing data having a directional or sequential flow.

Itis used to illustrate the sequential steps needed to complete a task or to depict
phases involved in development of a product.

2. Process:

Process layouts can be used as horizontal steps, vertical steps, circular
bending processes, etc.
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For example: Step Up Process, Ascent process, Chevron List, Segmented
Process, Arrow Ribbon, Equation are some of the types of Layouts under the
Process category.

Basic TimeLine Layout can be used to represent the sequence or flow of
steps in case of any work, event, task or design procedure.

Step up Process is used to express text and present the information in an
ascending or increasing manner.

Screenshots displaying the pattern or shape of the Basic TimeLine and
Step up type of Process are as shown:

3. Cycle:

This type of Smart Art graphic layout is used to represent a repetitive or circular
process such as Season cycles, Product development cycles, various life cycles,
Website publishing cycle and many more. In these layouts, there are no defined or
fixed beginning and ending points.

For example: Basic cycle, Text cycle, Block cycle, Segmented cycle, Basic
Pie, Radial cycle, Cycle Matrix, Gear, etc. are some of the examples or types of
Layouts under the Cycle category.

Basic Cycle and Segmented Cycle patterns or shapes are used for
denoting the progression of processes, tasks or events, in circular flow. .

Radial Cycle is used to show how the outer pieces of information or data
connect to the central data and what the surrounding shapes are contributing to
the central hub.

Screenshots displaying the Segmented Cycle and Radial Cycle SmartArt
Graphic are as shown:

o’

4. Hierarchy:

Hierarchy type is used to express information ina hierarchical manner. It basically
denotes and emphasizes the relationships in an organization. Hierarchy can also
be used to represent tree structures like decision trees, binary trees, B-trees. It is
mostly used in case of organization charts, related to companies or employment.

Hierarchy Type is used to show the various levels of organizations and
depicting the sequence of steps to be followed, for the purpose of reporting and
handling the employment system.

For Example: Organization Chart, Hierarchy, Labelled Hierarchy,
Horizontal Hierarchy, Hierarchy List and Lined list are some of the types of Layouts
under the Hierarchy category.




Screenshots displaying the Organization Chart and Hierarchy List are
as shown:

[Text] - [Text] Mggﬁ‘
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Organization Chart is mainly used for expressing the relationship among
the various levels of the organization or company. Also, Hierarchy List shown in

the second screenshot is used for denoting and representing the relationship and
flow of information in a collective manner, as groups.

5. Relationship:

This layout is used to express or denote non-progressive and non-hierarchical
relationships. Relationship layout can be used to show conceptual relationships
such as overlapping between two or more sets of things. Venn diagrams, showing
the overlapping areas at the centre of intersection, are a good example of the
Relationship SmartArt Graphics.

Thus, this type of layout is used for illustrating connections and depicting
how parts or pieces of information are related to the whole.

For example: Circle relationship, Arrow Ribbon, Basic Venn, Basic Target,
Radial cluster, and Diverging Radial are some of the common layouts under the
Relationship category.

Screenshots displaying Arrow Ribbon and Basic Target Relationship

are as shown:
@m @) =
Arrow Ribbon (displayed in the first screenshot) is used for denoting
concepts either as related or contradicting. Basic Target layout (shown in the
second screenshot) is used to show gradations or containment, while the Basic
Radial layout is used to collectively highlight processes in order to merge various
concepts into a single central idea.

6. Matrix:

Matrix layout is used to represent the relationship between pieces of information
or data, and express this information as a collective unit called matrix. It mainly
classifies or expresses information in two dimensional forms.

For example: Basic Matrix, Titled matrix, Grid Matrix and Cycle Matrix
are some of the popular layouts under the Matrix category.
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Screenshots displaying the Grid matrix and Cycle Matrix are as shown:
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In the first screenshot of Grid layout, the four lines showing the axes of
levell data appear in quadrants. The concepts are placed along the two axes.

In Cycle matrix, first four lines of level 1 are shown in the form of a Pie and
arectangular shape is used for showing level 2 data.

7. Pyramid:

Itis used to show hierarchical or proportional relationships, with largest component
being placed at one end and the smallest component at the other end. Thus, all the
patterns that belong to this category have an upwardly pointing shape. This layout
is basically used for expressing information or relationships in two approaches,
either top to down or bottom to up.

For example: Basic Pyramid, Inverted Pyramid, Pyramid List and
Segmented Pyramid are some of the popular layouts under the Pyramid category.

Screenshot displaying the Basic Pyramid is as shown:

Another type or layout df the Pyralhid category known as Pyramid List,
can be used to write text in rectangular boxes provided on top of the pyramid
background.

Screenshot displaying the shape of the Pyramid List is as shown:

8. Picture:

Picture layout is used for representing text and information using pictures. It gives
your presentation an authentic touch and makes it more interactive, as well as
attractive.

For example: Accented Picture, Alternating Picture Blocks, Bubble Picture
List, Captioned Pictures, Snapshot Picture List, Vertical Picture List and Spiral
Picture are some of the widely used types of Pyramid category layouts.




Screenshot displaying the Alternating Picture Blocks is as shown: Office Automation and
Fundamentals of

5 E e | Computers
NOTES
(W | [rex] |

Screenshot displaying Vertical Picture Accent List layout of Picture
category is as shown:

This layout is used for denoting information in non-sequential form by
grouping blocks. It also contains circles attached with text blocks, for attaching
and showing the pictures.

2.4.2 Working with Objects

Selecting objects
On the Home tab, in the Editing group, click Select and do one of the following:

e To select all of the objects and placeholders on the slide, click Select All.
e To select objects that are hidden, stacked, or behind text, click Select
Objects, and then draw a box over the objects.

e To open the selection pane, where you can select, multi-select, show, hide,
or change the order of objects, click Selection Pane, and then click the

options that you want.
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Grouping, ungrouping and regrouping objects
Grouping shapes, pictures or object

1. Press and hold CTRL while you select the shapes, pictures, or objects that
you want to group.

2. Do one of the following;

o To group shapes and other objects: under Drawing Tools, on
the Format tab, in the Arrange group, Click [g] , and then
click Group .

o To group pictures: under Picture Tools, on the Format tab, in
the Arrange group, Click , and then click Group.

If you do not see the Drawing Tools or Picture Tools tabs, make sure
that you selected a shape, picture, or other object. You might have to double-click
the object to open the Format tab.

Ungrouping shapes, pictures or object

To ungroup a group of shapes, pictures, or other objects (for example, if you want
to move a group but leave one shape behind or make extensive changes to one
shape without changing the other shapes), do the following:

1. Select the group that you want to ungroup.
2. Do one of'the following:

o To ungroup shapes or other objects, under Drawing Tools, on
the Format tab, in the Arrange group, click Group 8], and then

Click Ungroup.
(3 Bring Forward = |&~
3y Send Backward ~ Eﬁ"‘_ -
B, selection Pane | TF]  crou
L Arrange | ;:!!“ Rag
i I ungroup

o To ungroup pictures, under Picture Tools, on the Format tab, in
the Arrange group, Click , and then click Ungroup.

& Bring Forward = |2~

2 send Backward ~ (%':

4, selection Pane | T3]
Arrange | t’f’ Reagrous
(%1 Ungroumy |
If you do not see the Drawing Tools, Picture Tools, or Format tabs,
make sure that you selected a group of shapes, pictures, or other objects. You

might have to double-click the object to open the Format tab.
Regrouping shapes, pictures or object

1. Select any one of the shapes or objects that were previously in a group.
2. Do one of the following:




R

o To regroup shapes and objects: under Drawing Tools, on Office Ffi“i;’maﬁonland
the Format tab, in the Arrange group, click '3, and then . ag;;?uj;{
click Regroup.

o To regroup pictures: under Picture Tools, on the Format tab, in NOTES

the Arrange group, click ], and then click Regroup.
G Bring Forward = |2 -
Zy Send Backward ~ _@i"
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__ Amange |9 Regroup

| pt
0?!
(@

If you do not see the Drawing Tools, Picture Tools, or Format tabs,
make sure that you selected a group of shapes, pictures, or other objects. You
might have to double-click the object to open the Format tab.

Aligning object on a slide
Follow the steps given below to align object on a slide.

1. Hold down Shift, click the objects that you want to align, and then click

the Format tab.
2. Click Arrange > Align > Align to Slide.
Amange
£ % :*ﬁ“_: o m Reorder» Group &

et 2
Position Wrap Text I% Align » () Rotate v

3. Click Arrange > Align, and then click the alighment that you want.

Cut, Copy, Paste and Duplicating an object

You can cut, copy, paste and duplicate an object in a slide using the illustration
given below. In case of duplicating an object, Click to select the object that you
want to duplicate. Hover over the object with your mouse and press the CTRL
key until you see the plus symbol next to the arrow, While still pressing the CTRL
key, click and drag the object to the new location.
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* |53 Copy Shide» ] Sedtion ~ | g s S A A i
s T Dubtiote L mutdes Ll font AL ESIIEN
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2.4.3 Printing Slides

You can modify the common print settings by using the drop-down menus. The
print previews are automatically adjusted to allow you to see how the pages will
appear before actually printing them.
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Steps to print the slides are as follows:
1. Select the File tab in the Ribbon.

2. Select and click on the Print option. Then, fill the number of copies required
in the Copies drop-down box.

3. Asyou click on the Print option, Print Preview appears on the right side
of the PowerPoint window.

4. Click on the Print All Slides drop-down box in the Settings group to
select the options like Print All Slides, Print Current Slide, and Custom
Range of slides.

5. After checking the Print Preview, click on the Print button.
The screenshot of printing the presentation is as shown:
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. Print Layout
There are many options to print the slides in different formats. These options are
available in print layout tab. The options in Print Layout are as follows:

o Full Page Slides: It prints one slide on a full page.

e Handouts: There are various options available in the Handouts group.
You can choose any one of them like 1 Slide, 2 Slides. Also, you can print
slides in horizontal and vertical manner by using 4 Slides Horizontal, 4
Slides Vertical, etc.

o Notes Page: It prints one slide per page including notes that are added in
the Notes Pane while making the presentation.

e Outlines View: It provides the facility to print the slides in an outline format.
2.4.4 Putting Text on Slides

To add text anywhere on slides, follow the steps given below.

1. Click on Text box command in the Text group that is available in the Insert
menu.




2. Clickand hold down the left mouse button while you drag the mouse. Release
the mouse button when the size of box is as per your text size.

3. Click inside the text box and start typing.
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Using a Shape as a Text Box / Typing Text in Shapes

Microsoft Office PowerPoint 2010 allows its users to use Shapes as Text Boxes,
which implies that you can add a Shape to your slide and then you can use itas a
Text Box to write text inside it, making presentations more beautiful and informative.

e Turning a Shape into a Text Box:

Shapes can be added to Microsoft Office PowerPoint 2010, using the Shapes
option under the Ilustrations group of the Insert Tab. You can insert any shape
of your choice and use it to write text.

Steps to add a rectangular shape and use it as a Text Box are as follows:
1. First go to the Insert menu of the menu bar and click on it.

2. When you click on the Insert tab, you will find Illustrations group containing
three options namely, Shapes, SmartArt and Chart.

Screenshot displaying Shapes under the Ilustrations group of the Insert
tab is as shown:

m Home | Insert Design Transitions Animations
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Tables Images | I,liu trations

3. Now, click on the drop down arrow of the Shapes icon, to select the
ready-made list of available shapes like Lines, Rectangles, Basic Shapes,
Block Arrows, Equation Shapes, Flow charts etc.

Screenshot displaying several options for selecting and inserting shapes from
Shapes option is as shown:
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4. Now, suppose you want to insert the rectangle shape. Click on the first
shape under the Rectangles section.

Screenshot displaying the selection of rectangle shape is as shown:
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5. Now, after selecting the desired rectangular shape, drag the cursor and
click on the area where you want to create your rectangle. Move the cursor

away to create the rectangle.
Screenshot displaying the rectangle inserted into the PowerPoint file is as

shown:
‘Iick to add title

6. Now, as the rectangle is created and inserted, just click on the Rectangle
and wait for it to show a blinking cursor in the middle. This cursor will allow
you to enter text.

7. Enter the text in the Rectangle and press Enter. Thus, we see how,
Microsoft PowerPoint 2010 provides us the facility of turning any shape
into a text box.
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Screenshot of the Rectangle Shape seen in the PowerPoint slide, after
entering the text is as shown:

¢ Turning a Text Box into a Shape:

It is also possible to convert the text box into a shape and apply various Quick
Styles options to it, in order to resize, colour and modify according to your choice.
Steps to turn a text box into a shape are as follows:

1. Go to the Insert tab of the ribbon view and click on the Text Box icon of

the Text group.
Screenshot displaying the Text Box icon, available in the Text group of
the Insert tab is as shown:
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2. When you click on the Text Box, the shape of the cursor on the screen
changes.

3. Now, click on the desired location and drag the cursor to insert a text box.
Screenshot of a Text Box with sample text is as shown:
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4. Now; goto j:he Hmiié tab, and use the shape styling options of the Drawing
group to use this text box as a shape.

Screenshot of the Drawing group of the Home tab is as shown:
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5. Choose from the Quick Styles, Shape fill, Shape Outline or Shape

Office Automation and
Fundamentals o
Computers ! Effects to add a shape effect.
Screenshot of a text box, after adding Quick Style into it, is as shown:
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Sample text

Finding and Replacing Text
To find and replace the text in slides, follow the steps given below.

1. Click on Home tab.
2. Go to the editing group where you will get Find and replace button. Click

onit.
"Find" Menu
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3. Anew window will open as shown below. Type the text which you want to
find and its replacement also. After that click on Replace button. Using
Replace All button, you can replace every occurrence of text in the slide.

| Eind Next
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Close

|

Replace with:
[w Replace
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New Features in PowerPoint 2016/ Difference between PowerPoint
2010 and 2016

PowerPoint 2016 is not much different from PowerPoint 2013 or 2010. Here
also, all the menu items and often-used features are the same. The screenshot of
ribbon interface is given below.
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Although there aren’t any dramatic changes, the latest version, PowerPoint 2016,
brings some new enhancements to this top presentation programme, such as:

¢ PowerPoint Designer: With the new PowerPoint Designer, as soon as
you insert an image, the Design Ideas panel opens on the right, offering
several layout options for the graphical design of the current slide.

e Morph Transition: PowerPoint 2016 adds a brand new transition type
called Morph. This transition can help you make smooth animations,
transitions, and object movements across the slides in your presentation.

e Quick Shape Format: Draw a shape on a slide and you’ll see an increase
to the number of “preset” styles available, another enhancement in
PowerPoint 2016.

¢ Six New Chart Types: Microsoft Office 2016 has six new charts to show
off your work in PowerPoint, Excel, and Word. New chart types include
Waterfall, Treemap, Histogram (including Pareto), Box and Whisker, and
Sunburst.

e Screen recording: you can now include screen recordings in your
PowerPoint presentations with just a few clicks.

e Simple Collaboration and Sharing: Collaboration is more and more
integrated into Office 2016. Choose Share on the ribbon to share your
presentation with others on SharePoint, OneDrive, or another online
location. With real time co-authoring, you can now not only see when others
are working on the same shared presentation but also see an indicator that
shows you exactly what slides they’re working on, and where in the slides
they are making changes.

¢ Improved Version History: Now you can go to File > History to sec a
complete list of changes that have been made to your presentation and
even access earlier versions. Note: This feature is only supported for files
stored on OneDrive for Business or SharePoint.

¢ Tell Me: One of the other PowerPoint 2016 new features is the “Tell Me”
help tool. Look at the right side of the PowerPoint 2016 Ribbon menu after
the last tab, to see a light bulb that says “Tell me what you want to do.” Just
enter the words and phrases that describe the steps you want to do next
and quickly get the features or actions you want to use.
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¢ Smart Look Up: The Smart Lookup feature, which is available in most of
the Office 2016 programs, gives you access to quick searches from inside
of PowerPoint 2016.

Check Your Progress

16. What is the ribbon view?

17. When is the slide sorter view used?

18. How are files saved in PowerPoint 2010?
19. How can the order of the slides be changed?
20. What are the different handout options?

21. State the option to group pictures.

22. What does using shapes as text boxes imply?

23. How can shapes be added to Power Point 2010?

2.5 INTRODUCTION TO COMPUTERS

History and Generations of Computers

The first mechanical adding machine was invented by Blaise Pascal in 1642. Later,
in 1671, Baron Gottfried Wilhelm von Leibniz of Germany invented the first
calculator. Around this time, Herman Hollerith came up with the concept of punched
cards, which were extensively used as an input medium in mechanical adding
machines.

Charles Babbage, a nineteenth-century professor at Cambridge University,
is considered the father of the modern digital computer. During this period,
mathematical and statistical tables were prepared by a group of clerks. Utmost
care and precautions, however, could not eliminate human errors.

In 1842, Babbage came up with his new idea of the Analytical Engine,
which was intended to be completely automatic. This machine was capable of
performing basic arithmetic functions. But, these machines were difficult to
manufacture because the precision engineering required to manufacture them was
not available at that time.

The following is a brief description of the various generations of computers.

e Mark I Computer (1937-44): This was the first fully automatic
calculating machine designed by Howard A. Aiken and the design of
which was based on the technique of punching card machinery. In this
technique, both mechanical and electronic components were used.

e Atanasoff-Berry Computer (1939-42): This computer was developed
by Dr. John Atanasoff to solve certain mathematical equations. It used
45 vacuum tubes for internal logic and capacitors for storage.

e ENIAC (1943-46): The Electronic Numerical Integrator And Computer
(ENIAC) was the first electronic computer developed for military
requirements and was used for many years to solve ballistic problems.




Office Automation and
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EDVAC (1946-52): One of the drawbacks of ENIAC was that its
programs were wired on boards, which made it difficult to change them.

Computers
To overcome the drawbacks of ENIAC, the Electronic Discrete Variable
Automatic Computer (EDVAC) was designed. The basic idea behind this
concept was that sequences of instructions could be stored in the memory NOTES
of the computer for automatically directing the flow of operations.

o EDSAC (194749): Professor Maurice Wilkes developed the Electronic
Delay Storage Automatic Calculator (EDSAC), by which addition and
multiplication operations could be accomplished.

e UNIVACI (1951): The UNIVersal Automatic Computer (UNIVAC)
was the first digital computer to be installed in the Census Bureau in
1951 and was used continuously for 10 years. In 1952, International
Business Machines (IBM) introduced the 701 commercial computers.
These computers could be used for scientific and business purposes.

Computer Generations
Table 2.1 shows the various generations of computers.
Table 2.1 Generations of Computer
Generation Time Hardware Software Features Examples
¥ 1942- Vacuum Tubes Machine High-speed electronic switching | ENIAC, EDVAC,
1955 Language (Binary | device; memory type was EDSAC,
Language) electromagnetic; bulky in size; UNIVACI
generated a large amount of
heat; frequent technical faults;
quired constant mai
used for scientific purposes; air-
conditioning required .
)i 1955- Transistors High-level Better electronic switching Livermore Atomic h
1964 languages devices than vacuum tubes; Research
made of germanium Computer
iconductors; C),
R, | S | G450
COBOL, and more reliable; easy to
ALGOL, handle; much smaller than
SNOBOL vacuum tubes; generated less
heat as compared to vacuum
tubes; used for business and
industries for commercial data
processing; air-conditioning
required
it} 1964- Integrated Circuits (ICs) High-level ICs were smaller than Mainframe,
1975 made up of transistors, languages transistors; consumed less Minicomputers
resistors and capacitors fixed power; dissipated less heat as
on single silicon chip PLA to transistors; more
2 reliable and faster than earlier
PASCAL, generations; capable of
BASIC, VISUAL | performing about 1 million
BASIC, C, C++, instructions per second; large
C#, Java storage capacity; used for both
scientific and commercial
purposes; air-conditioning
required
w 1975- Microprocessor made up of Advanced Java Microprocessor had control on Personal
1989 Large Scale Integration (J2EE, JDO, logical instructions and memory; | Computers (PCs),
Circuits (LSI) and Very Large | JavaBeans), PHP, | semiconductor memories; LAN,
Scale Integration Circuits HTML, XML, personal computers were WAN
(VLSD SQL assembled; used in LAN and A
WAN to connect multiple Cscw
computers at a time; used
graphical user interface; smaller,
more reliable and cheaper than
third-generation computers;
larger primary and secondary
storage memories; had
Computer Supported
Cooperative Working (CSCW);
air-conditioning not required
¥ 1989- Ultra Scale Large Integration Artificial PCs were assembled — portable Portable PCs,
Present (USLI), Intelligence, and non-portable, powerful Palmtop
Optical Disks PROLOG, desktop PCs and workstions; Computers,
b s | Cawee
user-friendly feaf -
Mgy e-mailing; a{r-cmdiﬁoning not Self - Learning
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Analog and Digital Computers
Computers are classified into three types:
¢ Digital computers
¢ Analog computers
e Hybrid computers
Digital Computers

Digital computers are commonly used for data processing and solving problems
using programs. These operate by counting digits in the binary form and processing
data in discrete form. Digital computers have large memories that enable them to
store large quantities of data.

Analog Computers

Analog computers are generally used in industrial process controls and to measure
physical quantities such as pressure, temperature and so on. These do not use
binary digits for computation. They work on continuous electrical signal inputs and
the output is displayed continuously. Its memory capacity is less and can perform
only certain types of calculations. However, they are faster than digital computers.
The accuracy of result obtained from an analog computer is about 99 per cent.

Hybrid Computers

Hybrid computers are the combination of digital and analog computers. They use
the best features of digital and analog computers. They help the user to process
both continuous and discrete data. Hybrid computers are generally used for weather
forecasting and industrial process control.

2.5.1 Number System for Computers (Binary, Octal,
Hexadecimal)
A number system that uses only two digits, 0 and 1 is called the binary number

system. The binary number system is also called a base two system. The two symbols
0 and 1 are known as bits or binary digits.

The binary system groups numbers by two and by powers of two, shown in
Figure 2.1. The word binary comes from a Latin word meaning two at a time.

... LSD

t
Binary point

Fig. 2.1 Binary Position Values as a Power of 2

The weight or place value of each position can be expressed in terms of 2,
and is represented as 2°, 2!, 2, etc. The least significant digit has a weight of
2°(=1). The second position to the left of the least significant digit is multiplied by 2
(=2). The third position has a weight equal to 22 (= 4). Thus, the weights are in the
ascending powersof2 or 1, 2,4, 8, 16, 32, 64, 128, etc.

The numeral 10__ or 10, (one, zero, base two) stands for two, the base of
the system.




I In binary counting, single digits are used for none and one. Two-digit Office Automation and

numbers are used for 10, and 11__[2 and 3 in decimal numerals]. For the next F""dagj::als o
: i : . puters

counting number, 100, (4 in decimal numerals) three digits are necessary. After

111, (7 in decimal numerals) four-digit numerals are used until 1111__(15in

decimal numerals) is reached, and so on. In a binary numeral, every position has NOTES

a value 2 times the value of the position to its right.

A binary number with 4 bits, is called a nibble and a binary number with
8 bits is known as a byte.
For example, the number 1011, actually stands for the following representation:
1011, = 1522 50 % 2%+4-1 %21+ ] & 2P

=1x8+0x4+1x2+1x1
i 1011, =8+0+2+1=11,,
In general,
[h B o By 8], = b.2% 8. I +..+822 +5 2+ B2

Similarly, the binary number 10101.011 can be written as,

1 0 1 0 1 . 0 1 1
24 93 22 2! Q0 ; 21 oz 9-3
(MSD) (LSD)

10101.011, =1 XX +0x234+1x224+0x214+1x20
+O%27 +1 %2241 %23
=16+0+4+0+1+0+0.25+0.125=21.375,,

In each binary digit, the value increases in powers of two starting with 0 to the
left of the binary point and decreases to the right of the binary point starting with N
power —1.

Binary Number System used in Digital Computers

The binary number system is used in digital computers because all electrical and
electronic circuits can be made to respond to the two-state concept. A switch, for
instance, can be either opened or closed, only two possible states exist. A transistor
can be made to operate either in cut-off or saturation; a magnetic tape can be
either magnetized or non-magnetized; a signal can be either HIGH or LOW; a
punched tape can have a hole or no hole. In all of the above illustrations, each
device is operated in any one of the two possible states and the intermediate
condition does not exist. Thus, 0 can represent one of the states and 1 can represent
the other. Hence, binary numbers are convenient to use in analysing or designing
digital circuits.

Decimal Number System

The number system which utilizes ten distinct digits, i.e.,0,1,2,3,4,5,6,7,8 and 9
is known as decimal number system. It represents numbers in terms of groups of
ten, as shown in Figure 2.2.

We would be forced to stop at 9 or to invent more symbols if it were not for
the use of positional notation. It is necessary to learn only 10 basic numbers and
positional notational system in order to count any desired figure.
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1
Decimal point

Fig. 2.2 Decimal Position Values as Powers of 10

The decimal number system has a base or radix of 10. Each of the ten decimal
digits 0 through 9, has a place value or weight depending on its position. The weights
are units, tens, hundreds and so on. The same can be written as the power of its
baseas 10°, 10!, 10?, 1(°... etc. Thus, the number 1993 represents quantity equal to
1000 +900 + 90 + 3. Actually, this should be writtenas {1 x 10° + 9 x 10>+ 9 x 10!
+ 3 x 10°}. Hence, 1993 is the sum of all digits multiplied by their weights. Each
position has a value 10 times greater than the position to its right.

For example, the number 379 actually stands for the following representation.

100 10 1
107 10! 10°
3 7 9

3%100+7x10+9x1
379, =3x100+7x10+9x 1
=3x102+7x10'+9 x 10°

In this example, 9 is the Least Significant Digit (LSD) and 3 is the Most
Significant Digit (MSD).
Example 2.1: Write the number 1936.469 using decimal representation.
Solution: 1936469, =1x10° +9x10*+3 x 10'+6 x 10°+4 x 10"
+6x102+9x107
=1000+900+30+6+0.4+0.06+0.009 =1936.469

It is seen that powers are numbered to the left of the decimal point starting
with 0 and to the right of the decimal point starting with —1.

The general rule for representing numbers in the decimal system by using
positional notation is as follows:

ag .. dgag=alPta 105+, @10 +a 10 +a 108

Where n is the number of digits to the left of the decimal point.

Octal and Hexadecimal Numbers

Octal Number System
The octal number system was used extensively by early minicomputers. However,
for both large and small systems, it has largely been supplanted by the hexadecimal
system. Sets of 3 bit binary numbers can be represented by octal numbers and this
can conveniently be used for entire data in the computer.

A number system that uses eight digits, 0, 1, 2, 3,4, 5, 6 and 7 is called an octal
number system.

It has a base of eight. The digits, 0 through 7 have exactly the same physical
meaning as decimal symbols. In this system, each digit has a weight corresponding
to its position as shown below:

n 3 2 1 —1 —2 —n
a8"+..a,8+a8 +a8 +a_ 8" +a 8 °+..+a_8
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Octal Odometer

Octal odometer is a hypothetical device similar to the odometer of a car. Each
display wheel of this odometer contains only eight digits (teeth), numbered 0 to 7.
When a wheel turns from 7 back to 0 after one rotation, it sends a carry to the next
higher wheel. Table 2.2 shows equivalent numbers in decimal, binary and octal

systems.

Table 2.2 Egquivalent Numbers in Decimal, Binary and Octal Systems

Decimal (Radix 10) Binary (Radix 2) Octal (Radix 8)
0 000 000 0
1 000 001 1
2 000010 2
3 000011 3
4 000 100 4
8 000 101 5
6 000110 6
7 000111 7
8 001 000 10
9 001 001 11
10 001 010 12
11 001011 13
12 001 100 14
13 001 101 15
14 001110 16
15 001111 17
16 010 000 20

Consider an octal number [567.3],. It is pronounced as five, six, seven octal point
three and not five hundred sixty seven point three. The co efficients of the integer
partare a,=7, a, = 6, a, =5 and the co-efficient of the fractional partisa_; =3.

Hexadecimal Number System

The hexadecimal system groups numbers by sixteen and powers of sixteen.
Hexadecimal numbers are used extensively in microprocessor work. Most
minicomputers and microcomputers have their memories organized into sets of bytes,
each consisting of eight binary digits. Each byte either is used as a single entity to
represent a single alphanumeric character or broken into two 4 bit pieces. When the
bytes are handled in two 4 bit pieces, the programmer is given the option of declaring
each 4 bit character as a piece of a binary number or as two BCD numbers.

The hexadecimal number is formed from a binary number by grouping bits in
groups of 4 bits each, starting at the binary point. This is a logical way of grouping,
since computer words come in 8 bits, 16 bits, 32 bits and so on. In a group of 4 bits,
the decimal numbers 0 to 15 can be represented as shown in Table 2.3.

The hexadecimal number system has a base of 16. Thus, it has 16 distinct digit
symbols. It uses the digits 0, 1, 2, 3,4, 5,6, 7, 8 and 9 plus the letters A, B, C, D, E
and F as 16 digit symbols. The relationship among octal, hexadecimal, and binary is
shown in Table 2.3. Each hexadecimal number represents a group of four binary
digits.
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Fundamentals of Octal and Hexadecimal Number Systems

Computers
Decimal Binary Octal Hexadecimal
(Radix 10) (Radix 2) (Radix 8) (Radix 16)
NOTES
0 0000 0 0
1 0001 1 1
2 0010 2 2
3 0011 3 3
4 0100 - e
5 0101 5 5
6 0110 6 6
7 0111 7 7
8 1000 10 8
9 1001 11 9
10 1010 12 A
11 1011 13 B
12 1100 14 C
13 1101 15 D
14 1110 16 E
15 1111 17 F
16 0001 0000 20 10
17 0001 0001 21 11
18 00010010 22 12
19 00010011 23 13
20 00010100 24 14
Counting in Hexadecimal

When counting in hex, each digit can be incremented from 0 to F. Once it reaches
F, the next count causes it to recycle to 0 and the next higher digit is incremented.
This is illustrated in the following counting sequences: 0038, 0039, 003A, 003B,
003C, 003D, 003E, 003F, 0040; 06B8, 06B9, 06BA, 06BB, 06BC, 06BD, 06BE,
06BF, 06C0, 06Cl1...... and like that.

2.5.2 Data Representation and Coding Systems (BCD,
EBCDIC, ASCII)

Character Representation

Binary data is not the only data handled by a computer. We also need to process
alphanumeric data like alphabets (upper and lower case), digits (0 to 9) and special
characters like + —* / () space or blank, etc. These also must be internally

represented as bits.
Table 2.4 BCD Eguivalent of Decimal Digits
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Binary Coded Decimal
Binary Coded Decimal (BCD) is one of the early memory codes. It is based on the
concept of converting each digit of a decimal number into its binary equivalent
rather than converting the entire decimal value into a pure binary form. It further
uses 4 digits to represent each of the digits. Table 2.4 shows the BCD equivalent of
the decimal digits.

Converting 42,  into its BCD equivalent, would result in:

4 = 0100 0010 ' 41000010 in BCD

10 4 2

As seen, 4-bit BCD code can be used to represent decimal numbers only. Since
4 bits are insufficient to represent the various other characters used by the computer,
instead of using only 4-bits (giving 16 possible combinations), computer designers
commonly use 6 bits to represent characters in BCD code. In this, the 4 BCD
numeric place positions are retained but two additional zone positions are added.
With 6 bits, it is possible to represent 2° or 64 different characters. This is, therefore,
sufficient to represent the decimal digits (10), alphabetic characters (26) and special
characters (28).

Extended Binary Coded Decimal Interchange Code

The major drawback with the BCD code is that it allows only 64 different characters
to be represented. This is not sufficient to provide for decimal numbers (10), lower-
case letters (26), upper-case letters (26), and a fairly large number of special
characters (28 plus).

The BCD code was, therefore, extended from a 6-bit to an 8-bit code. The added
2 bits are used as additional zone bits, expanding the zone bits to 4. This resulting
code is called the Extended Binary Coded Decimal Interchange Code (EBCDIC).
Using the EBCDIC it is possible to represent 28 or 256 characters. This takes care
of the character requirement along with a large quantity of printable and several
non-printable control characters (movement of the cursor on the screen, vertical
spacing on printer, and so on.

Since EBCDIC is an 8-bit code, it can easily be divided into two 4-bit groups.
Each of these groups can be represented by one hexadecimal digit. Thus, hexadecimal
number system is used as a notation for memory dump by computers that use
EBCDIC for internal representation of characters.

Developed by IBM, EBCDIC code is used in most IBM models and many other
computers.

American Standard Code for Information Interchange

A computer code that is very widely used for data interchange is called the ‘ American
Standard Code for Information Interchange’ or ASCII. Several computer
manufacturers have adopted it as their computers’ internal code. ASCII code uses
7 digits to represent 128 characters. Now an advanced ASCII is used having 8-bit
character representation code allowing for 256 different characters. This
representation is being used in micro- computers.

Let us look at the encoding method. Table 2.5 shows the bit combinations required
for each character.
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Table 2.5 Bit Combinations

Thus, to code a text string ‘Hello.” in ASCIT using hexadecimal digits:

H e 1 | 0 .
48 65 6C 6C 6F 2E

The string is represented by the byte sequence 48 65 6C 6C 6F 2E.

Components of a Computer Memory

Memory in the computer system is required for storage and sub sequent retrieval
of instructions and data. We have learned that the Central Processing Unit (CPU)
contains several registers for storing data and instructions. But these can store
only a few bytes. Ifall the instructions and data being executed by the CPU resided
in secondary storage (like magnetic tapes and disks), and was loaded into the
registers of the CPU as the program execution proceeded, it would lead to the
CPU being idle for most of the time. This is because the speed at which the CPU
processes data is much higher than the speed at which data can be transferred
from disks to registers. Every computer thus requires storage space where
instructions and data of a program can reside temporarily when the program is
being executed. This temporary storage area is built into the computer hardware
and is known as the primary storage or the main memory. Devices that provide
backup storage (like magnetic tapes and disks) are called secondary storage or
auxiliary memory. Thus, a memory system can be considered to consist of three
groups of memories:

e Internal processor memory consists of a small set of high-speed registers
that are internal to a processor and are used as temporary locations where
the actual processing is done.

* Primary storage ormain memory is a large memory, which is fast, but not as
fast as the internal processor memory. This memory communicates directly
with the CPU and is mainly based on integrated circuits.

* Secondary storage or auxiliary memory or backing store is much largerin
size than the main memory but is slower than the main memory. It typically
stores all the system programs and other software.

Another type of memory that is increasingly being used in modemn computers
is called the cache memory. It is logically positioned between the internal memory




(registers) and the main memory. It stores and caches some of the content of the OﬁceFAugm“‘f?"g"d
main memory that is currently used by the processor. Figure 2.3 shows the memory v "2’;’;;” ,e:f
hierarchy.

CPU Registers NOTES

v 1

Cache Memory

v T

Main Memory

v 1

Secondary Memory

Fig. 2.3 The Memory Hierarchy

The total memory capacity of the computer can therefore be visualized as
being a hierarchy of components. It consists of all storage devices employed in a
computer system from the slow but high-capacity auxiliary memory to a relatively
faster main memory, to an even smaller and faster cache memory accessible to
high-speed processing logic. Thus, as one goes down in the hierarchy, the following
conditions occur:

e Decreasing cost per bit
e Increasing capacity
¢ Increasing access time

Decreasing frequency of access of the memory by the processor
Storage Evaluation Criteria

The most common properties used for characterizing and evaluating the storage
unit of the computer system are as follows:

o Storage capacity: Represents the size of the memory. It is the amount of
data that can be stored in the storage unit. Primary storage units have less
storage capacity as compared to secondary storage units. While the capacity
of internal memory and main memory can be expressed in terms of the
number of words or bytes, the capacity of external or secondary storage is
measured in terms of bytes.

e Storage cost: Another key factor that is of prime concern in a memory
system is cost. It is normally expressed per bit. It is obvious that lower
costs are desirable. It is worth noting that as the access time for memories
increases, the cost decreases.

e Access time: It is the time required to locate and retrieve the data from the
storage unit. It is dependant on the physical characteristics and the access
mode used for that device. Primary storage units have faster access time as
compared to secondary storage units.

e Access mode: Memory is considered to consist of various memory

locations. Access mode refers to the mode in which information is accessed ~ Self - Learning
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from the memory. Memory devices can be accessed in any of the following
ways:

0 Random Access Memory (RAM). 1t is the mode in which any memory
location can be accessed in any order in the same amount of time. Ferrite
and semiconductor memories, which generally constitute the primary
storage or main memory, are of this nature.

0 Sequential access: Memories that can be accessed only in a predefined
sequence are sequential access memories. Since sequencing through
other locations precedes the arrival at a desired location, the access
time varies according to the location. Information on a sequential device
can be retrieved in the same sequence in which it was stored. Songs
stored on a cassette, that can be accessed only one by one, is an example
of sequential access. Typically, magnetic tapes are sequential access
memory.

o Direct access: In certain cases, the information is neither accessed
randomly nor in sequence, but something in between. In this type of
access, a separate read/write head exists for each track, and on a track
the information can be accessed serially. This semi-random mode of
access exists in magnetic disks.

o Permanence of storage: If the storage unit can retain the data even after
the power is turned off or interrupted, it is termed as non-volatile storage.
While, if the data is lost once the power is turned off or interrupted, it is
called volatile storage. It is obvious from these properties that the primary
storage units of the computer systems are volatile, while the secondary
storage units are non-volatile. Non-volatile storage is definitely more
desirable and feasible for storage of large volumes of data.

Memory Capacity

Capacity, in a computer system, is defined in terms of the number of bytes that it can
store in its main memory. This is usually stated in terms of kilobytes (kB) which is
1024 bytes or megabytes (MB) which is equal to 1024 KB (10,48,576 bytes). The
rapidly increasing memory capacity of computer systems has resulted in defining
the capacity in terms of gigabytes (GB) which is 1024 MB (1,07,37,41,824 bytes).

Thus, a computer system which has a memory of 256 MB is capable of
storing (256 x 1024 x 1024) 26,84,35,456 bytes or characters.

Main memory

Static and dynamic RAM

The main memory is the central storage unit in a computer system. It is a relatively
large and fast memory and is used to store programs and data during computer
operations. The principal technology used for the main memory is based on
semiconductor integrated circuits. Integrated circuit RAM chips are available in
two possible modes, static and dynamic.

Static RAM (SRAM) stores binary information using clocked sequential
circuits. The stored information remains valid only as long as power is applied to the




unit. On the other hand, Dynamic RAM (DRAM) stores binary information in the Office Automation and
form of electric charges that are applied to the capacitors inside the chip. The stored Fuma?j;gf;{
charge on the capacitors tends to discharge with time and so must be periodically

recharged by refreshing the dynamic memory. Dynamic RAM offers larger storage :

capacity and reduced power consumption. Therefore, large memories use dynamic NOTES

RAM, while static RAM is mainly used for specialized applications.

The different types of memory discussed here belong to the read/write type.
What about a memory where only one of the operations is possible, e.g., if we allow
only reading from the memory (cannot change the information in the memory)? The
memory might have some major importance; an important bit of the computer’s
operating system which normally does not change, can be stored in this type of
memory. Such a memory is called ROM Read Only Memory.

Read Only Memory (ROM)

v wd v ra L bt T W N N

wd

Most of the memory in a general-purpose computer is made of RAM integrated
circuit chips, but a portion of the memory may be constructed using ROM chips.
Originally, RAM was used to refer to random-access memory, but now we use the
term read/write memory to distinguish it from read-only memory (since ROM is
also random access). RAM is used for storing bulk of the programs and data that
are subject to change, while ROM is used to store programs that are permanently
resident in the computer and do not change once the production of the computer is
completed.

Among other things, the ROM portion of the main memory is used for
storing an initial program called the bootstrap loader. The bootstrap loader is a
program whose function is to start the operating computer software when power .
is turned on. Since RAM is volatile, its contents are destroyed when power is
turned off. The contents of ROM remain unchanged even after the power is
turned off and on repeatedly.

Read-only memories can be manufacturer-programmed or user-programmed.
When the manufacturer burns the data into the circuitry of the computer, it is
called manufacturer-programmed ROM. For example, a personal computer
manufacturer may store the boot program permanently in the ROM chip of the
computers manufactured by it. Note that such chips are supplied by the
manufacturer and are not modifiable by the users. This is an inflexible process
and requires mass production. Therefore, a new type of ROM called PROM
F (Programmable Read-only Memory) was designed. This is also non-volatile in
nature and can be written only once using some special equipment. The writing
process in PROM can be performed electrically by the supplier or the customer.

In both ROM and PROM, the write operation can be performed only once
and whatever is written cannot be changed. But what about the cases where you
mostly read but also write a few times? Another type of memory chip called EPROM
(Erasable Programmable Read-only Memory) was developed to take care of such
situations. EPROMs are typically used by R&D personnel who experiment by
changing micro-programs on the computer system to test their efficiency.

Further, EPROM chips are of two types: EEPROMs (Electrically EPROM)
in which high voltage electric pulses are used to erase stored information, and
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UVEPROM (Ultra Violet EPROM) in which stored information is erased by exposing
the chip for some time to ultraviolet light.

Figure 2.4 shows the various types of random access memories.

RAM (Random Access Memory)
Read/ Write Read Only - ROM
(Volatile) (Non-Volatile)
I |
SRAM DRAM Manufacturer User
(Static) (Dynamic) Programmed Programmed
|

PROM EPROM

T

EEPROM UVEPROM
Fig. 2.4 Types of Random Access Memories

Cache Memory

Cache memories are small, fast memories placed between the CPU and the main
memory. They are faster than the main memory with access times closer to the
speed of the CPU. Although caches are fast, they are also very expensive and so
are used only in small quantities. For example, a cache of size 64K is normally used
in Pentium IV machines. Cache memories are therefore intended to provide fast
speed memory retrieval without sacrificing the size of the memory.

If the memory is so small, how can it be advantageous in increasing the
overall speed of memory? The answer to this lies in the phenomenon known as
locality of reference.

2.5.3 1/O Devices

A computer will be of no use if it is not able to communicate with the external
world. Tt must, therefore, have a system to receive information from the outside
world (users and other computers) and must be able to communicate results to
the external world. Computers have an input—output subsystem, referred to as I/
O subsystem, which provides an efficient mode of communication between the
central system and the outside world. Programs and data must be entered into
the computer memory for processing, and results obtained from computations
must be displayed or recorded for the user’s benefit.

This can be explained through a very common scenario. Suppose the
average marks of a student need to be calculated, based on the marks obtained
in various subjects by the student. The marks would typically be available in the
form of a document containing the student’s name, roll number, and marks scored
in each subject. This data must first be stored in the computer’s memory after
converting it into machine-readable form. The data will then be processed (average
marks calculated) and sent from the memory to the output unit that will present
the data in a form that can be read by users.
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Fig. 2.5 Role of I/O Devices in a Computer System

The I/O devices that provide a means of communication between the computer
and the outside world are known as peripheral devices. This is because they surround
the CPU and the memory of a computer system. While input devices are used to
enter data from the outside world into the primary storage, output devices are used
to provide the processed results from primary storage to users. F igure 2.5 shows
the role of input/output devices in a computer system.

In this unit, we will discuss the various input devices available for data input.

As mentioned earlier in this section, input devices are used to transfer user
data and instructions to the computer. The most commonly used input devices can
be classified into the categories of:

* Keyboard devices (general and special purpose, key-to-tape, key-to-disk,
key-to-diskette)

* Point-and-draw devices (mouse, trackball, joystick, light pen, touch screen
etc.)

¢ Scanning devices (optical mark recognition, magnetic ink character
recognition, optical bar code reader, digitizer, electronic-card reader, etc.)

¢ Voice recognition devices

* Vision-input devices (webcam, video camersa, etc.)

General Purpose Keyboard

The most familiar means of entering information or data into a computer is
through a typewrite-like keyboard that allows a person to enter alphanumeric
information directly.

Function Keys Numeric Keypad

QWERTY Keyboard  Cursor Movement Keys
Fig. 2.6 OWERTY Keyboard Layout

The most popular keyboard used today is the 101-keys with a traditional
QWERTY layout, having an alphanumeric keypad, 12 function keys, a variety of
special function keys, numeric keypad, and dedicated cursor control keys. Itis so
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called due to the arrangement of its alphanumeric keys in the upper left row (refer
Figure 2.6).

Mouse

A mouse is a small device that a computer user pushes across a desk surface in
order to point to a place on a display screen and to select one or more actions
possible from that position. The mouse first became a widely used computer tool
when Apple Computer made it a standard part of the Apple Macintosh. Today, the
mouse is an integral part of GUI of any personal computer. The mouse apparently
got its name by being about the same size and color as a toy mouse.

Trackball

A trackball is a pointing device that is much like an inverted mouse. It consists of a
ball inset in a small external box or adjacent to—and in the same unit as the keyboard
of some portable computers. It is more convenient and requires much less space
than the mouse since here the whole device is not moved (as in the case of a
mouse). Trackball comes in various shapes but supports the same functionality.
Typical shapes used are a ball, a square and a button (typically seen in laptops).

Joystick

A joystick is a vertical stick that moves the graphic cursor in the direction the stick
is moved. It consists of a spherical ball, which moves within a socket and has a stick
mounted on it. The user moves the ball with the help of the stick that can be moved
left or right, forward or backward, to move and position the cursor in the desired
location. Joysticks typically have a button on top that is used to select the option
pointed by the cursor. Video games, training simulators and control panels of tobots
are some common uses of the joystick.

Light Pen

A light pen is a pen-shaped device allowing natural movement on the screen. It is
made up of a light sensitive cell and a lens assembly designed in such a way that it
focuses onto itselfany light in its field of view. The pen contains a light receptor and
is activated by pressing the pen against the display screen. The receptor is the
scanning beam that helps in locating the position of the pen (X and Y coordinates on
screen). Suitable system software is provided to initiate the desired action once the
area on the display screen is located with the help of the light pen. Light pens are
typically used in Computer Aided Design (CAD) applications to directly draw on
screen.

Touch Screen

A touch screen is probably one of the simplest and most intuitive of all input devices.
It uses optical sensors in or near, the computer screen that can detect the touch of a
finger on the screen. Once the user touches a particular screen position, sensors
communicate the position to the computer. This is then interpreted by the computer
to understand the user’s choice for input.

The most common usage of touch screens is in information kiosks where
users can receive information at the touch of a screen. These devices are becoming
increasingly popular today.




Scanning Devices

§canning devices are input devices that are used for direct data entry from the
source document into the computer system. Scanners facilitate the capturing of
information and storing it in a graphical format for displaying it back on the
graphical screen. They consist of two components, one to illuminate the page so
that the optical image can be captured and the other to convert the graphical
image into a digital format for storing. The graphical images thus scanned can be
seen and processed directly by the computer.

There are two types of scanners, CONTACT and LASER. Both bounce
a beam of light off an image, and then measure the reflected light to determine
the value of the image. Hand-held contact scanners make contact as they are
brushed over the printed matter to be read. Laser-based scanners are more
versatile and can read data passed near the scanning area (refer Figure 2.7(a)

Fig. 2.7(a) A Hand-held Scanner Fig. 2.7(b) A Flat-bed Scanner

Hand-held scanners are used where the information to be scanned or the
volume of documents to be scanned is very low. They are much cheaper as compared
to the flat-bed scanners.

Capturing information using scanners reduces the possibility of human error
typically seen during large data entry. The reduction in human intervention improves
the accuracy of data and provides for timeliness of the information processed.

Most recent trends for data input is towards source data automation. The
equipment used for source data automation capture data as a by-product of a business
activity thereby completely eliminating manual input of data. Some common examples
of these are described below.

Optical Mark Recognition

Optical Mark Recognition (OMR) devices can sense marks on computer readable
paper. This kind of device is typically used by academic institutions to grade aptitude
tests where candidates need to mark the correct option from a number of alternatives,
on a special sheet of paper. These answer sheets can then be directly read by the
OMR device and can be used for further processing by the computer.

The actual technique used by an OMR device once again involves focusing
light on the page being scanned thereby detecting the reflected light pattern for the
marks. Pencil marks made by the user reflect light determining which responses are
marked.
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Magnetic Ink Character Recognition

Magnetic Ink Character Recognition (MICR) is similar to optical mark recognition
and is used exclusively by the banking industry. MICR devices are used by the
banking industry to read the account numbers on cheques directly and subsequently
do the necessary processing.

Banks using the MICR technology print cheque books on special types of
paper. The necessary details of the bank (like the bank’s identification code, relevant
account number and cheque number) are pre-printed on the cheques using an ink
that contains iron oxide particles that can be magnetized. (refer Figure 2.8).
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Fig. 2.8 A Bank Cheque using MICR Technology

MICR readers are used to read and sort cheques and deposits. An MICR
reader-sorter reads the data on the cheques and sorts the cheques for distribution to
other banks and customers or for further processing.

Optical Barcode Reader .

Data coded in the form of small vertical lines forms the basis of barcoding.
Alphanumeric data is represented using adjacent vertical lines called barcodes. These
are of varying widths and spacing between them used to uniquely identify books,
merchandise in stores, postal packages, etc.

Figures 2.9(a) and (b) give an example of a bar code used on one of the
books for its unique identification.

9
Fig. 2.9(a) Barcode Example Fig. 2.9(b) Barcode Reader

An Optical Barcode Reader (OBR) uses laser beam technology. The laser
beam is moved across the pattern of bars in a barcode. These bars reflect the beam
in different ways. The reflected beam is then sensed by a light sensitive detector
which then converts the light patterns into electrical pulses thereby transmitting
them to logic circuits for further conversion to alphanumeric value. Barcode devices
are available as hand-held devices.




Digitizer
Digitizers are used to convert drawings or pictures and maps into a digital format for
storage into the computer.

Fig. 2.10 Digitizing Tablet

A digitizer consists of a digitizing or graphics tablet, which is a pressure sensitive
tablet, and a pen with the same X and Y coordinates as on screen. Some digitizing
tablets also use a crosshair device instead of a pen. The movement of the pen or
crosshair is reproduced simultaneously on the display screen. When the penismoved
on the tablet, the cursor on the computer’s screen moves simultaneously to the
corresponding position on screen (X and Y coordinates). This allows the user to
draw sketches directly or input existing sketched drawings easily. Figure 2.10 shows
a digitizing tablet.

Digitizers see most common usage by architects and engineers as a tool for
Computer Aided Designing (CAD).

Computer Output Units

Anoutput device is an electromechanical device that accepts data from the computer
and translates them into a form that can be understood by the outside world. The
processed data, stored in the memory of the computer, is sent to an output unit,
which then transforms the internal representation of data into a form that can be
read by the users.

The output can normally be produced in two ways —on a display unit/device
or on paper. Other kinds of output like speech output and mechanical output are also
used in certain applications. Output produced on display units or speech output that
cannot be touched, is referred to as soft copy output while output produced on paper
or material that can be touched, is known as hard copy output.

A wide range of output devices are available today and can be broadly classified
under the categories of*
e Display devices
e Printers (dot matrix, inkjet, laser)
¢ Plotters (flatbed, drum)

Display Devices

One of the most common and important peripherals in a computer system is the
display device. Conventional computers used display terminals known as alphanumeric
terminals. These used a form of multi-dot (7 x 5 or 9 x 7) array to display characters.
These were used to read text information displayed on screen. The increasing demand
for displaying graphs and pictures, for visual presentation of information (more
effective for user interaction), brought about the advent of graphic display devices.
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Graphic display is typically made up of a series of dots called ‘pixels’ (picture
elements) whose pattern produces the image. Each dot on the screen can be addressed
uniquely and directly. Owing to the fact that each dot can be addressed as a separate
unit, it provides greater flexibility for drawing pictures. '

Display screen technology may be one of the three categories:

Cathode Ray Tube (CRT): The main components of a cathode ray terminal
are the electron gun, the electron beam controlled by an electromagnetic field and a
display screen which is phosphor-coated. The screen’s phosphor-coating is organized
into a grid of dots called pixels.

The electron gun emits an electron beam, which is directed towards the
phosphor-coated display by the electromagnetic field and this in turn creates the
image.

There are two types of CRT displays:

e Vector CRT display: In which the electron beam is directed only to
places where the image is to be created.

e Raster scan display: In which image is projected on screen by directing
the electron beam across each row of the picture elements from top to
the bottom of the screen. This type of display provides a high dynamic
capability since the image is continuously refreshed. It offers full colour

display at a relatively low cost and is, therefore, becoming increasingly
popular.

The quality of display is indicated by the resolution of the display device. The
number of horizontal and vertical pixels determines resolution. Typical resolutions in
graphic display range from (800 x 600) to (640 x 768) to (1024 x 1024) pixels. =

Based on the resolution and the number of colors supported, several standards
for color monitors have evolved. The most popular of these include:

e Color Graphics Adapter (CGA), whichhas a resolution of (320 x 200)
and supports up to 16 colors.

o Extended Graphics Adapter (EGA) has a resolution of (640 x 350) and
supports up to 16 colors.

e Video Graphics Adapter (VGA) has a resolution of (640 x 480) and
supports up to 256 colors.

e Super VGA having a resolutions ranging (800 x 600) to (1280 x 1024)
and supporting up to 256 or more colors.

Note that each one of these is implemented by installing an add-on card in the
computer, commonly known as graphics adapter or the video card. This card is then
connected to the appropriate monitor.

Liquid Crystal Display (LCD): Introduced in watches and clocks in the
1970s and is now applied to the display terminals. In this, the cathode ray tube was
replaced by liquid crystal to produce the image. It does not have colour capability
and the image quality is relatively poor. The main advantage of LCD is its low
energy consumption. It finds its most common usage in portable devices where
compactness and low energy requirements are of prime importance.

Projection Display: Projection display technology is characterized by
replacing the personal size screen with large screens upon which the images are




projected. These systems are connected to the computer and whatever appears on
the computer terminal gets enlarged and projected on a large screen. These are
being used today for large group presentations.

Monitors

Monitors use a CRT to display information. It resembles a television screen and is
similar to it in other respects. Figure 2.11 shows a CRT monitor.

Fig. 2.11 CRT Monitor

The monitor is typically associated with a keyboard for manual input of
characters. The screen displays information as it is keyed in, enabling a visual check
of input before it is transferred to the computer. It is also used to display the output
from the computer and hence serves as both an input and an output device.

The monitor along with the keyboard is called a Visual Display Unit (VDU).

This is the most commonly used input/output device today and is also known
as a soft copy terminal. A printing device is usually required to provide a hard copy
of the output.

Printers
Printers are used for producing output on paper. There are a large variety of

commercially available printers today (estimated to be 1,500 different types). These
printers can be classified into categories based on:

e Printing technology
e Printing speed
o Printing quality
Printing technology: Printers can be classified as impact or non-impact
printers, based on the technology they use for producing output.

Impact printers use variations of standard typewriter printing mechanism where
a hammer strikes the paper through an inked ribbon. These printers have a mechanism
that touches the paper in order to create an image. Dot matrix printers and character
printers fall under this category.

Non-impact printers do not touch the paper when creating an image. They
use chemical, heat or electrical signals to etch symbols on paper. Many of these
require special coated or treated paper. Inkjet, laser and thermal printers fall under
this category of printers.

Printing speed: Refers to the number of characters printed in a unit of time.
Based on speed these may be classified as character printer (prints one character
at a time), line printers (print one line at a time), and page printers (print the entire
page at a time). Printer speeds are, therefore, measured in terms of characters-per-
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il pages-per-minute or ppm for a page printer.
Printing quality: Is determined by the resolution of printing and is
NOTES characterized by the number of dots that can be printed per linear inch, horizontally

or vertically. It is measured in terms of dots-per-inch or dpi. Printers can be classified
as near-letter-quality or NLQ, letter-quality or LQ, near-typeset-quality or NTQ,
and typeset-quality or TQ based on their printing quality. NLQ printers of resolutions
of about 300 dpi, LQ of about 600 dpi, NTQ of about 1200 dpi, and TQ of about 2000
dpi. NLQ and LQ printers are used for ordinary printing in day-to-day activities,
while NTQ and TQ printers are used to produce top-quality printing, typically required
in the publishing industry.

The section that follows explains the working of some commonly used printers.

e g

Dot Matrix

Dot matrix printers were the most popular impact printers used in personal computing,
These printers use a print head consisting of a series of small pins to strike a ribbon
coated with ink, causing the ink to transfer to the paper at the point of impact.
Characters thus produced are in a matrix format. The shape of each character, ie.,
the dot pattern, is obtained from information held electronically. (refer Figures 2.12(a)

and (b)).
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Fig. 2.12(a) Characters Formed using Dots Fig. 2. IZ(b) An Dot Matrix Printer

The speed, versatility and ruggedness, combined with low cost, tend to make
such printers particularly attractive in the personal computer market.

Typical printing speeds in case of dot matrix printers range between 40-1000
cps (characters per second). The one major disadvantage of this technology is that
the print quality is low.

Inkjet
Inkjet printers use a series of nozzles to spray drops of ink directly on the paper.

These, therefore, fall under the category of non-impact printers. Figure 2.13 shows
an inkjet printer.

Fig. 2.13 An Inkjet Printer

The print head of an inkjet printer consists of a number of tiny nozzles that
can be selectively heated up in a few microseconds by an IC register. When this
happens, the ink near it vapourizes and is ejected through the nozzle to make a dot
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-on the paper placed in front of the print head. The character is printed by selectively

heating the appropriate set of nozzles as the print head moves horizontally.

Laser

Laser printers use dry ink (toner), static electricity, and heat to place and bond the
ink onto the paper. They use a combination of laser and photocopier technology.
Printing is achieved by deflecting laser beam onto the photosensitive surface of a
drum after which the latent image attracts the toner to the image. The toner is then
electrostatistically transferred to the paper and fixed into a permanent image. Figure
2.14 shows a lazer printer.

Fig. 2.14 A Laser Printer

Laser printers are capable of converting computer output into print, page by
page. Since characters are formed by very tiny ink particles, they can produce very
high quality images (text and graphics), generally offer a wide variety of character
fonts and are silent and fast in use (refer Figure 2.14).

Laser printers are faster in printing speed than other printers discussed above.
Their speeds can range from 10 pages a minute to about 200 pages per minute,
depending upon the make/model.

Laser is high quality, high speed, high volume and non-impact technology that
works on plain paper or pre-printed stationary. This technology is relatively expensive
but is becoming very popular because of the quality, speed and noiseless operations.

Plotters

Plotters are used to produce graphical output on paper. It is a device capable of
producing charts, drawings, graphics, maps, etc. It is much like a printer but is designed
to print graphs instead of alphanumeric characters.

Based on the technology used, plotters may be pen plotters or electrostatic
plotters. While pen plotters have an ink pen attached to draw the images, electrostatic
plotters work similar to a laser printer. Image is produced by charging the paper
with a high voltage. This voltage attracts the toner, which is then melted on the
paper with heat. Electrostatic plotters are fast but the quality is generally considered
to be poor when compared to pen plotters. This is why pen plotters are more
extensively used as compared to electrostatic plotters. Flatbed plotters and drum
plotters constitute the most commonly used plotters.

2.5.4 Types of Computers (Mini, Micro, Mainframe
and Personal Computers)

Computers are classified on the basis of their speed of operation, memory capacity,
hardware facilities and price. In many cases, there is a considerable amount of
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overlap among groups. The classification of the digital computer based on the
processing hardware is given below.

¢ Mainframe computers

¢ Minicomputers

e Microcomputers
Mainframe Computers

Mainframe computers support a number of users to access a variety of software
applications. They are also called organizational computers because they are used
in large organizations. The major characteristics of a mainframe computer are as
follows:

e It offers extensive problem-solving capabilities.

e It works at a very high speed. A large mainframe computer can process
more than 100MIPS (Million Instructions Per Second).

e Ithas a high, memory capacity, measured in gigabytes or more.
e Itis very expensive.

e It can handle multiple applications within a timesharing environment. This
provides many users with the ability to perform different tasks.

e It can serve as the heart of a teleprocessing system with remote connections
all over the world.

e It can act as a database server and other computers can network with it.

¢ Governments, universities and large business organizations use mainframe
computers. Such organizations have extensive processing needs.

e Itis commonly used for complex problem solving or large-volume jobs.
Banks, insurance companies and large research projects involving extensive
processing demands and fast processing speeds use mainframe computers.

Minicomputers

Minicomputers are a scaled-down version of mainframe computers. The processing
power and the cost of minicomputers are less than that of mainframe computers.
Minicomputers have larger memory sizes and faster processing speeds than
microcomputers. Minicomputers are also called workgroup systems because they
are well suited to the needs of smaller workgroups within a large organization. The
major characteristics of a minicomputer are as follows:

e They have extensive problem solving capabilities.
e They have moderate memory capacity measured in megabytes or gigabytes.

e They have high processing speeds and operating systems with multitasking
and network capabilities.

e They can be equipped with drives for floppy disks, magnetic tapes, compact
disks, and hard disks.

o They can serve as network servers.

e Large organizations use minicomputers instead of one mainframe.

F
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Microcomputers

Microcomputers are developed from advanced computer technolo gy. They are
commonly used in homes, classrooms and in the workplaces. Microcomputers
can be home computers, personal computers, laptops, personal digital assistants,
etc. They are powerful and easy to operate. In recent years, computers have
become portable and affordable. The major characteristics of microcomputers
are as follows:

e They are capable of performing data processing tasks and can solve
numerical programs. Microcomputers work faster like minicomputers.

e They have moderate memory capacity measured in megabytes.

* They are inexpensive. A variety of microcomputers is available to suit smaller
business organizations and educational institutions.

e The processing speed of microcomputers is measured in megahertz. A
microcomputer running at 90OMHz works approximately at 90 MIPS.

e Microcomputers are equipped with drives for floppy disks, compact disks
and hard disks.

* Only one user can operate a microcomputer at a time.

 They are normally dedicated to one job. Millions of people use
microcomputers to increase their personal productivity.

» Useful accessory tools like clock, calendar, calculator, daily schedule
reminders, scratch pads and so on, are available in microcomputers.

* Laptop computers, also called notebook computers, are microcomputers.
They use a battery power source. Laptop computers use a keyboard, mouse,
floppy disc drive, CD drive, hard disk drive and monitor. They are costlier
than personal computers.

Personal Computers (PCs)

Personal computers (refer Figure 2.15) are microcomputers commonly used for
commercial data processing, Desktop Publishing (DTP), engineering applications
and so on.

Digital camera

Printer

Fig. 2.15 A Computer and its Peripherals

Components of a Computer System

Apersonal computer, commonly available today, comprises a processor (Pentium
IV), akeyboard, a mouse, a Floppy Disk Drive (FDD), a Hard Disk Drive (HDD),
a Compact Disk Drive (CDD), a colour monitor, a printer (dot matrix/inkjet/laser),
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RAM (Random Access Memory) and ROM (Read Only Memory). The
microprocessor/CPU, RAM, ROM and other supporting circuitry are
interconnected on a single board called motherboard as shown in Figure 2.16.

Networking

t
Microprocessor/CPU ,Pm :

Monitor, Keyboard
and Mouse Ports

Sound card

Video/graphics card Floppy disk

drive

RAM Motherboard

Fig. 2.16 Motherboard and CPU

2.5.5 Auxiliary Storage Devices

As already discussed, the RAM is a volatile memory having limited storage capacity.
The cost of RAM is also relatively higher as compared to secondary memory. Logic
dictated that a relatively cheaper media, showing some sort of permanence of storage,
be used. As a result additional memory called external or auxiliary memory or
secondary storage is used in most computers.

The magnetic medium was found to be long lasting and fairly inexpensive,
and therefore became an ideal choice for large storage requirements. Magnetic
tapes and disks are commonly used as storage media. With the advancement3'in
optical technology, optical disks are making inroads as one of the major secondary
storage devices.

Magnetic Disk

Magnetic disks are a direct access medium and hence the most popular online
secondary storage devices. Direct access devices are also called random access
devices because information is literally available at random or in any order. Access
to any location on the device is direct and so approximately equal access time is
required for each location. An example of this is a music CD where if you wish to
listen to the 5th song, you can directly select the 5th track. It does not require you to
fast forward the previous four songs.

Track Sector

Inter -
track
Gap

Fig. 2.17 Logical Layout of a Magnetic Disk

A magnetic disk is a circular plate made of metal or plastic, coated with
magnetized material. Often both sides of the disk are used. Data is recorded on the
disk in the form of magnetized and non-magnetized spots (not visible to the naked
eye) representing 1s and 0s.

I



Data is stored in concentric rings or #racks. To minimize the interference of
magnetic fields, the adjacent tracks are separated by inter-track gaps. Tracks are
commonly divided into sections called sectors. In most systems, the minimum quantity
of information that can be transferred is a sector. Usually 8 or more sectors per
track are found. Figure 2.17 shows a layout of a magnetic disk.

A track in a given sector near the circumference is longer than the track near
the centre of the disk. If bits are recorded with equal density, some tracks would
contain more bits than the other tracks. To ensure that each sector can store equal
amounts of data, some disks use variable recording density with higher density on
tracks near the centre than on tracks near the circumference.

Hard Disk

Unlike floppy disks, hard disks are made up of rigid metal. The sizes for the disk
platters range between 1 to 14 inches in diameter. Depending on the way they are
packaged, hard disks can be categorised as disk packs or Winchester disks.

e Disk packs: It consist of two or more hard disks mounted on a single central
shaft, because of this, all disks in a disk pack rotate at the same speed. It
consists of separate read/write heads for each surface (excluding the upper
surface of the top most disk platter and the lower surface of the bottom most
disk platter, as mentioned earlier in this unit). Disk packs are removable in the
sense that they can be removed and kept offline when not in use (typically
stored away in plastic cases). They have to be mounted on the disk drive
before they can be used. Thus, different disk packs can be mounted on the
same disk drive at different instances, thereby providing virtually unlimited
(modular) storage capacity. Figure 2.18 shows a disk pack.

———

Fig. 2.18 A Disk Pack

* Winchester disks: Italso consist of two or more hard disk platters mounted
onasingle central shaft but are of the fixed type. The disk platters are sealed
ina contamination-free container. Due to this fact all the disk platters, including
the upper surface of the top most disk platter and the lower surface of the
bottom most platter, are used for storing data. So, even though Winchester
disks have limited storage capacity as opposed to disk packs, they can store
larger amounts of data as compared to the same number of disk platters.
Figure 2.19 shows a Winchester disk.
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Fig. 2.19 A Winchester Disk

Another kind of disk called the zip disk is very common today. This consists
ofa single hard disk platter encased in a plastic cartridge. Such a disk typically has
a capacity of about 100 MB. The zip drive can further be fixed or portable. The
fixed zip drive is permanently connected to the computer system while the portable
ones can be carried around and connected to any computer system for the duration
of its use. In both cases however, the zip cartridge (the actual storage medium) is
portable just like a floppy, albeit with a nearly 100 times larger storage capacity.
Figure 2.20 shows a zip disk and zip drive.

Fig. 2.20 Zip Disks and Zip Drive

Floppy Disk

The disks used with a floppy disk drive are small removable disks made of plastic
coated with magnetic recording material. There are two sizes commonly used, with
diameters of 5% and 3% inches. Figure 2.21 shows a floppy disk.

o The 5% inch disk is a 5% inch diameter floppy disk. Earlier, such disks recorded
data only on one side and were called single-sided (SS) disks. Today both the
surfaces are used for recording and are called Double Sided (DS) disks.
These are available in two capacities — Double Density (DD), and High
Density (HD), where density refers to the number of bits that can be stored
per square inch area.

e The 3% inch disk is a disk of 3% inch diameter. These record data on both
sides and are therefore double sided disks. These disks come in three
differentapacities — double density, high density, and very high density. These
are smaller and can store more data than can the 5% inch disks.
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Fig. 2.21 A 3% Inch Floppy Disk

The storage capacity for any disk can be calculated as:

Storage capacity = Number of recording surfaces x Number of tracks
per surface x Number of sectors per track x Number
of bytes per sector

Thus, for a 3-1/2 inch high density disk which has 80 tracks, 18 sectors/ track,
and 512 bytes/sector, the disk storage capacity can be calculated as
follows:

2x80x% 18 x512= 14,74,560 bytes or 1.4 MB (approximately)

Table 2.6 provides the necessary details and associated storage capacities of
various kinds of floppy disks.

Floppy disks are extensively used in personal computers as a medium for
distributing software to computer users.

Table 2.6 Associated Storage Capabilities of Floppy Disks

r
5Y 2 40 9 512 3,68,13%% ]E]}é'tes or
5% 2 80 15 51 | 1%2HB00Lyies
3% ) 40 18 512 7,37,%%8 E}étes or
3% 2 80 36 512 29£g,§g or
Optical Disk

Optical disks are storage devices with huge storage capacity. It is a relatively
new storage medium and uses laser beam technology for writing and reading of
data.

Optical disks consist of one large track that starts from the outer edge and
spirals inward towards the centre (this is unlike the magnetic disk in which tracks
are concentric circles on the disk platter). An optical disk is also split up into sectors
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24.
25.
26.
27
28.
29.
30.
31.
32.
33.
34.

35.
36.
37.
38.

39.

Check Your Progress

Who invented the first mechanical adding machine? -

Name three types of computers.

What is the rate of accuracy of analog computers?

How are single and two-digits used in binary counting?

What is the radix of decimal number system?

Define binary coded decimal.

How are 128 characters represented by ASCII?

Why is memory required in a computer?

What happens in the direct access mode?

What are peripheral devices?

What is the most common medium of entering information ordataina
computer?

‘What forms the basis of bar coding?

Name three types of digital computer based on processing hardware.
Name the various types of microcomputers.

Why was the magnetic medium considered to be an ideal choice for large
storage requirements?

Why are magnetic disks popular online secondary storage devices”

2.6

ANSWERS TO ‘CHECK YOUR PROGRESS’

. You can minimize the ribbon in the following ways:

¢ By clicking on minimize ribbon button.
e Bydouble clicking the tab on the ribbon.

e Byrightclicking the tab from the contextual menu and selecting minimize
ribbon button.

¢ Bypressing Ctrl+F1 button.

. .docm file format is used when the document is to be saved in macro-

enabled documents.

. When you click on the Ignore option then MS Word will skip checking the

word or phrase in the document without making any change or modification
toit.

. To correct the Spelling Errors, follow the steps given below.

e Place the insertion point at the word marked as error by MS Word.
Now right-click the marked underlined word. The menu with spelling
suggestions will appear.




10.

1.

12,

13,

* Select the spelling that is correct for your document from the list of
suggested spellings as shown below in the Illustration.

* MS Word will change the marked word with the corrected spelling in
the document. '

. Header and footer are the important parts of any document. They are used

for representing information about the document such as the page number,
heading of the document etc. Header is present on the top of the document
and footer is present at the bottom of the document.

. File management is the task of maintaining the newly created folders or the

existing folders in the computer. It involves various tasks such as saving the
folder, maintaining the data and many more.

You can save the important files in the Libraries so that you can access the
specific folder and files easily. The Libraries option appears on the left hand
side of the screen.

. Steps to change the font size are as follows:

* Selectacell in which you want to set specific font size,

* Click on Font Size from the Font on Home tab. There are two options
for increasing and decreasing fonts.

* Select font size from drop down list. Otherwise, click on increasing font
or decreasing font.

. Steps to change text alignment are as follows:

e Select the cell.
e (Click on the Home tab.

* Click on vertical Alignment and horizontal Alignment commands in
Alignment group.
Arithmetic operators involve four major operations. These are: addition,

subtraction, division and multiplication. These are known as the basic
operators.

Replace function is used to remove the sequence of unwanted characters
from the Excel sheet with another set of characters. These unwanted
characters appear in the cell whenever the data is copied from one Excel
sheet to another.

Steps to set the Font colour are as follows:

o Select the cell.

e Click on Home tab.

e Click on Font colour option in Font group.

e Select colour that you want to set in selected cell. Text in cell gets
displayed with selected colour.

Steps to set border are as follows:
o Select the cell.
¢ Goto Home tab.
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1.3,

16.

17.

18.

19.

20.

21.

22,

23,

24,

25,

26.

27.

28.
29.

e Click on Borders option in Font group.
¢ Select Border style that you want to use.

Conditional formatting is a tool of formatting a cell of the worksheet that
contains some condition. In the conditional formatting there are different
types of rules, bars of option, colour scale, etc.

Validation is the process of checking the values for desired type, that is, it
provides the facilities to enter only those values as input in the cell which are
appropriate. It is very useful in official documents or as database for the
program.

Ribbon view is a substitute that provides the facilities of accessing the
commands for applications. It is organized using a horizontal bar. It provides
an easy way to access the commands, as all the commands are organized
using tabs and groups.

This view is primarily used to sort slides and rearrange them. This view is

also ideal to add or remove sections as it presents the slides in a more
compact manner making it easier to rearrange them.

In PowerPoint 2010, by default, files are saved in .pptx format. In the
previous version, files are saved in .ppt format.

You can change the order by simply right click the thumbnail of the slide
that you want to move, and then drag it to the new location.

There are various options available in the Handouts group. You can choose
any one of them like 1 Slide, 2 Slides. Also, you can print slides in horizontal
and vertical manner by using 4 Slides Horizontal, 4 Slides Vertical, etc.

To group pictures: under Picture Tools, on the Format tab, in the Arrange
group, Click, and then click Group.

Microsoft Office PowerPoint 2010 allows its users to use Shapes as Text
Boxes, which implies that you can add a Shape to your slide and then you
can use it as a Text Box to write text inside it, making presentations more
beautiful and informative.

Shapes can be added to Microsoft Office PowerPoint 2010, using the
Shapes option under the Illustrations group of the Insert Tab. You can insert
any shape of your choice and use it to write text.

The first mechanical adding machine was invented by Blaise Pascal in 1642.

The three types of computers are digital computers, analog computers and
hybrid computers.

The accuracy of result obtained from an analog computer is about 99 per
cent.

In binary counting, single digits are used for none and one. Two-digit numbers
are used for 10two and 11two [2 and 3 in decimal numerals].

The decimal number system has a base or radix of 10.

Binary Coded Decimal BCD is one of the early memory codes. It is based
on the concept of converting each digit of a decimal number into its binary




30.
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32.

33.

34.

33,

36.

3.

38.

39.

equivalent rather than converting the entire decimal value into a pure binary
form.

ASCII code uses 7 digits to represent 128 characters.

Memory in the computer system is required for storage and subsequent
retrieval of instructions and data.

In direct type of access, a separate read/write head exists for each track
and on a track the information can be accessed serially.

The I/O devices that provide a means of communication between the
computer and the outside world are known as peripheral devices.

The most familiar means of entering information or data into a computer is
through a typewriter-like keyboard that allows a person to enter alphanumeric
information directly.

Data coded in the form of small vertical lines forms the basis of barcoding.

The three types of the digital computers based on processing hardware are
mainframe computers, minicomputers and micro-computers.

Microcomputers can be home computers, personal computers, laptops,
personal digital assistants, etc.

The magnetic medium was found to be long lasting and fairly inexpensive
and therefore became an ideal choice for large storage requirements.

Magnetic disks are a direct-access medium and hence the most popular
online secondary storage devices.

SUMMARY

Info section gives important information related to file, by specifying its
properties. It enables you to protect documents, check for issues and manage
versions.

In MS Word 2010, files are saved in the default format, which is .docx.
This is because .docx format is more secured and damages can be easily
recovered.

There are two methods for saving a document in PDF or XPS format, both
are given below:

0 One method of saving the file in Pdf or Xps format is with the help of
Save As button.

o Another method of saving the file in Pdf or Xps format is with the help of
Save & Send section.

The “Print Preview’ feature of MS Word helps you to view on the screen
how the printed version of the document would look like before printing a
hard copy. In latest versions of the MS Word (MS Word 2010 Onwards),
there is “NO’ Print Preview Tab or Option.

As an alternative, click on the File Tab then on the option Print from the

menu that appears on the left side. The Print pane will be displayed. In the
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:’-gﬁf;e Au“:";“""’" and Print pane, click on the ‘Page Setup’ option to open Page setup dialog box.

CZ::;uT:rZ b In the Page setup dialog box define the Margins, Paper Size and Layout
options for setting the document text so that the text remains within the
printable area. '

e MS Word provides significant feature ‘Proofing’ for checking the text in the
document by using the option ‘Spelling & Grammar’. If you have made
mistakes in the document while typing the text then you can use the numerous
proofing features provides by MS Word to produce error-free and
professional documents.

NOTES

e Table consists of the rows and columns. Rows are horizontal and columns
are vertical. At the intersection of the rows and column there is a cell which
contains the text. We can format the tables according to our requirements.

¢ In Microsoft Excel 2010, various new features have been included which
help in creating an effective and attractive worksheet.

e Microsoft Excel is used for storing the data in the form of table. It is used by
several organizations to perform complex calculations, statistical analysis
and tracking income and expenses.

» Excel sheet contains data in cells. These cells can be converted into table
using Format as Table command. There are many built-in table styles
available in Excel 2010. When you apply table style on cells Design tab
appears.

e Hyperlink provides a connection enabling the user to open another
worksheet or workbook or any website. Text written in any cell may be
defined as hyperlink.

¢ Conditional formatting is a tool of formatting a cell of the worksheet that
contains some condition.

e Excel file is a workbook that contains one or more worksheets. Formatting
Excel sheet improves the presentation of the worksheet and makes it easy
to use. By default, each Excel file has three worksheets.

e Ribbon view is a substitute that provides the facilities of accessing the
commands for applications. It is organized using a horizontal bar. It provides
an easy way to access the commands, as all the commands are organized
using tabs and groups.

e Normal view is the default view in PowerPoint and this is primarily used to
create and edit slides. User can create/ delete/ edit/ rearrange slides, add/
remove/ modify content and manipulate sections from this view.

e Reading view is new to PowerPoint 2010 and it was created mainly to
review the slide show without losing access to rest of the Windows
applications.

¢ In PowerPoint 2010, by default, files are saved in .pptx format. In the
previous version, files are saved in .ppt format.

¢ Animation is one of the most common features of MS PowerPoint. It is
used to make an attractive presentation and for creating the interest in
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audience. MS PowerPoint 2010 provides different varieties of animations Office Automation and
Fundamentals of

that can be applied to text, picture or other graphics in multiple ways. Chomiitirs

e Timing group of Animations tab allows user to adjust the sequence and
timing of selected animations. User can also adjust settings if an animation

should be performed when the mouse is clicked or automatically. HOEES

o Microsoft Office PowerPoint 2010 allows its users to easily use audio-
visual content in the presentation. It supports a large variety of video files
such as, Windows Media File, MP4 Video, MPEG-2 TS Video and Window
Media Video File, along with audio files such as ADTS Audio, ATFF audio
file (aiff), AU audio file, MP3 and MP4 audio files.

¢ A SmartArt can be easily inserted in MS PowerPoint 2010. SmartArt icon
can be found in Ilustrations group. The various graphics available in this
option are All (basic block list, alternating hexagon, etc.), matrix, relationship,
hierarchy, etc.

e SmartArt is a method, which helps to improve the artistic view of a
presentation. SmartArt is nothing other than the visual representation of
textual data presented in a document. You can create SmartArt graphics in
PowerPoint, Excel, Outlook, and Word.

e You can modify the common print settings by using the drop-down menus.
The print previews are automatically adjusted to allow you to see how the
pages will appear before actually printing them.

e Charles Babbage, a nineteenth-century professor at Cambridge University,
is considered the father of the modern digital computer. During this period, N
mathematical and statistical tables were prepared by a group of clerks.

e Analog computers are generally used in industrial process controls and to
measure physical quantities such as pressure, temperature and so on. These
do not use binary digits for computation.

e Hybrid computers are the combination of digital and analog computers.
They use the best features of digital and analog computers.

o The hexadecimal number is formed from a binary number by grouping bits
in groups of 4 bits each, starting at the binary point. This is a logical way of
grouping, since computer words come in 8 bits, 16 bits, 32 bits and so on.

e A computer code that is very widely used for data interchange is called the
‘ American Standard Code for Information Interchange’ or ASCIL Several
computer manufacturers have adopted it as their computers’ internal code.

e The total memory capacity of the computer can be visualized as being a
hierarchy of components. It consists of all storage devices employed in a
computer system from the slow but high-capacity auxiliary memory to a
relatively faster main memory, to an even smaller and faster cache memory
accessible to high-speed processing logic.

e Computers have an input—output subsystem, referred to as /O subsystem,
which provides an efficient mode of communication between the central
system and the outside world.
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¢ Scanning devices are input devices that are used for direct data entry from

the source document into the computer system. Scanners facilitate the
capturing of information and storing it in a graphical format for displaying it
back on the graphical screen.

Inkjet printers use a series of nozzles to spray drops of ink directly on the
paper. These, therefore, fall under the category of non-impact printers. The
print head of an inkjet printer consists of a number of tiny nozzles that can
be selectively heated up in a few microseconds by an IC register.

Microcomputers can be home computers, personal computers, laptops,
personal digital assistants, etc. They are powerful and easy to operate.

Logic dictated that a relatively cheaper media, showing some sort of
permanence of storage, be used. As a result additional memory called external
or auxiliary memory or secondary storage is used in most computers.

Optical disks are storage devices with huge storage capacity. It is a relatively
new storage medium and uses laser beam technology for writing and reading
of data.

Three optical memory devices that are becoming increasingly popular in
various computer applications are CD-ROM, WORM and Erasable Optical
disks.

2.8

KEY TERMS

Ribbon: It is a set of tabs and commands to perform various sets of functions
and operations on documents.

Border: Border is used to add the border around the document that is on
left, right, top and bottom side.

Header: Header is added on the top of the document which contains the
important information of the document such as title, page number and other
information.

Footer: Footer is added at the bottom of the document which contains the
page number and other added information about the document.

Break: Break is used to start the new line from the new page in the
document.

Validation: This is the process of verifying the data to determine if the data
is of correct format and in the desired range.

Formatting: It means changing the property or the style of cell according
to the need of the user.

Review tab: It contains Proofing, Language, Comments, and Compare
options. It is utilized for spelling and grammar editing.

View tab: The View tab manages how your screen looks as you create
your presentation.

Table: It is a representation in the form of rows and columns for managing
and presenting the data.




e Illustrations: An illustration is the area which is used to insert different

types of shapes, Charts, SmartArt graphics.

e Digital computers: These are commonly used for data processing and

solving problems using programs.

* Hexadecimal number: It is formed from a binary number by grouping bits

in groups of 4 bits each, starting at the binary point.

2.9

SELF-ASSESSMENT QUESTIONS AND
EXERCISES

~N N AW

o0

15.

16.

17.
18.
19.
20.
21,

Short-Answer Questions
1

What are the names of the notes that are added at the end of the page and
at the end of the document?

. Write the steps involved in the creation of the table.

. Write the steps involved in adding the break in the document.

. Write the steps to add column to the table.

. What is use of Sort command?

. Which command does Excel use for replacing data?

. Which sign will appear in header of each column when click on filter

command?

. What is use of Find command?

9. Name the basic arithmetic operators?
10.
11.
12.
1%
14.

Why is the text function used?

How can one exit the slide show and return to the presentation?
What s the shortcut key to save the presentation?

What is the function of Design tab?

used to display information such as page numbers, the date
and other information.

(a) Cut and paste (b) Header and Footer (c) Find and Replace (d) None of
these

Blank Presentation does not contain

(a) Picture (b) Text (c) Content suggestion (d) All of these
Microsoft PowerPoint is a part of
(a) MS Word (b) MS Office (c) MS Excel (d) MS Access
Who is considered as the father of modern digital computer?

Name the various types of computers.
Give one difference between binary and octal number system.
Define ASCIL

Give any three criteria’s of storage evaluation.
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22,
23,
24.
25
26.
27.
28.

What isa QWERTY keyboard?

What technology is used by the optical barcode reader?
What are the two types of CRT displays?

What is the use of a plotter?

How are digital computers classified?

Name any four characteristics of a microcomputer.

Define auxiliary memory.

Long-Answer Questions

L.
2,

o 3 N W

10.

1178

Define table. Explain the different actions that can be performed with table.

Define header and footer. Write the steps involved in adding header and
footer to the document and also explain how to remove the header and
footer from the document.

. Define border and shading. Explain the steps to add the border and shade

to the word document and the possible actions that can be performed.

. What do you understand by the term formatting? How is it done in MS

Word 2010?

. Why bullets and numbering is an important feature in MS Word?

. What are the various steps for creating custom bullet and numbering?

. Discuss the differences between MS Word 2010 and 2016.

. How will you align a statement in vertically middle and horizontally centez?

Explain with example.

. Prepare an Excel sheet to calculate the average of given numbers using the

average function?

The numbers are: 12, 43, 65, 32, 76, 72.
Prepare an Excel sheet to calculate the financial total using the PMT fumction?
The data is:

D2 - Rate

D3 - no of payments

D4 - Principal

D5 - Payment

E2 - 8%

E3-34

E4 - 5,000.00

Prepare an Excel sheet for Adidas showroom which contains the types of
products, their prices and code of every product. After this, use the IF
functions if number in B1 is less than 1500 print 100 else print 200, where
column B is for prices of products.
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12,

13.

14.
15.
16.

11,

18.

19,

20.
21
22.
23,
24.
25.
26.
27,
28.

29,
30.
31.

32.

Make a small Excel file and with list of 20 student name and their height.
Then, use conditional formatting to make the cell red for all those whose
height is less than 170 cm. Also attach picture or snapshots.

What do you mean by the term Charts in Excel. Explain the different functions
that are associated with Charts?

What are the differences between MS Excel 2010 and 20167
Discuss the steps to insert the chart and entering the data into it.

How are tables useful in PowerPoint 2010 for organizing and presenting
data?

Discuss Microsoft PowerPoint as the most popular program for creating
the interactive presentations.

How can you insert charts in Microsoft PowerPoint 2010? Write the steps
for inserting data in charts.

Elaborate the process of adding the animations and effects in your
presentation?

Explain the new features added to PowerPoint 2016.

Give a brief description of the various generations of computers.
Differentiate between digital computers and hybrid computers.
Differentiate between binary and decimal number system.

Explain the use of BCD.

What does a memory system consists of? Explain.

Describe the role of /O devices in a computer system.

Write a short note on display devices.

What is the difference between an inkjet printer and a laser printer?
Elaborate.

Explain the characteristics of minicomputers?

Describe the process of storing data in magnetic disks.
Write short note on:

(a) Hard disks

(b) Optical disks

Explain the advantages and disadvantages of CD-ROM.
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3.16 Key Terms
3.17 Self-Assessment Questions and Exercises
3.18 Further Reading

3.0 INTRODUCTION

Office automation refers to the varied computer machinery and software used to
digitally create, collect, store, manipulate, and relay office information needed for
accomplishing basic tasks. Raw data storage, electronic transfer, and the
management of electronic business information comprise the basic activities of an
office automation system. DSS is different from MIS in terms of its processing
capabilities. This is because the information in DSS is processed to support the
decision-making process for a manager, whereas in MIS, data is processed and
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converted into information. Several forces are always at play within an organization.
Executive Support Systems (ESS) which is designed for senior executives of
organizations. Executives are responsible for the growth and survival of the
organization. Expert systems offer an economical and practical way to capture,
refine and proliferate management skills. These systems provide a framework in
which to document the questions and answers that experts use to solve analytical
and operational problems.

Computer networks, which are essential for the structure of an organization.
Local Area Networks (LANs) offer reliable high-speed communication channels
which facilitate communication processes. Therefore, this distributed processing
system interconnects the information processing tools in a small area, suchas a
building complex, college grounds or a workplace structure. LANs allow multiple
workstations to share access to multiple host computers, other workstations,
printers and peripherals as well as connections to other networks. A computer
network is an interconnection of various computer systems located at the same or
different places. Networks help data transmission over distances. Speed, reliability,
cost and accessibility are taken into account when considering a network. Data
communication networks, components of a network, circuits, topologies and design
goals, switched and non-switched.

In this unit, you will study about the office automation systems, decision
support system, transaction processing systems, executive support systems, expert
systems, enterprise resource planning systems, concepts of communication,
networking, different types of computer network types, communication networks
and topologies. N

3.1 OBJECTIVES

After going through this unit, you will be able to:
e Describe the office automation systems
¢ Understand the decision support system
o Define the term transaction processing systems
¢ Learn about the executive support systems
o Understand expert systems
¢ Define the enterprise resource planning systems
e Explain the concepts of communication
e Now about the networking
e Understand the different types of computer network types
¢ Describe communication networks and topologies




3.2 OFFICE AUTOMATION SYSTEMS

Office automation systems is a type of information system that aids in automating
office tasks. Ithas a limited role in decision-making and is more usefil for operational-
level people. The information derived from this type of a system can be used for
rule-based decision-making by managers at the operational level. This system,
however, plays an important role in automating several functions of an office and
thus helps in creating paperless offices. This system helps in increasing the productivity
and efficiency of the office workforce by automating simple tasks. This system
mostly deals with operational data. More and more modern businesses, today opt
for a paperless office environment as this brings in unique advantages for the business,
which are as follows:

e Office work becomes faster and process-driven.
* All basic level data is digitized and stored for future action.

An example of Office Automation System is the MS Office suite of software,
which helps in automating simple office tasks like presentations and documentation.

Office Automation Systems (OAS) specify the application of computers
and communication technology for executing office functions. These automation
systems are the combination of hardware, software and personnel in information
systems that process office transactions and support office activities at various
levels. OAS also includes a wide range of support facilities, such as word processing
and electronic mail. These facilities enhance the productivity of managers by
providing them secretarial assistance and better communication facilities. Office
activities may be grouped under two classes, which are:

1. Activities performed by clerical personnel like clerks, secretaries and
typists. These personnel execute a number of operations like typing,
scheduling of meetings, retrieving documents, calendar keeping and
conferences.

2. Activities performed by executives like managers, engineers and other
professionals, such as economists and researchers. They carry outa
number of operations like conferencing, controlling performance, and
production of information such as messages and reports.

Nowadays, computer-based office automation devices, such as fax machines
and computer systems are used in offices. These computer-based Office
Automation Systems not only fulfil the communication needs of office managers,
but also help them to communicate with external entities such as investors and
vendors. Some of the applications of the OAS are:

* Word Processing: This refers to the computer-assisted preparation of
documents, such as letters and reports, using textual data. Text is entered
through a keyboard that is displayed on the screen of a visual display unit.
Data once entered into the screen through the keyboard can be manipulated
in various ways. Data can be edited and stored on magnetic media such as
a hard disk or a floppy disk. After this, the stored data can be reproduced
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using simple commands that eliminate the need for drafting the entire
document again. In the word-processing system, spelling errors are
automatically checked and pre-defined letters are generated. Currently, these
word-processing systems can even be modified to understand and convert
the dictation of the manager to text by using the word processor.

¢ Electronic Filing: This facilitates the storing of incoming and outgoing mails
or documents on a magnetic medium. In this, the information is captured
from documents and stored in the hard disk or on the magnetic medium for
future reference. Computer-based electronic filing systems have the
advantage of saving space and providing cross-reference indexes that can
be easily modified. These cross-reference indexes contain pointers to the
location of the document.

¢ Electronic Mail: Involves the transfer of letters and other documents
through telecommunication lines, rather than physically delivering the
documents. An electronic mail system requires a telecommunication network
and software. This system speeds up the mail deliveries and reduces the
cost and time taken by sending mail through paper. In addition, Local Area
Networks (LANS) facilitate the sharing of data files and software among
many different computer terminals. Workstations/terminals can also transfer
data/messages to each other. Voice mail, which is another form of e-mail,
transmits the messages in the form of digitized voice. The receiver can hear
the spoken messages in the voice of the sender by dialing a voice-mail
service.

String and Filing Data .

String represents the collection of characters. Handling of character strings is the
initialization, processing and manipulation of character or string. The character
strings are handled and manipulated in implementing the system for following

meaningful operations:
¢ Reading and displaying the string.
¢ Concatenating the string.
¢ Copying string from one location to another.
¢ Comparing the string as to whether they match or not.
e Extracting the part of string or character.

The filing system is designed to provide a simple filing system used for office
automation system and applications. Its design goals and functionality are covered
in the document. The strings are used with filing system and sent to the storage
device for further processing with reference to decision support system and system
implementation but for this the flash chip is required. The following constraints are
checked to implement this chip for DSS:

e The flash is divided into sectors (128K).
e Each sector is divided into pages and each page is 264 bytes long.
e Pages can only be written as a whole.

PR T I T T TR Y

i AT



* Pages should be erased before being written.
e Each page can be written a limited number of times.

* Erases are on a larger granularity than writes, for example 64k-erases, 528-
byte writes, etc.

Filing System is a customer service and developed to provide a mechanism for
individuals to submit and track the processing of certain applications. The data
(strings) is submitted to assist in getting the information provided by users. The
filing system provides a question and answer format for users to follow to complete
the form data and it also provides a user-friendly interface that helps for exact
entry of form data. As the user progresses through the application process, the
filing system automatically saves the user’s data as the user navigates from system
to system. Once the filing data has collected the submitted data from the user, the
system transmits the data to the appropriate benefits for admin side. In these days,
data warehousing processes separate Online Analytical Processing (OLAP) from
Online Transactional Processing (OLTP) by creating a new information repository
that integrates basic data from various sources, properly arranges data formats,
and then makes data available for analysis and evaluation aimed at planning and
decision-making processes. Filing data is used for storin , analysing and reporting
taxpayer accounts and collections information.

Figure 3.1 shows that data can be retrieved and sent for modeling to analyse
the data. This data can be string.

| Decision |

maker A

(system 3
user)

Queries Results

Data
retrieva

Data for analysis

Extracted Commands

data

String Database and Filing System

Fig. 3.1 String database and Filing System Approved by Decision-Maker

DSS uses one or more strings (data) to store the databases and sets of files that
provide information to support the decision-maker. The strings are updated in
filing system by suitable transaction processing system. It also supports the decision-
maker as an external entity or even as a part of system.
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proninent Iformatin 3 3 TRANSACTION PROCESSING SYSTEMS

Concepts and Networking

Transaction processing systems are crucial for the smooth functioning of an
NOTES organization. The objective of this system is to capture all transaction-related data
between the organization and its external and internal customers. Typically, the
transaction-level data is stored in a preformatted manner in a relational database
for further action in the future. TPS is the most widely used form of information
systemn, as it provides management with the flexibility of storing data in a structured
manner and retrieving it at a later date using the query facility. The system also
helps in aggregating and summarizing the data for creating management reports.
These reports are further improved using visualization tools, which help management
in understanding situations and scenarios better. The system deals with tactical
data from within the organization.

Anexample of TPS is a sales management system with a relational database
management system at the server-side back end and a customized front end to
interact with the users.

The Transaction Processing System (TPS) is defined as an information system
that processes transactions and produces reports that represent the automation of
the fundamental, routine processing. These reports support business operations,
but do not provide any support to the user to conduct the decision-making process.
Figure 3.2 shows how TPS uses and produces data.

GO

Fig. 3.2 Transaction Processing System

TPS is also termed as data processing system with authority at the lowest level in
the management hierarchy of an organization. Transactions in TPS can be both
internal as well as external in nature. External transactions are the transactions
generated by customers and suppliers, whereas internal transactions are generated
within an organization.

3.4 DECISION SUPPORT SYSTEMS

Decision Support System (DSS) helps the senior management to take strategic
decisions. Contrary to other systems, decision support system is developed with
the objective of providing the users (top management personnel) with unstructured
information. This system helps the management to develop the ‘what if analysis’,
so that different scenarios can be developed for decision-making. Decision support
systems deal with both internal and external data. Usually, this system is custom-
built with features like business dashboard, scenario panel, and so on.

This system is complex with models (internal) working on the data to provide
senior managers with decision support. Unlike the transaction processing system,
this system is not query-dependent. Its main role is to access data from a data
repository and then pass that data through a model (mathematical, heuristic,
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statistical, econometric, operations research, combinatorial, etc.), so that the top
management can take better decisions by doing either the ‘what if analysis’ and
scenario building or by doing ‘predictive analysis’ to get some insight into a business
issue. This system is very costly to build and requires advanced analytics tools.

Overview of DSS

The use of computers to solve complex analytical problems can be traced to the
early days of computing in the 1960s' and became an established field of work
for facilitating management decision-making (Michael S. Scott Morton, 1971). This
class of systems loosely clubbed as Decision Support Systems?, changed the way
in which MIS was conceived in those days (Gordon Davis, 1974) and together
with the work of Little (1970)—who observed that the biggest obstacle with
management science/operations research based models was that people at the
decision-making stage rarely used them and thus incorporated models inherently
in such systems—laid the foundation of today’s DSS. The framework for decision
support® was, however, laid much earlier by Gorry and Scott Morton (197 1), and
also in the seminal works of both Herbert Simon (1977) and Robert N. Anthony
(1965).

DSS is required when we have to take decisions on unstructured and semi-
structured problems. This means that the problem itselfis not clear, implying thata
lot of ambiguity is present in the problem and its possible decision path outcomes.
Such decisions are often required to be taken by the top management. In such
cases, a lot of judgement, experience, intuition and expertise are required to take
decisions as one is treading an uncertain path. No precedent is normally available
for such decisions. A decision support system is required in such a case. A DSS is
an information system class which assists in decision-making as described above,
The system is robust and allows the user to create a host of alternative decision
paths by analysing its data (internal data of the organization stored in a transaction
processing system as well as external data), and then suggests the ‘best fit’ solution
for the problem at hand. It prompts the decision-maker to take the best solution,
but does not decide on the decision-maker’s behalf. All the while, the DSS helps
the decision-maker by providing him with supporting information about each decision
path and is very interactive. The easy-to-use user interface hides the layers of
model housed in the system and the user stays oblivious to the complexities of the
system. It must be pointed out that the decision-maker has control over the process
of decision-making, and makes choices at each stage of decision-making like
choosing the database. The interactive nature of the system helps the decision-
maker maintain control over the decision-making process. The system only works
on data and provides alternatives to the user and also hints at the best pos sible
solution. According to Gorry Scott Morton (1989), decision support systems
‘couple the intellectual resources of individuals with the capabilities of the computer
to improve the quality of decisions. They comprise a computer-based support
system for management decision-makers who deal with semi-structured problems.*
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Concepis and Networking  Even though DSS can be of several types, fundamentally, each DSS will have the
following components:

NOTES o Interactive User-System Dialog Management Subsystem: DSS
requires continuous user interaction. Sometimes, the system should prompt
the user to give an input; at other times the user should be able to control
the processing. A typical user-system dialog management subsystem will
have the following elements:

o User Interface: The user interface of a DSS has to be dynamic and
GUI-based. It has to be an easy-to-use user interface, as most users are
not technical experts but management experts (top management) and
hence the interface should be minimalist in design. Also, the system should
be able to interact with the user in an interactive mode and hence, the
user interface has to be dynamic.

o Request Constructor: Since DSS works on an interactive dynamic mode,
it needs a request constructor (incorporating aspects of Language Query
Interface) which can convert the user’s instructions into a model
understandable form, and send the model’s data request to the database,
and the model’s instructions/requests to the user.

o Data Management Subsystem: Data is the most important component
of a DSS. Without data a DSS cannot function. The data management
subsystem manages the data fora DSS. Data is accessed ina DSS in many
ways such as: ad hoc basis, structured query basis and heuristic search
basis. Hence, a strong data management subsystem is required to ser¥ice
the varied data requests from a DSS. The subsystem has the following
elements:

o Database Management System: 1t is the data store for the DSS. It
manages the data and performs all functions that a typical DBMS package
does. In fact, in most DSS, a commercial DBMS or RDBMS package is
used to perform this task.

o Query Control: This is an element tailored to handle the query
requirements of DSS. It may connect the database directly to the user
interface or to the model base or both.

o Meta Data: This contains data/information about the data that is stored
in the database. This helps the DSS in understanding the data in the
database properly and helps in creating ad hoc queries.

e Model Management Subsystem: This is the unique feature of a DSS
that makes the system special. However, this also makes the system very
specific. There are very few examples of a generalized DSS, as generalized
models are not available. Those that exist, work on half-baked solutions.
The model management subsystem may use different classes of models
such as:

o Optimization models.
o Simulation models.
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0 Heuristic models.
0 Deterministic models.
0 Predictive models.

Each class of model is used to solve a specific class of problem like (say) a
routing problem or a scheduling problem or a combinatorial search problem. Model
and model management has several connotations in DSS literature and there have
been wide-ranging definitions of these terms. The common strain that evolves
from the plethora of definitions is that a model is conceived to consist of a solver
and a model for solving a problem and data (Ramirez, 1993), where model
represents relationships between variables, data represents the values of the
variables under consideration and the solver is the tool that enables the computation
of the variable values and their relationships. It has also been conceptualized in
some literature as a procedure which works on the data to give an output after
analysis.

The model management subsystem has the followin g elements:

* The Model Base Management System: A model base or rather a model
base management system is a software (is conceptually like what the DBMS
is to data) which has the capabilities to manage a model for it to be useful to
the decision-maker. It is the core of a DSS. It supports the generation of
models and works with data on one hand and user-supplied instructions on
the other.

® The Model Command Processor: It is the entity that processes the
commands coming from the dialog management subsystem.

* The Model Executor or Solver: It is the heart of the system. It is the
process through which the model is solved (using some algorithm). It works
with the model as generated by the model base (with instructions from the
user), the request constructor (dialog management subsystem in general) to
get the parameters of the model from the user and data from the data
management subsystem. It then solves the problem and displays the results
and some variations of the best fit solution through the dialog management
subsystem. The alternative solutions, as provided, help the user in decision-
making,

MIS and DSS

ADSS is different from an MIS. An MIS is used for generating consolidated
reports. Generally, these reports are in a fixed format and generated at a regular
frequency. When an MIS is designed, the reports it is required to generate are
decided a priori and become part of the MIS. If a user wishes to generate an
additional report, the system analyst may be required to modify the MIS. However,
asophisticated MIS may not require intervention for generating an on-demand
report. Most MIS are Web-enabled and provide Web interface. An MIS can
also generate exception reports to highlight deviation from the set targets. The
target figures are input to the MIS that may be changed periodically. To give an
example, sales target for a mobile cell company for December may be 1,00,000
new connections, whereas this figure may be 80,000 for J anuary. The manager of
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this company would be interested in knowing zonal/regional sales, the plans that
sell well/not so well, etc. based on the set targets.

In contract, a DSS helps in non-structured and semi-structured decisions.
The objective of a DSS is to help the decision-maker in analysing the situation
using the available data. The analysis may be required to predict future patterns,
study the impact of parameters on future patterns, etc. A manager may like to
increase sales and his options may be to increase the advertising budget, add
more sales force, set up more sales offices or reduce prices. In terms of Simon’s
decision-making model, the problem is to increase sales and the aforesaid solutions
are possible choices. In order to choose a solution, the manager would have to
analyse each solution using possibly different analytical tools. Once a solution has
been chosen for implementation, one has to monitor its impact. One can categorize
a DSS based on the analytical support it provides.

Types of Decision Support Systems

A manager makes use of organizational data as well as external data for trend
analysis. The external data may come from a marketing company involving
competition, etc. There are two basic types of decision support systems: model-
driven and data-driven. A model-driven DSS deploys a standard model to analyse
data. The user provides data to the system in a pre-specified form and the DSS
creates a parameterized model. A regression model, for example, assigns weights
to all free variables such that the variance in the bound variable is captured. A
manager can vary these weights to study the impact of changes on the bound
variable. Model-driven DSS have a strong theoretical model embedded in t]:lem.

A data-driven DSS focusses on data and on retrieving some interesting,
previously unknown and useful information from the data. Such systems are semi-
automatic and require human intervention. Data mining techniques form a major
percentage of data-driven systems. Data mining techniques are used for retrieving
the following types of information:

Associations: The most common use of association discovery is in the
market basket data analysis. A store would like to find out the items that people
tend to buy together so that these items can be shelved accordingly or introduce a
promotional scheme on one item only. The strength of the system is that the user
does not have to specify the items at all. The data mining system analyses sales
data and retrieves this information.

Sequential Pattern Identification: Such systems are used for identifying
association over time; for example, if one buys a camera, he is likely to buy a
tripod in the next one month. But the user does not have to specify the items or the
time frame. It is the responsibility of the data mining system to discover these
sequences. Notice that if one knows the items and the time frame, it is a simple
database query.

Classification: Let us take an example: A bank receives an application for
aloan and the loan manager wants to classify the application as a potential risky
loan or good loan application. A data mining classification system will look at past
applications and identify the parameters as well as values to propose a classification
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systems.

Data mining systems use statistical techniques, genetic algorithms, analytical
hierarchy processes and heuristics/rules-based systems. Let us look at the
components of DSS in detail.

NOTES

DSS Applications

In this section, we will list some of the applications of DSS. Banks use classification
systems to categorize a loan application as potential good or bad loan. A major
mobile company in India does similar analysis to identify customers who are likely
to switch service providers. Marketing departments may use a classification system
to identify volatile customers and promotion schemes for them. Indian Railways
has analysed passenger reservation data to upgrade to high class policy for
passengers. Their analysis had shown that higher class seats remain unoccupied
and many lower class passengers are not able to travel. Shifting some passengers
to higher classes without extra charge brings in revenues for seats at a reduced
rate which is better than no revenue at all; it leads to better utilization of resources
and convenience to passengers.

Airlines use statistical models to forecast passenger traffic based on their
past traffic, carrying capacity and traffic growth pattern.

All major projects go through scheduling and planning. The project manager
estimates the time and cost of various activities involved in the project. If similar
projects have been done in the past by the organization or some other organization,
past data is analysed to estimate most likely, optimistic and pessimistic time for
each activity and the whole project. Such analysis helps the organization plan the
project much better.

You are probably aware that the Indian Railways schedule goods trains and
their routes dynamically based on the demand. A scheduling system has been put
in place after considerable effort whose objective is to minimize delays and maximize
returns. Companies, such as Big Bazaar that carry a large number of products and
have multiple stores across the country use DSS to decide order quantity and
reorder point to maintain optimum inventory levels. A restaurant can use a decision
support system to rearrange tables to maximize revenues and minimize customer
waiting time. Dynamic pricing or promotional schemes may be introduced to shift
some of the peak period demand to off-peak periods. Blood banks face a situation
where they do not know the location and demand for blood in advance. They use
a probabilistic model to decide storage location for blood. A similar problem is
faced by manufacturing organizations. They use a similar model to decide the
product mix for manufacturing to maximize revenues. Applications that we have
just described are model-driven systems.

A software company analyses network traffic to identity patterns that may
correspond to hacking, etc. There is no fixed pattern that corresponds to hacking,
Nommal traffic is observed and any change in the traffic pattern has to be picked
up as a potential hacking attack. Such applications are data driven. Credit card

companies use classification systems to identify potential customers. i;lf - Liaming -
ateria
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DSS helps in various application areas to a large extent for the top management
NOTES support, training of managers and variety of decision-making situations. The areas
of applications of DSS in production and finance are:

e Production: DSS helps in various areas of production, such as cost
estimation and analysis, production planning and scheduling, making or
buying product decisions, inventory planning and control of manpower.

e Finance: DSS helps in various areas of finance, such as capital budgeting,
financial planning and analysis, tax planning, strategic financial planning,
budgeting, cash and working capital management, debt and equity financing
analysis, foreign exchange risk management, financial performance analysis
and variance analysis.

¢ Future Decision-Making: DSS helps managers to activate simulation
models to access the required information from the database for decision-
making. The simulation model is an interactive activity where the manager
can experiment and see projected results for the planned action that are to
be implemented in future.

Interactive System for DSS

Interactive system for DSS helps a decision-maker to evaluate the result of a
particular course of action to solve a business problem. If a shortcoming exists in
the solution, then the decision-maker can modify the solution or try for another
solution.

In this way, interactive system of DSS helps in providing the best solution to
a particular problem that can be applied in the concerned department of the
organization. Interactive system for DSS is created using various query and high-
level programming languages, such as SQL, COBOL and FORTRAN.

These languages prompt and help a user to make commands to retrieve the
information with a user-friendly interface.

Modelling in DSS

In any business, all the decisions that are taken can be divided into two groups —
programmable and non-programmable. A programmable decision is one which
can be simulated by a computer. In case of a non-programmable decision, the
rules on which they are based keep on changing depending on the internal and
external environment of the organization, such as government regulations and macro-
economic situation of the country.

A decision support system helps us in taking a programmable decision only,
as it is based on simulation technique. A decision support system can take various
approaches which can be categorized into three categories of models. These three
categories are mentioned as follows (refer Figure 3.3):

1. Behavioural Models.
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2. Management Science Models.
3. Operational Research Models.

m Management
Science Model
1. Behavioural Models: 4 behavioural model is an explicit statement of
variables that impact the observed actions of a system of objects or a
specific object or entity (Daniel J Power). It refers to that category of
DSS models that are based on the logic of understanding, explaining and
predicting the behaviour of business variables. Most of the models of this
category are based on statistical tools of analysis or mathematical equations.
Some of the models that fall in this category are:

a. Market Research Model: A market research model analyses the
information gathered in any market research by using statistical
formulas, such as variance, correlation, testing of hypothesis, etc.

b. Time Series Analysis: This is an essential model which uses data
from the past records to forecast variables like demand of aproduct,
cost of living index in a city or country, etc., by reducing the seasonality
effect.

C. Regression Model: This model essentially uses regression method
for business forecasting variables, such as sales of a product.
Regression is a tool for statistical analysis which quantifies a relationship
between uni or more independent variables and a dependent variable.

2. Management Science Models: All the DSS models that use the tried
and tested principles and techniques of various functions of business
management fall in the category of management science models. Most of
these models are used directly for the desi gn of decision support system.

Some of the examples of management science model have been discussed
below.

a. Budgeting Model: This model is used for planning, preparing,
monitoring and controlling various budgets like annual budget of a
company, sales or promotional budget, budget of an event, inventory
budget, capacity budget, production budget, etc.

b. Return of Investment Analysis: Any business would like to calculate
the return on each of its investments. This model gathers required
financial data, such as investment, inventories, sales, bills, receivables,
etc., and uses the financial equation of ROI (Return on Interest) to
give the result.

c. Cash Budgeting Model: Cash budgeting model helps a finance
manager in assessing and planning the liquidity condition of the
company.

Operations
Research Model

Fig. 3.3 4 DSS System
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d. Break-Even Analysis Model: This model gives the volume of
production and sales that a company should reach so that its fixed
costs are met and it starts making profits.

e. Cost Accounting Model: This model analyses data to give information
like total cost of acquisition of an asset, cost of manufacturing or
purchasing a product, allocation of overheads, etc.

. Project Planning and Control Model: This model uses the project
management techniques to assess the time required to finish a task/
project, thus helping in planning, monitoring and controlling them.

g. Procedural Models: These models are based on very simple
mathematical formulas to arrive at critical results, such as reorder level
of inventory or optimum order quantity. This category also includes
models with simple process decisions, such as vendor selection (by
purchase department) or candidate selection (by HR).

3. Operational Research Models: Operational research models is the
category of mathematical models which use tools like algebra, probability,
calculus, etc. in analysing the problem and giving the solution. They
necessarily use practical assumptions of real life situation to arrive ata
conclusion or solution. They are essentially used in production management
or project management. Some operational research models are:

a. Linear Programming Model: This model essentially uses linear
programming equations to calculate the optimum allocation of various
resources, such as raw materials, manpower and production capacity
of the factory. It calculates the quantity of each of the product that =
needs to be produced to maximize the profit of a manufacturing
company.

b. Inventory Control Model: The tools like ABC analysis are used in
this model to ensure that stock of inventory can be reduced to the
minimum to ensure better liquidity and at the same time the company
does not run out of critical inventory items.

c. Material Requirement Planning Model: This is another model to
help in the area of material management and is used to minimize
inventory cost. This is a relatively simple model which is used in
companies which have standard products and hence each bill of material
can be mapped against a product for which it was used. This is especially
used when there is high seasonality factor in the demand of the product.

Out of all the models that discussed above, the ones that are based on
mathematical or statistical calculation indicate a definite decision that should be
taken whereas the models which are based on principles of management form a
basis on which the decision can be taken. In short, they are helping to improve the
quality of decision that is to be taken.

Use of DSS Technology for Marketing, Finance, Production and
Human Resource Management

A large organization has enormous in flow of data. Data has an extensive usage
and is not restricted to a single channel, for example, each department maintains




the attendance of the employees working in their department. HR needs attendance
related data to prepare the payroll while the finance department needs the payroll
information for disbursement of salaries. Similarly, projections of production are
made by a production manager. The data is put to multiple use by different
executives. Marketing manager needs this information to base future sales target
for his team, for planning the time and budget allocation for promotion of a new
product. Similarly, the data related to inventory of raw material, work-in-progress
and finished goods are maintained by the production department. The same data
can also be used by the finance department at the time of preparing quarterly or
annual balance sheets.

Thus, any organization needs a seamless flow of data from one department
to another. If data is entered into the system at one section or department, it
should be available for analysis and used by the other department without having
to enter it again. To accomplish and maintain networked flow of data among various
departments, one needs an integrated system, such as a DSS based on Enterprise
Resource Planning (ERP).

Enterprise Resource Planning (ERP) is an enterprise-wide information
system designed to coordinate all the resources, information, and activities
needed to complete business processes such as order fulfillment or billing.

An ERP based decision support system assists in the amalgamation of
managerial cadres, workforce and infrastructure. An ERP based decision support
system has a distinct ability to coalesce different business units into a single system
so that it could cater to all business facets. Thus, it gives a holistic view of the
organization.

ERP software essentially has the following features:

o Single Database: An ERP software is integrated on a single database
system. All applications use the same database for data input and retrieval.

e Integration of Applications: It is an integrated set of various business
applications that includes accounts and finance, marketing, human resources,
production, etc.

¢ Integration of Internal and External Applications: It integrates the
internal applications of an organization with external applications to help
access the databases of a supplier and customer.

e Automated Business Transactions: In an ERP system, business
transactions, such as calculations of schedules of production, forecasts of
demand, inventory level, production cost, cost of acquisition of an asset,
etc., are automated to reduce manual intervention.

o Report Generation: ERP has automated recording, monitoring and report
generation features to facilitate the process of decision-making.

¢ Relational Database: Itis based on relational database that integrates
data inputs, transactions and output coming from various departments and
management functions.

¢ Information Sharing: Transactions that are taking place may be shared
at any other place in an ERP-driven business. Each of the users can share
and use data available depending on the rights that a person has.

Prominent Information
Systems, Communication
Concepts and Networking

NOTES

Self - Learning
Material 253



Prominent Information
Systems, Communication
Concepts and Networking

NOTES

Self - Learning
254  Material

e Modules with Automated Analysis: An ERP based decision support
system consists of various modules which are automated to do a variety of
tasks, such as analysis, forecasting, planning, scheduling and reporting.

There are a number of advantages of using an ERP based decision support
system in an organization. Some of these advantages are listed as follows:

e Integration of Data Across Departments at Various Geographical
Locations: In an ERP-driven business, integration of data can be done
over various departments located at different geographic locations, hence it
is helpful when an organization has various departments spread across various
geographic locations.

¢ Data Accuracy: Since data is entered only once, it reduces the probability
of errors.

e Improved Communication: An ERP based decision support system
ensures easy enterprise-wide information sharing. This leads to swift
communication among various management functions and hence increased
productivity and efficiency.

¢ Better Analysis and Reporting: An ERP based DSS has the facility of
producing multiple reports for better analysis, planning and decision-making.

e Use of Best Business Practices: ERP based decision support system
uses the best business practices followed across all industries. Since they
are tried and tested time and again, they offer high reliability through proven
performance.

¢ Fast Implementation: As the information is available online, implementétion
becomes easier and faster for policies, projects or performance targets.

e Data Security: Security of data of an organization is the responsibility of
the ERP vendor who places data at different geographic locations. Hence,
the data of all the organizations using ERP based decision support system is
secure.

e Maintenance: The maintenance of the ERP system is also the responsibility
of the ERP vendor. Hence, there is no time wasted in debugging software
errors, etc.

SAP (R/3) is the leading ERP vendor with a huge market share of 28.4 per
cent. It has a broad variety of applications for functions like finance, business
intelligence, customer relationship management, supply chain management, procduct
life cycle management, e-markets, portals, finance, human resources management,
manufacturing, project management and planning. SAP was initially developed as
a client server based software R/3. However, it is slowly changing into Web server
based architecture with the name mySAP.com.

Use of DSS in Marketing

According to the American Marketing Association, Marketing is an
organizational function and a set of processes for creating, communicating
and delivering value to customers and for managing customer relationships
in ways that benefit the organization and its stakeholders. In simpler words of
Philip Kotler, Marketing is satisfying needs and wants through an exchange
process.




Marketing essentially includes the process of identification and satisfaction
of customers’ needs and wants in a manner that is profitable for the business. A
marketing manager is responsible for taking tactical decision related to branding,
product launch, planning of advertisement budget, decision on product mix, revenue
forecasting, product cost optimization, pricing, optimizing product mix, customer
and channel promotion, and monitoring market share changes.

An ERP based decision support system in marketing is an information system
that facilitates the decision-making process of formulating a market plan. It helps
brand managers make pricing, promotion, advertising, sales effort, and budgeting
decisions for products, product lines and brands of all products. It can forecast
sales and make estimates of profitability using internal and external data regarding
customers, competitors, retailers, and other market information. There are various
models of an ERP based decision support system which perform the following
functions to facilitate the decision-making task of a marketing manager.

e It helps the manager to cope with information overflow by combining
information sources giving similar information and by increasing the speed
and ease of data access.

e Ithelps in experimentation with various marketing mix strategies and analyses
the effectiveness of different scenarios.

* It analyses marketing related data to do necessary business forecasts, such
as market demand, etc.

e Itallows creation of scenarios and hence quicker assessment of available
alternatives for making quality marketing decisions.

e Itsupports ‘what-if” analysis with the help of graphical as well as descriptive
interpretation of information that is available from the database.

e Ithelps in monitoring the performance of a sales team over the period of
time.

e It supports the fast solution of complex and semi/unstructured problems
and hence allows marketers to make objective and consistent decisions.

e Itisaflexible and adaptive tool which allows addition, deletion, combination
and rearrangement of basic elements to provide fast response to unexpected
situations.

e It provides a research tracker database system, necessary for marketing
research industry.

e It provides business consulting, including specialized consulting for non-
profit organizations,

e Ithelps in creation of consumer connection database system for consumer
durable goods manufacturers.

Marketing managers are more inclined towards SAP R/3 sales and
distribution, and CRM (customer relationship management).

Use of DSS in Financial Management

Allocating financial resources to areas that generate a major chunk of funds is
what financial management attempts to do. In the words of Steven Berger,

Financial Management is strategizing the organization's financial directions
as well as the performance of its day-to-day financial operations.
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In any stream of business, management of finances is an integral and crucial
part. A finance manager would like to know the current cash flow situation, balance
sheet, income and expenditure statements of the company. Each time you wish to
perform financial calculations, such as current ratio (an indication of a company’s
ability to meet short-term debt obligations), return on investment, return on sales
(the profit margin on the sale), tax and interest burden on the company, etc., you
have to manually calculate.

An ERP based decision support system in finance is a class of systems
which analyses crucial financial data to support the process of decision-making in
financial activities. It is a flexible and interactive tool that gives updated financial
statements and other crucial information to a finance manager from time to time in
order to assist in making intelligent and informed decisions. An ERP based DSS
for financial management calculates Return on Investment which is an important
financial ratio is as follows (refer Figure 3.4):

Eamings as Asset Turnover
percent of sales Ratio

Total

Eamings Investment

Cost of Long Term L
Sales Assets

Plant and + Other Fixed Accounts Cash and
Equipment Assets Receivable Securities

Fig. 3.4 ROI Calculation

+ Selling and

The earliest sector to use financial decision support systems were financial
institutions, such as banks, mortgage lenders, credit card companies, and investment
advisors. The participation of the financial institutions was primarily to understand
customer needs, preferences and behaviours. Earlier, they struggled with enormous
data of customers which were located in incongruent folders with different layouts.
Managing such high volumes of data was a complicated task and needed automated
data gathering and analysis tools. This became possible after the recent advancement
in information technology when database technology and data mining techniques
were used to develop such tools.

A decision support system in finance has high impact on the profit margins
of a company as it does the following functions:

e It provides online availability of funds position and balances. It instantly
calculates more than a dozen important aspects to indicate the financial
health of a company. A typical decision support system in finance could




easily calculate ROE (Return on Equity), ROI (Return on Investment), debt
to equity ratio, ROA (Return on Asset), profit margin on sales, company’s
growth rate, current ratio, quick ratio (an indicator of company’s short-
term liquidity), etc., to name a few.

The payroll module of an ERP based decision support system in finance
helps in writing paycheques, setting rates at which each employee needs to
be paid, tracking the number of hours for which a person worked in a day,
month or year and maintaining paperwork.

It helps in recording, classifying, summarizing, analysing and reporting on
the financial transactions of the organization.

It gives managers the ability to analyse present market and economic trends
to forecast the future trends and make informed decisions regarding the
business and its operations. It wams the management against future problems
when there is a strong deviation in financial results from historical patterns,
or where the ratios warn about problems in the future. Hence the
management can intervene at the right time.

Day-to-day record-keeping is automatically done by the accounting module,

For any new business opportunity, it does the cost-benefit analysis. The
cost associated in taking up a business venture is deducted from the total
benefits (forecast) to give the profit in venturing into a new line of business.

By using financial auditing module, it protects the company’s employees,
investors and owners from any kind of accounting fraud. It also ensures
that the company’s internal controls are properly set up to prevent fraud.

Itallows for careful financial planning and tax planning. When there is change
in profit of a company, cash and non-cash outlays need to be controlled
accordingly, changed tax liabilities need to be calculated and cash flows
need to be maintained positive throughout.

If there is no continuous monitoring, a company may end up in debt trap or
liquidity crunch when it is taking up one loan to repay another. With a decision
support system, the finance manager knows the amount of loan that the
company can take, for how long (for which maturities) and at which interest
rate.

It forces the top management to rationalize the policies related to
depreciation, inventory and inflation.

It can easily compare the financial health of a company with its competitors
oramong various divisions or lines of business.

It can indicate the production department about the amount of inventory the
company can hold without losing on liquidity front.

For a company investing in stock market, it studies the fluctuant, non-linear
and chaotic characteristics of the stock options and helps avoid manual
errors during analysis.

It is not possible to analyse the portfolio of a company at any point in time
However, this has become possible with the portfolio management tool in
DSS.
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Concepts and Networking  Production management refers to application of management functions to the
Production in the factory. It is the job of coordinating and controllingall the activities
NOTES required to make a product.

Production managers are concerned with taking critical decisions like
diversification of product, assessment of product quality, assessing optimum
production level and product mix, optimum stock level and reorder level, etc., in
the shortest possible time. They are constantly working towards increasing efficiency
of operations by reducing cost and lead time and improving the quality.

A decision support system became a necessity for many organizations after
the number of products they manufactured went high. This was also the reason
why decision support system in production function was among the first to be
developed. Hence, it is quite comprehensive in its application to production or
product management. An ERP based decision support system in the area of
manufacturing is especially developed for supporting the solution to management
problems which are not properly defined and structured. Most of the time,
manufacturing decision support system and production decision support system
are used interchangeably.

ERP based decision support systems in manufacturing help the process of
decision-making in the following ways:
e Optimally plan, implement, schedule, sequence, and supervise all processes
of production.

o Identify and solve exceptions and deviations in performance in an econosnical
way and in real time.

e Institutionalize lean manufacturing and six sigma processes and monitor
production to drive continuous improvement.

e Develop members of staff efficiency and build a superior class job
atmosphere.

e Capturing, management and analysis of production related data becomes
easier especially in very large production houses.

e It tracks and matches the purchase order, inventory receipts and invoices
generated by the vendors. It also helps in order tracking from the time of
acceptance of an order till order fulfilment.

e It maintains the revenue cycle from invoice till cash receipt.

e Use of data related to past trends in production and forecasting techniques
instead of partially informed, intelligent assumptions to predict about future
production needs.

e Coordination of operations with partners and suppliers and coordination of
all the elements of production to increase in overall utilization of a factory’s
production capacity, particularly in case of a complex system with multiple
product manufacturing.
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* Ithelps in deciding the optimum order quantity and reorder level for each of NOTE
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the stock item using inventory control tool.

¢ In case the production requirement is fluctuating from time to time, it helps
in planning, procurement, monitoring and control of inventory.

* The quality related module has the ability to assess the impact of any changes
in the quality level due to each defect in any of the products. Hence, it helps
in meeting quality parameters expected by the customers.

e Ituses techniques like PERT (Project Evaluation and Review Technique)
and CPM (Critical Path Method) to help a project manager in planning,
scheduling and controlling the time required in finishing a project.

e Complies with environmental, health and safety standards.

* Keeps arecord of production decisions taken for future reference.

Six Sigma: A systematic method for improving the operational performance
of an organization by eliminating variability and waste.

Linear Programming: Amathematical technique used to obtain an optimum
solution in resource allocation problems, such as production planning,

Project Evaluation and Review Technique: The Program (or Project)
Evaluation and Review Technique, commonly abbreviated PERT, is a model for
project management designed to analyze and represent the tasks involved in
completing a given project. PERT is a method to analyze the involved tasks in
completing a given project, especially the time needed to complete each task, and
identifying the minimum time needed to complete the total project.

Critical Path Method: Abbreviated as CPM, a project management
technique that analyses what activities have the least amount of scheduling flexibility
(i.e., are the most mission-critical) and then predicts project duration schedule
based on the activities that fall along the “critical path’, Activities that lie along the
critical path cannot be delayed without delaying the finish time for the entire project.
Projects planned with CPM typically are graphically represented in a diagram
showing how each activity is related to the others.

The most widely used ERP based DSS for manufacturing is SAP R/3, which
has specific modules like production planning, material management, quality
management and supply chain management.

Use of DSS in Human Resource Management

Human Resource Management (HRM) is the strategic and coherent approach to
the management of an organization’s most valued assets — the people working
there who individually and collectively contribute to the achievement of the
objectives of the business.

A manager of human resources is responsible for functions like workforce
planning, recruitment, induction, training and skill management, compensation and

payroll, employee welfare administration, performance appraisal and promotion ~ Self - Lf;amr'rrg P
Materia
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A decision support system for human resource management can help an

NOTES HR manager in the following ways:

o Assists in the selection process when the HR manager is taking personnel
job interview by providing useful suggestions after evaluating different
characteristics of a candidate.

o Evaluates the experience and skills of all the candidates and matches them
with the requirements to choose the one who best fits in that particularrole.

e Generates HR related reports that may contain both details and summaries
of employee population, compensation, turnover rates, and other elements
of human resources management.

e Keepsarecord of all employee details, their performance details and hence
helps in capacity utilization of human resources by matching their knowledge
and skills with that required in a particular profile.

e Keeps a current record compensation structures which allows to play
around with percentage changes affected by different performance ratings.

e ‘What-if’ analysis helps to see the impact of increase in salaries on the total
salary bill of the organization.

o Helps in analysing and reducing the discrepancy among the salaries of
employees who joined at the same time, same level of hierarchy and
performing similar tasks.

e Reduces the exception of various grade bands, designation bands,
experience bands by analysing salaries in each of the bands.

L

e Facilitates development of HR policies and defines rules which makes it
easier to make changes to the existing compensations of employees.

e Collects rules to help in writing employee handbooks which inform all
employees about the policies and procedures of the organization.

In the category of ERP based DSS for human resource management, HR
managers are mostly inclined towards PeopleSoft’s HRMS (Human Resource
Management System), SAP ERP HCM (Human Capital Management), Infor’s
HCM and Microsoft Axapta Human Resource Management III.

On one hand, ERP modules that are used under each of the functional areas
help individual management functions for improving the decision-making process.
On the other hand, they also help integration of databases so that they can be well
utilized by other departments as well. This integration is the most important feature
that is required by any multifaceted organization of modern times. It helps the top
management to have a holistic picture of the state of affairs in the organization and
forms the basis for making crucial strategic decisions. However, for effective
implementation ERP modules need to be customized so that they can adapt to the
specific workflow needs of individual industries. Then only they will be better
utilized across the industries.
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Decision Modelling Exercises

Decision Types

The decisions taken by an organization are different in many ways. These affect
the development of alternatives and the choice available among the alternatives.
The different decisions also affect the support provided by the design of an
information system for carrying out decision activities. The decisions are classified
on the basis of the following factors:

Purpose of Decision-Making

On the basis of the purpose of the decision-making activities, the organizational
decisions are divided into the following three different categories:

1. Strategic Planning comprises the decisions in which a decision-maker
develops objectives and allocates resources to achieve these objectives.
The decisions in this category are of a long-time period and involve large
investment and effort. Such decisions are taken by executives who are a
part of the conceptual process and are at the helm of the corporate ladder.
Examples of such decisions may include introduction of a new product and
acquisition of another firm.

2. Management Controls are those decisions taken by the management
control plan executives who are centrally placed in the corporate ranks.
These managers deal with the use of resources in the organization. Analysis
of variance, product mix and planning decisions fall in this category of
decisions.

3. Operational Controls are the decisions for dealing with the day-to-day
problems that affect the operation of an organization. For example, decisions,
such as production scheduling and inventory control fall in this category.
The product to be produced for the day or the items and their quantities to
be ordered are operational control decisions. Such type of decisions are
normally taken by executives who are at the lower level of the company.

Note: Due to the overlapping nature of some decisions, the boundaries for classifying

decisions in these categories are not very concrete and therefore, these decision types
should not be taken as discrete ones.

Programmability Levels of a Decision

According to the programmability levels of a decision, the decisions are of the
following two types:

1. Programmed or Structured Decision refers to the decisions that are
well defined and require application and implementation of some specified
procedure or decision rule in order to reach a decision. Such decisions
require little time for developing alternatives in the design phase. Programmed
decisions are made by operating procedures or by using other accepted
tools. More modern techniques for making such decisions involve operations
research (OR), mathematical analysis, modelling and simulation.

2. Non-Programmed or Unstructured Decision refers to the decisions,
which are not well defined and have no pre-specified procedure or decision
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rule. These decisions may range from one-time decisions relating to a crisis,
to decisions relating to recurring problems. The unstructured decisions
consume sufficient time in the design phase of the decision-making process.
These decisions can be solved using judgement and intuition. Modern
approaches to such decisions include special data analysis on computers
and heuristic techniques. Decisions of this kind are usually handled by strategic
planning level managers. As a result of their unstructured nature, these
decisions cannot be used as representatives for lower-level decisions and
are difficult to automate. For example, planning for R and D is an unstructured
decision.

3. Semi-Structured Decision refers to decisions that are neither structured
nor unstructured. These decisions are supposed to fall somewhere between
the structured and unstructured decisions. For example, introduction of a
new product is semi-structured decision.

Note: There is no distinct line of difference or boundaries between the two types of decisions;
rather they exhibit a continuum for the classification of decisions.

Knowledge of Outcomes

‘Knowledge of outcomes’ is another approach for classifying decisions. An outcome
defines what is going to happen if the decision is taken or the course of action is
taken. The knowledge of outcome plays an important role when you have more
than one alternative. On the basis of the level of knowledge of outcomes, decision-
making can be classified into three categories:

1. Decision-Making Under Certainty takes place when the outcome of
each alternative is fully known and there is only one outcome for each
alternative. In such a situation, a decision-maker is required to compute the
optimal alternative or outcome.

2. Decision-Making Under Risk occurs when there is a possibility of multiple
outcomes of each alternative and a probability of occurrence can be attached
to each outcome. Such decision-making is also similar to the decision-making
under certainty where instead of optimizing the outcomes, the general rule is
applied to optimize the expected outcome. A decision-maker is assumed to
be reasonable for choosing a particular decision. A decision-maker, for
example, has to choose from the given two options, one offering a 2 per
cent probability of a profit of Rs 1,00,000 and the other an 80 per cent
probability of a profit of Rs 10,000. The decision-maker chooses the second
alternative because it gives a higher expected value. This is explained as
follows using the formula:

Outcome x Probability = Expected Value
1,00,000 x 0.02 = 2,000
10,000 x 0.80 = 8,000
3. Decision-Making Under Uncertainty takes place when each alternative
has a number of outcomes, and the possibility of occurrence of the altematives

is unknown. Optimization criteria cannot be applied for making these types
of decisions because there is no knowledge of these probabilities. Decision-
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assign equal probabilities to all the outcomes for each alternative, so as to

treat the decision-making as decision-making under risk, whereas others

may adopt different criteria, such as maximax and maximin criteria to minimize NOTES

regret.
Methods for Choosing Alternatives

A decision-maker uses various methods for choosing the best alternative among
the available alternatives. The methods that are used for choosing alternatives
generally assume that all the alternatives are known.

Decision Theory and Decision Analysis

The decision theory and decision analysis refer to the techniques for analysing
decisions under risk and uncertainty. In the process of decision-making, a decision-
maker wants to achieve his goal, purpose or objective. The decision-maker chooses
one particular alternative from various alternatives, which is termed as the ‘strategy’
of the decision-maker. All alternatives and outcomes are assumed to be known to
the decision-maker. There are certain factors termed as ‘states of nature’, which
affect the outcome for different strategies. The strategy or alternative, along with
the state of nature, determines the degree to which the goal is actually achieved.
This measure of achievement of the goal is termed as ‘Pay-off”. The pay-off matrix
is used as amethod of presenting data in decision analysis. A pay-off matrix is a
good representation of a decision problem because the alternatives available to
the decision-maker are represented in rows, and the states of nature in columns.
Each cell of the matrix, which is an intersection of a strategy and a state of nature,
contains the pay-off. If the state of nature is known with certainty, then the the
decision-maker has the option to choose the strategy providing the maximum
pay-off. Figure 3.5 shows the pay-off matrix.

Strategies States of Nature
N1 N2 N3 N4
S1 a — Pay-off
S2
S3

Fig. 3.5 Pay-off Matrix

Assume, for example, that a marketing manager of a computer manufacturing
company chooses from the following three alternatives:
1. Launch a new PC having latest technology.
2. Leave the PC as it is and do nothing.
3. Modify the existing PC to improve its design and processing power.
There are three states of nature that affect the pay-off from each of the
alternative strategies. These states of nature are:
¢ Conditions remain the same as they are.
* Acompetitor may launch a new PC with the latest technology.
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e The government may impose high excise duty on manufacture of PCs
and reduce excise on laptops to encourage the use of laptops.

Figure 3.6 shows the various pay-offs from the combination of a strategy
and a state of nature.

(Pay-off in lakh of rupees)

Strategies States of Nature
Government Ban Same Conditions Competitor (0.40)
(0.20) (0.40)
New Product (S1) -13 10 3
Do Nothing (S2) =2 5 1
Modify (S3) -5 7 5

Fig. 3.6 Pay-off Matrix Combining Strategy and States of Nature

Each cell, which is an intersection of a strategy and a state of nature, contains
the probabilities for the occurrence of each state of nature, either based on historical
data or on personal judgement of the decision-maker. It can be seen that there are
three states of nature with known occurrence probabilities. This problem situation
is called decision under risk. To make a decision under such a situation, a decision-
maker should compute the anticipated worth of each option. The expected value
is determined by multiplying each pay-off by the probability of occurrence of the
state of nature (given in columns) and adding these values across all states of
nature (across the rows). In the above example, the expected value (EV) of strategy
S3, 1s:

EV of S3 = (-5)(0.20) + (5)(0.40) + (7)(0.40) .
=-1+20+2.8=38

The maximum expected value, that is Rs 3.8 lakh, is found to be of strategy
S3, which is to modify the PC. In addition, if the decision is made based on the
expected value objective function, strategy S3 will be selected.

The decision-maker is aware of the probabilities of various states of nature
while making a decision under risk. However, the decision-maker is unaware of
the probabilities of the different states of nature in case of decision-making under
uncertainty. Figure 3.7 shows the pay-off matrix for which the decision-maker
does not have the knowledge of probability of occurrence of the states of nature.

(Pay-off in lakh of rupees)

Strategies States of Nature
Government Ban Same Conditions Competitor (0.40)
(0.20) (0.40)
New Product (S1) -13 10 3
Do Nothing (S2) -2 5
Modify (S3) -5 7 5

Fig. 3.7 The Pay-off Matrix where Probabilities of Nature are Not Known

Therefore, a decision-maker cannot apply the maximization/minimization of
expected value criteria as in the case of decision under risk. In such decision
problems, the following decision rules or decision criteria may be applied:




1. Ciriterion of ‘minimize regret’ refers to the selection of: strategy that minimizes Prominent Information
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the maximum regret for each decision taken by a decision-maker. The Concepts and Networking
decision-maker might regret if he is not able to select the appropriate strategy
in terms of particular states of nature. The regret of the decision-maker is
the difference between the highest pay-off for a state of nature and the pay- NOTES
off for the other strategies for the same state of nature regret matrix. Figure
3.9 showing the regret matrix displaying minimum of maximum requests for
strategy S3, which includes modification of a PC. The regret of the decision-
maker is computed by subtracting the value in each entry in the column
from the highest value in the column. The decision-maker needs to select
the strategy that is going to give him the minimum of such maximum regrets.
Figure 3.8 shows the pay-off matrix showing the differences between the
highest pay-off for a state of nature and the other pay-off for the same state

of nature.
Strategies States of Nature
Government Ban Same Conditions Competitor
New Product (S1) -2(-13) =11 10-10=10 5-3=12
Do Nothing (52) =2-(-2)=11 10-5=5 5-1=4
Modify (S3) -2+(-5)=3 10-7=3 5-5=0

Fig. 3.8 The Pay-off Matrix showing the Differences between the Highest Pay-off
Jor a State of Nature and the Other Pay-off for the same State of Nature

Strategy Maximum Regret
S1 11 *
S2 5
Minimum of
53 3« | maximum requests

Fig. 3.9 The Regret Matrix

In the current case, the minimum regret is 3 lakhs. The decision-maker
should select strategy S3, which modifies the product. This is the minimum
regret, if all the other strategies available to a decision-maker are taken into
consideration. But at the same time, 3 lakhs is the maximum regret, which
the decision-maker experiences for strategy S3.

2. Maximax rule or criterion of optimism refers to the optimistic attitude of a
decision-maker that enables him to select the strategy that is able to provide
him the maximum pay-offunder the most favourable condition. In this
example, the decision-maker selects strategy S1, which gives him a maximum
pay-offof 10 lakhs for launching a new PC. Figure 3.10 shows the maximum
pay-offto the decision-maker by implementing the strategy S1.

Strategy Maximum Pay-off
S1 10 <+ Maximax
S2 5
S3 7

Fig. 3.10 The Maximum Pay-off Matrix
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3. Criterion of rationality assumes equal probabilities of various states of nature

and as a result, is considered a rational approach of decision-making. This
criterion is also termed the Laplace Criterion. This criterion becomes the
decision problem under risk after attaching the possibilities to the states of
nature. After attaching the possibilities, the expected pay-off for each strategy
is calculated and the strategy holding the highest expected pay-offis selected.
In the example that we have been discussing, the expected pay-off for each
strategy is given in Figure 3.11. The probability of each table is assumed to
be equal to 1/3 since there are three states of nature.

Strategy Maximum Pay-off
S1 1/73(10+3-13)=0
S2 13(5+1-2)=1.3
S3 1/3 (7 +5—5)=2.3 4r——— Highest EV

Fig. 3.11 The Expected Pay-off Matrix

Therefore, as per the discussed criterion, strategy S3 should be selected
because of the highest expected pay-off.

. The maximum rule or criterion of pessimism indicates that a decision-maker

has a pessimistic attitude and therefore, selects the strategy, which gives
him the maximum pay-off even if the worst condition occurs. Here, the
decision-maker does not like to take any risk and as a result, thinks about
the safest position in the worst situation. Therefore, the decision-maker
selects strategy S3, since in the worst situation, which is the case of a
government ban, the decision-maker sustains the minimum loss of Rs 2
lakhs due to this decision. Figure 3.12 shows the matrix for the mmimum
pay-off.

Strategy Maximum Pay-off
S1 —13
S2 —2 < Minimum Pay-off
S3 g

Fig. 3.12 The Minimum Pay-off Matrix

Decision Tree

Decision tree is an important method for presenting the analysis of a project. It
helps in displaying the graphical representation of a sequence of decisions and
actions. The analysis of the project presented by a decision tree resembles the
branches of a tree with the root of the tree as the starting point of the decision
sequence. Figure 3.13 shows the decision tree sequence.



Condition

Root

Condition

Fig. 3.13 Decision Tree Sequence

The function of a decision tree that helps in structuring the problem is
composed of the following two options:

1. Problem structuring includes understanding the logical processing of a
problem. Consider the case of a computer firm that offers the following
discount policy to its customers.

If the payment is made within a week,

4 per cent discount is allowed on orders above T 11,000.
3 per cent on orders up to ¥ 6,001 to ¥ 11,000.

2 per cent on orders up to T 6,000.

However, if the payment is made after a week, only 1 per cent discount is
allowed.

The above discount policy can be presented with the help of the following
decision tree as shown in Figure 3.14.

Order above Rs 11,000 — allow 4% discount

| Order upto Rs 6,001 to Rs 11,000 — allow 3% discount

Order upto Rs 6,000 — allow 2% discount

Decision

Point
Payment
done aftera —{ Allow only 1% discount
week I

Fig. 3.14 Decision Tree for Discount Policy
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2. Problem analysis includes the analysis of a problem. Suppose a company
named ABC wants to take decisions for the distribution channel for the
marketing of its products. The available alternatives with the company are:

A. Selling agent
B. Direct sales

The company may have high or low market penetration and market share.
The probabilities and net gains are as shown in Figure 3.15.

Channel Low Penetration High Penetration
Selling Agents 0.20 0.80

Net Gains 20 lakhs 80 lakhs

Direct Sales 0.40 0.60

Net Gains 30 lakhs 40 lakhs

Fig. 3.15 The Probabilities and Net Gain

Figure 3.16 shows the decision for the example as discussed above.

Gains EV

HP=0.80 Rs. 45 lakhs 36

LP=0.20 Rs. 20 lakhs 04
’ Total EV 40 lakhs
Decision
point
HP=0.60 _ Rs.40 lakhs as .
Rs. 30 lakhs 12

LP=0.40

Total EV 36 lakhs

Fig. 3.16 The Decision Tree

Here, LP means low penetration and HP means high penetration:
Expected pay-off for selling agent = (0.80)(45) + (0.20)(20) =40 lakhs

Expected pay-off for direct sales = (0.60)(40) + (0.40)(30) = 36 lakhs
Therefore, the decision taken by the decision-maker is as follows:

As the channel option selling through the agent would give a higher pay-off,
which is equal to 40 lakhs, the company selects this channel for marketing its
products. However, when large numbers of decisions need to be taken and each
decision affects the subsequent decision, the rollback procedure is adopted. In
this procedure, a decision-maker starts at the end of the branches and works from
the back to the front till the decision point of the decision tree is reached. This is
done to calculate the selected pay-off for all the branches of all the nodes of a tree.
The choice of maximizing the expected pay-off on the whole is found by analysing
the possible outcomes at each decision point.




Optimization Techniques

A number of optimization techniques, such as linear and dynamic programming
are available for taking decisions during a decision-making process. Various other
techniques in this category are integer programming, queuing models and inventory
models. These optimization techniques assume that the decision-maker knows all
the altenatives and the outcomes of'the alternatives. All these optimization techniques
are used by a decision-maker to reach an optimal decision to complete the objective
of the function.

Decision-Making and MIS

The role of a management information system is important to understand the concept
of decision-making. Decision-making concept is also used for designing an
information system. The support that the management information system provides
to the decision-making process in various ways is discussed as follows:

o Support for Decision-Making Process: MIS plays its role in all the three
stages of the decision-making process as already covered in the previous
segment. Following is the discussion of a decision-making procedure with
respect to the role played by MIS at three phases of the procedure.

o Intelligence Stage: Internal and external feedback could be provided

by the Management information systems. Internal information is
generated from the functional areas but the external information is
collected from various sources, such as newspapers and personal
contacts. Availability of a large amount of information at this stage
makes it necessary to scan the data sources to get the relevant
information. As a result, the information system is used to scan the
business environment of an organization.
Procuring the required information from an intelligence phase that
belongs to decision-making process, MIS must be designed so as to
answer pre-specified and ad hoc queries made by a decision-maker.
In other words, the information system design must have models, such
as historical planning along with a query language capability that provide
decision support capability for the system.

0 Design Stage: Management information systems provide support
by quantifying and automating a decision-making process during the
design stage while considering structured decisions. At this stage,
various alternatives are developed and evaluated. On the other hand,
for semi-structured and unstructured decisions, the support of a
management information system provides the abilities as follows:

— To reach a decision in an interactive process, which includes
decision support system capability
— To make ad hoc queries for information in the organizational
databases
Therefore, information systems should be designed to incorporate
various models of business operations and advanced statistical and
optimization techniques. These techniques can then be used to
manipulate information that is already collected in the intelligence stage
to develop and evaluate various alternatives.
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e ChoiceStage: Management information systems should provide summarized
and organised information to the decision-makers at this stage of the decision-
making process. It is the stage in which a course of action is selected and
feedback is collected on the implemented decision. MIS also provides the
feedback support to a decision-maker in case he/she wants to return to the
preceding stages of the decision-making process in order to gather more
information. Models, such as optimization and suggestion should be used
to select the most appropriate alternative, which helps the decision-makers
in selecting the best course of action.

Characteristics of DSS

The characteristics of DSS are as follows:

e DSS works in semi and unstructured environments rather than ina structured
environment. In structured environments, DSS is not required as the problem
(and environment) and information related to it is structured and available.
In most cases, structured decisions have precedence and thus have a
reference point. In unstructured and semi-structured environments, DSS is
required.

o DSS plays a decision-support role — It does not replace the decision-maker
but only helps the decision-maker to take a better decision by:

o Making more analysed data available.

o Processing the analysed data through a model and making available
possible decision paths.

o Enabling him to conduct ‘what if> analysis ina simulated environment.

o Helping him put up a realistic picture of outcomes.

e DSS can support individual users or a group of users — DSS can work inan
individual as well as a group mode as per the needs of the organization. In
case of group-based decisions, DSS can be tailored to work in groups.

e It supports all phases of the decision-making process.
o It focusses on effectiveness.

e It remains under the control of the DSS user unlike an expert system, which
can take action on its own. It remains under the control of the user and
functions as required by the user.

o Uses underlying data and models — DSS is useless without the underlying
data, as most DSS work on an empirical platform rather than a theoretical
platform.

e They can provide support for multiple independent or interdependent
decisions.

e Tthas amodel at its core which helps it to solve complex decision problems
_ the model is the heart of the DSS. It gives the DSS the capability to solve
unstructured and semi- structured problems.

Framework for DSS

Herbert Simon laid out the most popular framework for decision support which
consists of three linear phases—intelligence, design and choice. Van Grundy,
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Mintzberg and others have later on modified this framework to suggest that decision-
making, as an activity, was more complex to describe in a linear model and have
gone on to give more comprehensive frameworks. These works led to the
development of models on the framework of problem-solving. R.H. Sprague (1980)
gives us a framework for DSS itselfin which DSS is conceptualized as having three
components—database, model base and a dialog management system.

A DSS works normally in a client-server or 3-tier architecture environment,
where the client houses the model and interface, and the server houses the data.
Many variations of this are possible. A schematic diagram of a DSS in a client—
server environment is shown in Figure 3.17:

The Client

Fig. 3.17 The Decision Support System within a Client-Server Framework

Benefits of DSS

DSS helps the management to take decisions that are complex and difficult.
It improves the quality of decision-making by helping the decision-maker to make
informed choices. It thereby improves efficiency and improves performance. By
expediting problem-solving (mostly at the upper levels), it frees the managers and
helps them to concentrate on other tasks. Therefore, it helps the managers to
become effective and manage their time efficiently. It enhances the quality of decision-
making and thereby helps the organization to build a competitive edge.

3.5 EXECUTIVE SUPPORT SYSTEMS

Executive Support Systems (ESS) are designed for senior executives of
organizations. Executives are responsible for the growth and survival of the
organization. They need to monitor the performance of the organization, remain
competitive and respond to market changes and trends, etc.

Role of ESS

How will an executive know the performance of the organization? The answer is
very simple: by looking at the performance data. This data is stored in transaction
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:’g"’:;’:::”é g’rz’;m‘!’::’:on processing systems in terms of current sales, purchases, expenses incurred, etc.
c{mcep}s and Networking AT €xecutive or manager would like to look at the consolidated data, targets set,
performance of previous years and performance of the competitors. If he is
interested in details of a particular product or zone, he would have the option of
NOTES drilling down. There are two terms associated with executive support systems:
roll-up and drill-down. Roll-up refers to consolidating data and drill-down is the
ability to view expanded data. If, for example, sales data is available for an
organization for sixteen zones, a roll-up may present data in terms of five regions
and a drill-down view may present each product or each sales office, etc. An ESS
provides a graphical view of the data. The most challenging part of building an
ESS is to transform transactional data into usable form. The data may be incomplete
or the required fields may be missing. The problem is more pronounced in
organizations where each department or functional unit has its own independent
TPS. Each of these systems may have different software and hardware platforms,
different application software and different representation of the same data. Just
to give an example, you might have received a document that failed to open.
Different units may have evolved different nomenclature. An organization had
multiple manufacturing sites and each referred to components differently. This
interesting fact was discovered when the management decided to consolidate
purchases.

ESS needs to integrate external data for market trend analysis and forecast.
Sources of external data are the Web, market agencies and company reports.

An ESS should be easy to learn and use. Executives may not have time to
attend a training session. An ESS should also fulfil the information requirements of
the executives. ESS are a new phenomenon and some executives may feel
uncomfortable using an ESS. It is easy to monitor the performance not only of the
organization but also of colleagues. ESS are expensive as they are mostly custom
built, integrate organizational and external data and provide graphical user interface
and analytical capabilities. As with any project, ESS deployment also goes through
a cost-benefit analysis. However, most of the benefits of information systems are
intangible. Look around you: identify information systems that you use or see in
use and try to enumerate benefits. Start with cell phones and you will soon discover
that all benefits are intangible. Sometimes, it is difficult to justify investment in
information systems. But in the last two decades, the scenario has changed and
investment in information systems has increased.

Benefits of ESS

Executives in an organization are senior people who have years of experience
behind them. These people have done well without ESS for long. Since the economy
became global, business decisions have become global and require global thinking.
The competition has also become global and employees also tend to move for
better prospects. If there are no ESS to support decision-making, decisions are
people-centric and the organization depends on its executives. In the present
scenario, there is emphasis on putting systems in place to reduce dependence on
individuals. Information systems help immensely in achieving this objective.
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Apart from these generic advantages of information systems, an ESS helps Prominent Information
executives make decisions, especially the ones involving external data. Oncea  s'ems. Communication

. Conce, d Networki
system to transform and integrate data has been put in place, managers can analyse SR e
data and view it according to their requirements.
An ESS increases the domain, span and capability of a manager to analyse NOTES

data for trend analysis. It is not humanly possible to analyse a large amount of
internal and external data. A by-product of deploying a centralized data repository
is the introduction of organization standards.

ESS and Digital Firms

Business Intelligence (BI) has become the buzzword in every organization.
Traditionally, a data warehouse store organizational data that may not be current
and may have one or two days of time lag. The data was accessible to a select
few. Most of the employees had restricted access to the data and few made use of
the data. But nowadays, the emphasis is on using data intelligence to make small
as well as big decisions. The performance of the organization and brand image
depend on thousands of seemingly small decisions made by the employees. Business
intelligence systems analyse data and deliver timely information for multiple
purposes. Information may be disseminated through a graphical user interface
using charts, graphs and dashboards. More and more organizations are investing
in Bl systems.

Another application of ESS is monitoring organizational performance using
the Balanced Scorecard. There was a time when performance was measured
only in terms of profits. An organization did well financially one year but failed to
survive the following year. There were reasons, such as non-preparedness for
future and being out of sync with changing market trends. Sometimes, even
employees were not happy, committed and motivated. A balanced scorecard
measures the performance of an organization on four axes: shareholders’ view,
preparedness for future, employees’ view and customers’ view. There are many
software available in the market for helping an organization in implementing a
balance scorecard.

An ERP system integrates all functions through a centralized database.
Companies are performing add-on modules that use ERP data and provide data
reports and data analysis tools.

The challenge is to identify the requirements and deploy an appropriate
system. One does not have to invest in an information system just because it
exists. There has to be a clear objective in investing in information systems.

Check Your Progress

. What is office automation system?
. Define the term transaction processing system.
. What is DDS?

. Write the use of DSS in marketing according to American marketing
association.

5. What is Executive Support Systems (ESS)?

BOW N
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3.6 EXPERT SYSTEMS

Expert systems offer an economical and practical way to capture, refine and
proliferate management skills. These systems provide a framework in which to
document the questions and answers that experts use to solve analytical and
operational problems. With expert systems, the know-how of one ‘expert’ can be
put in the hands of many workers to improve consistency, accuracy and productivity
throughout the network.

An expert system program captures and stores logistics knowledge as rules
(heuristics), policies, checklists and logic, in a ‘knowledge base’ in much the same
way a conventional computer programme stores numeric information in a database.
As aresult, expert system programmes tend to be much easier to modify, update
and enlarge than conventional computer programmes.

Logistics expert systems are applied where expertise can increase the firm’s
return on assets. Applications include carrier selection, international marketing
and logistics, inventory management and information system design.

Expert systems include three components: knowledge base, inference engine
and user interface. The knowledge base contains the expertise in the form of a
series of “if. . . then’ conditions. The inference engine searches the knowledge
base to identify the rules that are relevant for a specific decision. The user interface
facilitates interaction between the decision-maker and the expert system. The
interface formats the key questions to the user in natural language and then interprets
the responses.

Expert systems have demonstrated their ability to improve logistics
productivity and quality. With the integration of logistics requirements and current
information technology capabilities, it is now possible for a firm to maintain a
competitive edge in today’s business environment.

Expert systems, bar codes, RF technology, satellite communication capability
and image processing require substantial capital investment prior to obtaining any
returns. However, the primary benefit of these technologies is not lower cost but
improved customer service.

3.7 ENTERPRISE RESOURCE PLANNING
SYSTEMS

ERP is an information system that integrates departments and functions across a
company using one database system. It runs off a single database, enabling various
departments to share information and communicate with each other. It is a business
management system that integrates all facets of the business, including planning,
manufacturing, sales and marketing. It automates the finance and human resources
departments and helps manufacturers in handling jobs such as order processing
and production scheduling. ERP began as a term used to describe a sophisticated
and integrated software system used for manufacturing. In their simplest sense,
ERP systems create interactive environments designed to help companies manage




and analyse the business processes associated with manufacturing, such as inventory
control, order taking, accounting and much more. Although this basic definition
still holds true for ERP systems, their definition is expanding. In today’s dynamic
and turbulent business environment, there is a strong need for organizations to
become globally competitive. The survival guide to competitiveness is to be closer
to the customer and deliver value-added products and services in the shortest
possible time. This, in turn, demands integration of the business processes of an
enterprise, which is the stronghold of ERP. The economy has shifted from being
based on manufacturing to service, and information has become an asset that
provides the competitive advantage. ERP helps an organization in obtaining accurate
and timely information. However, it is necessary for an organization to align IT
spending with business strategy and needs. ERP from an IT perspective is a
comprehensive software package that stores, retrieves, modifies and processes
the transactions of all the functions of an enterprise in an integrated fashion. ERP is
a semi-finished product with tables and parameters that user organizations and
their implementation partners configure according to their business needs. An
organization opts for an ERP implementation with a certain objective. The objective
translates into benefits and sub-benefits. The objective of ERP implementation
should be aligned with the firm’s competitive strategy. ERP can bring in many
benefits that can be broadly classified as strategic, operational and managerial.

An example will make the role an ERP system plays in an organization
clearer. Let us say, a customer places an order and it is entered into the ERP
system. The production unit will see the demand immediately and they can plan
their production accordingly. They will also have access to inventory data, inventory
in the pipeline, production in progress, etc. The shipment division can check the
availability of goods and plan to ship the goods. Once goods are shipped and data
is entered into the ERP system, the accounting unit will know the amount receivable.
When a customer inquires about the possible delivery date, the customer support
staff can access the inventory details, required shipping time and answer the query
with reasonable accuracy. Without an ERP system, the marketing and sales unit
would have to find out the answer from the production unit.

3.8 COMMUNICATION CONCEPTS

3.8.1 Signal and Data

Information exchange is an essential part of communication. It may be exchange
of information among users or equipment in the communication system. In the
communication context, signalling refers to the exchange of information between
components required to provide and maintain data communication service. In
case of PSTN, signalling between a telephone user and the telephone network
may include dialling digits, providing dial tone, accessing a voice mailbox and
sending a call-waiting tone etc. Looking at networking, perspectives, it is
transmission of service information such as addresses, type of service etc., between
nodes and/or terminals of a network. In other words, it is a process of exchanging
and generating information between components of a telecommunications system
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to establish, release, or monitor connections (call handling functions) and to control
related network and system operations (other functions).

Signaling System (SS7)

Signaling System 7 is the protocol designed for public switched telephone system
for providing services and setting up calls. The various value-added features such
as providing intelligence to PSTN services come under the service of SS7. Earlier
the same physical path was used for both the call-control signaling and the actual
connected call. This is called in-band signalling technique. This method of signalling
was inefficient and replaced by out-of-band or common-channel signalling
techniques. Out-of-band signalling performs its job by utilizing two networks in
one. As we know that in PSTN, our voice and data is carried over circuit-switched
network. It provides a physical path between the source and destination. The
other one is the signalling network, which carries the call control traffic. Itisa
packet-switched network using a common channel switching protocol.

Functions of SS7
e It controls the network.
o The SS7 network sets up and tears down the call.

e It handles all the routing decisions and supports all telephony services
including call forwarding, caller ID, remote network management and local
number portability (LNP).

In order to accomplish the above functions, SS7 uses voice switches, which
are known as Service Switching Points (SSPs). They handle the SS7 control
network as well as the user circuit-switched network. Basically, the SS#7 control
network tells the switching office which paths to establish over the circuit-switched
network. SSPs also query Service Control Point (SCP) databases using packet
switches called Signal Transfer Points (STPs). The STPs route SS#7 control
packets across the signaling network. The concept of SSP, STP and SCP has
been illustrated in Figure 3.18.

SCP

X =

SCP

S§S7 Links

Fig. 3.18 SS7 Signaling Points

3.8.2 Channel

In this section we are mainly concentrating on the channel characteristics. With
respect to data transmission, a channel may be defined as a path between transmitter
and receiver. This path may be logical or physical in nature. It may also be hard
wired or wireless. The path provides a passage for the information or data from
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be reproduced or the information may not reach the receiver at all. Such kinds of

phenomenon may be very well-understood from the following channel characteristic
issues: NOTES

Channel Noise

Itis the background interference present on the channel in small amount orunwanted
electrical or electromagnetic energy that carries no data or information but interferes
with the information or data. Hence, noise degrades the quality of information and
data by affecting communications and files of all types, including images, audio,
text, programs, and telemetry. Here, information and data may be treated as signal
in either electrical or electromagnetic form. Ifit is more than a threshold value, the
data or information may not be reproduced at the receiver’s end. Therefore, this
may be considered as the main source for transmission errors.

The noise may be classified as external or internal noise, based upon the
sources. External noise is generally picked up from electrical appliances existing in
the vicinity, from the atmosphere, from electrical transformers, and also from outer
space. Normally, this noise does not hamper the performance seriously. However,
if there are a number of electrical appliances in use or heavy-current machines,
external noise can affect communications. It also impacts communication during
severe thunderstorms. A remarkably good external noise slows down the data
transfer rate. The external noise is generally directly proportional to the wavelength
and inversely proportional to the frequency and therefore, has a remarkable impact
in wireless systems as compared to the impact in hard-wired systems. The noise
generated because of electricity or atmospheric disturbances is of the order of
300 kHz, that is quite lower than the high frequency range of 300 MHz, and
therefore may have more interference with the signal or information.

Noise generated in the channel or receivers is known as internal noise.
Internal noise is less dependent on frequency, but has a significant effect at higher
frequency, because external noise has less effect at higher frequencies. Minimizing
the signal bandwidth may contain the internal noise, but this will limit the maximum
speed of the data that can be delivered. Internal noise is fairly low in case of digital
signal processing, fiber optics technology.

Noise is measured in terms of the signal to noise ratio S/N or SNR with
L decibels (dB) as unit. Hence a low ratio implies that it is not worth paying attention
to the medium in question. The signal to noise ratio is calculated as follows:

Signal

Noise

SNR =2010g10 dB

Channel Bandwidth

Channel bandwidth may be simply defined as the size of the range of frequencies
that can be transmitted through a channel. In other words, we may define it as the

volume of information per unit time that a computer, person, or transmission medium
H can handle. It is measured in Hertz (Hz). Bandwidth is expressed as data speed in
bits per second (bps) in digital systems. In analog systems bandwidth is expressed

as the difference between highest frequency and lowest frequency. Bandwidth f;b: 8 {aiamfng o
aleria.
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determines how fast data flows on a given transmission path. It is determined as
the amount of data transmitted or received per unit time. It has already been
explained that low bandwidth signal produces less internal noise as compared to
high bandwidth signal. Therefore, this is preferred. However, inr this case, we have
to sacrifice data transmission speed. Therefore, a trade-off based on the
performance requirements is required to be determined.

Bandwidth is affected by the physical characteristics and type of media
used, data encoding method used and amount of noise present in transmission

channel.
Channel Data Transmission Rate (Bit Rate)

Channel data transmission rate is determined by the maximum number of bits that
can be transmitted per unit time through the physical medium. It is measured in bits
per second (bps). H. Nyquist gave the maximum data rate of a noiseless channel
in 1924, Further, C. Shannon extended the work of H. Nyquist and proposed a
data rate for random noise.

Nyquist stated that if an arbitrary signal has been run through a low pass
filter of bandwidth H, the filtered signal can be reconstructed by sampling the
signal twice the frequency of the signal. Mathematically,

Maximum data rate = 2H Log,W/Second
where, W represents the number of discrete levels in the signal.

The above is a case of a noiseless channel. If random (internal) noise is
present the situation deteriorates rapidly. We have already explained that SNR is
given by a quantity 10 log10S/N dB. .

Therefore, Shannon stated that the maximum data rate of a noisy channel
whose bandwidth is H Hz and whose signal to noise ratio S/N is given is represented
by:

Maximum data rate =H log,(1+S/N)
Channel Capacity

It is the amount of information per unit time handled by either a node or a link
(element, system). The messages that are transmitted may be either different or
similar. The measurement is usually done in bits per second.

Transmission Time

It is the time required for transmitting a message through the channel. It is the size
of the message in bits divided by the data rate in bits per second (bps) of the

channel over which the transmission takes place. It is also given as the packet
length divided by the channel capacity.

Propagation Time (Channel Latency)

The amount of time that is needed for the information to propagate from the source
to destination through the channel. It is the distance divided by the signal propagation
speed (usually the speed of light). Channel latency depends on signal propagation
speed, media characteristics, and transmission distance.




Throughput

Throughput may be defined as the number of bits, characters, or blocks passing
through a data communication system over a period of time.

Packet length in bits
Transmission time + Propagation time

Throughput =

Channel Utilization

Channel utilization is nothing but the fraction of the channel's data rate actually
used to transmit data. From the throughput it is observed that the propagation time
and transmission time are two different parameters which are dependent upon the
path length and packet length, respectively (number of bits in a message).

Hence Channel Utilization = —2—
’ l1+a

where, a is given as the ratio of propagation time and transmission time and
is known as bit length.

We may now consider an example to understand the above concepts.
Suppose, a channel’s data transmission rate is 10 Mbps and the time taken by one
bit to transmit through the channel is 107 seconds. The signal propagation speed
in the medium is 2 x 10°m/s. The transmission rate is 1bit /107 seconds that is
equal to 107 bit per second (bps). Therefore, bit length will be equal to 2 x 108
m/s/107 bps which is equal to 20 meters.

3.8.3 Baud Rate

Bit rate is the number of bits (0 or 1) transmitted during 1 second. The number of
signal changes per unit of time to represent the bits is called the data rate of the
modem. That rate is usually expressed in terms of a unit known as a baud. A signal
unit may have 1 or more than 1 bits. Therefore, the baud is the number of times
per second the line condition can switch from ‘1° to ‘0°. Baud rate and bit rate,
which are expressed in bits per second, usually are not the same, as several bits
may be transmitted through the channel by the modem in each signal change (a
few bits can be transmitted as one symbol). The relation between bit rate and
baud is expressed as: bit rate equals the baud rate times the number of bits
represented by each signal unit. Bit rate is always more or equal than baud rate.
Baud rate determines the bandwidth required to transmit the signal. The signal
may be in the form of pieces or block that may contain bits. A fewer bandwidth is
required to move these signal units with large bits for an efficient system. To
understand the relation between bit and baud rate, we consider an analogy of car,
passengers and highway with signal units, bits and bandwidth respectively.

A car has capacity of carrying 5 passengers maximum at a time. Suppose a
highway may support only 1000 cars per unit time without congestion. When
each car on the highway carries 5 passengers, it is considered that the highway is
capable of providing services without congestion. Thus hi ghway services are treated
efficient. Consider another case, when all these 5000 passengers wish to go in
separate cars, they require 5000 cars and highway can only support 1000 cars at
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atime. The services offered gets deteriorated because highway’s capacity is meant
only for 1000 cars. It does not bother as to whether these 1000 cars are carrying
1000 passengers or 5000 passengers or more. To support more cars, the highway
needs to widen. Similarly, the number of bauds determines the bandwidth.

3.8.4 Bandwidth

Bandwidth may be defined as the range of frequencies assigned to a channel. In
other words, we may say that bandwidth is the difference, expressed in Hertz,
between the highest and the lowest frequencies of a band. In general, the higher
the bandwidth, the more will be the data transmission rate or throughput. It should
be noted that bandwidth and data transmission rate are very closely interrelated to
each other. Any transmission system becomes more attractive if the available
bandwidth is greater, introduced errors are fewer, and the maximum distance
between various network elements (amplifiers, repeaters, and antennae) is greater.

Table 3.1 Frequency Spectrum

Name of Band Frequency Range Wavelength Usage
Audible 20 Hz-20 kHz >100 km Voice
Extremely/ Very Low Radio Navigation,
Frequency (ELF/ VLF) 3 kHz-30 kHz 10-100 km Weather, Submarine
Radio Communications
Radio Navigation,
Low Frequency: (LF) 30 kHz-300 kHz 10-1 km Maritime
Radio C g
ommunications
Medium Frequency (MF) B B Radio Navigation,
Radio 300 kHz-3 MHz 1 km—-100 m AM Radio
High Frequency (HF) 3 MHz-30 MHz 100-10 m g:;zﬂs Band (CB)

; Amateur (HAM)
ity HighFriuancy 30 MHz-300 MHz 10-1 m Radio, VHF TV, FM
(VHF) Radio Radi

adio
Ultra High Frequency : ) Microwave, Satellite,
(UHF) 300 MHz-3GHz 1 m—10 cm UHF TV
Super High Frequency g ; ;
(SHF) Radio 3 GHz-30 GHz 10-1 cm Microwave, Satellite
Extremely High y B ; ,
Frequency (EHF) Radio 30 GHz-300 GHz 1 cm—.1 mm Microwave, Satellite
Infrared Light 103-105 GHz 300-3 p Infrared
Visible Light 1013-1015 GHz 1-3p Fiber Optics
X-rays 1015-1018 GHz 103-107 p N/A
Gamma and Cosmic Rays >1018 GHz <017 p N/A

The symbols have the following meaning:
K (Kilo) = 1,000 M ( Mega) = 1,000,000 (1 million)
G (Giga) = 1,000,000,000 (1 billion) T (Tera)=1,000,000,000,000 (1 trillion)

c¢m = centimeter (1/100 meter) mm = millimeter (1/1,000 meter)

p = micron (1/1,000,000 meter)

In transmission of a signal, the range of carrier frequencies depends on the
nature of the medium and the requirements of the applications supported. Therefore,
frequency spectrum may be defined as the range of frequencies being supported
by a particular transmission medium. The actual range of frequencies supporting a
given communication is known as a pass band. These are given in the Table 3.1.




Distances: Higher frequency signals offer greater bandwidth, they also
generally suffer greater extent of signal attenuation than lower frequencies. This
results in more errors in transmission, unless the amplifiers/repeaters are spaced
more closely together. It clearly demonstrates the close and direct relationship
between bandwidth, distance, and error performance. Bandwidth, in this context,
refers to the raw amount of bandwidth the medium supports. Error performance
refers to the number or percentage of errors, which are introduced in the process
of transmission. Distance refers to the minimum and maximum spatial separation
between devices over a link, in the context of a complete, end-to-end circuit.

3.8.5 Bit Rate

Bit rate is the rate over network speed which is used to detect errors while transmitting
data. The most popular method for detecting errors is inserting a parity bit alongside
the data bits for a character. Receiving modems detect incorrect bit rate, which is
also called parity bit. It requests the sending modem to retransmit the character.

Table 3.2 String of Data with Start and Stop Bits

Stop Bit Data Bits Start Bit

0 1000001 0

Table 1.6 String of Data with Inserted Parity Bit

Stop Bit and Data Bits Start Bit
Parity Bit
0 1000001 0

A modem is a bridge gap between digital and analog data transmission which
allows the digital data to be transmitted/received over the telephone lines. In
telecommunication and network computing, bit rate are sometimes written as data
rate and are conveyed and processed per unit time. It is measured as bits per
second (bit/s or bps).

Table 3.3 The SI Prefix for Different Bits

Bit SI Prefix

Kilo Kbit/s or Kbps
Mega Mbit/s or Mbps
Giga Gbit/s or Gbps
Tera Thit/s or Thps

The net bit rate, also called useful bit rate, of a digital communication link, is
the capacity of the physical layer protocol, such as: Framing Bits, Time Division
Multiplex (TDM) and redundant Forward Error Checking (FEC).

The operating system indicates the connection speed of the network access
technology device. The speed of connection of bit rate is determined by FEC and
refers to physical layer net bit rate.

Forexample, the connection speed of IEEE (The Institute of Electrical and

Electronic Engineers) 802.11,a wireless network, is the bitrate of 6 Mbit/s and 54
Mbit/s while the gross bitrate is between 12 Mbit/s and 72 Mbit/s which includes
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error correcting codes. The connectionspeed of ISDN (Integrated Services Digital
Network) BSI (Basic Rate Interface) that is 2 B-Channels+ 1D Channel) of
64+64+16= 144 Kbit/srefersto the user datarates, while the linerate is 160 kbit/
s. The connection speed of Ethernet 100 Base—TX (TR ANSMIT) physical layer
is 100 Mbit/s, whichis also its grossbitrate.

Throughput and digital bandwidth consumption refers to the bit rate achieved
in a computer network over a logical or physical communication link via network
node. Throughput is affected by traffic load of network resources, whereas data
transfer rate is achieved by average net bit rate of all protocol overheads, data
packet transmissions.

Output Settaings

Output Formats : Export Settings —
Super Yideo CD IMPEGE) s Resolution ¥ (480 | |
HEEG, spamific = — * Zoom |Full (16:9 or 4:1%|

Video Bitrate Kbi &l |
_ ideo Bitrate Kbi L |Bi1inanr [ITTH ‘,:!I‘
Audio Bitrate Kbi (224 |V o
; e e fram|922 1
Hormal (Fa ™
—' Time to encode 00:00:38
Calewlati |mmx V| Estinated size 8253MEB

Motion searc

DCTfi'DCT Iﬂm{ ~v-| \-r'olums don’ t u.xcjad
E;eperi Settings i |Custom size 'Y|1Settlngs ‘
 Mux rate 5.6 | %  Mise =i :

[JIngnore overwrite messai
i B ook El KB Render every O=none [25 l B

| Huant matr |Default ¥ | Output Frame Rate

Export (WItPrer [RGE2e W 23978 OSC) £l
Betect progr. 24Hz
[(JPulldown 3:2 [Force 24 Hz

[ Apply ] [:heck standarr_i] |Set Sta.ndardl Cancel I

Fig. 3.19 Output Setting of Bit Rate

Figure 3.19 shows the video bit rate of the output MPEG file and audio bit rate,
which are arranged for output setting. Motion search is set to achieve a balance
between noise blurring and rendering speed around moving objects in the output
file.

Multimedia Bit Rate

Bit rate is the number of bits used per unit to represent continuous medium such as
audio or video following source coding (data compression) to the multimedia files.
The size of the multimedia file is the product of bit rate (in bit/s) in bytes and the
length of recording in seconds divided by eight. The bit rate is measured by input,
which avoids interrupts with reference to streaming multimedia.




Fundamentals of Bit Rate
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e The sample uses different number of bits. Concepts and Networking
¢ The datais encoded by different number of bits.
e The material is sampled at different frequencies. NOTES

e The information is digitally compressed by different algorithms.
Table 3.4 The Reference Standards for Different Measurements of Bit Rates

Bit Rate Measured Reference Standard

32 Kbit/s MW AM Quality

96 Kbit/s FM Quality

128-160 Kbit/s Bass Quality

192 Kbit/s Digital Audio Broadcasting (DAB)

224-320 Kbit/s CD Quality

800 bit/s Recognizable Speech

8 Kbit/s Telephone Quality

500 Kbit/s Audio Format such as FLAC, WavPack, Monkey’s Audio
1411.2 Kbit/s Compact Disc Digital Audio Video (MPEG2)

16 Kbit/s Video Phone Quality

128-384 Kbit/s Business — Oriented Videoconferencing System Quality
1.25 Mbit/s VCD Quality

5 Mbit/s DVD Quality

15 Mbit/s HDTV Quality

36 Mbit/s HD DVD Quality

54 Mbit/s Blue-Ray Disc Quality

Properties of Bit Rate with Reference to Speed

The bitrate is fixed and uniform for a specific network. The gross bit rate is the
number of bits transmitted per second by an ideal transmitter. It could be as high
as 1 Mbit/s. The net bit rate means the number of useful bits carried per second.
The latency of bit rate is the time interval between the instant of initialization, that
is, transmission request and the actual start of transmission including all algorithms
and parameters. It is used to calculate the speed of time to access the network,
without getting error frames.

Y
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Fig. 3.20 DVD Bit Rate via Network Speed
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The above figure shows the graph of DVD bit rate viewer as average bit rate
according to network searching speed.
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Fig. 3.21 Audacity Preferences

The above figure shows how the bit rate is set for MP3 (Music Player 3) Export
set up as library version. Here, it is set as 32 Kbit/s. It is significant to export the
messages as MP3s because they are smaller files as compared to WAV (Windows
Media Audio) files.

3.8.6 Simplex and Duplex Communication

From the viewpoint of the direction of transmission, communication modes can be
classified into the following three types:

Simplex
Data is always transmitted only in one direction. TV broadcasting is an example.
The information flows in one direction across the circuit, with no capability to
support a response in the other direction. Simplex transmission generally involves
dedicated circuits as shown in Figure 3.22. Simplex circuits are analogous to
escalators, doorbells, fire alarms and security systems.

Flow of Data

Fig. 3.22 Simplex Communication

Simplex

r

Half Duplex

Data is transmitted in one direction at a time, for example, a walkie-talkie. This is
generally used for relatively low-speed transmission, usually involving two-wire,
analog circuits as shown in Figure 3.23. Due to switching of communication




direction, data transmission in this mode requires more time and processes than Prominent Information
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under full duplex mode. Examples ofhalf duplex application include line printers, Concepts and Networking
polling of buffers, and modem communications (many modems can support full

duplex also). ' N——

Half duplex Flow of Data
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= O
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Fig. 3.23 Half Duplex

Full Duplex

Data can be transmitted in both directions at the same time. In general, four wires,
as shown in Figure 3.24, are required for full duplex transmission. Full duplex
typically requires two simplex circuits, one operating in each direction. All wide-
band and broadband circuits are full duplex in nature, as most of the multichannel
circuits. More typical examples of full duplex applications include channel links
between host processors, channel links between controllers/concentrators and
hosts, and other applications involving the interconnection of substantial computing
systems. Services such as Frame Relay, SMDS and ATM are based on full duplex
transmission.

Full duplex Flow of Data

O—0O

Fig. 3.24 Full Duplex

3.9 PROTOCOLS AND STANDARDS

The group of people responsible for monitoring and reviewing the progress made
in developing TCP/IP, initiated by US Department of Defense, is known as the
Internet Activities Board (IAB). Gradually, the IAB evolved from a DARPA-
specific research group into an autonomous organization. Its members chaired
smaller groups called Internet Task Forces (ITFs). Each ITF was required to deal
with different aspects of the evolution of TCP/IP and the Internet. In 1989, the
IAB was reorganized. Two subsidiary groups were created viz., the Internet
Engineering Task Force (IETF) and the Internet Research Task Force (IRTF).
The former was assigned the task of developing the Internet standards, and the
latter was made responsible for research and development. The Internet Society
(ISOC) was formed in 1992 as the standardizing body for the Internet Community.
The IAB was renamed as the Internet Architecture Board (IAB). For issuing new
standards this group relies on the Internet Engineering Task Force (IETF), and for
coordinating values shared among multiple protocols it relies on the Internet
Assigned Numbers Authority (IANA).
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3.10 TRANSMISSION IMPAIRMENTS

In data communication the signal has to travel through the transmission media that
may be wired or wireless. The transmission media may not be perfect and causes
anumber of impairments in the signal and sometimes, they are so damaging that
the original signal could not be obtained at the receiving end or it could be deciphered
partly. The signal, which is received, will differ from the signal that is transmitted
due to transmission impairments. These impairments cause various modifications
that degrade the signal quality. A binary 1 may be changed into a binary 0 and vice
versa due to bit error. There exist three causes of impairment. They are attenuation,
distortion and noise.

Attenuation

When signal amplitude degrades along a transmission medium, this is called signal
attenuation. When a signal passes over the transmission media and electronic
circuitry to finally reach its destination, the signal loses its power or energy.
Attenuation is the loss of the signal power of signal while traversing a transmission
media including electronic circuitry and is measured in terms of decibel (dB).
Distortion is calculated as the ratio of the signal at two different points or relative
power of two signals at the same point. A negative value of decibel indicates loss
of signal strength and a positive value of decibel indicates gain in signal strength.
The relative strength of the signal is given by:

10 log,, (P,/P,) dB

When an electromagnetic signal travels through a media, it progressively
loses energy as a result of absorption of energy. The reduction in amplitude of a
signal increases as it travels farther from the point of origin. In some instances, the
signal degrades so much that it becomes difficult to obtain the original signal.
Likewise, the electronic circuitry also tends to take away some of the signal power
in the form of heating of the copper, metals, etc. These are not the only causes,
there exists more causes that degrade the signal energy. All these causes have
therefore necessitated amplifying the signal at some intermediate points along the
path while it travels through electronic circuitry and transmission media. Amplifiers
or repeaters are inserted at intervals along the medium to improve the received
signal as close as possible to its original level. The attenuation includes a number of
factors like transmitting and receiving antennas, transmitter powers, modulation
techniques, frequency of the transmission, atmospheric conditions, etc. Distortion
is proportional to the square of the operating frequency.

Distortion

Distortion is the change in shape or form of a signal, when a signal travels through
a electronics circuitry and transmission media. A signal produces harmonic
frequencies as and when it passes through non-linear electronic circuitry and
becomes composite signal. Likewise a signal experiences varied frequency while
passing through a guided medium. The signal will include some harmonic distortion
or unwanted frequencies. Thus the signal composed of different frequencies will




have different propagation speed and therefore experience different propagation
delay to arrive at the destination. This causes a signal to distort and change its
original shape while passing over a transmission media. All these factors causes
signal components of one bit position to spill over into other bit position and lead
to change in waveform and information. As the distortion causes delay in the signal
and increase in the bit rate, some of the frequency components associated with
each bit transition are delayed and start to interfere with frequency components
associated with a later bit. This phenomenon is called intersymbol interference,
which is considered as one of the major limitations to maximum bit rate, Equalizing
devices are inserted at intermediate points to keep the shape of the signal intact.

Channel Noise

Itis a small amount of background interference in the channel or unwanted electrical
or electromagnetic energy. This unwanted electromagnetic energy is referred to as
noise. This does not carry data or information but interferes with the signal. The
information and data is nothing but signal in electromagnetic form. Hence, noise
degrades the quality of information and data. When noise has a value more than a
threshold value, the receiver will not be able to distinguish between signal and
noise and therefore data or information may not be reproduced at the receiver’s
end. This is considered as one of the main sources for transmission errors.

The noise may be classified as external or internal noise based upon the
sources. External noise is generally picked up from electrical appliances present in
the vicinity, atmosphere and even outer space. Normally, this noise does not hamper
the performance very seriously. However, if there are a number of electrical
appliances in use external noise can affect communications as an outcome of
cascading. The external noise is generally inversely proportional to the frequency
and directly proportional to the wavelength. The external noise has a remarkable
impact in wireless systems than in wired systems.

Noise generated inside channel or receivers is known as internal noise.
Internal noise is less dependent on frequency but has a significant affect at higher
frequency because external noise has less impact at these frequencies. Minimizing
the signal bandwidth can control the internal noise but this will limit the maximum
speed of the data that can be delivered. Internal noise is fairly low in case of digital
signal processing, fiber optics technology. Noise is measured in terms of the
signal to noise ratio S/N or SNR with decibels (dB) as unit. Hence a low ratio
implies that it is not worth paying attention to the medium in question. The signal to
noise ratio is calculated as follows:

Signal
Noise

dB

SNR = 20 log,, x

Data Rate Limits

A channel puts limit on the rate of transmission of data rate. Data transmission rate
is dependent on the bandwidth of the channel and the level of the signal which is
being transmitted. There exists another important factor for determining the quality
of the channel. That is the presence of level of noise in the channel.
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3.11 NETWORKS

In the mainframe and minicomputer environment, each user is connected to the
main system through a dumb terminal that is unable to perform any of its own
processing tasks. Processing and memory are centralized in this environment.
However, although this type of computerization has its merits, the major
disadvantage is that the system can easily get overloaded as the number of users,
and consequently, terminals increase. Second, most of the information is centralized
to one group of people, the systems professionals, rather than the end-users. This
type of centralized processing system differs from the distributed processing system
used by LANS. In a distributed processing system, most of the processing is done
in the memory of the individual PCs or workstations. Besides, they share expensive
computer resources like software, disk files, printers and plotters, etc.

One may question why PCs are not, be connected together in a point-to-
point manner. The point-to-point scheme provides separate communication
channels for each pair of computers. When more than two computers need to
communicate with one another, the number of connections grows quickly as the
number of computers increases. Figure 3.25 illustrates that two computers need
only one connection, three computers need three connections and four computers
need six connections.

Figure 3.25 illustrates that the total number of connections grows more
rapidly than the total number of computers. Mathematically, the number of
connections needed for N computers is proportional to square is:

Point-to-point connections required =(N’-N)/2

Fig. 3.25 (a), (b), (c) Number of Connections for 2, 3, 4 Computers, Respectively

Adding the Nth computer requires N—1 new connections, which becomes
a very expensive option. Moreover, many connections may follow the same physical
path. Figure 3.26 shows a point-to-point connection for five computers located at
two different locations, say, the ground and the first floor of a building.




Location 1 Location 2

Fig. 3.26 Five PCs at Two Different Locations

Components of a Network

In general, a computer network is composed of one or more servers, workstations,
network interface cards, active and passive hubbs, routers, bridges, gateways,
modem, software components like network operating systems and other application
software. The following components are widely used for the construction of
networks:

Server

It is the most powerful computer of the network. Usually in a local area network,
a powerful microcomputer or a super microcomputer with the power of a
minicomputer is used as a server. Two types of servers are normally employed in
alocal area network: dedicated servers and non-dedicated servers.

In a dedicated server, the server computer performs functions and services
for the entire network. It helps to efficiently run user applications and increases the
overall system cost. Users cannot run their applications directly in a dedicated
server. It provides e-mail service and faster response time, Italso enables computers
to share multiple hard disks and other such resources. Dedicated servers are
usually employed for larger networks with a heavy load.

In a non-dedicated server, apart from the role of a network controller, a
server too acts as an individual workstation. The server is equipped with a large
memory. Network operations demand only a portion of server memory. The
remaining portion of the memory may be used for user applications. Under light
load conditions, it is advisable to use a non-dedicated server, Some servers can
operate on both modes according to the requirement of the user.

File Server

The primary goal of a computer network is to share data among several users.
They also make their attached disk drives, printers, modems and unique
communication links available to the various client stations. Providing one computer
with one or more hard disks facilitates this. All client stations share these hard
disks. Clients can make their requests to access any of the shared facility to the
server. The file server is a powerful computer, which runs a special software. It
provides files and other shared resources to different users in the network. It
provides facilities like user authentication and security to various user programs
and data. It can be accessed through the Network Operating System (NOS).
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Typical configurations of a server are Pentium 4 machine with 128 MB or a higher
capacity RAM, 40 GB or a higher capacity hard disk, to serve upto 10 nodes or
workstations.

All activities of a file server can be monitored and controlled from a monitor
called console. The network administrators are given special privileges. They are
given supervisory passwords. They perform network administration operation for
the entire network. If any user of the network needs to get a new network service,
they have to contact the network administrator and make a request for the specific
service they require. The file server has a large memory, which is used for caching
directories, and files and hashing directories. Novell Netware and Windows NT
are the two network operating systems that run on a server machine.

Workstation

Another important component of a network is the workstation or the client. A
workstation is an individual computer with capabilities to communicate with other
machines. It must be equipped with the necessary hardware and software to connect
to a LAN. Usually a Network Interface Card (NIC) or an Ethernet card or an
Arcnet card is used for this purpose. Part of the network operating system is also
available in the workstation. A workstation can communicate with other
workstations or to a server. The hardware requirement for a workstation depends
on the application and the size of the network. In a typical LAN of a university
computer center, a Pentium III system with 64 MB RAM and 4 to 8 GB hard disk
capacity, with necessary network interface card can be used for a typical
workstation. In general, the memory and hard disk capacity of a workstation is
much less than that of a server. .

Network Interface Unit

Every computer on the network needs one add-on card called Network Interface
Card (NIC) or Ethernet Adapter or Network Interface Adapter. The role of NIC
is to move the serial signals on the network cables, or media into a parallel data
stream inside the PC. In some cases, two or more such NICs are used in the
server to split the load. These interface units also have the important job of
controlling access to the media. This includes activities known as carrier sense
(listen before transmit), sequential station number and token passing.

Transmission Media

Data signal travels through this medium. It has two general categories: bounded
(guided) and unbounded (unguided). Twisted pair, coaxial and fibre optic cables
are all bounded media. The data signals travel within the boundaries of the
transmission media. On the other hand, microwave and satellite transmissions,
travel through air, which has no boundaries, and hence are called unbounded
transmission.

Hub

Network hub is a centralized distribution point for all data transmission in a network.
Ahub may also be referred to as a concentrator. Data packet from an NIC arrives

at the hub. The hub receives and rebroadcasts them to other computers connected
to it. In general, the hub network is a passive device. It does not know the




destination of a received data packet. Hence, it is required to send copies to all
the hub connections. Hubs can be classified into the following three categories:

e Stackable and non-stackable hubs.
e Active and passive hubs.
o Intelligent and non-intelligent hubs.

Stackable hubs are hubs that can be stacked or interconnected to make a
single hub appearance. They are useful for vendors to make hubs of sizes suitable
to customer requirements. Non-stackable hubs cannot be interconnected. They
always provide only a fixed number of connections.

Hubs that connect to the network backbone are known as active hubs.
Those hubs which connect only to active hubs, are known as passive hubs.

Intelligent hubs contain a special firmware that can be accessed by remote
workstations. The firmware is known as Simple Network Management Protocol
(SNMP). Network performance and network status data are read from SNMP.

Repeater

A repeater is a communication device that connects two segments of the network
cable. It retimes, regenerates and strengthens the digital data and sends them on
their way again. Repeaters are often used to extend the cable length to enlarge
LANs. Wide area network contains many repeaters. Ethernet also frequently uses
repeaters to extend the length of the bus.

Bridge

Abridge interconnects two networks using the same technology, (such as Ethernet
or Arcnet). A bridge is more sophisticated than a repeater. A modern bridge reads
the destination address of the received packet and determines whether the address
is on the same segment of the network cables of the originating station. If the
destination is on the other side of the bridge, the bridge transmits the packet into
the traffic on that cable segment. Local bridges are used to connect two segments
of the same LAN. Remote bridges are used to link local LAN cables to thin long
distance cables and thus links two physically separated networks. Network
administrators often use bridges to split big networks into a number of small
networks. Bridges are easy to install. They provide an easy way to perform network
management functions.

Router

A router transfers data between networks. It is also possible for a router to transfer
data between different compatible network technologies such as Ethernet and IBM
token ring. Since the Internet consists of thousands of different network technologies,
routers are an integral part of the Internet. A router has its address on the network. A
bridge does not have an address. Hence, a router can act as an intermediate
destination. In other words, a computer can send a data packet to the router of
another network. A router will transfer the packet to the other networks. On the
other hand, a bridge must examine all the packets to determine which packets to
transmit between networks. As such, computers never send packets directly to a
bridge. A router examines a packet only if it contains the router’s address.
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A router can also act as a bridge. Such a router is known as a brouter. The
brouter receives a packet and examines whether it supports the protocol used by
the packet. If not, it simply drops the packet. A packet is bridged using the physical
address information. '

Gateway

Two dissimilar networks can be connected by means of a gateway. For example,
amainframe can be connected and made accessible to a PC network by means of
a gateway. Unlike routers, a gateway converts the format of the data sent between
two networks. A router adds only addressing information to the data packet.
Routers never change the content of the message. But a gateway has to identify
the protocols used in the networks, and recognize the data format and convert the
message format into a suitable format which is acceptable by the other networks.
Wide area networks often use gateways because there is a large number of dissimilar
networks present in a WAN. Gateways provide good connectivity to different
kinds of networks on the Internet.

Modem

Another significant network component is a modem. The term modem is the
shortened version of the name modulator—demodulator. A modem provide two-
way communication facility between a computer network and a telephone network.
As a Wide Area Network employs the existing telephone network to connect toa
distant network, it always uses a modem to dial-up the telephone network. A
modem converts the digital data from the computer into useful analog signals that
can be transmitted through a telephone network. Similarly, signals from the telephone
channels are converted back into digital data suitable for a computer.

Check Your Progress

Define the term expert system.

What is channel noise and how does it affect transmission?
. What determines the channel data transmission rate?

. What do you understand by the term ‘attenuation’?

10. Whatis a server?

11. What is a workstation?

© 0 N o

3.12 TYPES OF NETWORKS

This section will discuss the various networks, that is, LAN, WAN and MAN
Local Area Network

Networks that are privately owned, offer consistent fast-paced communication
channels which are optimized to connect information processing tools in a restricted
geographical area. These are known as Local Area Networks (LANS).

A shared, local (restricted-distance) packet network for computer
communication is a form of LAN. A common medium is used by LAN to link




T s R

peripherals and computers so that the user can share access to databases, files, Prominent Information
host computers, peripherals and applications. Systems, Communication

Coneepts and Networking
LANs, in addition to linking the computer equipment available on a particular
premise, also provide a connection to other networks either through a computer,
which s attached to both networks, or through a dedicated device called a gateway. NOTES
The main usérs of LANs include business organizations, research and development
groups in science and engineering, and industry and educational institutions. The
electronic or paperless office concept is possible with LANS.

The Local Area Network (LAN) technology connects people and machines
within a site. A local area network is a network that is confined to a relatively small
area as shown in Figure 3.27. LANs are described as privately owned networks
that offer reliable high-speed communication channels optimized for connecting
information processing equipment in a limited geographical area, namely, an office,
building, complex of buildings, and school or campus.

A LAN is a form of local (limited-distance), shared packet network for
computer communication. LANs interconnect computers and peripherals over a
common medium, so that, users might share access to host computers, databases,
files, applicationsand peripherals. They can also provide a connection to other
networks either through a computer attached to both networks, or through a
dedicated device called a gateway.

Bridge

Ethernet Ring Network
Fig. 3.27 Local Area Network (LAN)

The components used by LANs can be divided into cabling standards,
hardware, and protocols. Various LAN protocols are Ethernet, Token Ring, TCP/
IP, SMB, NetBIOS and NetBeui, IPX/SPX, Fibre Distributed Data Interchange
(FDDI) and Asynchronous Transfer Mode (ATM).

LAN in an Organization

A Local Area Network or LAN, connects computers that are in the same building
buta few kilometres apart. A LAN usually uses bus or ring topology. Fibre
Distributed Data Interface (FDDI) is also becoming popular, The transmission
rate varies from 10 million bits per second to 1 gigabits per second (10Mbps-
1Gbps). ALAN is usually under the control of a single organization. Almost 70
per cent of all LAN in the world use the Ethernet, which is a bus topology. Here,
all the computers are connected to one circuit. IEEE 802.3 is the standard for the
Ethernet.

Atypical LAN in an organization consists of a file server, a database server,
an application software server and a Web server. There may be about 100 desktop

systems and a single printer server. Earlier, computers were connected using hubs, ' . Eaontng
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which have now been replaced by switches. All computers are connected to a
switch.

The prime objective of a LAN is to facilitate information and resource sharing
within an organization. Application software, for example, which is used by many
people in an organization can be installed on one computer. This computer can be
made accessible to other computers through a LAN and everybody can use the
same software. The machine on which the software is installed is often called a
server. In the absence of a LAN, the same software has to be installed on all the
machines, which may be very expensive. In addition, an upgrade in the software
requires re-installation/modification on all the computers. The server may beafile
server, a printer server or a database server, depending on the service it provides
to its users.

Several LANs of an organization are connected with each other through a
backbone network. A backbone network is usually much faster than the LANs it
connects. Each LAN may be connected to the backbone network through a switch
gateway. There are numerous other ways of connecting LANSs together. Usually,
the administration of each LAN is done by the department system administrator
and the backbone is managed by the computer centre systems administrator.

Broadband versus Baseband LAN

There exist two LAN transmission options—baseband and broadband. Baseband
LAN, which is the most prevalent by far, is a single-channel system that supports
a single transmission at any given time. Broadband LANs, which are most unusual,
support multiple transmissions via multiple frequency channels.

¢

Baseband may use UTP, Coaxial or Fibre

i

Broadband using coaxial cable
Fig. 3.28 Broadband versus Baseband

Broadband LANs

Broadband LANSs are multichannel, analog LANs as shown in Figure 3.28. They
are typically based on coaxial cable as the transmission medium, although fibre
optic cable is also used. Individual channels offer bandwidth of 1 to 5 Mbps, with




T

20 to 30 channels typically supported. Aggregate bandwidth is as much as 500
MHz. Its characteristics are:

o Stations connected via RF modems, i.¢., radio modems accomplish the
digital-to-analog conversion process, providing the transmitting device
access to an analog channel.

e Digital signal modulated onto RF carrier (analog).
e Channel allocation based on FDM.
o Head-End for bidirectional transmission.
Advantages
e Has greater bandwidth.
e Data, voice and video can be accommodated on broadband channel.
e Covers greater distances.
Disadvantages
e Incurs high cost, requires modems.
o Lacks well-developed standards.
¢ Can be supported only by a coaxial cable.
¢ Requires alignment and maintenance.
Some broadband LANS are referred to as 10Broadband36 where 10 stands

for 10 Mbps, broadband for multichannel and 36 for 3600 metres maximum
separation between devices.

Baseband LANs

A baseband LAN is a single channel, supporting a single communication at a time
as shown in Figure 3.28. It is digital in nature. It provides a total bandwidth of 1 to
100 Mbps over a coaxial cable, UTP, STP, or fibre optic cable. Distance limitations
depend on the medium employed and the specifics of the LAN protocol. Baseband
LAN physical topologies include ring, bus, tree and star topologies.

Baseband LANs are by far the most popular and the most highly
standardized. Ethernet, Token Passing, Token Ring and FDDI LANSs are all
baseband. They are intended only for data, as data communication is, after all, the
primary reason for the existence of LANS. The characteristics of this system may
be summarized as follows:

¢ No need of modems — low cost installation.
Bidirectional propagation of signal.

o Unmodulated digital signal.

e Singlechannel.

e Stations connected via T connectors.

Advantages
o Simplicity.
e Low cost.
¢ Ease ofinstallation and maintenance.
e High rates.
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Disadvantages
e Limited distances.
¢ Data and voice only.

Advantages of LAN

LANSs are used almost exclusively for data communication over relatively short
distances such as within an office, office building or a campus environment. LANs
allow multiple workstations to share access with multiple host computers, other
workstations, printers and other peripherals, and connections to other networks.
LANS are also being utilized for imaging applications. They are being used for
video and voice communication as well, although currently on a very limited basis.

LAN applications include communication between the workstation and host
computers, other workstations and servers. The servers may allow the sharing of
resources. Resources could be information, data files, e-mail, voice mail, software,
hardware (hard disk, printer, fax, etc.) and other networks.

LAN benefits include the fact that a high-speed transmission system can be
shared among multiple devices in support of large number of active terminals and
a large number of active applications in the form of a multi-user, multi-tasking
computer network. LAN-connected workstations realize the benefit of
decentralized access to very substantial centralized processors, perhaps in the
form of mainframe host computer and storage capabilities (information repositories).
Additionally, the current technology allows multiple LANS to be inter-networked
through the use of LAN switches, routers, etc.

Disadvantages of LANs include concem for security of files and accounts.

Metropolitan Area Network (MAN)

A Metropolitan Area Network (MAN) covers large geographic areas such as
cities or districts. By interconnecting smaller networks within a large geographic
area, information is easily disseminated throughout the network. Local libraries
and government agencies often use a MAN to connect with citizens and private
industries. It may also connect MANs together within a larger area than a LAN.
The geographical limit of a MAN may span a city. Figure 3.29 depicts how a
MAN may be available within a city.

LR
e Router T
el .
Telephone :
\’ / Exchange
e e e Router
Ethernet Ring Network

Fig. 3.29 Metropolitan Area Network (MAN)

InMAN, different LANSs are connected through a local telephone exchange.
Some of the widely used protocols for MAN are RS-232, X.25, Frame Relay,
Asynchronous Transfer Mode, ISDN, OC-3 lines (155 Mbps), Asymmetrical
Digital Subscriber Line (ADSL), etc. These protocols are quite different from
those used for LANS.




w

Wide Area Network : Prominent Information
Systems, Communication

AWide Area Network (WAN) connects networks in different cities or countries, ~ Concepts and Networking
Gateways are used to connect these networks. A network which can connect

networks that are over a hundred kilometres apart is not built by any organization. NOTES
Instead, the organization uses leased telephone lines, satellite links or other wireless ’
media to provide this service. It is obvious thata WAN is not owned by a single
organization. It is owned and managed collectively by many cooperating

organizations,

This technology connects sites that are in diverse locations. Wide Area
Networks connect larger geographic areas, such as New Delhi, India or the world.
The geographical limit of WAN is unlimited. Dedicated transoceanic cabling or
satellite uplinks may be used to connect this type of network. Hence, a WAN
may be defined as a data communication network that covers a relatively broad
geographic area to connect LAN together between different cities with the help
of transmission facilities provided by common carriers, such as telephone companies.
WAN technologies function at the lower three layers of the OS] reference model.
These are the physical layer, the data link layer and the network layer.

Figure 3.30 explains a WAN, which connects many LANS together. It also
uses switching technology provided by local exchange and long distance carrier.

LR

. / Router -
=
Telephone .

7 Exchanges

== ==
Ethemnet Ring Network

Fig. 3.30 Wide Area Network (WAN)

Packet switching technologies, such as Asynchronous Transfer Mode , Frame
Relay, Switched Multimegabit Data Service (SMDS) and X.25 are used to
implement WAN along with statistical multiplexing to enable devices to share these
circuits.

The difference between MAN and WAN may be understood only from the
services being used by them. WAN uses both local and long distance carrier while
MAN uses only local carrier. Hardware and protocols are same for both.

Private Branch Exchanges

Networks may be classified on the basis of their geographic scope into local
networks and wide area networks. Wide area networks encompass a relatively
wider geographic area, from several miles to thousands of miles, whereas local
networks link local resources, such as computers and terminals in the same
department or building of a firm. Local networks consist of private brand exchanges
and local area networks.

A Private Branch Exchange (PBX) is a special-purpose computer

designed for handling and switching office telephone calls at a companysite. It can i;’{ y P‘jﬂmiﬂg -
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belong to a company or to a provider. Today’s PBXs can carry voice and data to
create local networks. PBXs can store, transfer, hold and redial telephone calls
and also switch digital information among computers and office devices. Using a
PBX, you can write a letter on a PC in your office, send it to the printer, then dial
up the local copying machine and have multiple copies of your letter created.

The advantage of digital PBXs over other local networking options is that
they do not require special wiring. A PC connected to a network by telephone can
be plugged or unplugged anywhere in a building using the existing telephone lines.
Many commercial vendors provide/maintain PBX services, so an organization
does not require a special expertise to manage them.

The geographic scope of PBXSs is limited, usually to several hundred feet,
although a PBX can be connected to other PBX networks or to packet-switched
networks to encompass a larger geographic area. The primary disadvantages of
PBXs are that they are limited to telephone lines and cannot easily handle very
large volumes of data.

Network Services and Broadband Technologies

In addition to topology and geographic scope, networks can be classified on the
basis of the service they provide.

Value-Added Network (VAN)

A value-added network is a private, third-party-managed network that offers
data transmission and network services to subscribing firms. Let us say, a business
firm wants to communicate purchase orders to its vendor. One possibility is that
both parties join hands and set up a communication system. Another possibilityis
to subscribe to a VAN service provider who will set up the system and the buyer
and the vendor will be connected to each other through the VAN service provider.
The VAN service provider will facilitate communications between both parties.
The parties pay only for the amount of data they transmit along with a subscription
fee. VANSs are cost effective because of economies of scale.

Other Network Services

It is more expensive to talk on a phone than to chat on the Internet. The latter is
cheaper because the packet switching protocol it uses enhances the use of
communication channels. In the case of telephone lines, circuit switching is used
wherein the circuits are switched to establish an end-to-end communication channel
which is dedicated to the duration of the conversation. In packet switching, each
message (voice, data, graphic) is broken down into multiple packets and each
packet has information about the destination and the sequence. Each packet then
travels on its own , from source to destination, using the available communication
channels. The packets are assembled together into a message at the destination.

Integrated Services Digital Network (ISDN)

It is an international standard to access dial-up network that integrates voice, data,
image and video services in a single link. Organizations and individuals that require
the ability to provide simultaneous voice or data transmission over one physical line
might choose this service. Primary Rate ISDN offers transmission capacities in the
megabit range and is designed for large users of telecommunication services.

F
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Like ISDN, digital subscriber line (DSL) technologies also operate over
existing copper telephone lines to carry voice, data and video, but they have higher
transmission capacities than ISDN.

High-speed transmission technologies are sometimes referred to as
broadband. The term broadband is also used to designate transmission media that
can carry multiple channels simultaneously over a single communications medium.
Broadband media is available in most big cities in India.

Network Convergence

As mentioned earlier, the need today is to have a single set-up to transmit voice,
data and video in a single network infrastructure. These multi-service networks
can potentially reduce networking costs by eliminating the need to provide support
services and personnel for each type of network. Many devices are available
nowadays that use ISDN to provide such facilities.

3.13 COMMUNICATION NETWORKS

LANGs are classified depending on the topology, access methods, signalling methods,
transmission medium and transmission mode.

Topologies and Design Goals

The control of the network is of two types viz., centralized and distributed. With
centralized control, access to the network and allocation of channel is controlled
by one node, such as a dedicated communications processor or switch. When
control is distributed, nodes have the ability to establish connections and access
the network channel independently, according to an accepted set of rules.

Most LANs are based on simple structured topologies, like the ring, bus or
star. Some of the basic characteristics of these topologies are outlined as follows:

Hierarchical Topology

A hierarchical topology connects multiple star networks to other star networks.
This type of topology contains a central root node that is a top-level hierarchy
which is connected to one level lower in the hierarchy. It maintains a point-to-
point link at the end of the previous level node. The total number of point-to-point
links in a network is based on the physical hierarchical topology.

Fig. 3.31 Nodes Setting in Hierarchical Topology
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Features

e This topology will have at least three hierarchies in the hierarchy network,
all based on the root mode.

e It supports two networks, the star and the linear topology, which connect
the node.

e Nodes can be added at any level of hierarchy.

e The higher level in the hierarchy performs more functions than the lower
level.

Advantages

e It supports point-to-point connections and wiring for individual segments.

¢ Systems access immediate and larger networks.

e Itissupported by several hardware and software vendors.

Disadvantages
e The whole network depends on the type of cable.
e It depends on the root trunk which is the backbone of the network.
e Ifarootnetwork fails, the entire network will fail.
e Itis difficult to configure.

Horizontal Topology (Bus)

Bus topologies are multipoint electrical circuits that can be implemented using
coaxial cable, UTP or STP. In a bus topology, data transmission is bidirectional,
with the attached devices transmitting in both directions. While generally operating =
at araw data rate of 10 Mbps, actual throughput is much less.

It is employed frequently in the LANs with distributed control in all nodes,
as shown in Figure 3.32, share the common bus. Messages placed on the bus are
transmitted to all nodes. Nodes must be able to recognize their own address in
order to receive messages. However, unlike nodes in a ring, they do not have to
repeat and forward messages intended for other nodes. As a result, there is none
of the delay and overhead which is ordinarily associated with retransmitting
messages at each intervening node. Because of the passive role that a node plays
in transmission on the bus, network operation will continue in the event of node
failures. This makes distributed BUS networks inherently resistive to single-point
failures.

)4— Terminator

EE=T
Fig. 3.32 Bus Topology
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Bus networks employ a decentralized method of media access control known
as CSMA (Carrier Sense Multiple Access), that allows the attached devices to
make independent decisions relative to media access and initiation of transmission.
This approach results in data collisions and requires frequent retransmission. Bus
networks are specified in the IEEE 802.3 standard, and generally have a maximum
specified length of 1.5 miles (2.5 km). Ethernet is based on a bus topology. A tree
topology is a variation of the bus topology, with multiple branches off the trunk of
the central bus. Bus networks also suffer from the vulnerability of the bus, that is,
if one node is down, all nodes in the bus will be down. Similarly, tree networks
depend on the integrity of the root bus.

Ethernet

Ethernet is the best alternative to a high-speed and cost-effective LAN. Data is
transmitted and received at the rate of 10 million bits per second. Heavy coaxial
cable (thick net) or fibre optic cable are used to transfer data between wiring
closets. Thick net coaxial is made to use over medium-long distances where the
level of reliability required is medium. A light duty coaxial cable known as thin net
is normally used to connect workstations within the same room. Figure 3.33 shows
the scheme of Ethernet where a sender transmits a modulated carrier wave that
propagates from the sender toward both ends of the cable.

Ethernet was first designed and installed by Xerox Corporation at its Palo
Atto Research Center (PARC) in the mid-1970. In the year 1980, DEC Intel and
Xerox came out with a joint specification which has become the de facto standard.
Ethernet was named DIX from this period onwards. It gained this name after its
business sponsors Digital, Intel, and Xerox.

Destination
computer
that receives

T T T
Terminator —{) Ethernet Cable (share bus) )4——- Terminator

Signal
e - propagates
along the
Sending entire cable

computer
transmits

Fig. 3.34 Signal Flow across an Ethernet

Star Topology

The distinguishing feature of star topology is that all nodes are joined at a single
point, as shown in Figure 3.34. This single point is called as a central node, hub, or
switch, to which all other devices are attached directly, generally via UTP or STP.
This topology is frequently used for networks in which control of the network is
located in the central node. This method is optimal when the bulk of communication
is between the central and outlying nodes. If traffic is high between outlying nodes,
an undue switching burden is placed on the central node.
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Transmission rates vary with AT&T’s Star LAN operating at 1 to 10 Mbps,
and both 100 Base-T and 100VG-AnyLAN at 100 Mbps. The primary advantage
of a star is that a disruptive or failed station can be isolated, thereby eliminating
any negative effect it may have on LAN performance. Additionally, each node has
access to the full bandwidth of the LAN, at least in a LAN switch environment,
The primary disadvantage is that a hub failure is catastrophic. Since the entire
connectivity is provided through the central hub, its failure affects the entire LAN.,

(B
=
----— il

(=)
Fig. 3.34 Star Topology

Asynchronous Transmission Mode (ATM)

Asynchronous Transfer Mode (ATM) is an International Telecommunication Union-
Telecommunication Standardization Sector (ITU-T) and is a standard for cell relay.
Here, information about video, data or voice and other service types is
communicated in tiny, fixed-size cells. Networks of ATM’s are connection-oriented.
ATM has emerged as a standard in communication. It provides medium to high
bandwidth and a virtual link between the delivery of real-time data, video and
voice.

Ring Topology

The ring architecture is a distributed architecture, with minimal connectivity and a
topology of two links connected to every node as shown in Figure 3.35 and forms
unbroken circular configuration. Figure 3.35 shows a network laid out in a physical
ring, or closed loop, configuration. Transmitted messages travel from one node to
another around the ring. Each node must be able to recognize its own address in
order to accept messages.

Information travels around the ring in only one direction, with each attached
station or node serving as a repeater. Rings generally are coaxial cable or fibre in
nature, operating at raw transmission rates of 4, 16, 20 or 100 Mbps or more.
Rings are deterministic in nature, and employ token passing as the method of
media access control to ensure the ability of all nodes to access the network within
a predetermined time interval.




Fig. 3.35 Token Ring Topology

Ring networks with centralized control are known as loops. When ring
networks with distributed control are used, some form of control strategies must
be used to avoid conflicting demands for the shared channel. The popular control

strategies are token passing, circulating slot and register insertion techniques.
Fibre Distributed Data Interface (FDDI)

Outer ring used for data Station adjacent to
l Failed station failure loops back

Inner ring
I{ unused except
during failure
(a) (b)
Fig. 3.36 (a) FDDI Network with Counter Ring (b) The Same Network after a Station

has Failed

FDDl s developed as a reliable, high-speed network to handle voluminous
traffic. It provides data speed at a rate of 100 Mbps and is capable of supporting
500 stations on a single network. FDDI operates on fibre cables by transmitting
light pulses which convey information back and forth between nodes. In some
cases, it may also operate on copper using electrical signals. A related technology,
Copper Distributed Data Interface (CDDI) works like FDDI using copper cables
instead of fibre cables.

FDDI is able to maintain high reliability because of the provision of two
counter-rotating rings as shown in Figure 3.36(a) in FDDI networks. These rings
provide a backup for each other by providing an alternate way to get the data, if
something goes wrong in the network. Figure 3.36(b) illustrates data flow when
one station fails. When a node fails, the adjoining node uses a reverse path to form
aclosed ring. FDDI is reliable because it has the ability to fix its own problems.
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Mesh Topology

In a mesh network, each pair of nodes is connected by means of an exclusive
point-to-point link. Each node requires a separate interface to connect with the
other device. Mesh networks are seldom constructed in practice. They are useful
in situations, where one node or station frequently sends messages to all other
nodes. Otherwise, a considerable amount of network bandwidth is wasted. The
advantages are excessive amount of bandwidth and inherent fault tolerance. The

structure of a mesh network is shown in Figure 3.37.

Fig. 3.37 Mesh Network

Switched and Non-Switched Network Options

Switching includes the ‘plug and play’ element. It determines Ethernet addresses
which are used on each segment and creates a table of signal packets. This feature
connects different network types together just like Ethernet and fast Ethernet of
the same types. The main advantage of switching is that there are no protocol
issues with switching. Nowadays, a fibre optic switch is used in switching technology
because it harnesses all the available bandwidth. Use of an optical switchallows
users on a network to send more information. It also provides huge advantage as
immunity to EMI (Electrical and Musical Industries) disturbance and lighting strike
which assures network security.
Switching provides gigabit speeds and several management options. Basic
management includes the following:
¢ General:— Switching manages location, system name, reboot on error,
statistics collection, Telnet login, etc.
¢ LAN Port: Switching configures speed and flow control, link type and
physical address, to change configuration on each port.
¢ Console: Switching, at this stage, changes the flow control method , baud
rate, modern control, set-up string, enable or disable SLIP (Serial Line
Internet Protocol), configure SLIP, SLIP subnet masking.

In switching, file transfer packets allow you to identify the port which is up and the
port which is down. The bandwidth option is increased through the trunk technique.
Basically, it is the process of hooking one switch to another in full duplex.




Prominent Information

Hub Network Switch Systems, Communication
Concepts and Networking
Intertnet
Access Router/ R
Gateway/Firewall
NOTES
— =)
Hub
'_{'ratMeter ' ;
'promiscuous mode' is on Workstatiot
Fig. 3.38 Switched Network
Figure 3.38 shows that in a switched network, a network switch which is also
called Ethernet switching, is used in segmenting to reduce network loading. It
blocks some data from branches of the network which basically do not require
the data.
Advance switching includes many tasks for setting up networking design
including the following:
¢ 12 Switching Database
e L3 IP Networking
* Bridging
e Static Filtering .
e Spanning Tree
e SNMP(Simple Network Management Protocol)
e Port Trunking
e Port Mirroring
Non-Switching Options
| Non-switching option is used by small organizations. The computer network consists
of only one segment to which all workstation computers are connected by a network
hub.
Hub S
Intertnet AL o| [cazaca) [oa
Access Router/ ﬁ;
Gateway/Firewall Workstation
-_—
’E Workstation
TrafMete 4
“promi:;auou: mtl;de" ison E
Workstation
Fig. 3.39 Simple Network Configuration Self - Learning
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Figure 3.39 shows how a segment is connected over a network by non-switching
options to access a router/gateway/firewall device. The TrafMeter is connected to
ahub carrying all traffic to and from the next gateway for non-switching network
configurations. -

Fig. 3.40 Pluggable Thermal Circuit Breaker used in Non-Switching Set-up

In a non-switched network environment, the network segment concept is followed.
Segment is a network architecture in which the router, bridge and hub are directly
addressable from each node. The main advantage is that frames are handled ina
broadcast manner. Each node examines the frame to see if it is addressed to them.

Step 2 Hub Router

Fig. 3.41 Non- Switching Set-up

Figure 3.41 shows how a non-switched network works. Here, Node B is
designed as the host which is used as a sniffing agent. Nodes A and C represent
the innocent who try to communicate with each other. The normal flow of traffic in
anon-switched network is as follows:

¢ Node A transmits a frame to node C.
e The hub broadcasts the frame to each active port.




¢ Node B receives the frame and examines the address in the frame after

determining that it is not a host. So, it discards the frame.

¢ Node C also receives the frames and examines the address. If it is the

intended host, further frame process is done in the same way.

e Then, network frames are passed to other hosts as well as higher network

layers where it is processed step-by-step.

12. Differentiate between baseband LAN and broadband LAN.
L%
14. What is the distinguishing feature of a star topology?
15. What s a ring topology?

Check Your Progress

State about the hierarchical topology.

3.14 ANSWERS TO ‘CHECK YOUR PROGRESS’

1.

Office automation systems is a type of information system that aids in
automating office tasks. It has a limited role in decision-making and is more
useful for operational-level people.

. TheTransaction Processing System (TPS) is defined as an information system

that processes transactions and produces reports that represent the
automation of the fundamental, routine processing.

. Decision Support System (DSS) helps the senior management to take

strategic decisions. Contrary to other systems, decision support system is
developed with the objective of providing the users (top management
personnel) with unstructured information.

. According to the American Marketing Association, Marketing is an

organizational function and a set of processes for creating, communicating
and delivering value to customers and for managing customer relationships
in ways that benefit the organization and its stakeholders. In simpler words
of Philip Kotler, Marketing is satisfying needs and wants through an exchange
process.

. Executive Support Systems (ESS) are designed for senior executives of

organizations. Executives are responsible for the growth and survival of the
organization. They need to monitor the performance of the organization,
remain competitive and respond to market changes and trends, etc.

. Expert systems offer an economical and practical way to capture, refine

and proliferate management skills. These systems provide a framework in
which to document the questions and answers that experts use to solve
analytical and operational problems. With expert systems, the know-how
of one ‘expert’ can be put in the hands of many workers to improve
consistency, accuracy and productivity throughout the network.

. Channel noise is the background interference present in the channel in small

amounts. It can also be the unwanted electrical or electromagnetic energy
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10.

11,

12.

13.

14.

18,

that does not carry any data or information but interferes with the information
or data. Hence, noise degrades the quality of information and data by
affecting communications and files of all types, including i images, audio, text,

programs, and telemetry.

. Channel data transmission rate is determined by the maximum number of

bits that can be transmitted per unit time through the physical medium. Itis
measured in bits per second (bps). H. Nyquist gave the maximum data rate
of anoiseless channel in 1924.

. When signal amplitude degrades along a transmission medium, this is called

signal attenuation. When a signal passes over the transmission media and
electronic circuitry to finally reach its destination, the signal loses its power
or energy. Attenuation is the loss of the signal power of signal while traversing
a transmission media including electronic circuitry and is measured in terms
of decibel (dB).

It is the most powerful computer of the network. There are two types of
servers normally employed in a local area network. They are dedicated
servers and non-dedicated servers.

A workstation is an individual computer capable of communicating with
other machines. It must be equipped with the hardware and software
necessary to connect to a LAN.

A baseband LAN is a single-channel system that supports a single
transmission at any given time. Broadband LANs support multiple
transmissions via multiple frequency channels.

A hierarchical topology connects multiple star networks to other star
networks. This type of topology contains a central root node that is top-
level hierarchy which is connected to one level lower in the hierarchy. It
maintains a point-to-point link at the end of the previous level node. The
total number of point-to-point links in a network is based on the physical
hierarchical topology.

The distinguishing feature of a star topology is that all nodes are joined at a
single point.

The ring architecture is a distributed architecture, with minimal connectivity
and a topology of two links connected to every node.

L

3.15 SUMMARY

o Office Automation Systems aids in automating office tasks. It has a limited

role in decision-making and is more useful for operational-level people.
The information derived from this type of system can be used for role-
based decision-making by managers at the operational level. This system,
however, plays an important role in automating several functions of an office
and thus helps in creating paperless offices.




* This type of system is critical for the smooth functioning of an organization. Prominent Information
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The objective of this system is to capture all transaction-related data between Concepts and Networking
the organization and its external and internal customers.

* Typically, the transaction-level data is stored in a preformatted mannerin a
relational database for further action in the future. TPS is the most widely
used form of information system, as it provides management with the flexibility
of storing data in a structured manner and retrieving it at a later date using
the query facility.

e Decision Support System (DSS) helps the senior management to take
strategic decisions. Contrary to other systems, DSS is developed with the
objective of providing the users (top management personnel) with
unstructured information. This system helps the management to develop
‘what if analysis’, so that different scenarios can be developed for decision-
making. DSS deals with both internal and external data.

e DSS helps the management to take decisions that are complex and difficult.
It improves the quality of decision-making by helping the decision-maker to
make informed choices. It thereby, improves efficiency and improves
performance.

NOTES

* Anexecutive support system (ESS) provides a graphical view of the data.
The most challenging part of building an ESS is to transform transactional
data into usable form. The data may be incomplete or the required fields
may be missing.

¢ Expert systems include three components: knowledge base, inference engine .
and user interface. The knowledge base contains the ex-pertise in the form
ofaseries of ‘if. . . then’ conditions.

* Enterprise resource planning began as a term used to describe a sophisticated
and integrated software system used for manufacturing. In their simplest
sense, ERP systems create interactive environments designed to help
companies manage and analyse the business processes associated with
manufacturing, such as inventory control, order taking, accounting and much
more.

* Inthe communication context, signalling refers to the exchange of information
between components required to provide and maintain data communication
service. In case of PSTN, signalling between a telephone user and the
telephone network may include dialling digits, providing dial tone, accessing
a voice mailbox and sending a call-waiting tone etc.

¢ Channel data transmission rate is determined by the maximum number of
bits that can be transmitted per unit time through the physical medium. It is
measured in bits per second (bps).

* Bitrate is the number of bits (0 or 1) transmitted during 1 second. The
number of signal changes per unit of time to represent the bits is called the
data rate of the modem. That rate is usually expressed in terms of a unit
known as a baud.
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| gﬁ’-’tmf"e"é 1 ”form‘?ff(;’?an e The group of people responsible for monitoring and reviewing the progress
stems, CLommunicarll . . s wgw .
| CJ;,,CEP,S and Neiworking made in developing TCP/IP, initiated by US Department of Defense, is
known as the Internet Activities Board (IAB).
NOTES e In general, a computer network is composed of one or more servers,

workstations, network interface cards, active and passive hubbs, routers,
bridges, gateways, modem, software components like network operating
systems and other application software.

e Networks that are privately owned, offer consistent fast-paced
communication channels which are optimized to connect information
processing tools in a restricted geographical area. These are known as
Local Area Networks (LANs).

o AMetropolitan Area Network (MAN) covers large geographic areas such
as cities or districts. By interconnecting smaller networks within a large
geographic area, information is easily disseminated throughout the network.

e A Wide Area Network (WAN) connects networks in different cities or
countries. Gateways are used to connect these networks. A network which
can connect networks that are over a hundred kilometres apart is not built
by any organization.

e LANSs are classified depending on the topology, access methods, signalling
methods, transmission medium and transmission mode.

3.16 KEY TERMS

e Office automation systems: This type of information aids in automating

office tasks and can be used for rule-based decision-making by the managers
at the operational level

e Decision support systems: This system aids the senior management in
taking strategic decisions and was developed with the objective of providing
the users with unstructured information

e Transaction processing systems: The objective of this system is to
capture all transaction-related data between the organization and its external
and internal customers

o Decision support system: It is defined as an information system application
that assists the managers in decision-making.

e Channel: with respect to data transmission, a channel may be defined as a
path between transmitter and receiver.

e Workstation: It is an individual computer capable of communicating with
other machines.

e Repeater: It is a communication device that connects two segments of a
network cable.

e Bridge: It interconnects two networks using the same technology (such as
Ethernet or Arcnet).
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* Bandwidth: It is the range of frequencies assigned to a channel. Prominent Information
Systems, Communication

¢ Router: It is a device that transfers data between network. Concepts and Networking
* Modem: It provides two-way communication facility between a computer
network and telephone network. NOTES

 Local Area Network (LAN): It is a form of local (limited-distance), shared
packet network for computer communications.

* Baseband LAN: It is a single-channel system that supports a single
transmission at any given time.

* Broadband LAN: This supports multiple transmissions via multiple
frequency channels.

3.17 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What are the limitations of office automation systems?
. What do you understand by filing data?
. Why is TPS required for the smooth functioning of a company?

W N

. Which support system helps senior management of a company take strategic
decisions?

. Which is the most important component of DSS?

. State about the digital firms in DSS.

. Name the components of an expert system.

. What is the main objective of the ERP?

. Define the term channel bandwidth.

10. Stat about the simplex and half duplex communication.
11. How do LANSs help us?

12. What are the disadvantages of broadband LANs?

13. Differentiate between LAN and WAN.

14. Distinguish between a WAN and a VAN.

O 00 01 O\

Long-Answer Questions

1. Briefly explain the office automation systems and its applications.
Explain the term transaction processing systems with the help of diagram.
. Discuss about the evolution of DSS with the help of diagram.
. Explain the elements in the model management subsystem.
Describe the role and benefits of Executive Support Systems (ESS).

SRV PN

. Discuss about the expert system as well as enterprise resource planning
system.
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9.
10.
Lk
12.

13
14.

Briefly explain the concept of communication with the help of appropriate
examples.

. Describe the protocols standards and transmission impairments giving

appropriate examples.

Why is a network required? Describe the components of a network.

List and describe the various network services available nowadays.

How a LAN system does helps an organization? Give an example.
Discuss the importance of MAN and WAN networks. What are their
applications?

What are communication networks? Why are they becoming important?
Briefly explain the topologies and its types with the help of diagram.
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4.0 INTRODUCTION

The important role of telecommunication systems have played in the emergence of
information technology. Computers were invented in the 1940s and became an
integral part of the commercial world in the1960s. Since then, the growth of this
industry has been phenomenal. Initial computers were built using vacuum tubes
that have now been replaced by microprocessors. Nowadays, computers and
other computing devices are extremely user friendly and can be carried around.
Computers are also networked through the use of different communication media.,
Computing power of computers has been growing at a faster rate than its usage.
They can process multimedia data such as sound, voice, still images and video
images.

Structured data analysis (systems analysis), analysing the flow of information
within an organization with data-flow diagrams. Systems analysis is ‘the process
of studying a procedure or business to identify its goal and purposes and
create systems and procedures that will efficiently achieve them’. Another view
sees system analysis as a problem solving technique that breaks down a system
into its component pieces, and how well those parts work and interact to accomplish
their purpose. Systems design, the process of defining the architecture, components,
and data of a system to satisfy specified requirements.

In this unit, you will study about the introduction of telecommunication,
overview of system analysis, information system design, planning and implementation
of MIS.
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4.1 OBJECTIVES

After going through this unit, you will be able to:
¢ Understand the introduction of telecommunication
e Explain the overview of system analysis
e Define the information system design
¢ Discuss about the planning and implementation of MIS

4.2 INTRODUCTIONTO
TELECOMMUNICATION

Most information systems used today require networking and communication
technology. This revolution has been possible due to the Internet which is a network
of networks. Each of the constituent networks is owned by a different organization.
Some networks are in the public domain. These constituent networks are spread
over 200 different countries across the globe and more than 6 billion people
(according to 2008 data) use the Internet. The Internet has transformed the shape
and form of business enterprises.

‘Information superhighway’ was a popular term used through the 1990s to
refer to digital communication systems. It is associated with Al Gore, the then US
senator and subsequently the Vice President, who had been involved with
computers since the 1970s. Gore could perceive the role telecommunications
was to play in commercial and educational systems. He provided the intellectual,
political and financial support required for the growth of telecommunication systems.
The Internet is extremely flexible; a network can join the Internet and leave without
affecting the overall network. All that is required is an IP address (explained
later) from a service provider to join the Internet.

The marriage of comrnunication and computers has greatly improved the
flexibility of computer systems. Consequently, managers have gained access to
information on the latest development in manufacturing technology, management
and the servicing industry. A manager can study all options and pick the most
suitable option. Before the Internet, information was difficult, time consuming and
expensive to access. In an academic environment, a Ph.D. student needs to read
at least a hundred research papers in his area of research. This activity took about
one and a half years, and the most time-consuming part was the collection of the
relevant papers. With the Internet, researchers can sit at their office/desk and read
research papers online and print the ones they finds relevant. The amount of non-
productive component, cost and time has reduced greatly. The Internet supports
multimedia data. There are search engines such as Google, Yahoo, etc., that facilitate
the search of information and documents. An individual or a group of individuals
or an organization, wishing to share information, can create a Website, get an IP
address from a service provider, an Internet connection and go public. The whole
effort can be completed in a few days’ time.




Components and Functions of a Telecommunication System

Telecommunication is the communication of information by electronic means, usually  4napsis and Design of Mis
over some distance. Previously, telecommunication meant voice transmission over

telephone lines. Today, a great deal of telecommunication transmission is digital
data transmission, using computers to transmit data from one location to another.
Telecommunication systems can transmit text, graphic images, voice or video
information.

Telecommunication System Components

A telecommunications system is a collection of compatible hardware and software
arranged to communicate information from one location to another. A network
system consists of hardware components as well as software components. The
following are the essential components of a telecommunication system:

* Server or Host Computer: This is the computer at one end of the

[ ]

* Network Interface Card (NIC): This is the interface between the network

transmission system that has data to transmit.

Client: This is the computer at the other end of the transmission system. It
receives the data transmitted by the server,

cable or transmission system and the computer. Earlier, an NIC had to be
bought separately and installed in the computer. Nowadays, the NIC has
become a standard component of a computer system.

Circuit or Transmission System: The circuit is the pathway through which
data travels between a client and a server. The circuit may be a copper wire
or an optical fibre. The commonly used media are Unshielded Twisted-Pair
(UTP) cables, Shielded Twisted-Pair (STP) cables and coaxial cables. A
cable has little cable connectors at both ends. One connector is plugged
into the computer and the other one is connected to the switch or hub.
Each type of cable has restrictions on its maximum length. The distance
between the computer and the hub or switch is limited by the type of cable
used to connect the two. The cost of each of these cables is also different.
As an example, a UTP-CATS5 wire can be 200 metres (maximum) long
with RJ45 as the cable connectors. The cost of the cable is approximately
Rs 20 per metre. Nowadays, fibre optic cables are being used in place of
copper wires. Fibre optic cables can withstand higher temperatures and
have much higher bandwidths. Communication takes place through a wireless
medium. Microwaves are also used for data transmission.

Network Hubs and Switches: Hubs and switches are used to connect
cables. Ahub is a simple device that broadcasts an incoming message on all
its ports. Hubs come in 4, 8 and 16 port sizes. An 8-port hub can connect
8 systems to the central cable. Earlier, computers were connected using
hubs, which have now been replaced by switches. A switch has more
intelligence (circuitry) and knows the ports of the computers that are
connected toa LAN. An incoming message is transmitted only through the
appropriate port. Hubs are inexpensive as compared to switches. Each
computer is connected to a switch by a network cable.
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e Network Operating System (NOS): In addition to the hardware, there is
always a special purpose network software that makes the hardware work.
NOS is the software that controls the network. It has software for the
server as well as the client. Novell NetWare is one of the oldest NOSs.
Novell supports a wide variety of topologies, protocols and computers.
Microsoft Windows NT and Linux are two other very popular NOSs and
are growing rapidly .
Cellular telephones work by using radio waves which communicate with
radio antennae (towers) placed within adjacent geographic areas called cells. A
telephone message is transmitted to the local cell by the cellular telephone and
then passed on from antenna to antenna—cell to cell—until it reaches the destination
cell where it is transmitted to the receiving telephone. Older cellular systems were
analog in nature while the newer cellular systems are digital in nature.

Newer models of digital cellular phones can handle voice mail, e-mail and
faxes, save addresses, access a private corporate network and information from
the Internet as well as provide wireless voice transmission. These smart phones
are equipped with Web browser software that lets digital cellular phones or other
wireless devices access Web pages formatted to send text or other information
that is suitable for tiny screens. Some smart phone models offer larger screens and
keypads to make Internet access easier.

Data cannot be transmitted seamlessly between different wireless networks
if they use incompatible standards, for example, digital cellular services may use
Code Division Multiple Access (CDMA), Global System for Mobile
Communications (GSM) or Time Division Multiple Access (TDMA) technology;
which are not compatible with each other.

4.3 AN OVERVIEW OF SYSTEM ANALYSIS

System analysis is a process in which data is collected and then interpreted to
identify problems within the system. After interpretation, problems are identified.
Therefore, the collected information can then be used to recommend improvements
in a system. In other words, system analysis includes identifying, understanding
and examining a system so that the objectives of the system can be achieved. The
pre-determined objectives of the system analysis include:
e Knowledge of the system operation
e Identification of the user requirements in the proposed system
The system analysis stage investigates the system operations and determines
the solutions to solve the problem. Therefore, system analysis is considered a
logical process.
System analysis is really vital in the completion of the development process
of a system. It may be possible that a user is aware of the problem but may not
have the solution. In such a scenario, a system analyst works with the user so that

alogical model of the system can be developed. A system analyst from a technical
background may move too quickly to the program design stage in order to make
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a system more physical. This approach is not desirable and should be avoided
because it can affect the ultimate success of the system. A system analyst can
work with a user to obtain a complete knowledge of a system. For complete
information about a system, a logical model of the system is developed, based on
a detailed study of the system. A detailed study should involve various modern
tools and techniques, which include data flow diagrams, data dictionary and rough
descriptions of the relevant algorithms. A set of system requirements for a proposed
information system is the final product of the system analysis stage.

Requirement Analysis

The basic understanding of a system can be developed by analysing the requirements
of the system. The requirements tell us the need for the system, the users of the
system, the problem that the system is being created to solve, etc. In short, it gives
us a lot of information about the finctional nature of the system and hence it is very
important to thoroughly analyse the requirements, so that there is no gap in the
analysis.

Requirement analysis is a formal process of interacting with a client to
understand and establish the requirements of the client in a formal document.
Itinvolves the use of fact-finding techniques and a keen eye for detailed information
to find the underlying cause of an issue. Sometimes, the client may not be sure of
the requirements. The requirement analysis process should take the client through
a journey by which the client is able to articulate the requirements clearly. The
client may look at the requirements from a superficial angle, thereby identifying the
symptoms of the problem as requirements instead of analysing the source of the
problem. The requirement analysis phase helps to structure the process of
requirement analysis highlighting the actual requirement of the client.

While initiating the process of requirement elicitation and analysis, some

key issues must be understood so that this analysis is easier. The key issues from
the perspective of the developers are as follows:

e The key people driving the request. This will help them to focus their
information collecting activity on these people, so that the actual nature of
the requirement becomes evident.

e The key people who will use the system. This gives the development team
an understanding of the user profile.

e The financial benefit. This gives the requirement elicitation team an
understanding of the financial benefit that is expected from the solution.

e What according to the user is a good solution? This gives the team an idea
of the expectation from the system by the user.

o What is the problem that the system will address? This gives the team the
reason for the development of the system.

A series of client interactions result in the preparation ofa system requirement
specification document, which is then used for designing the system.
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Analysis principles
The key principles on the basis of which analysis is done are as follows:

e The information domain of the problem is to be given due regard:
This means that the domain of information in which the problem operates
has to be appreciated.

e The key functions of the system have to be defined: The key
functionality of the system has to be defined clearly.

o System must be modular: This is required to help create the systemina
faster way.

e System has to be defined in an abstract term: This helps reduce
complexity.

¢ Reduce ambiguity: The ambiguity in the system must be reduced to enable
the system designer to clearly focus on the outcome.

System Requirements Specification (SRS)

This is a formal document that is created to capture the requirements of the system.
It should have the following descriptions:

¢ Information description: A detailed information description.

o Functional description: A description of the functionality required from
the system.

e Validation description: This is the data validation and business rule
description required in the system. &

SRS is a formal document and the entire process of system development
depends on this. SRS is also a matter of negotiation between the client and the
developer as there may be differences in the understanding of the requirement.
IEEE and ANSI have set guidelines for SRS.

Requirement Determination

It is essential to determine the requirements of a system for the system analysis
process. The requirement determination is the preliminary step of the system
development activity and is also known as software requirement specification (SRS).
The requirement determination activity is the most difficult activity involved in the
development of a system. Since there is a communication gap between a user and
a developer, this activity is more prone to errors. The communication gap arises
because the user usually may not understand the software of the organization or the
developer may not understand the user’s problem and application areas. To bridge
the communication gap between the user and the developer, requirement
determination is introduced. This requirement determination process provides a
means of translating the ideas given by a user, into a formal document. The benefits
provided by a good SRS are as follows:

e [t bridges the communication gap between a user and a developer.

e [t reduces the development cost as it overcomes errors.




e Itactsas a basis of reference for the system, so that it can validate the final
product.

Requirement determination consists of the following activities:

1. Requirement anticipation: This activity includes the past experience of
the system based on a study performed on the existing system. It also predicts
the possibility of certain problems and requirements for a new system.

2. Requirement investigation: This activity is central to the system analysis
process. In this activity, the existing system is studied and documented for
further analysis. For this purpose, various methods such as fact-finding
techniques are used.

3. Requirement specification: This activity involves the analysis of the data
that was produced during the fact-finding investigation in order to determine
the requirement specification.

We can conclude that requirement determination involves the following information:
¢ The general process
¢ The data produced during the process
¢ Various constructs in terms of time and volume of work
o The performance controls applied in the system
These activities are further elaborated in the following section.

Understand the process

The basic step in the requirement determination activity is the knowledge of the
process. The process can be well understood if the information collected includes:

e The purpose of the business activity
o The steps involved in the activity
o The persons performing those activities
e Other information such as the frequency, time and user of the resulting
information
Identify the data used and the information generated

After understanding the process, the system analyst should look for the data that is
required to perform each activity discussed in the previous step. For example, in an
inventory system, a buyer may require data describing the quantity of an item, supplier
name, item cost and demand for the item.

Determine frequency, timing and volume

After the identification of data, information is collected so that it can be identified
how often an activity is repeated. It also determines the number of items that can be
handled in each activity. Similarly, time is another constraint while evaluating certain
steps of an activity.
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Analysis and Design of MIS  The determination of performance control is important in the requirement
determination activity as it enables the system analyst to understand how business
functions can be maintained. It allows the system analyst to gather information
during system investigation. The information in this phase can be gathered mainly
from the personnel and the written documents of the organization. The written
documents include financial reports, personnel documents and various other
documents such as transaction documents and manuals.

NOTES

It should always be kept in mind that the personal managerial attributes of
an individual manager and an organizational environment affect the information
requirements of the proposed system. Personal attributes may include the manager’s
knowledge of information systems, managerial style and his perception of
information needs. On the other hand, organizational environmental factors may
include nature of the company, level of management and structure of the

organization.
Strategies for Requirement Determination

There are certain strategies for requirement determination that allows a system
analyst to understand the existing system and also to determine the information
requirement. Various strategies that solve the purpose are described below:

Interview

The interview strategy follows a method in which a user and a developer interact
with each other to collect the required data. In this method, the developer poses
questions to the user and based on the response given by the user, the developer
finds some solutions. The interview can be formal or informal and the questions
asked may be structured or unstructured. This method is helpful for gathering
information from individuals who may be weak in written communication or who
may not have the time to answer questionnaires.

This strategy is the oldest and the most often used device for gathering
information about an existing system. Though it is one of the preferred techniques,
it is not always the best source of application data. This is because the users are
sometimes unable to explain the system in detail. This process is time-consuming
and hence other methods are used to gather information.

It is important that the system analyst must be trained in interviewing the personnel,
as the success of an interview depends on the skill of the interviewer and on his or
her preparation for the interview. Hence, it is important for a system analyst to plan
the interview. A system analyst must have the following information before the
interview:

e The person to be interviewed

e The time of interview

¢ The questions to be asked

¢ The venue of the interview

o The initiation point of the interview

o The termination point of the interview
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The advantages of interview can be summarized as follows: Telecommunication,
Project Planning,

1. Useful in exploring issues of an undefined nature and complexity. Analysis and Design of MIS

2. Useful in gathering more information in less time. .

3. Useful in knowing the reactions and responses of the respondents. NOTES
Questionnaire

A questionnaire is a method that involves a set of questions to which an individual
needs to respond. This strategy allows a system analyst to gather information
regarding different aspects of a system among a large number of persons. This
strategy provides more reliable data in comparison to the other fact-finding techniques,
such as, interviews and focus groups. In addition, a questionnaire is less time
consuming as compared to interviews. The downside of a questionnaire is that
sometimes it becomes difficult to design exhaustive questionnaires. In addition, the
expressions and reactions of respondents cannot be observed through a questionnaire
but can be observed easily during an interview. Questionnaires need to be tested
and modified by the interviewer based on prior questionnaires and the experience
and background of the respondents.

The advantages of a questionnaire can be summarized as follows:
1. Respondents could hide their identity if they do not want to reveal it.

2. Itis an efficient way of collecting information through paper documentation
or through the Internet.

3. Itis less time consuming.

Record review

The record review strategy is also known as review of documentation strategy. The
r.. main purpose of this strategy is to find the quantitative information regarding

' constraints such as volumes, frequencies and ratios. A system analyst examines the
information that has been recorded about a system and its users. The records include
manuals, regulations and standard operating procedures of an organization. The
records act as a guide to the managers and other employees. To study and understand
the existing system, records prove to be helpful for the system analyst.

The limitation of this approach is that the records may not be completed or
updated. An existing system can be viewed in two different views. One such view
that favours the study of the existing system states that the shortcomings associated
with an existing system can be learned. This knowledge of shortcomings is then
further used and therefore, the common mistakes can be identified and avoided.

Another view argues that new ideas cannot be generated and the developer
must follow the logic associated with the old system. Both the views seem valid
and therefore, it is difficult to comment upon each view.

Observation

Observation is also one of the strategies used for gathering information. This is a
process in which people, object and occurrences are recognized and noticed in order
to collect information from sources. The information collected using this strategy is
useful when a system analyst needs to observe the way in which the records are

handled, processes are carried out and whether the specified steps are actually i;b‘ - Fjamiﬂg 1
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followed. The drawback of this strategy is that an observer may not be able to
gather all the required information. Moreover, the method used in this strategy is
time-consuming and costly. Electronic observation and monitoring methods are widely
used as information gathering tools because of their speed and efficiency.

A system analyst uses a combination of all the approaches to study an existing
system because one approach may not be sufficient for gathering the required
information of the system.

Tools for Structured Analysis

The above discussed fact-finding strategies represent only one aspect of system
analysis. These strategies do not provide any mechanism that can help in organizing
the details collected in each phase of the system analysis process. The information
collected needs to be organized. Various tools that can be used for organizing
information are known as structured analysis tools. These tools help a system analyst
to document the system specifications of a system. These tools are:

¢ Data Flow Diagram (DFD)
e Data Dictionary
e Structured English
¢ Decision Trees
e Decision Tables
These tools are described in further detail in the following section.

Data Flow Diagram (DFD)

Data flow diagram is a tool that helps in expressing the system requirements ina
simple form. It provides a graphical representation of the logical flow of data. This
tool is also known as a bubble chart. The purpose of data flow diagram is to
simplify the system requirements. DFD is responsible to decompose the requirement
specification in each stage of the system analysis process. Lines that represent data
flow in a system can join the information or data. The main symbols that are used in
DFD are as follows:

e Square: This symbol is used to represent the source or destination of system
data. Figure 4.1 shows the square symbol.

Fig. 4.1 The Square Symbol

o Arrow: This symbol is used to identify the data flow. The arrow specifies a
pipeline through which the data flows. Figure 4.2 shows the arrow symbol.

|

Fig. 4.2 The Arrow Symbol
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e Circle/Bubble: These symbols are used to represent a process that
transforms incoming data flow into outgoing data flow. A process canbe ap5is and Design of MIS

represented by a circle or an oval bubble. Figure 4.3 shows the circle symbol.

Fig. 4.3 The Circle Symbol

¢ Open rectangle: This symbol is used to represent a data store. Figure 4.4

shows the open rectangle symbol.

Fig. 4.4 The Open Rectangle Symbol

There are certain rules that need to be followed while drawing a DFD. These rules
are as follows:

1.

The processes must have a name and number associated with it. The name
of the process represents the process.

. The direction in which the data flow is represented should be from top to

bottom and from left to right.

. A proper numbering of processes must be maintained. This means when a

process is exploded into lower levels, the exploded processes can be easily
identified. For example, process 1 is exploded to further processes, which
should be numbered as 1.1,1.2 and so on.

. The name of the data stores, sources and destinations should be written in

capital letters. The name of the process and data flow must have first letter
capitalised.

. The data flows should not intersect.
. Looping is not allowed. This means that the data flow out of process A

going to process B cannot come back to process A from process B, without
going through another step in between.

. Entities should not directly access data stores. They should go through a

process.

. Data flows cannot be orphan data flows, which means that they must

terminate to a process or an entity of a data store or another DFD.
Logical DFDs are more popular and physical DFDs are rarely used.
It is important to note that a DFD can contain 10-12 processes. The DFD

is just a graphical representation of data flow and therefore, it should have minimum
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content of a data store. This tool is very effective when the required design is not
clear and the user and analyst require some symbolic representation for
communication.

The concept of DFD can be explained with the help of an example. Consider
the example of a library management system to issue books to each student of an
institution. Figure 4.5 represents the data flow for the library management system.

Student

Student Data
Books

Information

> Library
Management

Library Database

Student File

Updated
Records

Fig. 4.5 A DFD for Library Management System

The student data originates from the library database and acts as a source. The data
is then processed and the students receive the information regarding the books. The
updated data on students is stored in an intermediate file known as the data store
and is required for processing in the subsequent months. The drawback of this
approach is that it requires a large number of iterations to arrive at an accurate and
complete solution.

DFD is a powerful tool to understand the functional and informational
perspective of a system. It can be of two types—logical data flow diagram and
physical data flow diagram. Logical data flow diagram deals with the functional
view of the system and defines the system in terms of its functionalities and
information flows. It uses the following symbols for such representations:

An entity is represented by this:

Fig. 4.6 An Entity

Figure 4.7 illustrates a curve which represents information flow from one
entity or process or data store to another.

Fig. 4.7 Information Flow from One Entity or Process
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Figure 4.8 illustrates two parallel lines which represent data store.

Fig. 4.8 Data Store

Figure 4.9 illustrates a process which is represented by a circle.

Fig. 4.9 A Circle

Figure 4.10 illustrates a DFD of a cheque deposit system.

Account-related data (signature, etc.)

Verification of
account and
deposit into
account

Customer
depositing a
cheque

Account
management

Bank

Bank’s account balance

Fig. 4.10 Cheque Deposit System

A DFD can be represented in levels of detail. The abstraction provided by
a DFD helps in understanding the system. The top-level DFD is called level 0. All
the processes of a DFD are numbered and named. All entities, data flows and
data stores are named. A DFD is hierarchical in nature and the top-level DFD is
called a context diagram. A DFD further breaks down the levels of abstraction
and complexity, until the atomic level is reached and no more granularity is possible.
According to the numbering convention for processes in a DFD, the level of the
DFD comes first, followed by a dot and then the number of the process. If the
process is a subprocess, then this goes on until the process number unique to the
process is given.

Data dictionary

A data dictionary is a structured repository of data that defines the basic organization
ofa database. The data dictionary contains a set of precise and accurate definitions
of all the DFDs, data elements and data structures.

A data dictionary makes accessing of data more simple, as it supports
documentation in a better way. The data dictionary does not contain any actual
data from the database. It only provides precise and consistent definitions for
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various data elements, terms and procedures. It also helps in improving
communication between a user and a system analyst. It serves as a common
database for programmers and can also be used for control purposes. The data
dictionary is a desirable feature for most of the databases.

The data items present in a data dictionary include:
e Data element: The smallest unit of data that cannot be further decomposed.

o Data structures: A group of data elements that are handled as a single
unit. It contains a number of data elements as its fields.

e Data flows and data stores: Data flows are the data structures in motion
and data stores are the data structures in rest. Data stores are the locations
where the data structures are temporarily stored.

Table 4.1 explains the different symbols used in the data dictionary.
Table 4.1 Symbols Used in Data Dictionary

Symbol Meaning

= Is equivalent to

+ Add

[Option 1 Only one of the options is used at a given time

Option 2]

Max {Component} Highest possible number of iterations. Component is
optional

L)

Min {component} Lowest possible number of iterations. Component is
optional

* Comment * Words included within asterisks are considered as
comments

You need to follow certain rules while constructing a data dictionary. The rules are:

e The terms used to describe the data structures should always be in capital
letters.

¢ Multiple word names must be hyphenated.
o Assigned names should be straight forward and user-oriented.

e Every data flow, data store, data structure and data element must have a
name associated with them.

e A consistency check should be performed.

e The processes must have their identification numbers and names that must
be mentioned in the data dictionary.

e Assumed names of the processes must be discouraged.

It is important to note that the data dictionary and DFD are correlated and
the data should be presented in a specification. A data dictionary does not provide
functional details and therefore, is not much acceptable among non-technical users.
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This is another tool used in the design of systems. A data dictionary includes

a complete and comprehensive definition of all the data elements in the system. It Analysis

is the source document for specifications of all inputs, protocols, outputs, data
structures, database structures, metadata and algorithms. It is a data repository of
all design data about the system. Several description formats are available. One
such format requires that for each data item, the following information must be
stored in DD:

Name: Formal name of the data item/control item according to the convention
used.
Alias: Any other name for the same item.

Use: Where the data/control item is used, by which process, when and for what
purpose.
Description: Standard description of the item.

Additional information: Any other information critical for the item.

Awell-constructed DD is very useful not only for design but also for posterity.
When the system breaks down for some reason, a DD sometimes comes to the
rescue.

A DD normally serves the following purposes:
o A summary of the documentation
¢ A tool to reduce redundant data
o A background for I/O design
¢ A centralized control of all data in the system
e A controller of data integrity

Decision tree and structured English

A process can be represented using a decision tree as well. Similar to DFDs, a
tree is formed in this graphic representation. The logic of the process that is not
understood by data dictionary can be made clear using a decision tree. A decision
tree has as many branches as many logical alternatives are there. It is easy to
construct, read and update. Figure 4.11 shows the decision tree.

The logic can also be represented using structured English. Structured English
uses logical construction and imperative sentences that are designed to carry out
instructions for actions. In structured English, decisions are made using if-then-

else statements.

Branches

Leaf Node Leaf Node

Y y

Set of possible answers Set of possible answers

Fig. 4.11 Shows the Decision Tree
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Structured English consists of:

» Sequences of instructions (action statements)

¢ Decisions (if-else)

o Loops (repeat-until)

e Case

o Groups of instructions
Decision trees can be used to verify logic in problems that involve few complex
decisions. However, its biggest limitation is a lack of information due to its structure.
Decision table

A decision table is a compact way to represent complicated logic. It is a matrix that
contains rows and columns representing conditions and actions. Decision tables are
used in situations where complex branching routines are required.

Decision tables are divided into four quadrants. Table 4.2 shows a decision table.
Table 4.2 Decision Table

Conditions Condition alternatives

Actions Action entries

The above shown table describes a decision table in which the following quadrants
are included:

1. Conditions: These are at the upper left corner in the table. The
questionnaire is listed in the conditions. )

2. Condition alternatives: This section is at the upper right corner and
contains answers to the questions that were asked in the conditions column.

3. Actions: This section is at the lower left corner in the table and it outlines
the action that is required to perform in order to meet each condition.

4. Action entries: This section is at the lower right corner in the table. It
indicates the appropriate action, resulting from the answers to the conditions
in the condition quadrant.

There are certain rules that must be followed for constructing a decision table.
These rules are:

e A name should be given to each decision that has to be written at the top
left of the table.

e The logic should be independent of the sequence in which the condition
rules were written, but the actions take place in the order in which the
events occur.

o There should be a proper usage of consistent and standardized language.

¢ Duplication of terms should be avoided to the maximum extent.




Check Your Progress

1. Which US politician played a major role in the creation of the information
superhighway?

2. What is a host computer?

3. State about the system analysis.

4. What is Software Requirement Specification (SRS)?

5. Define the term data dictionary.

4.4 INFORMATION SYSTEM DESIGN

Objectives of System Design

System design is an important step in the system development process. This phase
comes into existence after the system analysis is completed. This means the output
of the system analysis phase provides an input to the system design phase. In other
words, the requirement specifications provided by the system analysis is used in the
system design phase of the system development process. The identification of data
requirements include:

e Identifying data sources
o The nature and type of available data
¢ Data gaps
The design of a system must adhere to the following objectives:

o Practicality: This objective notifies that the design of a system should be
user-oriented. This means the users of the system can easily learn and operate
the system.

o Flexibility: The flexibility of a system design describes the dynamic nature
of a system. In other words, a system must be designed in such a way that
the system may respond to the changes requested by the users.

o Integrity: The integrity of the system design requires use of specific practices
and processes such as requirements tracing and verification and validation.
The integrity of the system allows the system design phase to be easily
integrated with other phases of the software development, to carry out the
system development process.

o Reliability: The reliability of the system design describes the dependency
on the system design for any system errors and faults, in order to analyse
the time period of the existence of the system.

o Efficiency: Efficiency is highly important while designing a system. A system
must perform its jobs within a specified time period. The efficiency of a
system can be measured based on the following features:

o Throughput: is the rate at which a system performs its jobs per unit
time.
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0 Response time: is the time taken by a system to react to a given

input.
0 Run time: is the ability to undertake a complete job within a specified
time limit. :
o Security: The security of a system includes:
0 The hardware reliability of the system
o Physical security of data
o Detection and prevention of exploited data

The system design phase is carried out at two levels:
(1) Conceptual level or conceptual design
(i) Physical level or physical design

Principles of Design

The fundamental principles of design are as follows:

e The first principle of a good design is that it should have an overall
macro view of the system rather than a tunnel view: This helps the
designer to fit the components and integrate them in the overall design. The
designer will have a comprehensive view rather than only a problem-solving
View.

e The design process should be logical: The design should have steps,
which blend logically. The relationship of logic in the process of design
should be unidirectional and strong.

o The design should not reinvent the wheel: The design should not tread

into territories, which have already been confirmed. The idea is not to revisit
an issue unnecessarily.

e The design should be a very close abstraction of the problem: The
design should make a clear abstraction of the problem it is supposed to
solve.

e The design should be uniform and integrated: The design should be
uniform throughout and integrated, without having loose components which
do not have any linkage with the system.

e The design should be structured: The design has to be structured in

order to be of value to the developer. The process of design itself and the
output from the design process will have to be structured.

e The design should be reviewed on a real-time basis to minimize
errors: The design should not be allowed to proceed unreviewed. While
accepting the fact that design is a creative endeavour, the process around
design should be such that mistakes in the design should be identified before
more time is spent on creating more design around the mistake.

Concepts of Design

Some major design concepts that are to be adhered to in designing the system are
as follows.
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some level of generalization, without regard to irrelevant low-level details
(Wasserman, 1983). At the top level, abstraction is used in broad terms and defined
with the variables of the environment; however, at the lower levels, it is defined in
problem-oriented, procedure-oriented and implementation-oriented terms, Several
types of abstraction are possible at the lower level. They are as follows:

* Procedural abstraction: When abstraction is used to define procedural
issues. It is a named collection of several sequential procedural steps.

* Data abstraction: A set of data that defines an object.
o Control abstraction: A named control mechanism, which has several steps.

Refinement

Refinement is a top-down design strategy in which the design is refined after
successive steps. In each step of refinement, greater detailing is done in the
instructions. Refinement helps the designer in elaborating the systems and identifying
low-level details as the design progresses.

Modularity

Modularity is a very important concept for any system design. It helps the
designer to compartmentalize the design into functional compartments as the
entire system can be conceived to be composed of a set of modules, each
having its own special feature and functionality rather than a monolithic entity.
Modularity helps the designer to comprehend the system better. However, the
division of a system into modules comes at a cost. If modules increase in
number, then initially the cost/effort per module for creating the system decreases
as less dependencies make the system less costly; however, the cost of integration
rises. Thus, the total cost reduces initially but then rises. Therefore, any system
should be divided into an optimum number of modules, so as to keep the cost
low.

Effective modular design in general, reduces the complexity of the system
by dividing the system into easily understandable modules. These modules, in order
to be effective, must exhibit a functional independence, cohesion and coupling.
Functional independence in a module means that the module is focused on the
delivery of some output, in a functionally independent manner. It does not interact
with other modules a lot to achieve this goal. Functional independence make the
modules easier to create, maintain and reuse. They work like components in an
engineering application, each module performing a task with minimum interaction
with other subsystems. These types of modules are easy to create and develop.
Cohesion is the degree of singularity of purpose in a software procedure. Coupling
is a measure of interconnectivity of modules.

Conceptual Design

The conceptual design stage allows a system analyst to choose an effective
information system from among different management information system designs.
This design stage determines the feasibility of the management objectives that are
accomplished. The conceptual design is also known as external design or high-level
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design. This high-level design becomes a basis for the detailed design of the
information system. In other words, we can say that a conceptual design is a
prerequisite for the detailed design. The steps involved in the conceptual design are:

1. Problem definition

. Set system objectives

Constraints identification

. Determination of information requirements
. Determination of information sources

. Development of designs

. Conceptual design documentation
8. Preparation of report
Abrief discussion of these steps will make the concept clear.

1. Problem definition

The first step in the conceptual design of an information system involves the problem
definition. It is important to understand the definition of the problem before
implementing the information system. The function of information system is to solve
problems related to information requirements for the organization. It is important to
note thatin the problem definition step, not only the current problems are considered,
italso deals with the long-range planning of an organization, so that future problems
also get resolved. The information requirements of an organization are identified
and then determined by understanding the objectives and strategic plans of the
organization. *

2. Set system objectives

After the problem definition step, a system analyst must set the system objectives.
The system objectives are always set with the help of the users. This is because the
value of an information system lies in the benefits of the users. Setting the system
objectives is not a straightforward process and hence, a system analyst needs to
consider specific objectives. Once specific objectives are set, they help an organization
in improving the efficiency of the information system. However, it is quite difficult to
set the real objectives of an information system. Such circumstances should be
avoided in which the objectives of an information system are set in vague terms. In
other words, the objectives such as keeping accurate records, maximum efficiency,
reduced costs and quality information should not be considered as specific objectives.

It is also important that the system objectives must be defined in such a way
that they can be easily achieved by the system. In addition, the system provides a
measure of performance. In other words, the system objectives should be stated,
as far as possible, in quantitative rather than qualitative terms.

3. Constraints identification

System constraints, also known as problem boundaries, are essential for the
conceptual design of a system because the identification of constraints helps the
system designer in considering the limitations that restrict the design of the system.
These constraints help in designing a system that meets the specified objectives. In



addition, a constant review of the objectives is necessary. System constraints can be
classified into:

* External constraints: These constraints are external to an organization.
This category includes constraints posed by the customers, government
and suppliers.

® Internal constraints: The constraints that are internal to an organization
are known as the internal constraints. The constraints within the organization
include:
o Non co-operation and lack of support from the top management
0 Anunfavourable organizational policy
o Resource constraints such as manpower, time, and money

4. Determination of information requirements

For an effective design of the information system, it is important to understand the
information requirements of the users. This step focuses on the identification of the
information requirement that helps the management of an organization in performing
their functions. A user must specify the following requirements:

» What are the expectations of the user from an information system?
* The information required in achieving the predetermined objectives.
Itis the responsibility of the system analyst to adopt an approach that can help in

achieving the information requirements of the system. There are two approaches
for extracting information requirements: direct and indirect.

The direct approach allows a system analyst to ask various responsibilities
of the users. This is followed by certain information that is required to execute
each of the specified responsibility. On the other hand, the indirect approach avoids
direct questions. A system analyst in the indirect approach asks a user to describe
the decision-making process that helps in the system development process. An
indirect approach is considered to be simpler, as the user is familiar with his/ her
job and can easily describe the decision-making process.

Similar to the system analysis process, several approaches to system design
include interviewing the users, using questionnaire, record review and observations.
Also, it is required for the system analyst to arrive at a thoughtful decision for
adopting the best approach.

S. Determination of sources of information

As the determination of the information requirement is essential, similarly, the
determination of the information source is also important. The determination of
information source identifies the input data along with the information, such as the
timing and format of the information source. The main information required by most
of the information systems can be managed within the organization. The information
that can be managed within the organization includes intemal records, books, statistical

and accounting documents. A study of the existing system is quite helpful in determining
the information source. The classification of information sources ofa system includes:

® Internal and external records: Internal records can be in a written form
such as files, inputs and outputs, reports and documentation. On the other
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hand, external resource may include trade publications and government
statistics.

e Managers and operating personnel: This classification is an important
source for understanding input, output and data processing requirements of
an information requirement. Information in this classification can be gathered
by conducting interviews of the managers and the operating personnel.

After the information sources and information requirements are determined, the
next step is to match the information requirements and sources. This can be done
using a matrix diagram, which is considered as a valuable means for the integration
of sub-systems and for the remaining system design process. Table 6.2 shows the
information requirements and information sources matrix.

6. Development of designs

The next activity includes the development of different designs in the conceptual
design process. In this activity, a system analyst must know the overall structure of
the information system that has to be designed. It is important to note that a conceptual
design provides an overview or a sketch of the structure of an information system.
The conceptual design further guides and restricts the detailed design of an information
system. The development stage of the conceptual design process defines the
following areas:

¢ The decision points

¢ The flow of information

e The channels of information

e Therole of users

Table 4.3 The Information Reguirements and Information Sources Matrix

Information
Reauirements

1

Annual requirements X

Consumption Rate X

Ordering Cost X

Delivering Cost X

Unit Price X
———— | Production | Accounting | Purchasing

Information Sources
Based on these areas, the system analyst works on the combinations of input, storage,
processing, communication and generates the output in terms of various conceptual
system designs. Different conceptual designs are developed and then compared in
order to select the optimum design. The selected design should meet the requirements
of the users as well as the organization and must be cost-effective.
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The development of various conceptual designs can be evaluated on the basis of the
following criteria:
o Economic basis: Each alternative based on this criterion provides benefits
in terms of cost analysis.

o Performance basis: Each alternative must be evaluated for the anticipated
performance, in accordance to the system objectives.

o Operational basis: Each alternative must determine the strong and weak
points in terms of the quality of the databases, the information and the
potential breakdown points.

7. Conceptual design documentation
After the selection of the final conceptual design, the design is documented in
specific terms. The documentation of the conceptual design involves:

1. Overall system flow

2. Systeminputs

3. System outputs

4. Other documentations such as, activity sheet and system description.

8. Preparation of report

The next step to the documentation of the conceptual design is to get an approval
from the management of the organization. Once an approval is given to the prepared
document, a detailed design activity can be introduced. A proposal which involves
the cost incurred and the probable organizational changes, is prepared in this stage.
The report prepared in this stage should contain the following specifications:

1. A brief'statement of the problem

2. A briefstatement of the objectives

3. Anoverall view of the system

4. A simplejustification for selecting a particular design among different designs

5. Other resources, such as, the time required for developing and implementing
the system

The top management of the organization then reviews the submitted report. If the
submitted report is approved, a detailed system design activity can be undertaken.

4.5 PLANNING AND IMPLEMENTATION OF
MIS

Steps to implement MIS are:
¢ Planning for implementation
o Acquisition of facilities and space planning
e Developing MIS procedures
¢ User training

e Acquisition of hardware and software
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¢ Creating forms and database
o Testing
e Change over

Planning for Implementation

Planning involves identifying various actions such as determining the sequence of
activities and estimating the time needed for each activity required to implement
MIS. All these activities vary according to the design specifications of MIS, such
as input, output, equipment and processing. Various tools can be used for planning,
these include Gantt Charts and Network Diagrams.

Figure 4.12 shows a Gantt Chart.
Toriy

Prepare organization Plan h

Develop computer software EEEaE 00
Design forms PR R e
e .
parallel test
Evaluate the new MSI S ——
I [ [ I | I [
0 1 2 3 4 5 6 7
[] Scheduled
Bl Completed

Fig. 4.12 A Gantt Chart

A Gantt chart contains horizontal bars displaying a time line on which activities are
shown. The chart displays various interdependent jobs such that jobs that are
done in parallel or jobs that are done in a sequence are highlighted. For example,
Figure 5.4 shows a chart for developing a new MIS, in which five main activities
are shown. Here, one can visualize that while the preparation of the organization
plan finishes, the task of developing the computer software continues.

In this chart, the scheduled time for the tasks has been displayed by an
empty bar and the actual time of completion is denoted by filling the area in the
blank bar. The chart aids in assessing whether a particular task has been completed
within schedule and how far is the target date of completion. The chart shows a
schedule of approximately seven weeks.

A network diagram is prepared when a project contains many tasks, each
task composed of several subtasks. For a simple project like this, a Gantt chart is
adequate for planning the implementation.




Acquisition of Facilities and Space Planning

To implement MIS at the user’s workstation, various facilities such as a computer
room and a computer library are required. Therefore, the MIS manager also needs
to do space planning. Space planning includes estimating the space occupied by
computers and its various peripherals such as terminals, printers and workers.
The MIS manager also needs to decide the location of the computer room and its
safety and security factors.

Since MIS handles vital information related to the working of the organization
that involves a collection of information, networking may be required to facilitate
an easy transfer of information. If different departments of the organization are
located at different areas of the same place, a local area network is sufficient. This
requires the MIS manager to coordinate with the system developers. The records
related to the functioning of MIS should be secured in an area where access is
restricted. Due to space constraints the cost of space these days is quite high thus,
an economy of space utilization is vital. Multi utility desks, shelves, etc, should be
used to allow an economical space utilization for storing records, stationery and
storage devices such as floppy disks, CD-ROM and external disks.

Organization and Procedure Development

The MIS manager starts recruiting other required human resources for the MIS.
The MIS manager also starts developing procedures for various other activities
such as evaluating as well as selecting hardware as well as buying or developing
the required software.

Depending on the nature of organizational activities, the MIS manager
develops formats required to manage the information system according to which
the software is developed. Since received information has to be sent to the
management for its review and subsequent decision-making process in a report
form, only that information which is relevant to the higher management should be
provided. These reports should be timely and accurate.

Inabig organization, different types of reports are prepared requiring suitable
personnel. The MIS manager has to organize the human resources available for
such purpose to work on data required to create such reports using a computer-
based information system. A cquisition of suitable software and hardware is required
for this purpose, keeping in view the upcoming needs of the organization. It is
always advisable to acquire a system that supports scalability. This means that
when the workload increases and the system is required to handle a large volume
of data, of a somewhat different nature, it should be able to do it without any
additional investment in system upgradation or the services of an expert. For
example, a hardware should be able to support a more advanced system software.
Atpresent Windows XPis used in most organizations and it requires a minimum of
256 MB of RAM, but runs better on a system havinga 512 MB of RAM. But it
will be wise to take 1 GB of RAM or a system in which another 512 MB RAM
can be added to accommodate an improved version of the operating system that
supports an advanced application software. Now Windows 7 has entered the
market that requires 1 GB of RAM. Thus, making a system adaptable to an
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advanced software enhances the installed system which facilitates in the
development of a more efficient procedure without replacing the hardware.

User Training

For successfully implementing MIS, the MIS manager must organize trainings for
the users according to their requirement. For example, training for clerical users
must include the processing and functioning of MIS. A manager must also be
informed about the procedure for online inquiries.

Once the system is installed and put to use, the users should be conversant
with its use. When a new system is installed or an old system is replaced with the
new system, users need suitable training about the system. This requires a proper
training to enable users to work efficiently on the system. Most developers provide
manuals and other documentations for this purpose, but it is not possible for
everyone to learn these by merely going through these documents and such an
approach is not practical. Thus, training is essential and the system developer
should be entrusted with the task of training customers after installation. The MIS
manager with the help of a system developer should organize the training for an
efficient handling of the MIS system. The main aspects of user training are:

o Imparting knowledge on the execution of the package
e The method of data entry
¢ Processing of data to take out reports in the prescribed format

Acquisition of Hardware and Software

Immediately after deciding the MIS design specifications, the process of purchasing
or developing the required hardware and software starts. Selecting hardware and
software is discussed later in this unit.

The MIS manager should ensure that the essential prerequisites such as
computer room, electric connections and communication lines, required to install
the hardware are fulfilled. The MIS manager should also ensure that other
consumables, such as papers and floppies are available as required.

While acquiring hardware and software, the recommendations of the system
developers should be kept in mind. More vendors should be invited to submit
their bids to get a competitive price. A general idea of products offered by different
vendors and manufacturers should be acquired. The quality of hardware should
not be compromised in order to acquire low prices. While inviting bids, a list of
installations made for users by the supplier/manufacturer should be demanded,
and an internal enquiry regarding these listed users should be made. There are
many new entrants in the market and their products may yet not be established. It
is always advisable to avoid such entrants even if they offer products at cheaper
rates.

Creation of Forms and Database

The database is used to store data, and forms are used for transmitting data.
Forms are used to input data to MIS and receive the output data from the MIS.
Therefore, the implementation of MIS also requires forms and databases. The
database and forms are generated in context of the entire MIS.




Different formats needed for MIS should be created and carefully reviewed T e‘ﬁ:f’_’"":%"caf{ﬂ"’
and a suitable database for this should be made, suited to the requirement ofthe 41,55 an e Signa;f ﬂ%
MIS used by the organization. Developers recommend the use of a relational :
database package. There are many such relational database packages. Such
relational databases can be used for a variety of purposes. A company database NOTES
should be created according to the need of the organization on any of these software
packages, for efficient retrieval of information, based on queries needed for creating
reports in suitable formats. Forms should be designed such that they can be opened
online when needed and sent directly. Such online forms ensure secrecy of vital
business-related information. This also reduces the need for papers.

Testing

Testing is a process that is performed to evaluate whether or not each element of
MIS such as equipment, programs and forms, works according to the design
specifications. Testing also calculates accuracy, range of inputs, frequency of inputs,
operating conditions and reliability factors of the MIS.

Nowadays, a Computer Aided Software Engineering (CASE) tool is used
to perform testing of MIS.

Developers of the system after successful testing get ready for the acceptance
test by the end-user. Thus testing is conducted at the customer's premises to show
that the system developed is capable of performing well as desired by the customer.
Developers should display the workability of the system and the end-users have
the responsibility to check whether the system installed meets the needs or not.
Normally, demonstrations on the working of the system and training of personnel
who will handle the system are in tandem.

The system must be evaluated by testing after implementation. Evaluation is
essential for the following reasons:

* Evaluating the accessibility of the system
* Analysing the limitations of the system
¢ Further enhancements of the system

Testing and evaluations are of four types:
() Operational evaluations; to check for proper operation
(i) Evaluation for organizational impact; to see how it improves the working
(i) User's assessment about the product
(iv) Development of performance based on existing practice and future
needs

This is the last opportunity that the customer gets for removal of bugs, if any,
that may be found in the system.

Changeover

After performing the testing, the last step is to put the MIS at the user’s workstation.
The process of placing the newly developed MIS at the workstation differs
depending on the following two situations:

e Placing only the new MIS system
. . Self - Learning
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If an MIS system is not available at the user’s workstation, then you can directly
install MIS.

However, if an MIS system is available at the user’s workstation, then there are
four policies to replace the existing MIS system with the new one:

¢ Direct: Uninstall or remove the existing MIS and install the newly developed
MIS in place of the old one. This policy is used when the existing MIS is
absolutely worthless.

¢ Parallel: Install the newly developed MIS parallel to the existing MIS,
until the new MIS is tested properly. In this policy, output from both the
existing and the new MIS are compared and tested. If the new MIS gives
the desired output then the previously installed MIS can be removed.

e Modular: Install the new MIS at the user’s workstation on a module basis.
In this policy, the user’s workstation is divided into groups and the new
MIS is installed for each group.

e Phase-in: [s similar to the modular policy. However, in this policy the new
MIS is segmented, instead of the user’s workstation. In this policy, each
MIS segment is installed at the user’s workstation and performs a specific
function.

Check Your Progress

. What are the objectives of system design?

. What are the types of abstractions in system design? N
. How can you classify system constraints?

. State about the forms and database in MIS.

O o0 9 O

4.6 ANSWERS TO ‘CHECK YOUR PROGRESS’

it

. Al Gore, former US Vice President.

. A host is a computer that has data to transmit. It is at one end of the
transmission system.

o

3. System analysis is a process in which data is collected and then interpreted
to identify problems within the system. After interpretation, problems are
identified. Therefore, the collected information can then be used to
recommend improvements in a system. In other words, system analysis
includes identifying, understanding and examining a system so that the
objectives of the system can be achieved.

4. Itis essential to determine the requirements of a system for the system
analysis process. The requirement determination is the preliminary step of
the system development activity and is also known as software requirement
specification (SRS).




5. A datadictionary is a structured repository of data that defines the basic Telecommunication,
. . i o p . Project Planning,
organization of a database. The data dictionary contains a set of PIeCISe  aiysis and Design of MIS

and accurate definitions of all the DFDs, data elements and data structures,

6. The objectives of the system design are: Practicality, flexibility, integrity,
reliability and efficiency.

7. The abstractions in system designs at the lower level are: Procedural
abstraction, data abstraction and control abstraction.

NOTES

8. System constraints may be classified into external constraints and internal
constraints.

9. The database is used to store data, and forms are used for transmitting
data. Forms are used to input data to MIS and receive the output data from
the MIS. Therefore, the implementation of MIS also requires forms and
databases. The database and forms are generated in context of the entire
MIS.

4.7 SUMMARY

e Information superhighway was a popular term used through the 1990s to
refer to digital communication systems.

¢ Telecommunication is the communication of information by electronic means,
usually over some distance.

* A telecommunications system is a collection of compatible hardware and
software arranged to communicate information from one location to another.
A network system consists of hardware components as well as software
components.

* A host is a computer that has data to transmit. It is at one end of the
transmission system.

e System analysis is a process in which data is collected and then interpreted
to identify problems within the system. After interpretation, problems are
identified. Therefore, the collected information can then be used to
recommend improvements in a system. In other words, system analysis
includes identifying, understanding and examining a system so that the
objectives of the system can be achieved.

e System analysis is really vital in the completion of the development process
of a system. It may be possible that a user is aware of the problem but may
not have the solution.

* Requirement analysis is a formal process of interacting with a client to
understand and establish the requirements of the client in a formal document.

e Itis essential to determine the requirements of a system for the system
analysis process. The requirement determination is the preliminary step of
the system development activity and is also known as software requirement
specification (SRS).
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e The interview strategy follows a method in which a user and a developer

interact with each other to collect the required data. In this method, the
developer poses questions to the user and based on the response given by
the user, the developer finds some solutions. :

The record review strategy is also known as review of documentation
strategy. The main purpose of this strategy is to find the quantitative information
regarding constraints such as volumes, frequencies and ratios.

A data dictionary is a structured repository of data that defines the basic
organization of a database. The data dictionary contains a set of precise
and accurate definitions of all the DFDs, data elements and data structures.

System design is an important step in the system development process.
This phase comes into existence after the system analysis is completed.
This means the output of the system analysis phase provides an input to the
system design phase.

The objectives of the system design are: Practicality, flexibility, integrity,
reliability and efficiency.

The abstractions in system designs at the lower level are: Procedural
abstraction, data abstraction and control abstraction.

System constraints may be classified into external constraints and internal
constraints.

In order to ensure smooth implementation of MIS, certain steps are planning
for implementation, acquisition of facilities and space planning, developing

MIS procedures, user training, acquisition of hardware and software, creating -

forms and database, testing, changeover.

4.8

KEY TERMS

Telecommunication: It is the communication of information by electronic
means, usually over some distance.

Telecommunication system: It is a collection of compatible hardware
and software arranged to communicate information from one location to
another.

Requirement analysis: A formal process of interacting with a client to
understand and establish a formal document of his requirement.

System Requirements Specification (SRS): A formal document that is
created to capture the requirements of the system.

Data Flow Diagram (DFD): A powerful tool to understand the functional
and informational views of a system.

Data Dictionary (DD): A structured repository of data that defines the
basic organization of a database.

Abstraction: The conceptualization of an issue or problem or entity in
terms of some level of generalization disregarding irrelevant low-level detail.
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¢ Refinement: A top-down design strategy in which the design is refined
after successive steps.

e Modularity: A concept which aids the designer to compartmentalize the
design into functional compartments as the entire system can be conceived
to be composed of a set of modules, each having its own special feature
and functionality.

e Procedural abstraction: A named collection of several sequential
procedural steps when abstraction is used to define procedural issues.

4.9 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions
1. Name and briefly describe the components of a telecommunication system.
. Define requirement analysis.
. List the various structured analysis tools.
. What is a data flow diagram?
. 'Wirite the principles of design.
. State about the abstraction.
7. What is user training?

N B W

Long-Answer Questions

1. Why has telecommunication technology become such an important issue
for managers and organizations?

2. What is a telecommunication system? Explain the principal functions and
components of all telecommunication systems.

3. Briefly explain the principles of analysis.
4. Explain the various strategies for requirement determination.

5. Describe the data items required in a data dictionary with the help of
appropriate examples.

6. Discuss the stages in development of designs.

7. Briefly explain the various steps to implement MIS giving appropriate
examples. '
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5.0 INTRODUCTION

A database is an organized collection of data stored and accessed electronically
from a computer system. Where databases are more complex they are often
developed using formal design and modeling techniques. The database management
system (DBMS) is the software that interacts with end users, applications, and
the database itself to capture and analyze the data. The DBMS software additionally
encompasses the core facilities provided to administer the database. The sum
total of the database, the DBMS and the associated applications can be referred
to as a “database system’. Often the term ‘database’ is also used loosely to refer
to any of the DBMS, the database system or an application associated with the
database.

Business organizations, non-profit organizations and individuals depend on
information systems to manage their day-to-day functions, get competitive
advantage, supply as well as receive services and lead comfortable lives. For
example, modern business firms depend on information systems to process their
accounts and manage human resources; local governments use information systems
to provide basic services to its citizens; individuals rely on information systems for
studying, shopping, banking and investing purposes.

In this unit, you will study about the introduction of file processing and DBMS,
typical information system.

Database Management
and Typical Information
Systems

NOTES

Self - Learning
Material 345



Database Management
and Typical Information
Systems

NOTES

Self - Learning
346  Material

5.1 OBJECTIVES

After going through this unit, you will be able to: .
¢ Understand the introduction of file processing and DBMS
e Explain the typical information system

5.2 INTRODUCTION TO FILE PROCESSING
AND DBMS

Many firms require Online Transaction Processing (OLTP), which means the
transactions entered online are processed immediately and the database is updated.
However, network failure, heavy network traffic, low server resources, etc., can
lower or disrupt the performance of the system. This can cause huge losses to
business firms, and thus, firms employ many methods to ensure that the systems
are operational during critical situations and the applications are always available.
Some of the methods are as follows:

e Fault-tolerant systems contain multiple hardware, software and power supply
components so that in case any one of them goes down, the other component
takes over. A fault-tolerant system has extra memory chips, processors,
and storage devices, and it uses software routines to detect any hardware
failure, and automatically switches to the backup device.

* High-availability computing provides system availability by speedy recovery
in case of a system crash. \

e [oad balancing is done to distribute large numbers of access request to
multiple servers so that no single server is flooded with all the requests.

e Mirroring is done to duplicate all the processes and transactions of a primary
server on a backup server. In case of failure of primary server, the backup
server takes over immediately so that there is no interruption in providing
service.

Why are Systems Vulnerable?

Today, most organizations use Web-based information systems, which typically
include a Web client, a server, and a database linked together through
communication lines. Each of these components is vulnerable to different types of
threats (see Figure 5.1). The client systems, for example, are vulnerable to computer
viruses, user errors and unauthorized access. Similarly, communication lines are
vulnerable to tapping and sniffing, database is vulnerable to data theft and alteration,
and so on.




, ’ Database Management
Client Server Database and Typical Inforfn:jn?n

computer computer Systems

Communication
)]

lines
$

NOTES

Tapping, Data theft,
Virus, sniffing, Hacking, data
unauthorized  altering virus, alteration,
access, message, etc. denial of etc.
damage to service
machine, etc. attacks, etc.

Fig. 5.1 Vulnerabilities of Various Systems

Note that any natural calamity, power failure, and other electrical problems can
cause disruptions at any point in the network. These threats can be the result of
technical, organizational, or environmental factors. These factors can increase the
potential of threats if management decisions are poor.

Systems are also vulnerable to attack by an employee of the organization
who has grudges with the management or the organization. This employee can
tap important information of the organization with much more ease than an outsider .
and can sell it to some rival company.

Outsourcing of application development to other organizations increases
system vulnerability. Programmers developing the applications might include some
code in the applications which later enable someone to gain unauthorized access
to the application or its data.

Internet Vulnerabilities

Private network of organizations may have connection to public network, such as
the Internet. In such situations, the information systems of organizations become
more vulnerable to attack because anyone connected to the Internet can illegally
access the confidential information. Since the Internet is a very big network, the
sources of the threats are spread virtually over the entire world.

Organizations may connect their network to the Internet by dial-up
connection or by cable modems or Digital Subscriber Lines (DSL). In case of
dial-up connections, a temporary IP address is assigned to computers for each
session. On the other hand, computers constantly connected to the Internet through
cable modems or DSL have fixed IP addresses. The fixed IP addresses make the
computers more prone to damage, since the targets for hackers are fixed.

Data in non-encrypted form is more vulnerable if it travels over insecure
public network. Most of the voice data over the Internet, for example, is not
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Database Management encrypted, which makes it more vulnerable. Anyone linked to the network can

§;’f,f§f G listen to the conversations and can take away the confidential personal information,
such as credit card numbers.

E-mail and other instant messaging services have increased the vulnerability
of the system. E-mails can have malicious software program (like virus) attached
to them which can install itself on the user computer. This program might enable
the person who sent the mail to read the personal information. Employees may
also send companies’ secrets to unauthorized users via an e-mail message or
attachment.

NOTES

Internet Hackers

Hackers are people who focus on finding some weak points in the security
mechanism of Websites and other computer systems in order to gain unauthorized
access. In the hacking community, the hackers with criminal intent are often termed
as crackers; but in mass media these two terms are often used interchangeably.

The activities of hackers are not limited to only gaining unauthorized access
to systems, but also include theft of confidential information and damage to the
information systems. They can also introduce viruses in the network which can
enter database or other applications and crash the whole server.

Spoofing and Sniffing

Hackers often spoof by hiding their identity and pretending themselves to be
someone else by using fake addresses. Hackers can divert a Web link to some
other address that is of the hackers’ interest. A link directed to a duplicate e-_
commerce Website created by a hacker, for example, can help him in collecting
and processing orders, stealing sensitive customer information, and so on.

Sniffer programs are used to listen to data travelling in the network without
permission of the sender of the data. These programs, if used in the right way, can
help in finding network trouble spots or criminal activities on the network. Sniffer
can also be used for criminal activities like extracting e-mail messages, files and
confidential reports.

Denial of Service (DoS) Attack

Hackers mischievously flood a network server or a Web server with many false
requests for services in order to crash the network. In this situation, the server is
not able to serve the genuine requests. This attack is known as Denial of Service
(DoS) attack. A variant of DoS attack is Distributed Denial of Service (DDoS)
attack in which numerous computers are used to generate false requests for a
network. Using numerous computers help the hacker to flood the network with
false requests very quickly.

Note that DoS attack does not damage information or access the restricted
areas, but can shut down a Website, thereby making the site inaccessible for
genuine users. Such kinds of attacks result in a huge loss of business if used on
busy e-commerce sites, such as eBay and Buy.com, because the customers cannot
make purchases while the site is shut down.
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Data Hierarchy ; Darabajse Management
and Typical Information
In computer systems, data is organized in a hierarchy where bit is at the lowest Systems
level and database is at the highest level (see Figure 5.2). All the terms in the
increasing order of hierarchy are as follows: NOTES
* Bit: The smallest unit of data that can hold only one of the two values, 0 or
1, is known as bit.

* Byte: A group of 8 bits is known as a byte. It indicates a single character
that can be a number, an alphabet, or any other symbol.

e Field: A set of characters that together form a word is known as a field. A
grouping of alphabets, for example, may form a name field and the grouping
of numbers may form a salary field.

* Record: A group of related fields that can be treated as a unit form a
record. Fields such as employee number, name, address, department
number, and salary for a particular employee form a record.

¢ File: A collection of logically related records is called a file.

* Database: A group oflogically related files is called database. It combines
the records from several distinct files into a centralized location from where
many applications can retrieve the data.

Database
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Fig. 5.2 The Data Hierarchy

The File Processing Approach

Earlier, the file processing approach was used across organizations for business
data processing where data was stored in independent files, and a number of
application programs were required to be written by the programmers to manipulate
the files. Each functional area, such as finance, marketing and human resources,
used to maintain their own set of data files and application programs. Thus, the
data of the organization was dispersed throughout different functional areas.
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Database Management The file processing approach was adequate until the development of

g’:ie%’ feal Information enterprise-wide applications which required the coordination and integration of
data from key business processes. Besides, this approach has some other
disadvantages, which are as follows: :

TES . .
Hel e Data Redundancy and Inconsistency: Same information may be

duplicated in several files. The name and address of an employee, for
example, may appear in a file consisting of details of employees as well as
in files consisting of details of working hours of employees. This duplication
of data is known as data redundancy, which leads to wastage of storage
space. The other problem with file processing approach is that the data
may not be updated consistently. Suppose the address of an employee
changes, then both the files containing the address of that employee must
be updated. This is because if the address is not modified in any of the two
files, then the same employee will have different address in different files.
This is known as data inconsistency.

e Integrity Problems: In any application, there are certain data integrity
rules that need to be maintained. These rules could be in the form of certain
conditions or constraints. The integrity rule that each employee, for example,
should have an employee number has to be implemented in all those
application programs that need to access the file containing the employee
number. In a file processing system, all these rules need to be explicitly
programmed in all the application programs. In addition, when new
constraints are to be enforced, all the application programs should be
changed accordingly. .

e Lack of Insulation Between Program and Data: The file processing
system lacks insulation between program and data. This is because the file
structure is embedded in the application program itself; thus, it is difficult to
change the structure of a file as it requires changing all the application
programs accessing it. Suppose, the data type of the field employee number
is changed from string to number, changes have to be made in all the
application programs that are accessing the file containing the employee
number.

e Difficulty in Accessing Data: Suppose a need arises to print the details
of all the employees working on a particular project. One way to handle
this request is to use the existing application program that prints the details
of all employees according to their projects, and then manually generate the
list of employees working on a particular project. Obviously, it is
unacceptable. Alternatively, the programmer is requested to write a new
application program. Now, if after sometime, suppose that another request
arises to filter the list of employees working on a particular project and
having salary less than ¥ 10,000. Then again we have to write a new
application program.

e Poor Security: The application programs are added in an unplanned manner,
the detail of each file is easily available to every user. Thus, the file processing
system lacks the security feature.
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The Database Approach

The bottlenecks of the file system approach lead to the introduction of the database
approach, which consolidates data from distinct files into databases that can be
shared by a number of applications. A database can be defined as a collection of
interrelated data from which users can efficiently retrieve the desired data.

In addition to the storage and retrieval of data, certain other operations can
also be performed on a database. These operations include adding, updating and
deleting data. All these operations on a database are performed using a Database
Management System (DBMS), which is an integrated set of programs used to
create and maintain a database. The main objective of DBMS is to provide a
convenient and an effective method to define, manipulate, store, and retrieve the
data stored in the database. In addition, DBMS ensures the security of the database
from unauthorized access, and the recovery of data during system failures. It also
provides techniques for data sharing among several users. The database and the
DBMS software are collectively known as the database system.

Advantages of the Database System

In the database approach, the data is stored at a central location and shared
among multiple users. Thus, the main advantage of the database system is the
centralized data management. The centralized nature of the database system
provides several advantages which overcome the limitations of the conventional
file processing approach. These advantages are as follows:

e Controlled Data Redundancy: During the database design, various files
are integrated, and each logical data item is stored at a central location. This
eliminates replication of the data item in different files, and ensures consistency
and saves the storage space. Note that the redundancy in the database
systems cannot be eliminated completely, as there could be some
performance and technical reasons for having some amount of redundancy.
However, DBMS should be capable of controlling this redundancy in order
to avoid data inconsistencies.

e Enforcing Data Integrity: In the database approach, enforcing data
integrity is much easier. Various integrity constraints are identified by the
database designer during designing the database, some of which are enforced
automatically by DBMS while others are to be implemented in the application
programs.

e Data Sharing: The data can be shared among the various application
programs. Moreover, new applications can be developed to use the same
stored data. Data sharing enables to satisfy the data requirements of new
applications without having to create any additional data or with minimal
modification.

¢ Ease of Application Development: The application programmer needs
to develop the application programs according to the needs of the users.
The other issues like concurrent access, security and data integrity are handled
by DBMS. This makes the application development an easier task.
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e Data Security: Since the data is stored centrally, enforcing security
constraints is much easier. DBMS ensures that the only means of access to
the database is through an authorized channel. Hence, data security checks
can be carried out whenever access is attempted to sensitive data. To ensure
security, DBMS provides security tools, such as user codes and passwords.

o Multiple User Interfaces: To satisfy the demands of various users having
different technical knowledge, DBMS provides different types of interfaces,
such as query languages, application program interfaces, and Graphical
User Interfaces (GUI) that include forms-style and menu-driven interfaces.
A form-style interface displays a form to each user and the user interacts
using these forms. In a menu-driven interface, the user interaction is through
the lists of options known as menus.

e Backup and Recovery: DBMS provides backup and a recovery
subsystem which is responsible for recovery from hardware and software
failures. If, for example, the failure occurs in between the transaction, the
DBMS recovery subsystem either reverts the database back to the state
which existed prior to the start of the transaction or resumes the transaction
from the point it was interrupted, so that its complete effect can be recorded
in the database.

In addition to the advantages due to the centralized data management, database
system also has some other advantages, which are as follows:

e Program-Data Independence: It is an important characteristic of DBMS
that allows changing the structure of the database without making any changes
in the application programs which are using the database.

e Data Abstraction: The property of DBMS that allows program-data
independence is known as data abstraction. Data abstraction allows the
database system to provide its users with an abstract view of data without
providing the physical storage and implementation details.

Components of DBMS

A database management system has the following three components:

1. Data Definition Language (DDL): The data definition language is a
special language that allows specifying the structure of the database. The
DDL statements are also used to specify the integrity rules, thereby maintaining
the database integrity. Like any other programming language, DDL also
accepts a set of instructions (statements) as input and generates the
description of structure of the database as output.

2. Data Manipulation Language (DML): Once the database structure is
defined, data needs to be manipulated. The manipulation of data includes
insertion, deletion, and modification of records. DBMS provides a Data
Manipulation Language (DML) that enables users to retrieve and manipulate
the data. The statement which is used to retrieve the data is called a query.

3. Data Dictionary: Apart from the data, the database also stores metadata,
which describes the tables, columns, indexes, constraints, and other items
that make up the database. In simple words, metadata is data about data.
This metadata is stored in an area called the data dictionary. DBMS refers
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the data dictionary before reading or'modifying the data. Note that the Database Management
database users cannot update the data dictionary; instead it is onlymodified @ Dpical Info {
by the database system.

People who Work with Databases NOTES

Database is an important asset of business. To design, use and maintain such
important asset, many people are involved. The people who work with databases
include the database users, systems analysts, application programmers, and
the Database Administrator (DBA). Database users are those who interact with
the database in order to query and update the database, and generate reports.
Database users are further classified into the following categories:

* Naive Users: The users who query and update the database by invoking
some already written application programs. The naive users interact with
the database using form interface.

* Sophisticated Users: Users, such as business analysts and scientists who
are familiar with the facilities provided by DBMS interact with the system
without writing any application programs. Such users use the database query
language to retrieve data from the database to meet their complicated
requirements.

* Specialized Users: The users who write specialized database programs
which are different from traditional data processing applications, such as
banking and payroll management which use simple data types. Specialized
users write applications, such as expert systems, knowledge-based systems,
and CAD systems that store data having complex data types. .

Systems analysts determine the requirements of the database users (especially naive
users) to create a solution for their business needs, and focus on non-technical and
technical aspects. The non-technical aspects involve defining the system requirements,
facilitating interaction between the business users and technical staff. The technical
aspects involve developing the specification for user interface. Application
programmers are the computer professionals who implement the specifications given
by the systems analysts, and develop application programs. They can choose tools,
such as Rapid Application Development (RAD), to develop the application programs
with minimal effort. The database application programmer develops application
programs to facilitate easier data access for the database users.

The Database Administrator (DBA) is a person who has central control
over both the data and the application programs. The responsibilities of a DBA
vary depending on the job description, and the corporate and organizational policies.
Some of the responsibilities of a DBA are as follows:

* Schema Definition and Modification: The overall structure of the
database is known as the database schema. It is the responsibility of the

DBA to create the database schema by executing a set of data definition

statements in DDL. The DBA also carries out the changes to the schema

according to the changing needs of the organization.

* New Software Installation: It is the responsibility of the DBA to install
new DBMS software, application software, and other related software.

After installation, the DBA must test the new software. Self - Learning
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¢ Security Enforcement and Administration: The DBA is responsible for
establishing and monitoring the security of the database system. It involves
adding and removing the users, auditing, and checking for the security
problems. :

e Data Analysis: The DBA is responsible for analysing the data stored in
the database, and studying its performance and efficiency in order to
effectively use the indexes, parallel query execution, etc.

¢ Preliminary Database Design: The DBA works along with the
development team during the database design stage due to which many
potential problems that can arise later (after installation) can be avoided.

e Physical Organization Modification: The DBA is responsible for carrying
out the modifications in the physical organization of the database for better
performance.

¢ Routine Maintenance Checks: The DBA is responsible for taking the
database backup periodically in order to recover from any hardware or
software failure (if they occurs). Other routine maintenance checks that are
carried out by the DBA are checking the data storage and ensuring the
availability of free disk space for normal operations, upgrading disk space
as and when required.

DBMS Architecture

A major purpose of DBMS is to provide users with an abstract view of the database.
It implies that the system does not provide all the details of data; rather it hides the
details of how the data is stored and maintained. DBMS provides three levels of
abstraction, namely internal, conceptual and the external level.

(i) The Internal Level: This is the lowest level of data abstraction that deals
with the physical representation of the database on the storage medium.
The internal level is also known as the physical level. At this level, complex
low-level data structures are described in detail which deal with the actual
storage. The data structure simply includes what data is stored and how it is
represented in the memory. The low-level data structure also includes the
internal details of the database, such as the storage space occupied by a
record and the offset for each data of a record.

(ii) The Conceptual Level: This level describes what type of data is actually
contained in the database and what relationships exist among them. The
conceptual level is also known as the logical level. At this level, the database
is described in the form of simple structures, such as tables and constraints.
The users of the conceptual level are not concerned with the details of the
internal level. They are just concerned with “what’ data is contained rather
than ‘how’ it is contained.

(iii) The External Level: This is the highest level of abstraction. The external
level (or the view level) depicts the view of the database from an individual
user. Most users of the database do not require all the information contained
in the database. Hence, the database can provide different information to




different classes of users. Concisely, this level is concerned with the way in
which individual users view the data.

Figure 5.3 shows the DBMS architecture (also known as the three-level
architecture) for the employee database containing details like employee number,
employee name, salary, and so on. The external level shows the database view
from two different users. The first user’s external view incorporates two fields,
Employee Number and Employee Name. The second user’s external view also
incorporates two fields, namely Employee Name and Salary. The conceptual level
represents different fields of database like Employee Number (6 characters),
Employee Name (25 characters) and Salary (5 digits). The internal level represents
the total record length (36 bytes) of the database. Note that an offset is the
displacement of the data from the base address in the memory.

View 1 View 2 EXTERNAL LEVEL
Employee Number Employee Name
Employee Name Salary

Employee Number Character(6)
Employee Name  Character(25)

Salary Number (5) CONCEPIAL LEVEL
Employee length = 36 Offset = 0, index = ex
Employee Number Type = Byte (6), offsef = 6 INTERNAL LEVEL
Employee Name  Type = Byte (25), offset = 20
Salary Type = Byte (5),

Fig. 5.3 The DBMS Architecture

Data Independence

The main advantage of the three-schema architecture is that it provides data
independence. Data independence refers to the ability to modify the database
structure at one level without affecting the database structure in the next higher
level. There exist two levels of data independence, namely logical data
independence and physical data independence.

* Logical Data Independence: 1t is the ability to make changes of the
external views or application programs at the conceptual level independently.
Simply, it pertains to the immunity of the external model to the modifications
in the conceptual model. The examples of the changes at the logical level
include addition and removal of entities in the database.

* Physical Data Independence: 1t is the ability to change the physical

organization of data without making any changes at the conceptual or external
level. Modification at the physical level is occasionally necessary in order to
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improve the performance. Simply, it pertains to immunity of an application
to the modifications in the internal level and the access strategy (the way of
accessing data). The examples of changes at the physical level include
reorganization of files, adding a new access path, etc. '

Data Models

As discussed earlier, the conceptual level describes what type of data is actually
contained in the database and what relationships exist among them. However,
how and what data structures are required to represent the data and their
relationships depend on the data model being used. The term data model refers to
organizing and representing a detailed database in different ways. A data model
consists of the following two parts:

e A mathematical notation to depict the data and the relationships.
o A setof operations for manipulating the data.

There are three basic types of database models, namely hierarchical, network
and relational. These database models share similar concepts; however, their
differences result from how they store the data.

The Hierarchical Data Model

The Hierarchical Data Model is the oldest type of data model, developed by IBM
in 1968. In this Model, data is organized in a tree-like structure where each child
node (also known as dependents) can have only one parent node. In other words,
a hierarchical database is a collection of records connected to one another through
links. The top of the tree structure consists of a single node that does not have any
parent and is called the root node. The root may have any number of dependents;
each of these dependents may have any number of lower level dependents.

Consider, for example, an Employee database that includes the record types
(collection of similar type of records)}—Employee, Project and Duration. The
Employee record type includes the fields Employee Code, Employee Name and
Salary of an employee. The Project record type includes Project_Code and
Project_Desc. The Duration record type includes No_of hrs spent by the employee
on a project. Every employee is assigned some projects.

Figure 5.4 represents the Hierarchical Model for the Employee database.
One complete record of each record type represents a node. The node for an
Employee record is linked to all those nodes of the Project record type that represent
the projects on which that employee is working. In addition, each node of the
Project record type is linked to a specific node of the Duration record type.

|EMP01 I John | 17000 | <- Employee record type

IP001 | Project1 ! < Project record type

- |
[poo2| Projecz | 1] 250 < Duration

|P003 Project3 (400 ] record type
250 |

Fig. 5.4 The Hierarchical Data Model for the Employee Database
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all the tables can be linked with each other using a common attribute in the tables.

gﬁﬁf et Ty Such linking is called a relationship.
Figure 5.6 represents the Relational Model of the Employee database. In
NOTES this figure, the Employee database includes three relations—Employee, Project

and Duration. The Employee relation includes the attributes Employee_Code,
Employee Name and Salary. The Project relation includes the attributes
Project_Code and Project_Desc. The Duration relation includes the attributes
Employee_Code, Project Code and No_of hrs. Since an employee is assigned
a project, the relations Employee and Project are linked with each other with the

help of the relation Duration.
Employee Relation
Employee Code Employee Name Salary
EMPO!1 John 17000
EMP02 Smith 19000
EMP03 Clark 22000
Project Rel/guon | Duration Relation
Project Code Project Desc Employee Code | Project Code No of hrs
POOL Project! EMPO1 PO01 450
P001 Project2 EMPO!L P002 400
P001 Project3 EMPO01 P003 250
P001 Project4 EMPO4 P004 300
1 |

Fig. 5.6 The Relational Data Model for the Employee Database

Keys

Key is one of the important concepts of relational database. It can be primary
key, candidate key, and foreign key.

Primary Key

An attribute that uniquely identifies each record in a relation is known as a primary
key. This implies no two records in the relation can contain the same value for the
primary key. In addition, the attribute chosen as the primary key cannot accept
null value. In the Employee relation, for example, the attribute Employee code is
the primary key because all employee codes are unique. Note that in any relation
there can be only one primary key.

Candidate Keys

In a relation, there can be more than one attribute that can uniquely identify each
record. All such attributes are known as candidate keys. Out of these candidate
keys, one is chosen as a primary key while the others that are not chosen as the
primary key are referred to as alternate keys. In the Employee relation, for example,
there are two candidate keys, namely Employee code and Employee name
(considering no two employees can have the same name). If the attribute Employee
code is chosen as a primary key, the attribute Employee name becomes the
alternate key.

Foreign Key

An attribute of a relation that references the primary key of another relation is

Sely-- Lagruing referred to as the foreign key. Figure 5.7 illustrates the relationship of the foreign
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key constraint to the primary key constraint. Here, the attribute Item_Code in the
PURCHASE relation references the attribute Item Code in the ITEM relation.
Thus, the attribute Item_Code in the Purchase relation is the foreign key.

Primary Key

PURCHASE

Foreign Key

ITEM

Primary Key
Fig. 5.7 The Foreign Key

Check Your Progress

1. What is the full form of OLTP?

2. What is spoofing?

3. Whatis a bit?

4. Name a few sophisticated users of database.
5. Who developed the Relational Data Model?

5.3 TYPICAL INFORMATION SYSTEMS

The most precious asset of an organization is its human resource. Managing it well
leads to growth and prosperity and mismanagement results in losses. Human
resource MIS (HRMIS) helps managers manage the HR of the organizations ina
better manner. The HRMIS, sometimes called HRIS, is an integrated system
consisting of the following subsystems:

¢ Recruitment subsystem: Recruitment is a regular activity in an organization
and involves the selection of suitable people for suitable jobs. Recruitment
activity tends to increase with the expansion of the organization. It is an
ongoing process because people leave an organization for various reasons.
Therefore, recruitment neutralizes the effect of attrition and ensures that
sufficient staff is always present to handle the growth activities of the
organization.
The HRIS is connected to online job portals and through these job portals,
it downloads and shortlists candidates for the suitable positions in the
organization. This subsystem also helps in manpower planning and in
managing bench. The HRIS gives detailed information about likely candidates
and aids the recruitment process.

* Training and development subsystem: The HRIS helps the ongoing
training and development activities in an organization by giving detailed
information about the training needs of employees, training modules and
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content, etc. to help the HR department take training and development-
related decision.

¢ Compensation and benefits management subsystem: Compensation
management involves deciding employees’ compensation and benefits to
ensure that they are satisfied in terms of the remuneration they receive and
the facilities and benefits they are provided with. Compensation-related
decisions depend on issues such as performance and seniority.

The HRIS provides information on current market rates for the types of
skill and competence that an individual possesses to help managers take a
decision on compensation. Other related information like pay parity,
information of similar ranking people in the organization, the historical
compensation structure of the organization, etc. are also available with the
HRIS to help the HR department decide compensation packages.

¢ Performance management subsystem: Performance managementis a
controlling activity wherein weak performers are recommended for training
and strong performers are appropriately rewarded.

The HRIS maintains important measures of performance for each employee
to rate his/her performance. Based on the rating, high performers are
rewarded, and the poor performer are relieved. This type of information is
very important for deciding the employees’ career plan.

Functions of Information Systems

Functionally, management can be segregated into several compartments; each
having specific specializations. Normally, management is a term loosely used to
identify people within an organization who have the authority and capability to
take decisions (mostly functional for the middle and junior level, but strategic for
the top level). The following is a brief description of the various functions wherein
information systems are useful.

1. Marketing function

Marketing is the activity of reaching out to customers, communicating the offerings
of the organization to them, selling the product or service and ensuring their
satisfaction. It is the activity through which an organization can keep its ears close
to the pulse of the market.

It generally encompasses the following sub-activities:

e Sales: It is the activity of selling the products or services of a firm. It is one
of the most important activities of marketing and employs a large number of
employees within the marketing department. Normally, sales function deals
with the management of the channels of sales, i.e. managing wholesalers,
retailers, stockists, etc., to ensure that the product or service reaches the
consumer. Some authors argue that selling is a push activity for marketing in
the sense that selling normally involves a top-down approach. Sales
department is the interface between the customer and the organization. One
can conceptualize a sales department as lying at the boundary between the
organization system and the environment of the customers.




* Advertising: It is the activity of highlighting the positive aspects of a product,

service, brand or company in electronic or print medium to create need
among consumers. Advertising is essentially a ‘pull’ activity. It creates a
need among consumers and thereby increases the revenue of the
organization. Sometimes, advertising can also be associated with creating
an image for the organization or sending a message to the consumers. It is a
tool in the hands of marketers to promote their products or services.
However, advertising is not an exclusively targeted activity in the sense that
the communication from the company to its consumers is not targeted at the
specific segments of consumers but sent to all consumers in general. This
“carpet-bombing’ kind of strategy is a drawback of advertising.

Publicity: It is that activity, which also results in greater revenue for the
company. It ensures that positive articles get published or broadcast so that
consumers are convinced of the efficacy of a product or service. Normally,
it is done in a way to show that the article or broadcast does not have any
direct association with the company or the brand. For example, when a
prominent nutrition specialist writes a positive article about a health drink
saying that it reduces (say) cholesterol, people reading the article may rightly
infer that this is the honest opinion of the nutritionist; however, the fact may
be that the health drink company may have persuaded or induced the
nutritionist to promote the company’s health drink. Publicity is used to create
awareness and build customer base.

Product management: It is the activity of managing the entire life cycle of
a product. It involves managing all activities associated with the product.

Customer relationship management: It is the activity of fostering loyalty
of the customer towards a brand or a product or a company. It encompasses
activities, which result in greater understanding and knowledge of the
customer. It is the activity, which enables a company to have a long-term
view of customers rather than having a short-term view. The activity of
CRM s based on the understanding of the customer as a person who has a
long-term relationship with the organization rather than at the time of sale
only.

Market research: It is the activity of conducting research on the market
for planning strategies or finding out whether the strategies of the company
are bearing results. It involves a lot of sampling survey and is applied to all
aspects of marketing activity like finding out if an advertisement campaign
has been successful or whether a class of product will have a market, etc.
This activity is more prone to mathematical and statistical treatment and
involves a lot of customer interaction.

Pricing: It is the activity of setting the price of a product or a service. It is
normally a strategic decision as it is done with a view to beat competition.
Packaging: It is the activity of creating suitable packages for consumers so
that the consumer is able to buy the product or service in order to maximize/
optimize the profit of the organization.
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2. Finance function

No organization can survive without managing its finances. It is responsible for the
management of receivables and payables, capital expenditure, costing and
budgeting, taxes, etc. In short, finance is the function which helps us measure the
value of the organization in monetary terms using several accounting, costing and
mathematical tools. Financial management includes:

e Working capital management: It is the activity of managing the working
capital of an organization. Working capital is the capital required to run an
organization on a regular basis. It is used to pay for salaries and materials. It
is normally in the form of a short-term debt.

¢ Receivables and payables management: The receivables and payables
of a company are managed in this activity. It results in the management of
creditors and debtors and helps management to take suitable decisions.
This is a very important activity of finance and is done with diligence.

e Budgeting: It is a strategic function of finance. It is the activity by which
the quantum of money spent on each activity of the organization is set. This
is a complex exercise and one which requires a strategic view of the
organization for the future.

e Capital expenditure management: This is an important activity which
takes care of the capital expenditure of the company and makes a plan for
such investments. These investments are inevitably linked with the cost of
capital.

e Auditing: It is the process of controlling finance systems. It gives us the
variations between the planned and unplanned financial decisions. It also
serves as a tool for taking care of malpractices in the firm by exposing
frauds within the system. It also reveals any deviation from the general rules
of finance as laid down by the company. These deviations, if analysed further
and found serious enough, warrant attention by the top management which
fixes responsibilities on people for such deviations and takes corrective
actions.

e Managing external borrowings: It is also an important function these
days as more and more companies are borrowing from outside the country.
This is a specialized task involving management of foreign exchange, etc.

3. Operational function

Every organization has an objective for existence, an offering in the form of a
product or a service. Without an offering, management of other activities is
meaningless. Operations management is that function, which helps an organization
manage the various activities related to the creation of a product or service. The
various activities associated with the operations management are as follows:

* Production management: It is the activity of managing the production
process of a firm. It involves planning of production and capacities,
monitoring of the production process, etc. so that control can be exercised
over the production process.




¢ Maintenance management: It is the activity of managing the maintenance Database Management

g ; g . : : and Typical Information
of machines in a firm. Different companies have different maintenance L Sysitems

policies.

e Quality management: This activity is considered very important in most
manufacturing and services organizations. It is the activity that measures the
final output of the finished product or service against the standard. Any
deviation from the standard is considered an aberration and corrective
measures are applied to rectify the same. Quality management itself has
several dimensions. Statistical quality control is a form of quality management
that takes a view of quality that is measurable. Total quality management is
the all-encompassing improved view of quality management that considers
quality as a comprehensive package of managerial initiatives aimed at
improving the quality culture of the organization.

NOTES

e Project management: It is that activity that helps in efficient management
of projects. It focuses on managing projects with respect to time and resource
management. Precise mathematical techniques are used in this activity to
manage projects.

¢ Inventory management: It involves the management of the raw materials
and finished goods inventory of the company. This is an important activity
as a lot of monetary resources are tied up in these areas. In addition, any
shortfall in the raw materials may trigger a cascading effect on production
and hence this activity is closely monitored. Vendors who supply the raw
materials are carefully chosen and nurtured so that they perform their tasks
with a high degree of reliability. Also, the lead time of vendors is closely
monitored and updated regularly to reflect the current status. A lot of
mathematical models are used for managing this function.

4. Human resource function
This function includes the following activities:
» Recruitment
¢ Training and development
¢ Compensation and benefits management
e Performance management
Macro-Level Information Systems
The main functions of Macro-level information systems are as follows:
e Collection, documentation and analysis of data
¢ Dissemination of market information

Various organizations require timely and accurate market information to
take decisions. The various techniques for dissemination of market information at
the macro level are as follows:

¢ Radio
e Newspaper
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The macro-level challenges to the use of information systems are as follows:

NOTES e Changing world: Information systems have brought in tremendous
change in the cultural, social, economic as well as political facets of the
society. These changes affect the information systems also.

* Greater concern for relevance: As the society is changing, the
information systems must change. Convincing the traditional stakeholders
about the relevance of information systems is essential. Information
systems are changing in accordance with the needs of modern
organizational and business issues such as profitability and sustainability.
For example, modern information systems provide agricultural programs
that adapt to the challenges of community and economic development,
biotechnology, youth programs, and drug and alcohol abuse.

e Greater need for determining impact: To determine the impact of
information systems, appropriate impact indicators should be identified.
It is difficult to identify the impact indicators because of the following
reasons:
o Scattered sources

o Timelag

¢ Information explosion: Knowledge has been rapidly changing and |
expanding owing to the modern information systems. E-leaming, distance '
education and publishing on the Internet have caused a kind of *
information revolution. '

Check Your Progress .
. Define the term advertising. |
. What is the function of HRIS?

. What are the main functions of MIS?
. Name the five macro-level challenges to the use of information systems.

o 00 9 N

5.4 ANSWERS TO ‘CHECK YOUR PROGRESS’ |

1. Online transaction processing system.

2. Spoofing is the process by which a hacker hides his identity and poses as
someone else.

3. Bitis the smallest unit of data that can hold only one of the two values, i
Oorl.

4. Users, such as business analysts and scientists who are familiar with the
facilities provided by DBMS interact with the system without writing any
application program.
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5. The relational data model was developed by E.F. Codd of IBM in 1970.
6. Advertising is the activity of highlighting the positive aspects of a product,

. The main functions of macro-level information systems are as follows:

. The macro level challenges to the use of information systems as follows:

service, brand or company in electronic or print medium to create need
among consumers.

The function of human resource information systems is to download resumes
from job portals and shortlist candidates for suitable positions in an

organization.

e Collection, documentation and analysis of data
e Dissemination of market information

¢ Changing world

o Greater concern for the relevance

o Greater need for determining impact
e Information explosion

SUMMARY

* In computer systems, data is organized in a hierarchy where bit is at the

Many firms require Online Transaction Processing (OLTP), which means
the transactions entered online are processed immediately and the database
is updated. However, network failure, heavy network traffic, low server
resources, etc., can lower or disrupt the performance of the system. This
can cause huge losses to business firms, and thus, firms employ many methods
to ensure that the systems are operational during critical situations.

Most organizations today use Web-based information systems, which include
a Web client, a server and a database linked together through communication
lines.

Private network of organizations may have connection to the public network,
like the Internet. In such situations, the information systems of organizations
become more vulnerable to attack because anyone connected to the Internet
can illegally access the confidential information. Since the Internet is a very
big network, the sources of the threats are spread virtually over the entire
world.

Hackers are people who focus on finding some weak points in the security
mechanism of Websites and other computer systems in order to gain
unauthorized access. In the hacking community, the hackers with criminal
intent are often termed as crackers; but in mass media these two terms are
often used interchangeably.

lowest level and database is at the highest level.
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e Earlier, the file processing approach was used across organizations for

business data processing where data was stored in independent files, and a
number of application programs were required to be written by the
programmers to manipulate the files. -

The bottlenecks of the file system approach lead to the introduction of the
database approach, which consolidates data from distinct files into databases
that can be shared by a number of applications. A database can be defined
as a collection of interrelated data from which users can efficiently retrieve
the desired data.

Database is an important asset of business. To design, use and maintain
such important asset, many people are involved. The people who work
with databases include the database users, system analysts, application
programmers, and the database administrator.

The Hierarchical data model is the oldest type of data model, developed by
IBM in 1968. In this model, data is organized in a tree-like structure where
each child node can have only one parent node.

The first specification of the Network data model was presented by the
Conference on Data Systems Languages in 1969. It is powerful but
complicated. Like the hierarchical model, in a network model also, the data
is represented by links. The link in a network data model represents an
association between precisely two records.

The Relational Data model was developed by E. F. Codd of IBM in 1970.
Though both the Hierarchical and the Network models were more flexible
as compared to the traditional file processing systems, they were still not
flexible enough. These limitations resulted in the development of the Relational
Data Model. In relational systems, creating a new database and modifying
the existing database structures are easier and faster as compared to a
network and hierarchical database.

The most precious asset of an organization is its human resource. Managing
it well leads to growth and prosperity and mismanagement results in losses.
Human resource MIS (HRMIS) helps managers manage the HR of the
organizations in a better manner.

Marketing is the activity of reaching out to customers, communicating the
offerings of the organization to them, selling the product or service and
ensuring their satisfaction.

5.6

KEY TERMS

Database: A collection of interrelated data from which users can efficiently
retrieve the desired data

Database management system: An integrated set of programs used to
create and maintain a database




¢ Recruitment: It is a regular activity in an organization that involves the
selection of people for suitable jobs.

5.7 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions
1. Name a few vulnerabilities of systems.
2. Who are hackers?
3. Whatis SPOOLing?
4. What are the advantages of the network data model?
5. What are the sub-activities of the marketing function?
6. Why is publicity of a product important for a company?
7. State the process of recruitment.
8. What is information explosion?
Long-Answer Questions
1. Discuss the main concept of multiprogramming.
. Briefly explain the data hierarchy with the help of diagram.
. Write a note on system analysts and application programmers.
. Describe the three levels of abstraction in the DBMS architecture.

. Discuss about the typical information systems with the help of appropriate
examples.
6. Briefly explain the various functions of information systems.

7. Explain the need and challenges of macro-level information systems.
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